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Safety Instructions

Be sure to read these instructions in order to operate the product safely. Follow these instructions to prevent
injury or harm to the operator of the product or others.

/N\ WARNING

Denotes the risk of serious injury or death.

e Stop using the product in any case of unusual circumstances such as the presence of smoke or a strange
smell.

* Do not touch any exposed internal parts.

e Do not get the product wet. Do not insert foreign objects or liquids into the product.

¢ Do not touch the product connected to a power outlet during lightning storms. This may cause electric shock.

e Do not disassemble or modify the product.

¢ Do not expose the product to strong shocks or vibration.

e Use only power sources specified in this instruction manual for use with the product.

¢ Observe the following instructions when using a battery charger or AC adapter.

- Do not touch the battery charger or AC adapter connected to a power outlet during lightning storms.

- Do not use the product if the power plug is not fully inserted into the power outlet.

- Do not unplug the product by pulling the power cord.

- Do not plug in or unplug the product with wet hands.

- Do not place heavy objects on the power cord. Do not damage, break or modify the power cord.

- Do not leave the product connected to a power source for long periods of time.

- Do not expose the power plug and terminals to dirt or let them come into contact with metallic pins or other
metal objects.

- Do not charge batteries/battery packs at temperatures outside the range of O - 40 °C (32 - 104 °F).

e Observe the following instructions when using commercially available batteries or provided battery packs.

- Do not use leaking batteries/battery packs.
If a battery/battery pack leaks and the material contacts your skin or clothing, flush the exposed area
thoroughly with running water. In case of eye contact, flush thoroughly with copious amounts of clean
running water and seek immediate medical assistance.

- Use batteries/battery packs only with their specified product.

- Do not heat batteries/battery packs or expose them to fire.

- Do not charge batteries/battery packs using non-authorized battery chargers.

- Do not expose the terminals to dirt or let them come into contact with metallic pins or other metal objects.

- Keep batteries out of the reach of children.

- When disposing of batteries/battery packs, insulate the terminals with tape or other means.

e Do not shoot the sun directly or point a lens or a camera with a lens attached at the sun. Even when the sun
does not appear on the screen or is behind the subject, the lens may concentrate the sunlight and cause a
malfunction or fire.

e Do not leave a lens or a camera with a lens attached, exposed without the lens cap attached. The lens may
concentrate the light and cause fire.

e Do not wrap the product in cloth or other materials when in use or shortly after use when the product is still
warm in temperature.

e Do not allow the product to maintain contact with the same area of skin for extended periods of time during
use. This may result in low-temperature contact burns, including skin redness and blistering, even if the
product does not feel hot. The use of a tripod or similar equipment is recommended when using the product in
hot places and for people with circulation problems or less sensitive skin.

¢ Keep the product out of the reach of young children.

e A strap wrapped around a person’s neck may result in strangulation.

e Periodically remove any dust buildup from the power plug and power outlet using a dry cloth.

e Follow any indications to turn off the product in places where its use is forbidden. Not doing so may cause
other equipment to malfunction due to the effect of electromagnetic waves and even result in accidents.

e Before installing, be sure the surface is capable of supporting the total weight of the camera and connected
devices, and sufficiently reinforce the surface if necessary.




A\ cauTions
Follow the cautions below. Otherwise physical injury or property damage may result.

e Strap is intended for use on the body only. Hanging the strap with any product attached on a hook or other
object may damage the product. Also, do not shake the product or expose the product to strong impacts.
This may cause injury or damage to the product.

¢ Do not leave the product in places exposed to extremely high or low temperatures. The product may become
extremely hot/cold and cause burns or injury when touched.

¢ Only mount the product on a tripod that is sufficiently sturdy.

* Do not look at the screen for prolonged periods of time. This may induce symptoms similar to motion
sickness. In such a case, stop using the product immediately and rest for a while before resuming use.

Only for European Union and EEA (Norway, Iceland and Liechtenstein) and United Kingdom
These symbols indicate that this product is not to be disposed of with your household
E R waste, according to the WEEE Directive (2012/19/EU), the Battery Regulation ((EU) 2023/
1542) and/or national legislation implementing those Directive and Regulation and the UK
— Waste Electrical and Electronic Equipment Regulations and the UK Batteries and
Accumulators Regulations.
If a chemical symbol is printed beneath the symbol shown above, in accordance with the Battery Regulation
and the UK Batteries and Accumulators Regulations, this indicates that a heavy metal (Hg = Mercury, Cd =
Cadmium, Pb = Lead) is present in this battery or accumulator at a concentration above an applicable
threshold specified in the Battery Regulation and the UK Batteries and Accumulators Regulations.
This product should be handed over to a designated collection point, e.g., on an authorized one-for-one
basis when you buy a new similar product or to an authorized collection site for recycling waste electrical
and electronic equipment (EEE) and batteries and accumulators. Improper handling of this type of waste
could have a possible impact on the environment and human health due to potentially hazardous
substances that are generally associated with EEE. Your cooperation in the correct disposal of this product
will contribute to the effective usage of natural resources.
For more information about the recycling of this product, please contact your local city office, waste
authority, approved scheme or your household waste disposal service or visit
Www.canon-europe.com/sustainability/approach/.
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Introduction

About this Manual

Thank you for purchasing the Canon EOS C80. Please read this manual carefully before you use the camera and
retain it for future reference. Should the camera fail to operate correctly, refer to Troubleshooting (11 224).

Before Using the Camera

e Before making important recordings for the first time, make test recordings using the video configuration(s)
you plan to use to check that the camera operates correctly. Should it fail to operate correctly, refer to
Troubleshooting (1 224).

¢ Copyright notice: Unauthorized recording of copyrighted materials may infringe on the rights of copyright
owners and be contrary to copyright laws.

¢ Notes on privacy and publicity rights regarding the use of video: \When using the camera, exercise proper
caution in order to protect privacy and avoid any violation of publicity rights.

e About the LCD screen: The screen is produced using extremely high-precision manufacturing techniques, with
more than 99.99% of the pixels operating to specification. Very rarely, pixels may misfire or light up
permanently. This has no effect on the recorded image and does not constitute a malfunction.

 About the access indicator: Observe the following precautions while an access indicator (1] 36) is illuminated
or flashing in red. Failing to do so may result in permanent data loss.

- Do not turn off the camera and do not remove the battery or other power source.
- Do not open the card compartment cover.

Conventions Used in this Manual

@ MPORTANT: Precautions related to the camera’s operation.
o @NOTES: Additional topics that complement the basic operating procedures.
¢ [11: Reference page number.
¢ The following terms are used in this manual.
- “Screen” refers to the LCD monitor's screen.
- “Battery” refers to a supplied or optional battery pack.
- “AC adapter” refers to the CA-CP300 B Compact Power Adapter.
- “SD card” refers to an SD, SDHC or SDXC memory card.
- “Card” alone, not specified: refers to SD cards.
- “RAW” refers to the data recorded in Cinema RAW Light.
- “Multi-Camera Control” refers to Canon Multi-Camera Control.
- “CAMERA mode”: operating mode for making recordings (shooting mode).
“MEDIA mode”: operating mode for playing back and managing recordings (playback mode).
- “Access indicator”: when not specified, refers collectively to the SD CARD access indicators.
¢ Unless indicated otherwise, shooting functions are utilized in CAMERA mode.
¢ Unless indicated otherwise, illustrations in the manual show the Canon EOS C80 camera with a Canon
RF24-1056mm F4 L IS USM lens attached.
¢ Photographs in the manual are simulated pictures taken with a still camera.
e Some screenshots have been altered to make them easier to read. Furthermore, screenshots used are from a
product in development and may differ slightly from the actual screens due to product enhancement.



Supplied Accessories

Supplied Accessories

The following accessories are supplied with the camera. For accessories sold separately, please refer to Optional
Accessories ([J] 241). Unless indicated otherwise, accessories mentioned in this manual are the ones supplied

10  with the camera.

CG-A20 Battery Charger BP-A30N Battery Pack Handle Unit

(incl. terminal cover)

Microphone Holder Multi-Function Shoe Cover* Body Cap* SS-1200 Shoulder Strap
(incl. M4 fixation bolts, x2)

Tape Measure Hook* Quick Guide

* Comes pre-attached to the camera.

@ nvPorTANT
e Do not use the supplied compact power adapter and power cord with other devices as this may cause a
malfunction.
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Names of Parts

—1

| U +
|IIII
AIRINTAKE

—

=)
5

H

)
o)

w
=
7
S

REMOTE

\J__I—m

‘
—_
~

-

—_
w

Hom

/
N
J@

—_

ND FILTER +/- buttons ([1] 72)
2 WB (white balance) button (11 77)/
Assignable button Camera 1 ([J] 125)
3 % (white balance adjustment) button (11 77)/
Assignable button Camera 2 ([1] 125)
4 Strap mounts
Pass one end of the SS-1200 Shoulder Strap
through the strap mount and adjust the length of
the strap.

* Can be assigned exclusively as a REC button ([I1 125)

Removing and attaching the terminal covers
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Air intake vent ([] 44)

SDI OUT terminal ([J] 154)

INPUT 1/INPUT 2 terminals ([J1 102)
MIC (microphone) terminal (1] 102)
USB terminal (1 122)

10 ) (headphone) terminal (1] 106)

11

REMOTE terminal (11 123)
For connecting the RC-V100 Remote Controller or
commercially available remote controllers.

12 HDMI OUT terminal ([J1 154)
13 DISP (display) button (11 49)/

Assignable button Camera 5 ([1] 125)

14 ZEBRA button (01 93)/

Assignable button Camera 6 ([11 125)

15 WFM (video scope) button ([J] 108)/

Assignable button Camera 4* (1] 125)

16 PEAKING button ([T1 82)/

Assignable button Camera 3 ([1] 125)

You can remove the covers of the camera’s terminals to access them more easily. To remove a terminal’s
cover, open the cover and gently pull it straight out. To attach back the terminal cover, insert the connecting
strip into the opening. If the connecting strip is difficult to grasp, use a pair of tweezers or similar tool.
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Strap mounts

Insert the end of the SS-1200 Shoulder Strap from
the top of the strap mount and pull it from the
exhaust ventilation outlet to attach it to the
camera.
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Exhaust ventilation outlet ([1] 44)

Assignable button Camera 10 ([J] 125)

Card slots and (B (1 36)

Card compartment cover ([1] 36)

TIME CODE terminal ([J] 98)

Tripod screw holes (1/4"-20, 7.5 mm (0.29 in.)
deep)
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10 1

Lens mount

1 REC (start/stop recording) button ([1] 47)

2 Grip belt
Adjust the grip belt so that you can reach the REC
button with your index finger but still have a
comfortable but secure grip.

Front control dial ([J] 69, 73)

RF lens mount index ([11 29)

Monaural microphone ([I] 100)

Power indicator (green)/Tally lamp (red) (11 47)
Lens lock pin

Lens release button ([ 29)
Assignable button Camera 11 (1] 125)
The [REC] function can be assigned.
10 Lens contacts ([ 29)

11 AF LOCK button (11 85)/

Assignable button Camera 12 (1] 125)

© o0o~NO O ~W
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Names of Parts
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LCD monitor ([11 23)

INPUT 1 (top) / INPUT 2 (bottom) switches

(audio source selection, [1] 102)
Joystick ([I] 26)

You can push the joystick in 8 directions (up/
down, left/right, or diagonally) and press the

joystick itself to confirm.

PUSH AUTO IRIS (momentary automatic aperture)

button (11 74)/

Assignable button Camera 7 ([1] 125)
MAGN. (magnification) button (1] 82)/
INDEX button (11 142)/

Assignable button Camera 8 ([11 125)
Rear control dial (1] 69, 74)

FUNC (main functions) button (11 57)/
Assignable button Camera 9 ([1] 125)

Audio level dials for CH1 (top) and CH2 (bottom)
([0 104)

Audio level switches for CH1 (top) and CH2
(oottom) (1] 103)

AUDIO STATUS (display the [ Audio Setup]
status screens) button ([J] 213) /

Assignable button Camera 13 ([J] 125)
Ethernet terminal (11 167)

DC IN terminal (1 21)

Battery compartment ([ 20)

BATTERY RELEASE button ([ 20)

CANCEL button ([1] 26)

SELECT dial/SET button ([11 26)

MENU button ([ 26)
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1 Accessory mount with socket for 1/4"-20 7 SLOT SELECT (card selection) button ([ 38,
mounting screws (7.5 mrg (0.29 in.) deep) (11 33) 142) onE
2 Tape measure hook and @ focal plane mark 8 SD CARD access indicator: ffM/f£1 ([11 36)
Use the hook to accurately measure the distance 9 Power cord clamp (unplugging prevention)
from the focal plane. (@22
3 switch 10 Exhaust ventilation outlet ([T] 44)
@: Key lock. 11 Socket for tripod’s anti-rotation pin
CAMERA: Starts the camera in CAMERA mode. (5.6 mm (0.22 in.) deep)
OFF: Turns off the camera. 12 DC cable clamp ([11 22)
4 Speaker ([1] 146) Used to prevent accidental disconnection.
5 Multi-function shoe (with shoe cover) (1] 34) 13 Screw holes for 1/4"-20 mounting screws
6 MEDIA button ([I] 141) (7.5 mm (0.29 in.) deep)
When the camera is on, press to toggle the 14 Screw hole for 3/8"-16 mounting screws
camera between CAMERA mode (shooting) and (7.6 mm (0.30 in.) deep)
MEDIA mode (playback). 15 Screw holes for tripod reinforcements and

accessories with 1/4"-20 mounting screws
(7.5 mm (0.29 in.) deep, x2)

Locking the camera’s controls (key lock)

You can set the switch to & (key lock) to lock all the camera’s buttons* and switches. This is useful
in preventing settings from being changed due to inadvertently pressing one of the buttons. Set the
switch back to CAMERA to reactivate the controls.

When the camera’s controls are locked, you can still operate the camera using an RC-V100 Remote
Controller or the Browser Remote application.

* REC buttons are not locked by default but you can choose to lock them too ([1] 211).

15
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Names of Parts

@ nvPorRTANT

¢ Do not use tripods and other accessories with mounting screws exceeding the depth of the screw holes on
the camera as this may damage the camera.

¢ Mounting the camera on a tripod using only one of the 1/4"-20 screw holes for tripod reinforcement may
damage the camera.

Handle Unit (1] 32)

4
1 Locking knob 4 Sockets for the microphone holder ([11 33)
2 Cable clamp

3 Accessory shoe

Microphone Holder ([T 33)

1 Microphone lock screw 3 Microphone cable clamp
2 Microphone holder



Workflow Overview: 4K and Higher

Workflow Overview: 4K and Higher

The following illustrates the typical workflow for 6K/4K recording with the camera.

Recording Post-production

4K recordin:
SDI OUT/ b 9

HDMI OUT
terminal
output

External
recorder

) Primary clips
@ 6K/4.3K recording (RAW), YEAC

| 1
| 1
| 1
4Krecording (XF-AVC/ ' e HEVCS| !
I I
| 1

XF-HEVC S / XF-AVC S) XF-AVC S
data

SD card

RAW O [Ful-quality
- dat
e Cinema ata
_ RAW
Development

1
i © 2K recording (XF-AVC / TR —— :
©Shooting e HEVC 5/ XF-AVC 9) data P—
1
NLE E
SD card software -
@ 6K recording
HDMI |
RAW External Fullaqtt.leTI
recorder aia

1 Shoot in 6K/4K mode (11 59).

2 You can record primary clips (6K/4.3K: RAW, 4K: XF-AVC / XF-HEVC S / XF-AVC S) on an SD card in the
camera, record 6k data to an external recorder using HDMI RAW, or record 4K data using an external recorder
connected to the camera’s SDI OUT or HDMI OUT terminal ([J] 155).

3 While recording primary clips, you can simultaneously record 2K proxy clips on an SD card B.
¢ The file names of 2K proxy clips (XF-AVC / XF-HEVC S / XF-AVC S) and 4K clips are linked and identical for

the most part (11 42).

4 You can use the 2K proxy clips recorded on the SD card, proxy files generated by Cinema RAW Development
or 6k data recorded to an external recorder using HDMI RAW on NLE software to edit the video offline and
create an EDL.

5 After recording RAW data on an SD card in the camera, develop the clips using the Cinema RAW
Development software ([J1] 162) to generate full-quality data.

e You can also generate proxy data.
6 Perform color grading based on the full-quality data.



Workflow Overview: 4K and Higher

Color Grading with the ACES Workflow

You can perform color grading using ACES, the color encoding system defined by the Academy of Motion
Picture Arts and Sciences.

HDMI RAW —— Post-production
External RAW
™ recorder data > RAW Input
L - Development => Transform =>
A Cinema RAW Color grading
ol == D card et Gt p| Development (ACEScc/ACEScct)
e Input OpenEXR
Transform (ACES)
XF-AVC
RO S I —
data < Transform ASC-
1 CDL
CanonlLog2/3
Cinema Gamut Output
Transform
| |

Color spaces:
ST2065-1:
ACEScc:
ACEScct:

Input Transform:

Output Transform:

ASC-CDL:

APO primaries, linear floating-point encoding.
AP1 primaries, log floating-point encoding.

AP1 primaries, log floating-point encoding. Differs
from ACEScc by adding a ‘toe’ to the encoding,
with a behavior resembling that of the Cineon
curve.

Refers to the table used for converting color
information of the input device to ST2065-1 color
space. It can be downloaded from Canon'’s
website.

Refers to the table used for mapping ST2065-1
color space information to the specific color
information scheme used by the display device.
Refers to the list that contains color grading
adjustment data. This step requires equipment
compatible with ASC-CDL.

124 BT.709
AN BT.2020
1 : N - - - Cinema Gamut
) N APQ
084 \ AP1
I \
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>
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Preparations

Preparing the Power Supply

You can power the camera using a battery or a power outlet. Even when a battery is attached, if the camera is
connected to a power outlet, it will not draw power from the battery.

Using a Battery

You can power the camera using the included BP-A30N Battery Pack or the optional BP-A60N Battery Pack.
Both battery packs are compatible with Intelligent System so you can check the approximate remaining battery
usage time (in minutes) on the screen. For more accurate readings, when using a battery for the first time, charge
it fully and then use the camera until [Change the battery pack] appears on the screen.

Charging the Battery AC adapter

Charge battery packs using the CG-A20 Battery Charger and
CA-CP300 B Compact Power Adapter. Before charging, remove
the terminal cover of the battery pack.

1 Connect the AC adapter to the battery charger and plug the
power cord into a power outlet.
2 Attach the battery to the battery charger.

e Press lightly and slide the battery in the direction of the
arrow until it clicks.

e The CHARGE indicator starts flashing and also indicates the
battery pack’s approximate charge. The indicator will stay CHARGE
on when charging has completed. indicator

Battery Charger

¥ ¥ approx. 0% to 49%: Flashes once every 2 seconds
¥k ¥k approx. 50% to 74%: Flashes twice every 2 seconds
kK ek approx. 75% to 99%: Flashes 3 times every 2 seconds

3 Disconnect the AC adapter from the battery charger and unplug the power cord.
4 Remove the battery from the battery charger.

@ vroRTANT

¢ Do not connect to the battery charger any product that is not expressly recommended for use with this
camera.

¢ \When using the battery charger or AC adapter, do not fix it permanently to one place as this may cause a
malfunction.

¢ Even within the operating temperature range of the included CG-A20 Battery Charger or the optional CG-A10
Battery Charger, charging may not be possible depending on the internal temperature of the battery.

19
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Preparing the Power Supply

e To prevent equipment breakdowns and excessive heating, do not connect the battery charger or AC adapter
to voltage converters for overseas travels or special power sources such as those on aircraft and ships,
DC-AC inverters, etc.

(i) notes

¢ We recommend charging the battery in temperatures between 10 °C and 30 °C (50 °F and 86 °F). Outside the
temperature range of 0 °C to 40 °C (32 °F to 104 °F), charging will not start.

e [f there is a malfunction with the battery charger, AC adapter or battery, the charge indicator will go out and
charging will stop.

¢ For handling precautions regarding the battery, refer to Handling Precautions ([1] 238).

¢ For approximate charging times / usage times, refer to the Reference Tables ([11 251) and Approximate
Continuous Recording Times ([ 247).

e Charged batteries continue to discharge naturally. Therefore, charge them on the day of use, or the day
before, to ensure a full charge.

* \We recommend that you prepare batteries to last 2 to 3 times longer than you think you might need.

¢ Repeatedly charging and completely depleting a battery will eventually shorten its battery life. You can check
the battery life on the [ System Setup] status screen ([(J1 213). Fully charging the battery pack and then
depleting it until [Change the battery pack] appears on the screen will give you a more accurate reading.

Attaching the Battery
1 Turn off the camera.

2 Insert the battery all the way into the compartment as
shown in the illustration and press it gently toward the left
until it clicks.

Removing the Battery
1 Turn off the camera.

2 Holding down the BATTERY RELEASE button (), slide
the battery toward the right and then pull it out ().

BATTERY
RELEASE

0




Preparing the Power Supply

Checking the Remaining Battery Charge

You can check the approximate charge level on the battery itself. When the camera is turned on, you can check
the approximate remaining battery usage time (in minutes) by looking at any recording/playback screen or the
[¢ System Setup] status screen ([ 213).

Press the CHECK button on the battery. An indicator will
light for approximately 3 seconds and show the gk
approximate remaining battery charge. — 0 ® e e e100%

0-25%
26-50%
51-75% Battery charge CHECK button
76-100% indicator
- o

 The remaining battery charge level displayed in minutes on the screen may not match the [ System Setup]
status screen or the indicators on the battery pack.

Using a Power Outlet

You can also power the camera directly from a power outlet using the CA-CP300 B Compact Power Adapter
(AC adapter). While the camera is powered using a power outlet, you can replace the battery pack even when
the camera is turned on.

Connect the power cord to the AC adapter, the AC
adapter’s DC plug to the DC IN terminal on the
camera, and the power plug to a power outlet.

@ vPoRTANT

* Make sure to turn off the camera before connecting or
disconnecting the AC adapter.

¢ \When using the AC adapter, do not fix it permanently to
one place as this may cause a malfunction.

¢ In order to prevent the camera from powering off due to
a power outage or accidental disconnection, it is
recommended to attach a battery pack even when
recording with the camera connected to the AC adapter.
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Preparing the Power Supply

Preventing the accidental unplugging of the power cord

IN3A ISNVHX3 @ anisnvix ®

Pass the power cord through the DC cable clamp
(recommended) and/or the clamp at the bottom of
the camera as shown in the illustration to prevent
the accidental unplugging of the DC plug.

Checking the Voltage Level of the Power Source

The voltage level appears on the screen (1] 49). Select MENU > [¥ System Setup] > [DC IN Warning (V)] to set
a power warning level. When the voltage from the DC IN terminal reaches the set value, the onscreen voltage
indicator will turn red and a warning will be displayed.

(i) NoTES

¢ The camera will not start recording if the voltage falls below the selected low-power warning level ([1] 211).
While shooting, the recording will be interrupted and the camera will turn off if the power voltage falls below the
level required for the camera's operation.



Using the LCD Screen

Using the LCD Screen

This section explains how to adjust the LCD monitor. You can adjust the direction of the screen as shown below,
as well as image settings such as brightness or contrast. Additionally, you can use the touch screen to select the
subject or perform a variety of settings using direct touch control (1] 56). 23

1 Open the LCD monitor 180 degrees (D) and adjust to the desired angle (2).

2 When the screen is facing the subject (®), you can also place it back in its original position with the
screen facing out (@).

(i) NoTES

e You can adjust the brightness, contrast, color saturation, sharpness and luminance of the LCD screen with the
respective settings in the MENU > [(E)) Monitoring Setup] menu ([J] 204). These settings do not affect the
recorded video.

¢ In CAMERA mode, you can use the MENU > [[Z) Monitoring Setup] > [B&W Image: LCD] setting to change
the image on the screen to black and white display. Even when the captured image is displayed in black and
white, onscreen displays and icons will be shown in color.

¢ You can use the MENU > [¥ System Setup] > [Touch Screen Response] setting to adjust the LCD monitor’s
response to touch input.

¢ When the LCD panel is rotated 180 degrees toward the subject, you can set MENU > [[E) Monitoring Setup]
> [LCD Mirror Image] to [On] to flip the image horizontally so it shows a mirror image of the subject.

e For details about how to take care of the LCD monitor, refer to Handling Precautions (11 238), Cleaning

(11 240).
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PIN Code, Date, Time and Language Settings

PIN Code, Date, Time and Language Settings

You will need to set the PIN code, date and time on the camera the first time you power it on, or after the
camera's settings have been reset. Refer to Using the Menus ([11 26) for instructions on setting operation.

Setting the PIN Code

First, set a 6-digit PIN ¢

1 Enter a PIN code (6-digit number).
e The numeric keypad screen is displayed by touching the input area in the center of the screen.
e Touch a key on the screen to select a number, then touch [OK] to confirm the entry.
e You can also use the SELECT dial or the joystick to select a number and press the SET button to enter it.

2 Select [OK].
3 Enter the PIN code again following the on-screen instructions and select [OK].

4 When the confirmation message appears, select [OK].
e You will need to enter the PIN code when starting up the camera.
¢ By configuring the following settings, you can omit entering the PIN code from next time.
- Select [Don't require PIN code again] on the PIN code entry screen.
- Set MENU > [¥ System Setup] > [PIN Code Management] > [PIN Code Request] to [Disable].

@ vrorTANT

e |f you forget your PIN code, you will need to reset the device. Please note that all camera settings will be
initialized.

e Setting a PIN code does not protect the recorded data stored on the card.

e Canon shall not be liable for the theft of this product or any memory cards.

e |f you configure the settings to omit entering the PIN code, please be careful to prevent third parties from
accessing the camera's settings and other information.

(i) NoTES

e Until you enter the PIN code, these connections are not available while the PIN code screen is displayed.
- USB connection
- Network connection

¢ To change the PIN code, go to MENU > [ System Setup] > [PIN Code Management] > [PIN Code Changel.



PIN Code, Date, Time and Language Settings

Setting the Date and Time
Date/Time

UTC-05:00 Jan 1 . 2024 12 : 00

¥

New York

1 Select the desired time zone* using the joystick or the SELECT dial, and confirm by pressing the SET
button or the joystick itself.
® The cursor will move to the next field.

e You can also push the joystick left/right to move between the fields.

* The default time zone is [UTC-05:00] (New York) or [UTC+01:00] (Central Europe), depending on the country/region of
purchase. Time zones are based on Coordinated Universal Time (UTC).

2 Change the rest of the fields in the same way.
3 Select [Set] and then press SET.

(i) NoTES

¢ You can display the date/time with the MENU > [[Z)) Monitoring Setup] > [Custom Display 2] or [Custom
Display] > [Date/Time] setting.

¢ With the following settings, you can make changes after the initial setup. You can also change the date format
and clock format (12 or 24 hours).
- MENU > [¥ System Setup] > [Time Zone], [Date/Time] and [Date Format]

¢ \When you do not use the camera for about 3 months, the built-in backup battery may be depleted completely
and the date and time setting may be lost. In such case, recharge the built-in backup battery (1] 239) and set
the time zone, date and time again.

e Using the GP-E2 GPS Receiver, you can have the camera adjust settings automatically according to the UTC
date/time information received from the GPS signal ([J1 211).

Changing the Language

The camera’s default language is English. You can change it to German, Spanish, French, Italian, Polish,
Portuguese, Russian, Ukrainian, Simplified Chinese, Korean or Japanese. Please note that some settings and
screens will be displayed in English, regardless of the language setting.

Refer to Selecting an Option from the Menu ([ 26) for details on how to navigate the menu to complete this
procedure.

1 Select MENU > [¥ System Setup] > [Language & ].
2 Select the desired language and press the MENU button to close the menu.

25
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Using the Menus

Using the Menus

Many of the camera’s functions can be adjusted using the menus. In CAMERA mode, you can also register
frequently used menu settings in a customized menu (My Menu) for easy access. For details about the available
menu options and settings, refer to Menu Options (1] 199).

Front control dial
When the menu is open, turn
the dial to move to the next/
previous menu page.

Rear control dial
When the menu is open, turn the dial to move
to the next/previous setup menu.

MENU button

Press the button to open the setup menus and
then press again to close the menu after
adjusting desired settings.

4 N

MENU

—— SET button

Wﬁ% Press the SET button to confirm a selection.
@ <l SELECT dial

Turn the dial to move the orange selection
CANCEL 0

frame in the menu.

CANCEL button

Press to return to the previous menu/submenu
- - level or to stop some operations that are in
progress.

Joystick/SET button

When making a menu selection, push the joystick
to move the orange selection frame in the menu.
Then, press the joystick itself to select the menu
item indicated by the orange selection frame.

Selecting an Option from the Menu

The following is a step-by-step explanation of how to select a typical option from the setup menus. Some menu
items may require additional steps. Such operations will be explained in the respective section of the manual.
For brevity's sake, references to menu settings throughout the manual will be abbreviated as follows:

MENU > [¥ System Setup] > [Language &3 ] > Desired option

1 Press the MENU button.

e The menu opens. The icon displayed in orange is the menu item that was selected the last time the menu
was closed (unless the camera was turned off).

e \When a menu icon is not selected, first push the joystick up or press the CANCEL button to move the
orange selection frame to one of the icons.
2 Push the joystick left/right to select the icon of the desired setup menu.
¢ You can also use the rear control dial.



Using the Menus

3 Press the joystick or the SET button to confirm your selected setup menu.
e The cursor moves to the first item on the first page of the selected setup menu.
e You can also push the joystick down to move the cursor to the list of menu items.
e Going forward, this operation will be referred to as “press SET” in this manual.

4 Select the desired menu item ([Language & ], in the example) and then press SET.
e Joystick operation:
- Push the joystick left/right to scroll through the menu pages. Moving left/right from the first/last page will
move to the previous/next setup. You can use the front control dial.
- Push the joystick up/down to move the cursor over the menu items on the page.
e Dial operation:
- Turning the SELECT dial will scroll through the menu items on the page. Scrolling beyond the first/last
menu item in the list will move to the previous/next menu page.
- Scrolling beyond the first/last page will move to the previous/next setup menu.
5 Push the joystick up/down or turn the SELECT dial to select the desired setting option and then
press SET.

¢ During the selection, the currently selected option is indicated with a b mark. Press SET to confirm your
selection and go back to the previous screen.

¢ \When many options are available, a scroll bar will appear on the right. Scroll up or down to see other
options.
® Press the CANCEL button or select [©] and press SET to return to the previous menu level.
6 Press the MENU button to close the menu.
® Pressing the MENU button at any time closes the menu.

(i) NoTES

e Unavailable items may appear grayed out.

» On some screens, the following icons may be displayed as a guide: (SET), MENU), CAWCE] . They refer, respectively,
to pressing the joystick or SET button, the MENU button and the CANCEL button.

¢ When an RC-V100 Remote Controller is connected to the camera, you can use the remote controller’s up/
down/left/right/SET buttons in the same way as the camera’s joystick. Pressing the SET button is equivalent to
pressing the joystick on the camera.

¢ You can check most of the current settings on the status screens ([ 213).

¢ You can set MENU > [ System Setup] > [Ctrl Dial in Menus] to [Disable] to disable the use of the front and
rear control dials while browsing the menus. In such case, use the SELECT dial to move between menus.

Using the Customized Menus (My Menu)

In CAMERA mode, you can register up to 6 frequently used menu settings under a My Menu page for easy
access. You can save up to 5 separate sets of My Menu settings each with 6 options for different shooting

situations. Furthermore, if you set an assignable button to [My Menu] ([11 125), you can press the button to
access your registered menu settings even faster and more easily.

Adding Menu Settings
1 Select MENU > [% My Menu] > Desired menu page > [Edit] > [Register].
e A screen will appear where you can select the menu setting you want to add.
e Press the CANCEL button to cancel the operation and return to the regular menu.
2 Select the menu setting you want to add.
3 Select [OK].
e The menu setting you registered will now appear under the currently selected My Menu set.
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Using the Menus

Rearranging Menu Settings
1 Select MENU > [ My Menu] > Desired menu page > [Edit] > [Move].
2 Select the menu setting you want to move.
e The & icon will appear next to the setting you selected to move.
3 Move the menu setting to the desired position and press SET.

Removing Menu Settings
1 Select MENU > [ My Menu] > Desired menu page > [Edit] > [Delete].
2 Select the menu setting you want to remove and then select [OK].

Resetting All the My Menu Sets
Reset all the menu settings registered to the currently selected My Menu set.
Select MENU > [% My Menu] > Desired menu page > [Edit] > [Reset All] and then select [OK].

Renaming My Menu Sets

You can give each of the 5 My Menu sets a more descriptive name to make them easier to identify.
1 Select MENU > [% My Menu] > Desired menu page > [Edit] > [Rename].

2 Enter the desired name (8 characters long) using the keyboard screen (see the following sidebar).

Entering text and numbers
There are two types of screens used to enter text and numbers — the keyboard screen, and the data entry
screen. Which screen is used, as well as the available characters will depend on the menu setting.

Keyboard screen
1 Touch the character you wish to enter.
e The characters you entered will appear in the input area at the top of the screen.

Key Function CAMERA

«/n Moves the cursor in the input area.

G Shift key

;{_’_\,‘1 / Ae1 | Switches between letters, numbers and special characters.

— Space key @@ S [IED ox
« Backspace key

e You can also move the cursor with the SELECT dial or the joystick, and select the desired character by
pressing SET.

2 After entering the desired text, touch [OK] to confirm.

Data entry screen

Use the SELECT dial or the joystick to select characters. Metadata > User Defined

1 Select a character and then press SET to confirm.
® The cursor will move to the next field. ‘ AJNJORN
e You can also push the joystick left/right to move between the fields.
e Change the rest of the characters in the same way.

2 Select [Set] to confirm the text or value.
e Press CANCEL to stop entering text.



Preparing the Camera

Preparing the Camera

This section details how to prepare the camera for the first time, including how to mount and remove lenses and
the handle unit.

Examples of Camera Configurations

Your camera allows you to build the shooting configuration that best fits your needs and shooting conditions. For
details on the optional accessories compatible with this camera, refer to Optional Accessories ([1] 241) and the
Cinema EOS System Expansion User Guide (PDF file).

Configuration with microphone Configuration with handle Minimal configuration
holder and handle

@ wrorRTANT

e Be careful not to drop the camera or accessories when attaching, removing or adjusting the various
accessories. Use a table or other stable surface to change the camera’s configuration.

Preparing the Lens

As much as possible, attach and remove the lens quickly and in a clean environment free of dust. You can also
use an EF lens or PL lens by attaching a mount adapter to the RF lens mount. Refer also to the instruction
manual of the lens/mount adapter used.

@ vrPoRTANT

¢ \When attaching/removing a lens, avoid direct sunlight or strong light sources. Also, be careful not to drop the
camera or lens.

(i) NoTES

o After removing a lens/When a lens is not attached to the camera:
- Do not touch the lens’s surfaces, the lens mount or any components inside the lens mount area.
- Place the body cap back on the lens mount and the dust caps on the lens. Clean any dust or dirt from the
body cap and dust caps before using them.

29



Preparing the Camera

Attaching a Lens
1 Turn off the camera.

2 Remove the body cap from the camera and the dust caps
30 from the lens.
—— 3 Attach the lens to the camera and turn the lens in the
direction of the arrow until it clicks in place.
¢ Align the red mark on the lens with the red lens mount
index mark on the camera.

Removing a Lens
1 Turn off the camera.

2 Hold down the lens release button and turn the lens all the
way in the direction of the arrow until it stops.

3 Remove the lens.

4 Place the body cap back on the lens mount and the dust
caps on the lens.

(i) NoTES

e Turning on the image stabilization function of a lens may reduce the effective usage time of the battery pack.
When image stabilization is not necessary, for example if the camera is fixed to a tripod, it is recommended to
turn it off.

¢ Depending on the lens used, you may experience one or more of the following limitations.

- The lens model name may be shortened when displayed on the screen.

- You may not be able to focus manually when the focus mode switch of an EF lens is set to AR
- You may not be able to use the focus preset function on an EF lens (super telephoto lenses).

- You may not be able to use the power zoom function on EF lenses with that function.

e This camera’s sensor is larger than the sensor size for which RF-S/EF-S lenses are designed (APS-C). When
using RF-S/EF-S lenses with this camera, you may notice peripheral illumination fall-off or vignetting (11 200).

¢ When using a compatible lens, you can use the MENU > [ System Setup] > [Retract Lens] setting to retract
the lens automatically when the camera’s power is turned off with the lens's focus mode switch set to AR

¢ When a VR lens is attached, the handle unit, accessories attached to the handle unit or the hand holding the
grip may be reflected in the image. Check the image before recording.

Using the EF-EOS R 0.71x Mount Adapter

e You can use the EF-EOS R 0.71x Mount Adapter to attach a compatible EF lens to the camera and shoot
video with an angle of view equivalent to full frame (when the sensor mode is [Super 35mm (Cropped))).
Additionally, you can use autofocus, peripheral illumination correction and chromatic aberration correction. For

details on compatible lenses, visit your local Canon website.
* Setting the camera's sensor mode to [Full Frame] causes vignetting.

¢ \When using the EF-EOS R 0.71x Mount Adapter with some EF lenses, a frame that limits the AF range may be
displayed.



Preparing the Camera

Updating the Firmware of a Lens/Mount Adapter/Power Zoom Adapter/Accessory

You can update the firmware of the lens/mount adapter/power zoom adapter/accessory attached to the camera
(only in CAMERA mode). For details about firmware updates, visit your local Canon website. The following
example explains how to perform a firmware update for lenses.

1 Download the lens/mount adapter/power zoom adapter/accessory firmware update file from the Canon
website and save it on the root directory of an SD card. Insert the SD card containing the firmware update into
the camera's SD card slot B ([1] 36).

2 Attach the lens/mount adapter/power zoom adapter/accessory you want to update and turn on the camera in
CAMERA mode.
e Attach a lens also when updating the firmware of the mount adapter/power zoom adapter.
3 Select MENU > [¥ System Setup] > [Firmware] > [Lens], [Mount Adapter], [Power Zoom Adapter] or
[Accessory].
e The current lens/mount adapter/power zoom adapter/accessory firmware version will appear on the screen.
e |f the menu option is grayed out, the attached lens/mount adapter/power zoom adapter/accessory may not
support firmware updates or the SD card used may not contain a valid lens firmware file. Check the lens/
mount adapter/power zoom adapter/accessory and SD card and repeat the procedure from the beginning.
4 Select [OK].
5 Select the lens firmware file (.LFU or .AFU file).
6 Select [OK].
¢ The firmware will be updated. Once in progress, the lens firmware update cannot be canceled.
7 When the confirmation message appears, press SET.

@ vPoRTANT
® Be sure to observe the following precautions while the lens firmware is being updated.
- Do not turn off the camera and do not remove the battery pack or other power source.
- Do not remove the lens/mount adapter/power zoom adapter/accessory.
- Do not operate any buttons or controls on the camera.
- Do not open the card compartment cover and do not remove the SD card.

(i) NoTES

¢ The lens firmware cannot be updated while pre-recording is activated.
e Power the camera using an AC adapter or a sufficiently charged battery pack.
¢ When using an EF extender, remove the extender before performing the procedure.

In-Camera Lens Correction

Depending on the characteristics of the lens used, the corners of an image frame may be darker than the center
due to light fall-off (peripheral illumination drop), color shift/color fringing may be visible along high-contrast
edges in the image (chromatic aberration), the image produced may not be as sharp at certain apertures (lens
diffraction), or the image might appear distorted (distortion aberration). In CAMERA mode, you can apply a
correction to compensate as necessary. To apply peripheral illumination or chromatic aberration correction,
correction data for the lens used is necessary. Distortion aberration correction is only possible for compatible RF
lenses.

1 Attach the lens you want to use and turn on the camera in CAMERA mode.
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2 Select MENU > ["™ Camera Setup] > [Periph. lllum. Corr.], [Chromatic Aberr. Corr.], [Diffraction

Correction], or [Distortion Aberr. Corr.].

e |f correction data is not available, [Periph. lllum. Corr.] or [Chromatic Aberr. Corr.] will appear grayed out. Visit
your local Canon website and check if there is correction data available for the lens you are using. If so,
download the necessary update package, update the camera’s firmware version and repeat the procedure
from the beginning.

e |f the appropriate correction data for distortion aberration is not available for the lens attached, [Distortion
Aberr. Corr.] will appear grayed out.
3 Select [On].
¢ The camera will apply the correction for the attached lens to all future recordings.

(i) NoTES

¢ About in-camera lens correction data: The camera contains a register of correction data for compatible lenses
that were available at the time the camera went on sale. Correction data for future lenses will be made
available as part of the regular updates released for the camera’s firmware. For more details, visit your local
Canon website.
¢ When peripheral illumination/diffraction correction is activated:
- Depending on the recording conditions, noise may appear in parts of the image.
- The level of correction will be lower for lenses that cannot provide distance information.
- The level of correction will be lower the higher the ISO speed/gain setting used.
- When using RF-S/EF-S lenses, peripheral illumination fall-off may be more pronounced.
¢ Peripheral illumination/chromatic aberration correction cannot be applied in the following cases:
- When the appropriate correction data is not available for the lens attached.
- When using non-Canon lenses. Even if the corresponding menu setting is available (not grayed out), setting
it to [Off] is recommended.
¢ Diffraction correction cannot be applied when the camera cannot obtain the current aperture value of the lens.
¢ Depending on the shooting settings, peripheral illumination/chromatic aberration/distortion aberration of the
shooting lens is corrected and applied during playback.

Attaching the Handle Unit
1 Insert the handle unit’s mounting screw into the screw hole of
the camera’s accessory mount.

2 Tighten the locking knob to firmly secure the handle in place.

e |f necessary, use a hex wrench for 0.64 cm, 1/4" screws to tighten
the locking knob.
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Attaching the Microphone Holder

To the Right Side of the Handle Unit
1 Attach the microphone holder to the handle unit.

2 Use a commercially available Phillips head (“crosshead”) screwdriver
to secure it firmly with the 2 M4 bolts.

Checking the Camera’s Inclination

You can display the level of the effective inclination compensation of the camera.

Select MENU > [[Z) Monitoring Setup] > [Custom Display 1] > [Level (Numeric)] or [Level (Bar)].
¢ The following settings are possible if you select [Level (Bar)].
- [Tilt+Roll]: Displays inclination for both tilt and roll.
- [Tilt]: Displays the vertical inclination of the optical axis.
[Roll]: Displays the amount of rotation around the optical axis.
- [Off]: Inclination is not displayed.

(i) NoTES

* You can set the level sensitivity and reference angle from MENU > [ System Setup] > [Level Sensitivity] or
[Level Reference Setting]. The [Level Reference Setting] function uses the angle detected by the camera as
reference and displays an angle relative to that reference angle.

e The [Level Reference Setting] function allows you to fine-tune the angle of the level and is enabled only near
the following postures.

- Upright posture, vertical posture (rotation of 90°, —-90° in the roll direction)
- Upside down (rotation of 180° in the roll direction)

- Lens facing upward (90° in tilt direction)

- Lens facing downward (-90° in tilt direction)
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Preparing the Camera

Attaching an Accessory Compatible with the Multi-Function Shoe
For details on how to attach and use accessories, refer to the instruction manual of the accessory in use.

Remove the multi-function shoe cover (D) and slide the
accessory's connecting terminal into the multi-function shoe

@)

¢ When attaching accessories that communicate through contacts
of the multi-function shoe, insert the accessory's mounting foot
until it clicks into place, then slide the mounting foot locking lever
to secure it.

@ vrorTANT
¢ Protecting the multi-function shoe:

- After removing accessories from the multi-function shoe, reattach the shoe cap to protect the contacts from
dust and water.

- Blow off any foreign material on the multi-function shoe with a commercially available blower or similar tool.
- Allow the multi-function shoe to dry before use if it gets wet.
e Using accessories with screws may damage the multi-function shoe.
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Preparing Recording Media

The camera records clips, photos and other files on SD cards*. The camera has two card slots, and recording on
two cards is possible ([1] 39).

Initialize cards ([J] 37) when you use them with this camera for the first time.
* The SD card is used also to save/read other files such as custom picture files.

Compatible Recording Media

The following types of memory card can be used with this camera. When recording in RAW format, only SDXC
memory cards can be used. For the latest information about recording media tested for use with this camera,
visit your local Canon website.

SD cards
SD card type: Sa® 5D cards, =22 SDHC cards, 222 SDXC cards
UHS Speed Class*: U3
Video Speed Class*: V30, V60, V90

* UHS and Video Speed Class are standards that indicate the minimum guaranteed data transfer rate of SD cards.

Recommended speed class by video configuration

Video configuration
- - - Recommended speed class
Recording mode Recording format Resolution
Slow & fast motion recording - - V90
RAW ST
RAW LT - Voo
4096x2160,
3840x2160 Voo
XF-AVC YCC422 10 bit
2048x1080, V60
1920x1080
. 4096x2160,
XF-HEVC S YCC422 10 bit 3840x2160 V60
Other recording modes 20962160
. X ,
XF-HEVC S YCC420 10 bit 3840x2160 U3, V30
4096x2160,
) 3840x2160 Vo0
XF-AVC S YCC422 10 bit
2048x1080, V60
1920x1080
. 4096x2160,
XF-AVC S YCC420 8 bit 3840x2160 U3, V30

@ vPoRTANT

o After repeatedly recording, deleting and editing clips (if the memory is fragmented), you may notice slower
writing speeds to the card and recording may even stop. In such case, save your recordings and initialize the
card with the camera. Be sure to initialize cards especially before shooting important scenes.

e |f you repeatedly record for short periods of time at a low bit rate, you may not be able to record even if the
card has free space.
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e About SDXC cards: You can use SDXC cards with this camera but these cards are initialized by the camera
using the exFAT file system.
- When using exFAT-formatted cards with other devices (digital recorders, card readers, etc.), make sure that
the external device is compatible with exFAT. For more information on compatibility, contact the computer,
operating system or card manufacturer.

- If you use exFAT-formatted cards with a computer OS that is not exFAT-compatible, you may be prompted
to format the card. In such case, cancel the operation to prevent data loss.

(i) NoTES

e Proper operation cannot be guaranteed for all cards.

e SDHC cards are formatted using the FAT32 file system so, when recording proxy clips, the video (stream) file in
the clip will be split approximately every 4 GB. Playback with the camera will be seamless.
SDXC cards use the exFAT file system so the stream file in the clip will not be spilit.

Inserting and Removing an SD Card

1 Wait until the SD CARD access indicator is off or is
illuminated in green.

2 Open the card compartment cover.

3 Insert the card straight, with the label facing the side
opposite to the lens, into the SD card slot until it clicks.
e You can use two cards, one in each card slot.

¢ To remove the card, make sure the SD CARD indicator is off
and then push the card once to release it. When the card
springs out, pull it all the way out.

4 Close the card compartment cover.

¢ Do not force the cover closed if the card is not correctly
inserted.

SD card access indicator

Indicator Card status
Red Accessing the card.
Green Recording/playback is possible and the card is selected for recording/playback.
off A card is not inserted or the card slot is not currently selected.

If you set MENU > [¥ System Setup] > [Card Access LED] to [Off], the SD card access indicator will not
illuminate.

@ nvrorTANT

¢ SD cards have front and back sides that are not interchangeable. Inserting a card facing the wrong direction
can cause a malfunction of the camera. Be sure to insert the card as shown in the illustration.
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Initializing Cards

Initialize cards when you use them with this camera for the first time. You can also initialize a card to permanently
delete all the recordings it contains.

1 Select MENU > [£% Recording/Media Setup] > [Initialize Medial.
2 Select the desired card.

3 Select [OK].
* The card is initialized and all the data it contains is erased.

@ wPoRTANT

e SD cards are initialized using the FAT file system, SDHC cards using the FAT32 file system, and SDXC cards
using the exFAT file system.

e |nitializing a card will permanently erase all data, including photos and protected custom picture files. Lost data
cannot be recovered. Make sure you save important recordings in advance.

e Depending on the card, initialization may take up to a few minutes.

(i) NoTES

¢ If you set an assignable button to [Initialize Media] ([I1] 125), you can press the button to open the [Initialize
Media] submenu.

Setting a Card’s Volume Label

You can set the volume label for SDXC cards used for recording, in order to make it easier to identify and
organize them later.

1 Select MENU > [£% Recording/Media Setup] > [Volume Label] > Desired option.
2 Initialize the card ([1 37).
3 If necessary, set the clip file name’s metadata elements ([ 42).

4 Record clips on the card.
e The card’s volume label changes when the first clip is recorded on a just initialized card.

Options
[Canon]: The card’s volume label will be “CANON” regardless of the clip file name settings.

[Canon + Metadatal:
The card’s volume label will be “CANON?”, plus the camera index number and the reel number

(1 42).
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Preparing Recording Media

Switching Between Card Slots
If both slots contain a card, you can switch the card used for recording/playback as necessary.

Press the SLOT SELECT button.

e The access indicator of the selected SD card slot will illuminate in
green.

(i) NoTES

® You cannot use the SLOT SELECT button to switch between card
slots while recording or playing back.

e You can also perform this function remotely using Browser Remote

(11 190).

Checking the Remaining Recording Time on a Card

The display on the upper left of the screen shows the card icons and the remaining recording time* (in minutes)
on each card ([] 51).

Onthe [£¥ Recording/Media Setup] status screen ([ 213), you can check the total space, used space and
approximate remaining recording time* of each card. The approximate remaining number of photos (SD card B

only) and speed class will be displayed as well.
* Remaining recording times are approximate and calculated based on the current video configuration used.

Recovering Recordings

Some actions, such as suddenly turning off the camera or removing the card while data is being recorded, can
cause data errors in the recorded file. You may be able to recover recordings with corrupted data using the
following procedure.

1 Switch to MEDIA mode and open the index screen with the recordings you wish to recover ([11 141).
2 Select the desired recording (with the 2 icon).

3 Press SET to open the file menu and select [Recover] > [OK].
e The camera will attempt to recover the corrupted data.

(i) NoTES

¢ The file may not be recorded if the power is cut or if the SD card is removed immediately after starting
recording. In case of recordings with a duration of less than 0.5 seconds, such files may be deleted if file
recovery is attempted.

* In some cases, it may not be possible to recover the data. This is more likely when the file system is corrupted
or the card is physically damaged.

e Only clips, audio (WAV) and News Metadata files recorded with this camera can be recovered. Photos cannot
be recovered.

¢ In the RAW/XF-HEVC S/XF-AVC S index screen, recovered clips appear with a B> icon instead of the usual
thumbnail.



Selecting the Video Recording Method

Selecting the Video Recording Method

This camera features various recording modes, as well as video recording methods using two cards. You can
also stream the audio/video while recording it on a card ([J] 185). Below is an overview. For details, refer to each
function’s section.

39

Recording modes

[Recording Mode] Description A
) Normal recording. Records a clip in the selected recording format. The most basic video recording 47
[Normal Recording]
method.
(Slow & Fast Motion] Slow & fast motion recording. Records using a frame rate that is different from the playback frame 114
rate (overcrank/undercrank shooting). Audio is not recorded (muted).
(S&F Clip / Audio (WAV)] If [S&F'Cllp / A'udlo' (WAV)] is selected, audio (WAV) is recorded to the card that is not the video 114
recording destination.
’ Pre-recording. Records onto a temporary memory (3 seconds) so the clip will contain a few seconds | 117
[Pre-Recording] . ) ) .
of video and audio recorded before you perform the recording operation.
. ) Continuous recording. SD card A is used for normal recording (following REC button record/stop 118
(@M Min / ElContinuous Rec] operations), and SD card B is used for continuous recording (uninterrupted recording).
[Frame Recording] Frame recording. A preset number of frames are recorded each time the REC button is pressed, and | 119
g saved as one clip when frame recording mode ends. Audio is not recorded (muted).
) Interval recording. Automatically records a pre-defined number of frames at a pre-defined interval. 119
[Interval Recording] . o
Sound is not recorded in this mode.
Second card recording Functions
[2nd Card Rec Functions] Description A
Proxy recording. Simultaneously records a proxy clip (to SD card B, while the main clip is recorded to | 64
[ Main / [ Proxy Rec] SD card A) with a smaller file size for offline editing. The proxy clip is recorded with a file name
associated with the main clip.
. Sub recording. Simultaneously records a clip to SD card B with a different video configuration from 63
(@M Main / E0Sub Rec] that of the main clip on SD card A.
) ) The main clip is recorded on card A, and a WAV file* is recorded on card B simultaneously. 100
(@M Vain / (B Audio Rec] * Differs from WAV files recorded using slow & fast motion recording.
[Relay Recording] Relay recording. Continues recording on the other card without interruption when the card you are -
y 9 using becomes full. It is available from SD card A to SD card B and vice versa.
[Double Slot Recording] Double slot recording. Records the sarpe clip simultaneously to both cards, which is a convenientway | —
to make a backup copy of your recordings.

1 Select the recording mode

e Use direct touch control ([T 56) or in the menu, select MENU > [ €% Recording / Media Setup] >
[Recording Mode] > Desired option.

2 Select the second card's recording function

e Use direct touch control ([I] 56) or in the menu, select MENU > [ £% Recording / Media Setup] > [2nd
Card Rec Functions] > Desired option.
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Available simultaneous recording configurations

Second card recording function

i Rezz)or)t?i/ng DY Re?:ltjj(rj(lj(i)ng Res::(??:]gz [:R(:euctz)lfdﬁllgt
Normal Recording o o o [ J o o
Slow & Fast Motion Recording [ J o' o' - - -
Slow & Fast Motion Recording / @ - - - - -
Recording Audio (WAV)*
mode Pre-recording? () ® ® - ° Y
Continuous Recording 0323 - - - - -
Frame Recording o - - - o o
Interval Recording ([ J - - - ([ J [

e Simultaneous recording is available only with normal recording while connected to a network with IP streaming
activated.

! Only when the main recording format is RAW.

2 Not available when recording in RAW format.

3 Not available when recording in XF-AVC format.

4 Unavailable when the slow & fast motion recording frame rate exceeds 60P.

(i) notes

e |t is not possible to switch between card slots when proxy recording, sub recording, continuous recording or
audio recording is activated.

e [f a card becomes full during double slot recording, recording on both cards will stop. On the other hand, if an
error occurs with one of the cards, recording will continue on the other card.

Video Recording and Outputs (Diagram)

HDMI @ Main recording
RAW (HDMI RAW)

| Image | O Vew L HDMI OUT
Sensor ”| processing g as(:sDta’\;llSe. terminal
© Custom Picture © View
v assistance: —p SDI OUT terminal
O Proxy (SDI)
recording color
conversion © View
assistance: pp | CD monitor
! ) v ¥ (LCD)

XF-AVC XF-AVC

XF-AVC

or or or
RAW XF-HEVC S/ XF-HEVC S / XF-HEVC S/

XF-AVCS XF-AVCS

XF-AVCS

© Main recording @ Main recording © Sub recording @ Proxy recording

(RAW) (XF-AVC/XF HEVC S/
XF AVC S)

@ Select the main recording format ([I1 62, 155)

@ Second card recording functions ([T1 39)

¢ Audio recording, relay recording and double slot recording are also available. Some functions are not
available depending on the main recording format and recording mode.

© Custom picture settings ([J1 129)
¢ You can control various aspects of the image produced using custom picture files.



O For proxy clips: select the proxy recording color conversion (1] 64)
e Changes the gamma and color space settings.

© Apply the view assistance function to the image displayed ([1] 158)
e Changes the gamma and color space settings.

Selecting the Video Recording Method
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Setting the File Name for Recordings

Setting the File Name for Recordings

This section explains how to set the file names for RAW clips, XF-AVC clips, XF-HEVC S clips, XF-AVC S clips
and photos.

Clips File Names

The camera allows you to change several settings that determine the clip file name of recorded clips (only in
CAMERA mode). For more details on how to enter characters, see Entering text and numbers ([1] 28).
The basic file name structure is as follows.

A_0001C001Xyymmdd _hhmmssXX_CANON_001_Proxy

—/\ S\ S\ I\ / /o I /
1 2 3 4 5 6 7 8 9 10 1

1 Cameraindex: Two characters (Ato Z,or“_"for 6 Special recording mode identifier: |dentifies the

the second character) that identify the camera recording mode (“_" for normal, “C” for the
used. continuous recording clip on SD card B) used by
2 Reel number: 4 characters (0001 to 9999) that the camera.
identify the card used. The number is assigned 7 Recording time: Recording hour, minute, and
automatically but you can set the initial number. second (set automatically by the camera).
After you insert a new card (just purchased or 8 Random component: 2 characters (humbers 0O
initialized), the number advances by one when the to 9 and capital letters A to Z) that change
first recording is made. randomly with each clip.
3 Clip number: 4 characters (C001 to D999). The 9 User defined field: 5 characters (numbers 0 to 9
clip number advances automatically with each and capital letters A to Z) for any other
clip recorded (switching to D001 after C999), but identification purposes.
you can set the initial clip number and select the 10 Stream number: When an SD or SDHC card is
clip numbering method. used to record clips, a stream number (001 to
4 Main codec identifier: One character that 999) will be added. The stream number will
identifies the main codec (X: RAW, A: AVC/H.264, advance every time the video (stream) file within
H: HEVC/H.265). the clip is split.
5 Recording date and time (set automatically by 11 Proxy clips only: The camera will automatically
the camera). add the suffix “_Proxy” to the file name of proxy
clips.

e Apart from component number 11, the file name of the primary clip and the proxy clip will be identical.
e The file name of double slot recording clips will be the same on both SD cards.

e Apart from the WAV extension, the file name of the audio recorded with slow & fast motion clips will be the
same as that of the main clip, and will be saved on the "/PRIVATE/AUDIO" folder.

To set the camera index
Select MENU > [£% Recording/Media Setup] > [Metadata] > [Camera Index] > Desired camera index ([1] 28).

To set the clip numbering method

Select MENU > [£® Recording/Media Setup] > [Metadata] > [Clip Numbering] > [Reset] or [Continuous].
Options

[Reset]: The clip number will restart from 001 every time you insert a new card.

[Continuous]:  Clip numbers will start from the initial number set with [Clip Number] (following procedure) and
continue across multiple cards.
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To set the reel number or initial clip number

1 Select MENU > [£% Recording/Media Setup] > [Metadata] > [Reel Number] or [Clip Number] > [Changel.
¢ To return to initial settings, select [Reset] instead.
2 Enter the reel/clip number using the data entry screen ([1] 28). 43

To set the user-defined field

1 Select MENU > [ 28 Recording/Media Setup] > [Metadata] > [User Defined] > [Changel.
e To return to initial settings, select [Reset] instead.
2 Enter the desired text string using the data entry screen (11 28).

Photo Numbering

Photos are automatically assigned consecutive numbers and stored on the SD card in folders. You can select
the numbering method to be used.

Photo folder names and file names

Photo number

XXX -nnnn :“xxx”indicates the folder number (from 100 to 999), and “nnnn” indicates the consecutive
— I—'—' number assigned to the photo (from 0001 to 9999).

Xxxx_mmdd : Folder name. “mmdd” indicates the month and day of recording.

A.

— .
IMG_nnnn.JP G : Photo file name.

Select MENU > [ 2% Recording/Media Setup] > [Photo Numbering] > Desired option.

Options

[Reset]: Recording numbers will restart from 100-0001 every time you insert a new card. If a card already
contains previous recordings, numbers will continue from the number following that of the last
photo on the card.

[Continuous]:  Recording numbers will continue from the number following that of the last photo recorded with
the camera. This setting is the most convenient for managing files on a computer. We
recommend using the [Continuous] setting.

(i) NoTES

e Each folder can contain up to 500 files. When that number is exceeded, a new folder is created automatically.
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Using the Fan

Using the Fan
The camera uses a cooling fan to lower the camera’s internal temperature. In CAMERA mode, you can change

the fan’s operation mode and speed. In MEDIA mode, the fan runs at all times but you can select its speed.

Setting the Fan’s Operation in CAMERA Mode
1 Select MENU > [§ System Setup] > [Fan Mode] > Desired option.

If you selected [Always On]
2 Select MENU > [§ System Setup] > [Fan Speed (Always)] > Desired fan speed.

If you selected [Automatic]
2 Select MENU > [ System Setup] > [Fan Speed (STBY)] > Desired fan speed in record standby mode.
3 Select MENU > [ System Setup] > [Fan Speed (REC)] > Desired fan speed while recording.

¢ The [Maximum] option offers the maximum cooling effect but is available only for [Fan Speed (STBY))], as it is
noisier.

Options for [Fan Mode]

[Automatic]: The fan runs while the camera is not recording and is automatically turned off while the camera
is recording. However, if the internal temperature of the camera is too high (E appears in
yellow), the fan will be activated automatically (in that case, will appear next to the
icon). When the camera’s temperature has decreased sufficiently, the fan will be turned off. Use
this setting when you do not want the camera to pick up the fan’s operating sound.

[Always On]:  The fan runs at all times.

Setting the Fan Speed in MEDIA Mode
1 Select MENU > [§ System Setup] > [Fan Speed].
2 Select the desired option.

@ vroRTANT
¢ While the fan is running, the exhaust vent will emit warm air.
¢ Be careful not to obstruct in any way the fan’s air vents ([J] 11, 12, 15).

(i) NoTES

® Depending on the ambient temperature and other shooting conditions, the fan may not turn off even if you set
its operating mode to [Automatic].
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Adjusting the Black Balance

In CAMERA mode, you can have the camera adjust the black balance automatically when ambient temperature
changes considerably or if there is a noticeable change in a true black video signal.

1 Attach the body cap to the lens mount and set the camera to CAMERA mode.

¢ |f alens was attached, turn off the camera and remove the lens. Place the body cap back on the lens mount
and turn on the camera.

2 Select MENU > ["™ Camera Setup] > [ABB] > [OK].
¢ The automatic black balance procedure will start. It may take about 1 minute depending on the frame rate.

e |f the sensor is not completely shielded from light, [Error] will appear on the screen. Repeat the procedure
from the beginning.

(i) NoTES

Adjusting the black balance is necessary in the following cases:
- When using the camera for the very first time or after a long period of not using it.
- After sudden or extreme changes in ambient temperature.
- After changing the sensor mode.
- After activating or deactivating slow & fast motion recording (including switching to another special recording
mode).
- After changing the shooting frame rate, when slow & fast motion recording is activated.
- After resetting the camera’s settings.
¢ During the adjustment of the black balance, you may notice some irregular displays appear on the screen. This
is not a malfunction.
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Adjusting the Black Balance



Recording

Recording Video and Photos

This section explains the basics of recording clips* and photos. For details on recording audio, refer to Recording
Audio (11 100).

* “Clip” refers to a single movie unit recorded with a single recording operation. You can also include metadata with the clip.

Recording

Power indicator/
Tally lamp

SD card access indicator

REC button

* Can be assigned to function as a REC button ([11 125).

1 Set the switch to CAMERA.
e The camera turns on in CAMERA mode and enters record standby mode ([STBY]). The power indicator (tally
lamp) illuminates in green.
e The access indicators of card slots with a card inserted will illuminate momentarily in red. Then, the access
indicators of cards selected for recording will change to green.

2 Press the REC button to begin recording.
e Recording starts. The tally lamp changes from green (power indicator) to red and the recording indicator at
the top of the screen changes from [STBY] to [@ REC].
® The access indicator of cards used for recording will iluminate in red.
* You can also perform this function remotely using Browser Remote on a connected network device ([ 187) or
an XC protocol-compatible device.

3 Press the REC button to stop recording.
e The clip is recorded and the camera enters record standby mode. The tally lamp changes from red to green
(power indicator).
* The access indicator of cards selected for recording will change back to green.
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Recording Video and Photos

@ nvrorTANT
e Be sure to save your recordings regularly, especially after making important recordings. Canon shall not be
liable for any loss or corruption of data.

@ NOTES

e If you record using metadata or News Metadata settings, those settings will be recorded or added to the clip.
For more details, refer to Using Metadata (11 111) and Using News Metadata ([1] 112).

If the camera switches to the other card while recording video due to the relay recording function ([ 39), the
two parts (before/after the switch) will be recorded as separate clips.

A single clip can be recorded continuously for up to 6 hours. At that point, a new clip will be created
automatically and recording will continue on a separate clip (excluding RAW recording, slow & fast motion
recording).

¢ You can use the review function ([11 55) to play back part or all of the last clip recorded without having to
switch to MEDIA mode.

When recording clips on SDHC cards, the video (stream) file in the clip will be split approximately every 4 GB.
Playback with the camera will be seamless.

You can assign the [REC] function to assignable button Camera 4 or Camera 11 and use it to start/stop
recording.

You can set MENU > [ System Setup] > [Onscreen REC/STBY Button] to [On] to use the onscreen
[@REC)/[STBY] touch buttons to stop and start recording respectively.

When MENU > [¥ System Setup] > [Tally Lamp Settings] is set to an option other than [REC], the tally lamp
illuminates when PGM tally information is input.

To take photos
While the camera is in record standby mode, you can record photos on SD card B.

1 Set an assignable button to [Photo] (11 125).

2 When the camera is in record standby mode, press the assignable button.
¢ » Y appears on the screen and the photo is recorded on SD card B.
e The SD CARD access indicator will illuminate in red.

¢ The size of the recorded photos depends on the video configuration currently in use. For details, refer to
Specifications ([1] 246).

(i) Notes

¢ Photos cannot be recorded in the following cases

While recording a clip, or when slow & fast motion recording is activated.
When pre-recording is activated.

- While Browser Remote is activated.

While color bars are displayed.
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Onscreen Displays

Refer to this section for an explanation of the various screen displays that appear in CAMERA mode. You can
use the custom display function (1 204) to turn off individual onscreen displays if they are not required. The
menu item that controls each display is given in the following tables (1: indicates a menu item under [Custom
Display 1] and 2: indicates a menu item under [Custom Display 2]).

The position of some icons and onscreen displays may change depending on the display level settings, which
can be set to level 1, level 2 or level 3. The following screenshot and tables describe the onscreen displays at
display level 1 with the [All Displays] setting ([1] 53).

= ) frameio G 11 Full
9999 mm 999 m

M Yo S

g @-9.9

3840x2160
YCC422 10bit
ra

°

icc1 Tl (2
2 Yol {zE]
v ovojolr v+ Base 128004§AM 12:00
- + AE 40,25 [CH3+4/CH3+4
Bclosed 150102400

The lens does not work.
AA1234D999

DD DD DD DD

5000K +20

AF frames
You can turn AF frames on/off with the MENU > [(Z) Monitoring Setup] > [Custom Display 1] > [Focus Mode]
setting.

Continuous AF frame —
in white/gray/red/yellow (1 83)
One-shot frame —

in white/green/red (1 83) Eye detection: Main subject’s eyes ([I1 86)

Focus adjustment frame: In red
when it is not possible to stop at
or locate the focus position

during one-shot AF, or when the
subject is out of focus (outside
the close/far range of the lens)
during continuous AF.

Tracking: Subject selection

(me7)

Frame for trackable subjects ([1] 83)

Tracking: During tracking

Subject detection frame (main
subject): white/gray/green/red/
yellow ([1] 86)

Subject detection frame (subjects
other than the main subject): gray

Focus frame with focus guide ([1] 81)
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Left side of the screen

Icon/Display

B8

[Fp ML NI CV Protocol B

)Ir frameio | [ 00, =11 00,
Full

Description
Network connection status, functions and upload status ([ 183).

Custom Display
2: [Network Functions]

Object distance (bar).
e Only when an RF lens/RF Cinema lens is attached to the camera.

1: [Object Distance (Bar)]

0000 mm Approximate focal length of the lens. 1: [Focal Length]

000.0 m Object distance (numeric). 1: [Object Distance
« Only when an RF lens or certain EF Cinema lenses are attached. (Numeric)]

(MF), Focus mode (1 80). 1: [Focus Mode]

Subject to be detected ([ 86).

Detection priority, detection only.

Digital tele-converter ([ 90)

1: [Tele-converter]

-©

Lens information. 1: [Lens]
(Lens infor mathﬂ) ¢ Depending on the lens, the information displayed may differ.
(ﬂé , (g, 618 Image stabilization enabled/disabled ([ 88). 1: [Digital IS]
(W) Lens optical IS ([I] 88)
(in red) Lens error warning (11 226). 1: [Lens]

RNy (in yellow)

S
-l
o
o

Custom picture file selected ([ 129).

e (=]
2
O] =
I
=3
8l g
3
=
el 2]
=l
g

[Gamma/Color Space] setting in the custom picture file (11 134).

|| [o9 (O
=S
SHEIERS
A B E R

(=s]

—

=

=

s

Look Files (1] 131).

1: [Custom Picture]

2.8 @ Light metering mode (1 76). 1: [Light Metering]
View assistance (] 158). 1: [View Assist]
Status of the accessory attached to the multi-function shoe (1 34). 2: [Multi-Function Shoe]
e Appears in red in case of a communication error or if the attached accessory is
turned off.
<Q GPS signal: continuously on - satellite signal acquired; flashing - satellite signal not | 2: [GPS]
acquired.
o Displayed only when a GP-E2 GPS Receiver is connected to the camera.
FAN Fan operation: in white — normal ([ 44); in red — fan warning ([] 226). 2: [Temperature/Fan]
(in green) Temperature warning ([1] 44).
(in yellow) e When the camera internal temperature rises above a certain level, & will
3 (in red) appear in yellow. If the temperature rises further, B will appear in red.
(VEMO] User memo ([0 111). 2: [User Memo]




Top of the screen

Icon/Display

Recording Video and Photos

Description

Recording media status, estimated remaining recording time and recording format

A, A (in green)
000 min

/ (E: SD card

The card’s status is indicated by the icon’s color: in green — can record; in yellow —
card almost full (5 minutes or less); in red — card almost full (less than 1 minute); in
white — reading the card.

o The card selected for recording is indicated with a p mark.

A, A (in red) END

Card is full.

R, B (inred)

No card or cannot record on the card.

[RAW M XF-AVCIR XF-HEVC S
XF-AVC SR

Video format ([ 62) and audio format ([ 114).

Custom Display
2: [Remaining Rec Time]

Recording operation

2: [Recording Mode]

STBY, @REC Normal recording: record standby, recording.

S&F STBY, Slow & fast motion recording ([1 114): record standby, recording.

S&F @REC

PRE STBY, Pre-recording (11 117): record standby, recording.

PRE @ REC

CONT, @ CONT Continuous recording ((I] 118)

FRM STBY, Frame recording (31 119): record standby, recording.

FRM @ REC,

FRM @ STBY

INT STBY, Interval recording (11 119): record standby, recording.

INT @REC,

INT @WAIT
0s / 00m00s Interval counter ([T 119). 2: [Interval Counter]
REC=, STBY Recording command ([] 154). 2: [Rec Command(EXT
EXT REC#, EXT STBY # "EXT" is displayed when there is no recording media. REC)]
D]} Double slot recording ([ 39). 2: [Recording Mode]
00.00P, 00.00i Frame rate (] 62). 2: [Frame Rate]

When slow & fast motion recording is activated, the shooting frame rate is also
displayed (000/00.00P).

Tilt 000.0° Level (numeric) (11 33) 1: [Level (Numeric)]
Roll 000.0°
o Key lock (11 15). 1: [Key Lock]
00:00:00.00 / 00:00:00:00 Time code ([ 95). 2: [Time Code]
R,PFEE Time code status ([] 96).
Power supply level indicator 2: [Remaining Battery]

— ] - Remaining battery charge of a BP-A30N or BP-AGON Battery Pack and estimated

LI /| R I | remaining usage time (in minutes).

(in red) e When is displayed, replace the battery pack with a fully charged one.

000 min « Depending on the conditions of use, the actual battery charge level may not be

indicated accurately or may not match the levels shown on the [§ System
Setup] status screen or the indicators on the battery pack.
DC IN 00.0V Power supply voltage when using an AC adapter.

o When the voltage falls below the selected low-power warning level (] 211),
the voltage will be displayed in red.
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Right side of the screen

Icon/Display Description Custom Display
60(24)fps, Video output ([T 125). 2: [Output Terminals
60(30)fps Status]

[Full], Sensor mode ([] 62). 2: [Sensor Mode]
0000x0000 Resolution ([11 62). 2: [Resolution/
YCC000 00 bit Color sampling, bit depth (21 62). Color Sampling]
» B (in green) Photos can be recorded on the SD card ([J1 48). 2: [Photo]

»ED (in red) No SD card or cannot record photos on the SD card.

(in yellow) Output onscreen displays ([ 157). 2: [0SD Output]

XD (in yellow) Magnification (1] 82). 1: [Magnification]
, (in yellow) Peaking (11 82). 1: [Peaking]

Audio level meter (11 103).

2: [Audio Level Indicator]

Audio limiter ([T 104).

)00, (O Headphone volume ([ 146). -

Date/time 2: [Date/Time]
CHO/CHO, Audio output channels (1] 160). 2: [Monitor Channels]
CHO+CHO/CHO+CHO

1/0000.00, 000.00°, 000.00Hz

Shutter speed ([] 66).

1: [Shutter]

Bottom and center of the screen

Icon/Display Description Custom Display
v, O, Y, = Wireless microphone 2: [Wireless Mic]
[ ol ] Level (bar) (1 33). 1: [Level (bar)]
(horizontal/vertical)
Base 0000 Base IS0 (1 68). 1: [Base IS0]

Bl Start Tracking B End
Select Again End

Stop Tracking

The lens does not work.

Tracking guide, warning.

5)

)

Direct touch control ([ 56)

A_0001C001 to ZZ9999D999

Clip identification. Includes the camera index, reel number and clip number
components of the clip file name (] 42).

2: [Reel/Clip Number]

00 00 00 00 User bit (11 96). 2: [User Bit]
e Exposure bar ([11 76). 1: [Exposure Bar]
AE +0.00 AE shift (11 75). 1: [AE Shift]
NUA/ B, se:, 38, [4, | White balance (1 77). 1: [White Balance]
AWB

00000K +00

ND 00 stops ND filter (11 72). 1: [ND Filter]

[, F00.0 / T00.0, closed Aperture value (0 73). 1: [Iris]

1SO 000000, 00.0dB ISO speed/Gain value ([ 68). 1: [ISO/Gain]
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Selecting the Onscreen Display Level

You can press the DISP button to control de amount of information shown
over the image. Repeatedly pressing the DISP button will change the
display level: Display level 1 — Display level 2 — Display level 3 — Display
level 1. In CAMERA mode, you can change the information displayed at
each display level in the menu ([T] 204).

Example f the
[Main Recording Displays] option

CAMERA mode
Display level' Options Description
[DISP Level 1] | [All Displays] All onscreen displays at a larger size.
[All Displays (Periph. Border)] | All onscreen displays at a smaller size, more appropriate for use with the peripheral border.
[DISP Level 2]2 [Main Recording Displays] Only the onscreen displays most relevant for shooting.

[Only FUNC/MENU] Only markers, focus frames/tracking frame, and video scopes are displayed. When the FUNC
button, MENU button or an assignable button is pressed, the necessary information will be
displayed.

[DISP Level 3]2 [Only REC/STBY] No onscreen displays except for the recording operation (REC/STBY).

[No Displays] No onscreen displays at all.

MEDIA mode
Display level' During clip/photo playback Index screen/During audio playback
[DISP Level 1] All onscreen displays.
[DISP Level 2] No onscreen displays. All onscreen displays.

[DISP Level 3] -

" MENU > [[E) Monitoring Setup] > [DISP Level 1], [DISP Level 2] or [DISP Level 3].
2 Smaller onscreen displays (same size as when set to [All Displays (Periph. Border))).

(i) NoTES

¢ You can change the transparency level of onscreen displays ([11 157).
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Peripheral Border Display

You can apply the peripheral border display to all display levels. With the peripheral border display, the camera’s
image is reduced slightly so the onscreen displays are shown mostly around it and not on top of it, partially
hiding it. The peripheral border is linked with the display level. You can select the levels that use the peripheral
border with the MENU > [[Z) Monitoring Setup] > [Apply Peripheral Border] setting.

Full-screen display Peripheral border display

(i) Notes

* When using a display level with the peripheral border display, if you set MENU > [[Z) Monitoring Setup] > one
of the [OSD Output:] settings to [Off] or [Off (Clean)], the video output from each video terminal will be
displayed in full screen.

e When [SDI Output Signal] is set to [4096x2160P/3840x2160P], the peripheral border display is not applied to
video output from the SDI OUT terminal.

Displaying the Tally OSD

While recording (REC), the tally OSD (red frame or bar) can be displayed on the screen. Displaying the tally OSD
allows you to easily check whether recording is in progress even when viewing the screen from a distance.

1 Select MENU > [[Z) Monitoring Setup] > one of the [Tally OSD:] settings > [On].
e Confirm and/or change the screen for tally OSD display and the output destination.

2 Select MENU > [[Z) Monitoring Setup] > [Tally OSD Settings] > Desired option.
Tally OSD Settings List

[Tally OSD Settings] Tally Input State Recording Status (REC) Tally OSD Lamp Color
PGM Red
[Tally In (PGM/PVW)] PVW — Green
PGM + PYW Amber
[REC] — )
Recording Red
PGM Red
[REC/Tally In (PGM/PVW)]
PVYW Record Standby Mode Green
PGM + PYW Amber

3 Select MENU > [[Z) Monitoring Setup] > [Tally OSD Position] > Desired option.

Frame Top Bottom
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(i) noTes

¢ Recorded video/still images are not affected.

Onscreen Displays in Portrait Mode

When shooting in portrait mode, you can change the orientation of the onscreen

displays. 745 min
102 min

1920x1080

-mm YCC422 10 bit

Select MENU > [[Z) Monitoring Setup] > Desired [OSD Orientation:] setting > | oo
[ ¢<c 90 Degrees Left] or [ 32, 90 Degrees Right]. S

(i) NoTES

e The menu and status screens cannot be rotated.

e Direct touch control (other than recording settings) and the peripheral border
display cannot be used when the CAMERA mode screen is rotated.

Base 400 -t

Reviewing a Recording

If you set an assignable button to [Review Recording] in advance, you can review the last clip (primary clip)
recorded on the recording media currently in use even with the camera set to CAMERA mode.

1 Set an assignable button to [Review Recording] (11 125).
2 Select MENU > [¥ System Setup] > [Review Recording] > Desired option.

3 After you finish recording a clip, press the assignable button.

* The last clip that was recorded is played back for the selected duration. [P REVIEW] appears on the
screen.

* There will be no sound from the built-in speaker but the audio will be output from the () (headphone), HDMI
OUT or SDI OUT terminal.

* You can use the joystick to jump back/forward within the clip. You can also touch or slide the onscreen
progress bar to move to a different position in the video (1] 145).

e Press CANCEL or flick down on the screen to stop reviewing the clip.
e After the clip finishes playing back, or if you stop reviewing the clip, the camera returns to record standby
mode.
Options
[Entire Clip]: Allows you to review the entire clip.
[Last 4 sec]:  Allows you to review just the last 4 seconds of the clip.

(i) NoTES

e |f the camera switched cards during a recording, the camera will play back the clip on the card most recently
recorded on.

¢ You cannot review clips when continuous recording is activated.
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Adjusting Camera and Recording Settings

Using direct touch control, you can perform a variety of settings (camera, recording, assistance functions, etc.) in
CAMERA mode. White balance and exposure related settings can also be modified with the direct setting mode,

using the FUNC button.

Performing Basic Settings with Direct Touch Control

With direct touch control you can change commonly used settings such as camera and recording settings and
assistance functions. For details about each function, refer to the respective section on the manual.

Available Direct Touch Control Settings

Touch button
White balance

Available settings
White balance mode (custom, preset, color temperature, automatic (AWB)), color correction value.

ND filter 0ff, 5 different density settings.

Aperture Adjustment of the F value/T value.

IS0/Gain Adjustment of ISO or gain value/adjustment value preset.
Shutter speed Adjustment of the value in the current shutter speed mode.

(assistance functions)

Focus guide (on/off), peaking (type), WFM, zebra (type), false color (on/off), markers (on/off), view assistance (on/

off).

% (recording settings)

Sensor mode, recording mode, second card recording functions, continuous recordingL 2, slow & fast shooting
frame rate, frame recording frame rate, interval recording frame rate, interval recording time interval, main
recording format, file selection, main resolution, frame rate, bit rate, f[5J] recording format, proxy recording
color conversion, [E resolution, fE]] bit rate, fEY] frame rate, LCD luminance.

1 Only when the main recording format is XF-HEVC S / XF-AVC S.
2 Only when the [Continuous Recording] setting (I 118) is changed from [STBY] to [REC].

Opening ((C)/ Closing (X) the —

direct touch control interface

59.94pP

00:00:00.00P
DCIN24.5v
{Full

3840x2160
YCC422 10bit

A_0004C034
(<38 Assistance functions

-+
I

Camera settings

Turn on/off the Direct Touch Control Interface

Even when the direct touch control interface is displayed, you can still use other functions such as recording,
menu settings, direct setting mode or status screens.

1 Touch () to open the direct touch control interface.
2 Touch X to close the direct touch control interface.
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Changing Camera Settings
1 Touch the setting you want to adjust, then select the desired value/
setting.
e Once the settings menu is displayed, touch to select the desired
value/setting as needed.

¢ When the slider appears, drag the slider left/right or touch the 4/
» buttons to adjust the desired value.

e You can also use the SELECT dial or the control dial. Drag the slider to select the desired value
2 Touch ®.

Using Assistance Functions

1 Touch (assistance functions) and then turn assistance functions p— - o
on/off, or select the desired assistance function. LS orF v ] &= @

Zebra_ False Color

2 Touch ®. ‘ T

180.00°| &

Changing Recording Settings
1 Touch % (Recording Settings)

® The recording settings menu will be displayed. There are three Sensor Mode
pages that can be switched by swiping left and right. Full Frame rmal Recording

2nd Card Rec Functions

2 Select the desired menu setting and then select the desired option.
3 Touch X.

Off

Direct Setting Mode (FUNC Button)

You can adjust main camera functions—white balance, aperture, 1ISO
speed/gain and shutter speed —using the FUNC button (direct setting
mode). This section will explain the basic operation of the direct setting
mode. For details about each function, refer to the respective section on
the manual.

1 Press the FUNC button.

* The onscreen display of the selected function will be highlighted in
orange.

e Press the FUNC button repeatedly or push the joystick left/right to
select a different function (the rear control dial can also be used).
2 Push the joystick up/down or turn the SELECT dial to select the
desired value or white balance mode.
e You can also use the front control dial.

3 Press SET.
® The selected value/mode will be set and direct setting mode will end.
e The onscreen display of the selected function will return to normal.
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(i) Notes

® The camera will automatically end the direct setting mode in the following cases.
- If no operation was performed for more than 6 seconds.
- If the FUNC button is pressed while selecting the shutter speed.
- If the menu or a status screen was opened.

e |f you set an assignable button to [White Balance], [Iris], [ISO/Gain] or [Shutter], you can press the button to
enter direct setting mode with the respective function highlighted.
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Video Recording Configuration: Video Format, Sensor Mode,
System Frequency, Resolution and Frame Rate

When recording media, you can set the video configuration used for primary clips with the following procedures. 59
Select the sensor mode, main recording format (video format, color sampling, bit depth), primary resolution, -
frame rate and bit rate settings that best match your creative needs. The camera uses a variable bit rate (VBR).

Intra-frame options compress the image after analyzing each frame separately and are more appropriate for

editing. Long GOP options compress the image after analyzing also changes across a group of pictures and

offer better compression (smaller data size). Available options for some settings may change depending on

previous selections for other settings. See the following tables for a summary.

For details about sub recording clips and audio, refer to Sub Recording Clips ([11 63) and Recording Audio

(12 100) respectively.

RAW
Main System frequency/Frame rate/Bit rate
Sensor mode  recording . S'\gﬁjg - Bit depth 59.94 Hz 50.00 Hz 24.00 Hz
format 50.94P  2097P  2398P  5000P  2500P  24.00P

[ ) o o o
Fullframe | RAWLT | 6000x3164 - 639 Mbps | 552 Mbps - 576 Mbps | 553 Mbps

) @ o o o
Super 35mm RAWST 136812504 12t - 563 Mbps | 451 Mbps h 470 Mbps | 451 Mbps

X

(Cropped) RAW LT ° ° ° ° ° °

678 Mbps | 366 Mbps | 293 Mbps | 611 Mbps | 306 Mbps | 293 Mbps
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XF-AVC
System frequency/Frame rate
Bit rate 59.94 Hz 50.00 Hz 24.00 Hz
59.94P  59.94i 29.97P 23.98P 50.00P  50.00i 25.00P  24.00P
600 Mbps Intra-frame o - [ J - - - - -

Main recording Main
format resolution

500 Mbps Intra-frame - - - - o - o -

480 Mbps Intra-frame - - - o - - - [ J

450 Mbps Intra-frame - - o - - _ _ _

375 Mbps Intra-frame - - - - — _ Py _

4096x2160

3840%2160 360 Mbps Intra-frame - - - [ ] - - — ()

300 Mbps Intra-frame - - [ ] - — _ _ _

250 Mbps Intra-frame - - - - — _ Py _

240 Mbps Intra-frame - - - o - - - [ J

250 Mbps Long GOP o - - - o - - _

150 Mbps Long GOP - - [ J o - - () ®

XF-AVC YCC422 300 Mbps Intra-frame o - - - - - - —

10 bit 250 Mbps Intra-frame | — - - - ° - - _

150 Mbps Intra-frame - - [ ) - - _ _ _
2048x1080

125 Mbps Intra-frame - - - - - - () -

120 Mbps Intra-frame - - -

50 Mbps Long GOP

o
300 Mbps Intra-frame o - - - - — _ _

250 Mbps Intra-frame - - - - o - - _

150 Mbps Intra-frame - o [ ) - _ _ _ _

1920x1080 | 125 Mbps Intra-frame - - - - - o o _

120 Mbps Intra-frame - - -

50 Mbps Long GOP o o [

25 Mbps Long GOP - o - - — o _ _

XF-HEVC S

System frequency/Frame rate
Main recording

format Main resolution Bit rate 59.94 Hz 50.00 Hz 24.00 Hz
59.94P 29.97P 23.98P 50.00P 25.00P 24.00P
4096x2160 225Mbps Long GOP | @ - _ ° _ _
XF-HEVC S YCC422 3840x2160 135 Mbps Long GOP - ) ) - [ °
10 bit
2048x1080
1920x1080 50 Mbps Long GOP o [ J o o ([ [
4096x2160 150 Mbps Long GOP [ ] - - ™Y _ _
XF-HEVC S YCC420 3840x2160 100 Mbps Long GOP - [ ) o - o [ )
10 bit 2048x1080
1920x1080 35 Mbps Long GOP o [ ) o o o [ J
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XF-AVC S

Main recording

System frequency/Frame rate

format Main resolution Bit rate 59.94 Hz 50.00 Hz 24.00 Hz
59.94P 29.97P 23.98P 50.00P 25.00P 24.00P

600 Mbps Intra-frame @ [ J - - - -

500 Mbps Intra-frame - - - o ) _

480 Mbps Intra-frame - - [ ] - - [

450 Mbps Intra-frame - [ } - - _ _

375 Mbps Intra-frame - - - - ) _

ggigig 28 360 Mbps Intra-frame - - o - - ()

300 Mbps Intra-frame - @ - - — _

250 Mbps Intra-frame - - - - ) _

XF-AV(;OSJS vh22 240 Mbps Intra-frame - - o - - ()

250 Mbps Long GOP [ ) - - o - _

150 Mbps Long GOP - [ ) o - [ ()

300 Mbps Intra-frame [ ) - - - - _

250 Mbps Intra-frame - - - () — _

2048x1080 150 Mbps Intra-frame - [ ] - - — _

1920x1080 125 Mbps Intra-frame - - - - ° _

120 Mbps Intra-frame - - o - - o

50 Mbps Long GOP @ [ J o (] () ()

4096x2160 150 Mbps Long GOP [ - - ® - -

XF-AVC S YCC420 3840x2160 100 Mbps Long GOP - [ J o - ( J (]

“’“ BB gy @ @ | @ e | e

(i) NnoTes

e For details on the signal output from each terminal, refer to Video Output Configuration ([1] 151).

Selecting the System Frequency

You can change the system frequency also in MEDIA mode if you want to play back clips from a card recorded
with a different system frequency setting.

1 Select MENU > [£% Recording/Media Setup] > [System Frequency].

2 Select the desired option.
e The camera will reset and restart in the selected mode.

61
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Selecting the Sensor Mode
You can change the area of the imaging circle covered by the CMOS sensor to produce the recorded image.
1 Select MENU > [£2 Recording/Media Setup] > [Sensor Mode].

* You can also adjust this setting using direct touch control ([11] 56).

2 Select the desired option.

Selecting the Main Recording Format
Select the combination of video format, color sampling and bit depth for primary clips.
1 Select MENU > [£% Recording/Media Setup] > [Main Rec Format].
¢ You can also adjust this setting using direct touch control (1] 56).
2 Select the desired option.

Selecting the Resolution of Primary Clips

1 Select MENU > [£® Recording/Media Setup] > [Main Resolution].
¢ You can also adjust this setting using direct touch control (1] 56).

2 Select the desired option.

Selecting the Frame Rate
Select the frame rate for the primary clips. This procedure is not necessary when the system frequency is set to
24.00 Hz.
1 Select MENU > [£% Recording/Media Setup] > [Frame Rate].
* You can also adjust this setting using direct touch control ([1] 56).

2 Select the desired option.

Selecting the Bit Rate for Primary Clips

Select the bit rate when the primary clip has the following recording format, resolution and frame rates.

Main recording format Main resolution Frame rate Bit rate
29.97P 600 Mbps, 450 Mbps, 300 Mbps
XF-AVC YCC422 10bit 4096x2160 Intra-frame 25.00P 500 Mbps, 375 Mbps, 250 Mbps
XF-AVC S YCC422 10bit 3840x2160 Intra-frame 24.00P 480 Mbps, 360 Mbps, 240 Mbps
23.98P 480 Mbps, 360 Mbps, 240 Mbps
XF-AVC YCC422 10bit 1920x1080 Long GOP 59.94i, 50.00i 50 Mbps, 25 Mbps

1 Select MENU > [£% Recording/Media Setup] > [Bit Rate].
¢ Operation by direct touch control is also possible ([I] 56).

2 Select the desired option.
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Sub Recording Clips

While recording a primary clip on SD card A, you can simultaneously record the same scene on SD card B.
Recording formats that can be used in conjunction are shown below. Refer to Recording / Output Signal and
Detailed Settings (11 214) for more details. For more details on audio, see Recording Audio (1] 100). When
HDMI RAW is set to [On], the primary clip (RAW) will be output from the HDMI OUT terminal and the sub
recording clip will be recorded to the card in slot B (] 155).

You can also use direct touch control to perform this function ([11 56).

Primary clip Sub recording clip

Recording format / color sampling

Main recording format XF-AVC XF-HEVC S XF-AVC S
YCC422 10 bit YCC422 10 bit YCC420 10 bit YCC422 10 bit YCC420 8 bit
RAW ST
RAW LT o o ( J ( J ( J
HDMI RAW
XF-AVC YCC422 10 bit o - - ( J ( J
XF-HEVC S YCC422 10 bit - (] ( J - -
XF-HEVC S YCC420 10 bit - - ( J - -
XF-AVC S YCC422 10 bit - - - ( J ( J
XF-AVC S YCC420 8 bit - - - - o

1 Insert an SD card into each card slot (slot A for the main clip, slot B for the sub recording clip).

2 Select MENU > [£% Recording/Media Setup] > [2nd Card Rec Functions] > [f@Main / ESub Rec].
3 Select MENU > [
4 Select MENU > [
5 Select MENU > [£¥ Recording/Media Setup] > [ Rec Frame Rate] > Desired option.

6 Select MENU > [£¥ Recording/Media Setup] > [ Bit Rate] > Desired option.
e Steps 3 to 6 can only be selected with some main recording formats.

7 Press the REC button to start recording.
e Proxy clips will be recorded simultaneously with the primary clips.

(i) NoTES

e [f there is no card inserted in the slot used for the primary clip, only the sub recording clip will be recorded.

% Recording/Media Setup] > [ Rec Format] > Desired option.
% Recording/Media Setup] > [ Resolution] > Desired option.
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Proxy Clips

While recording a primary clip on SD card A, you can simultaneously record the same scene as a proxy clip on
SD card B. Because proxy clips have smaller files, they are suitable for offline editing. When HDMI RAW is set to
[On], the main clip (RAW) will be output from the HDMI OUT terminal, and the proxy clip will be recorded to the
card in slot B ([1] 155).

You can also use direct touch control to perform this function (1] 56).

Available configurations
Proxy clips

Recording format / Resolution / Scanning method / Color sampling / Bit rate

. . XF-AVC XF-HEVC S XF-AVC S
Primary clip
2048x 2048x  1920x  1280x  2048x  1920x  1280x
1080 AL g 1080 1080 720 1080 1080 720
P P [ P p
Resolution 8bit
format method
35 Mbps 16 Mbps, 9 Mbps 6 Mbps 16 Mbps, 9 Mbps 6 Mbps
RAW
HDMI RAW N N i N N i N - o N N
4096x2160
204811080 | d N N - - - d - -
XF-AVC | 3840x2160
1920x1080 P - * B B - - B
1920x1080 [ - o' o - - - - ()
4096x2160
2048x1080 - N N i N - N N N
XF-HEVCS © aaox2160
X
1920x1080 P - N N N o o N N N
4096x2160
204811080 | - N N - - - d - -
XEAVCS T saona160
X.
19201080 B N N - - B N i i

T Cannot be selected if the proxy clip has a larger bit rate than that of the main clip.

1 Insert an SD card into each card slot (slot A for the main clip, slot B for the proxy clip).
2 Select the main recording format ([J] 62).

3 Select MENU > [£% Recording/Media Setup] > [2nd Card Rec Functions] > [fMain / @Proxy
Rec].

4 Select MENU > [£% Recording/Media Setup] > [ Rec Format] > Desired option.
5 Select MENU > [ 2% Recording/Media Setup] > [ Resolution] > Desired option.
6 Select MENU > [£% Recording/Media Setup] > [ Frame rate] > Desired option.

7 Select MENU > [£8 Recording/Media Setup] > [ Bit rate] > Desired option.
e Steps 4 to 7 can only be selected for some primary clip recording formats.



Proxy Clips

8 Select MENU > [£% Recording/Media Setup] > [Proxy Rec Color Conversion] > Desired option.

e |f you select [Conform to Custom Picture], the gamma curve and color space are determined to conform to
the gamma curve of Custom Picture. Furthermore, if you select [BT.709 (Canon 709)] or [BT.709 (CMT 709)],
they are converted as follows.

. Gamma curve after conversion Color space after conversion
Gamma curve of Custom Picture
BT.709 (Canon 709)  BT.709 (CMT 709)  BT.709 (Canon 709)  BT.709 (CMT 709)
BT.709 Standard BT.709 Standard BT.709 Standard
BT.709 Wide DR BT.709 Wide DR BT.709 Wide DR
Canon 709 Canon 709 Canon 709
The gamma curve and color space after BT.709
applying the Look File and after conversion is SDR SDR
[SDR BT.709] or [SDR BT.2020].
Other Canon 709 CMT 709

e |f you select [BT.709 (Canon 709)] or [BT.709 (CMT 709)], proxy clips are recorded after converting the
gamma curve and color space. The value set for MENU > [[Z) Monitoring Setup] > [Gain for HDR = SDR
Conv.] (11 159) is applied to the proxy clips as well.

9 Press the REC button to start recording.
e Proxy clips will be recorded simultaneously with the primary clips.

(i) NoTES

e |f the recording of the primary clip stops during simultaneous recording, recording of the proxy clip will stop as
well.

e |f there is no card inserted in the slot used for the primary clip, only the proxy clip will be recorded.
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Shutter Speed

You can set the shutter speed according to the shooting conditions. For example, you may want to set slower
shutter speeds in darker environments. The camera offers the following modes.
You can also perform this function remotely using Browser Remote on a connected network device (11 187).

[Speed]: Allows you to set the shutter speed (in fractions of a second). You can select the increment to use when
adjusting the shutter speed between 1/3-stop and 1/4-stop increments.

[Angle]: You can set the shutter angle to determine the shutter speed.

[Clear Scan]: Set the frequency in order to record CRT computer monitors without displaying black bands or
flicker on the screen.

[Slow]: You can set slower shutter speeds to obtain brighter recordings in places with insufficient lighting.
[Off]: The camera uses a standard shutter speed based on the frame rate.

Available shutter speeds
The individual setting options that can be selected will change depending on the frame rate used.

System frequency/Frame rate

Shutter speed mode 59.94 Hz 24.00 Hz 50.00 Hz
59.94P / 59.94i 29.97P 23.98P 24.00P 50.00P / 50.00i 25.00P
1/3-stop 1/1 t01/2000 (34 setting options in total
increments
[Speed]' 1/4-stop
A 1/1 0 1/2000 (47 setting options in total) 1/1 10 1/2000 (45 setting options in total)
increments
[Angle]! 360.00°, 240.90", 180.00°, 120.90", 90.00°, 60.00°, 45.00°, 30.00°, 22.50°, 15.00°, 11.25°
Also angle values equivalent to the following shutter speeds: 1/120, 1/100, 1/60, 1/50, 1/40, 3/100, 1/30, 1/25.
23.97 Hz t0 1971 Hz
[Clear Scan]! Within the above range, the frequency can be set with the minimum available resolution depending on the sensor
mode and frame rate.
1/4,1/8,1/15, 1/3,1/6, 1/12,
[Slow]? 1/30 1/4,1/8, 115 1/3,1/6,1/12 125 1/3,1/6, 1112
[off]! 1/60 1/30 1/24 1/50 1/25

T When slow & fast motion recording is activated, available setting options will vary depending on the selected shooting frame rate.
2 Not available when slow & fast motion recording is activated.

1 Select MENU > "™ Camera Setup] > [Shutter Mode] > Desired shutter speed mode.
2 For [Speed] only: Select MENU > ["™ Camera Setup] > [Shutter Increment] > [1/3 stop] or [1/4 stop].

3 Adjust the shutter speed, angle value or clear scan frequency using the direct setting mode ([1 57).
* You can also use direct touch control (1] 56).

Using slow shutter mode

When recording in dark surroundings, you can obtain a brighter picture by using slow shutter mode. You can
also use this mode when you wish to add certain effects to your recordings, such as blurring the background
during panning shots or recording a moving subject with an afterimage trail.

¢ Image quality may not be as good as when using faster shutter speeds in brighter surroundings.

(i) NoTES

¢ \When the shutter speed mode is set to [Slow], bright red, green or blue dots may appear on the screen. In
such case, use a faster shutter speed or select a lower ISO speed or gain value ([I] 68).

¢ When an RC-V100 Remote Controller is connected to the camera, you can change the shutter speed mode
with the remote controller’s SHUTTER SELECT button and the shutter speed value with the remote controller’'s
SHUTTER A /W buttons.
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Recording Under High-Frequency Light Sources
Flickering may occur when recording video under a rapidly blinking light source. When you execute [Auto Clear

Scan Setting], the camera detects the frequency of the light source (in a range of 50.0 Hz to 2011.2 Hz) and
shoots at a shutter speed that matches the blinking cycle, reducing flickering.

1 Select MENU > ["™ Camera Setup] > [Shutter Mode] > [Clear Scan].
2 Select MENU > ["™ Camera Setup] > [Auto Clear Scan Setting] > [OK].

3 Change the shutter speed to the displayed speed.
¢ When you select [OK], the shutter speed changes to the displayed speed.

When [No flicker detected.] is displayed, or when the flickering does not disappear even after changing to the
displayed shutter speed, perform the following operations:
e Execute [Auto Clear Scan Setting] again.
e Execute [Auto Clear Scan Setting] after changing the camera’s orientation by about 90 degrees.
e Adjust manually.
- Set a control dial / control ring to [Clear Scan (Steps)] or [Shutter] (11 210).
- With [Clear Scan (Steps)], you can change the shutter speed to 2, 3, or 4 times, or to 1/2, 1/3, or 1/4 times
the frequency set using [Auto Clear Scan Setting].
- With [Shutter] you can make fine adjustments.

(i) NoTES

¢ The accuracy of high-frequency flickering detection may be reduced under the following conditions.
- When there are repetitive patterns (such as grid or stripe patterns).
- When the subject is in constant movement.
- In extreme brightness or darkness.
- When there are multiple light sources in the screen.
- When the blinking light source is too small.
- When the subject illumination is low.

Flicker Reduction
You can perform the following procedure to have the camera automatically detect and reduce flicker.

Select MENU > ["™ Camera Setup] > [Flicker Reduction] > [Automatic].

(i) NoTES

¢ When recording under artificial light sources such as fluorescent, mercury or halogen lamps, the screen may
flicker depending on the shutter speed. You may be able to avoid flicker by setting the shutter speed mode to
[Speed] and the shutter speed to a value matching the frequency of the local electrical system: 1/50* or 1/100
for 50 Hz systems, 1/60 or 1/120 for 60 Hz systems.
* May not be available depending on the frame rate.

Flicker reduction cannot be used in the following cases.

¢ During slow & fast motion recording when the following shooting frame rates are not used:
- 59.94 Hz: 30P/60P/120P
- 50.00 Hz: 25P/50P/100P

¢ \When the system frequency is 24.00 Hz. Or when the frame rate is 23.98P when using a recording mode
other than slow & fast motion recording.
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ISO Speed/Gain

You may want to adjust the brightness of the image according to the shooting conditions. You can choose
between manual and automatic settings. By choosing manual settings you can change the ISO speed or gain
value to adjust the sensitivity of the sensor. You can also set the camera’s base ISO speed by choosing from four
modes.

You can also perform this function remotely using Browser Remote on a connected network device ([1] 187).

Available setting values

1S0/Gain’ Increment? Available setting values
[1 stop] 1004, 160°, 200, 400, 640°, 800, 1600, 2500%, 3200, 6400, 12800, 25600, 512004, 102400*
I0] [1/3 stop] 1004, 1254, 160, 200, 250, 320, 400, 500, 640, 800, 1000, 1250, 1600, 2000, 2500, 3200, 4000, 5000,

6400, 8000, 10000, 12800, 16000, 20000, 25600, 320004, 40000, 51200%, 64000%, 800004, 102400*

[“:grg;‘;” —6dB*, ~3dB*, ~24B%, 0dB to 42B, 450B* to 54dB*
e [Finel —2dB to 42dB, 42.5dB* to 54dB*
(0.5 dB) e
Available range
Base ISO 1S0/Gain' Increment? ARl L
Extended range®
[1S0] Any setting 160 to 25600 100 to 102400
[Auto Selection] ) [Normal] (3 dB) —2dB to 42dB —6dB to 54dB
(Gain] [Fine] (0.5 dB) —2dB to 42B —~20B to 54dB
(Base 150 160] / [Base 1S0 160 (-24B)] [1S0] Any setting 160 to 6400 100 o 12800
[Base IS0 400] / [Base 1SO 400 (6dB)] _ [Normal] (3 dB) —2dB to 30dB —~6dB to 360B
[Base IS0 800] / [Base IS0 800 (12dB)] [Gair] [Fine] (0.5 dB) —2dB to 30dB —_24B to 36dB
[Base IS0 640] / [Base ISO 640 (~2dB)] [1S0] Any setting 640 to 25600 400 to 51200
[Base IS0 1600] / [Base IS0 1600 (6dB)] _ [Normal] (3 dB) —~24B to 3008 —60B to 360B
[Base IS0 3200] / [Base IS0 3200 (12dB)] [Gain] [Fine] (0.5 0B) 2B 10 308 odB 1o 36B
[Base 150 2500] / [Base IS0 2500 (_2B)] [1S0] Any setting 2500 to 25600 1600 to 102400
[Base IS0 6400] / [Base IS0 6400 (6dB)] , [Normal] (3 dB) ~2dB to 184B —60B to 30dB
[Base IS0 12800] / [Base ISO 12800 (12dB)] (Gain] [Fine] (05 6B) “odB 1o 1848 odB 10 3008

T MENU > ["™ Camera Setup] > [ISO/Gain] setting.

2 MENU > ["™ Camera Setup] > [ISO/Gain Increment] setting.

3 Available only when MENU > ["™ Camera Setup] > [ISO/Gain Extended Range] is set to [Off].
4 Available only when [ISO/Gain Extended Range] is set to [On].

Base ISO Speed

Set the base ISO speed for the recommended dynamic range. You can achieve low noise even at high ISO/gain
levels by switching to one of three settings that suit different lighting conditions (normal lighting, low light, and
dark places). Additionally, the [Auto Selection] setting automatically switches between three levels of base ISO
according to the ISO/gain value, ensuring an optimal dynamic range and S/N ratio.

Select MENU > ["™ Camera Setup] > [Base ISO] > Desired option.

¢ Available values will depend on the [Gamma/Color Space] setting in the custom picture file and the recording
format.
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Base ISO settings
MENU > ["™ Camera Setup] > [IS0/Gain]

Gamma curve
[1S0] [Gain]
[Canon Log 2] / [Canon Log 3] [Auto Selection], [Base I1SO 800], [Base IS0 3200], | [Auto Selection], [Base ISO 800 (12 dB)],
(Also applies when the main recording | [Base IS0 12800] [Base ISO 3200 (12 dB)], [Base ISO 12800 (12 dB)]
format is RAW)
[PQ] / [HLG] / [Canon 709] / [Auto Selection], [Base I1SO 400], [Base IS0 1600], | [Auto Selection], [Base ISO 400 (6 dB)],
[BT.709 Wide DR] [Base ISO 6400] [Base ISO 1600 (6 dB)], [Base ISO 6400 (6 dB)]
[Auto Selection], [Base ISO 160], [Base IS0 640], | [Auto Selection], [Base ISO 160 (-2 dB)],
[BT-709 Standard] [Base IS0 2500] [Base IS0 640 (~2 dB)], [Base IS0 2500 (-2 dB)]

(i) NoTES

e |f you select an ISO/gain value below the base ISO speed, white clipping in the highlights is more likely to
occur.

e There is a difference in the amount of noise between each base ISO speed setting. Example: when comparing
base ISO 800/I1SO 800, base ISO 3200/ISO 3200, and base ISO 12800/I1SO 12800, there is a difference in the
amount of noise generated in the dark areas.

Manual ISO Speed/Gain Value
1 Select MENU > "™ Camera Setup] > [ISO/Gain] > [ISO] or [Gain].
2 Select MENU > ["™ Camera Setup] > [ISO/Gain Mode] > [Manual].

3 Depending on your previous selection, select MENU > ["™ Camera Setup] > [ISO/Gain Increment] >
Desired option.

4 Adjust the ISO speed or gain value using the direct setting mode ([I] 57).
* You can also use direct touch control (1] 56).

Using the Control Dial/Control Ring Control dial

You can adjust the ISO speed or gain value using the control dial or the
control ring of an RF lens.

1 Perform steps 1 to 3 in the Manual ISO Speed/Gain Value procedure.
(69

2 Select MENU > [ System Setup] > [Front Control Dial], [Rear
Control Dial] or [Control Ring] > [ISO/Gain].

3 Turn the control dial or control ring to set the desired ISO speed or
gain value.

ISO Speed/Gain Preset
Using direct touch control (1] 56), you can adjust and use up to 3 preset ISO speed/gain values.

Saving a preset value
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ISO Speed/Gain

1 Touch [y > Current ISO speed/gain value. Touch to register a preset value
2 Adjust the value selected and touch [Register]. Stored preset values
3 Touch the desired position to save the preset value.

* The current value is saved.

Using a saved preset value

Drag the slider to select the desired value

1 Touch [ > Current ISO speed/gain value.
2 Touch the desired preset value (above the slider).
¢ The selected preset value is applied.

(i) notes

e When high ISO speeds or gain levels are set, the picture may flicker slightly.

e When high ISO speeds or gain levels are set, bright red, green or blue dots may appear on the screen. In such
case, use a faster shutter speed ([11 66) or select a lower ISO speed or gain value.

e When the ISO speed or gain level is changed, some noise may appear momentarily on the screen. Do not
adjust the ISO speed/gain level while recording.

e You can use the MENU > [¥ System Setup] > [Front Ctrl Dial Dir.], [Rear Ctrl Dial Dir.] or [Control Ring Dir.]
setting to change the direction of the adjustment when you turn the control dial or control ring.

¢ When an RC-V100 Remote Controller is connected to the camera, you can adjust the ISO speed or gain value
with the remote controller’s ISO/GAIN A /W buttons.

e |f you set an assignable button to [ISO/Gain Mode] ([11 125), you can press the button to switch between
automatic and manual adjustment.

Automatic ISO Speed/Gain

The sensitivity limit will be set automatically according to the [Gamma/Color Space] setting in the custom picture
file.

Gamma curve Base IS0' Lower sensitivity limit
[Auto Selection]
IS0 800 (Gain 12 dB)
[Canon Log 3] [Base IS0 800]
[Canon Log 2] [Base ISO 3200] IS0 3200 (Gain 12 dB)
[Base ISO 12800] 1SO 12800 (Gain 12 dB)
[Auto Selection] )
[BT.709 Wide DR] 1SO 400 (Gain 6 dB)
PQ] [Base IS0 400]
(HLE] [Base IS0 1600] IS0 1600 (Gain 6 dB)
[Canon 709]
[Base IS0 6400] IS0 6400 (Gain 6 dB)
[Auto Selection]
1SO 160 (Gain —2 dB)
[Base IS0 160]
[BT.709 Standard]
[Base IS0 640] IS0 640 (Gain —2 dB)
[Base IS0 2500] IS0 2500 (Gain —2 dB)

T When the main recording format is RAW, the available base ISO settings are the same as when the gamma curve component of
the [Gamma/Color Space] setting in the custom picture file is set to [Canon Log 2] / [Canon Log 3].

Select MENU > ["™ Camera Setup] > [ISO/Gain Mode] > [Automatic].
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(i) noTes

¢ You can set the responsiveness of the automatic exposure function with the MENU > ["™ Camera Setup] >
[AE Response] setting*.
* Except when using an incompatible lens ([1] 249).

Setting an automatic ISO limit
By setting an ISO limit in automatic mode, you can curb the amount of noise and keep a dark ambient.
Select MENU > ["™ Camera Setup] > [Limit for Auto Mode] > Desired option.
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ND Filter

ND Filter

Using the ND filter allows you to open up the aperture to obtain a shallower depth of field even when recording in
bright surroundings. You can also use the ND filter to avoid the soft focus caused by diffraction when using small
apertures. By default, you can select one of 3 density levels. If you enable the extended ND range, you can
select one of 5 density levels.

You can also perform this function remotely using Browser Remote on a connected network device (11 187).

Press the ND FILTER + or - button to select the desired ND
filter setting.

ND Filter Range

Displayed units
Stop Transmittance Optical Density
0 11 0.0
2 1/4 0.6
4 1/16 1.2
6 1/64 1.8
8 1/256 2.4
10 1/1024 3.0

e Repeatedly pressing ND FILTER + button will change the ND filter setting in the following order (when set to
[Stop]): [ND 2 stops] — [ND 4 stops] — [ND 6 stops] — [ND 8 stops]* = [ND 10 stops]* — ND filter off. (The ND
FILTER - button cycles through the settings in reverse order.)

* Only when MENU > ["™ Camera Setup] > [Extended ND Range] is set to [On].

¢ You can also adjust this setting using direct touch control ([T 56).

® For the displayed units (["® Camera Setup] > [ND Display Units]), you can choose from [Stop], [Transmittance]
or [Optical Density].

(i) NOTES

¢ You can also press an assignable button set to [ND +] or [ND -] to perform this operation ([1] 125).
e Depending on the scene, the color may change slightly when turning the ND filter on/off. Setting a custom
white balance ([] 78) may be effective in such case.
About the extended ND range
- When you switch to or from a density level in the extended range, the focus may shift, affecting also the
indication on the lens’s focus distance scale.
- When you switch to a density level in the extended range, depending on the lens, the camera may not be
able to focus at infinity focus.
Changing the ND filter setting using the RC-V100 Remote Controller
- When the remote controller is connected to the camera, you can use the remote controller’s ND button in
the same way as the camera’s ND FILTER + button.
- When using settings up to level 4 (for [ND Display Units] > [Stop]: 2 to 8 stops), the corresponding ND filter
indicator (1 to 4, respectively) will illuminate in orange. When the ND filter is set to level 5 (for [ND Display
Units] > [Stop]: 10 stops), indicators 1 and 4 will both illuminate.
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Aperture

You can affect the brightness of your recordings or change the depth of field by adjusting the aperture.
Depending on the lens used, the aperture value displayed may differ (F value or T value) and available aperture
values will vary as well ([J] 249). You can select the adjustment increment and even use the smallest iris
increment allowed by the lens.

You can also perform this function remotely using Browser Remote on a connected network device (1] 187).

Manual aperture: Adjust the aperture value manually.
Automatic aperture: The camera adjusts the aperture automatically.

Push Auto Iris: Momentary automatic aperture. During manual aperture, press the AUTO IRIS button to
temporarily adjust the aperture automatically (only while the button is held pressed down).

Aperture Settings of the Lens

To adjust the aperture from the camera, you will need to enable automatic adjustment using the controls on the
compatible EF Cinema/RF (with iris ring) lens. Required settings vary depending on the lens. Refer to the
instruction manual of the lens used.

Set the lens or iris ring to automatic aperture.

Manual Aperture: Changing the Aperture Value

1 Select MENU > ["™ Camera Setup] > [Iris Mode] > [Manual].

* This setting is available only when a lens compatible with automatic aperture is attached to the camera. For
non-compatible lenses, the aperture mode is automatically set to [Manual] and cannot be changed.

2 When using a lens equipped with aperture settings, set the lens to automatic aperture mode.

3 Select MENU > ["™ Camera Setup] > [Iris Increment] > [1/2 Stop] or [1/3 Stop].
® You can also set MENU > ["™ Camera Setup] > [Fine Increment] to [On] to use the smallest iris increment
allowed by the lens attached. Nevertheless, the aperture value displayed on the screen will be the closest
value in the selected increment scale.
4 Adjust the aperture value using direct setting mode ([11 57).
* You can also use direct touch control ([J] 56).
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Aperture

Using the Control Dial/Control Ring

You can also adjust the aperture settings using the control dial (after assigning the [lIris] function) or the control

ring of an RF lens/mount adapter.

1 Select MENU > [¥ System Setup] > [Front Control Dial], [Rear Control dial
Control Dial] or [Control Ring] > [Iris].

2 Turn the control dial or the control ring of an RF lens to adjust the
aperture.

(i) NoTEs

¢ You can use the MENU > [¥ System Setup] > [Front Cirl Dial Dir.], [Rear Ctrl Dial Dir.] or [Control Ring Dir.]
setting to change the direction of the adjustment when you turn the control dial or control ring.
¢ Closing down the aperture when recording under bright conditions may cause the picture to appear soft or out
of focus. The following measures may be effective in avoiding the loss of sharpness due to diffraction.
- Using a denser ND filter (11 72).
- Using a faster shutter speed ([1] 66).
- Applying diffraction correction (1] 31). Results may vary depending on the lens used.
¢ If you set an assignable button to [Iris +] or [Iris -] (1] 125), you can press the button to respectively open up
or close down the aperture.
¢ When using a lens equipped with aperture settings, you can also adjust the aperture with the iris ring on the
lens (11 73).
¢ When using a lens with no lens contacts or an incompatible lens ([1] 249), you cannot adjust the aperture
using the camera. Adjust it using the lens.
¢ \When using a lens that can correct the aperture value according to the position of the zoom, you can use the
MENU > ["®™ Camera Setup] > [Zoom-Iris Correction] setting to activate this correction.
¢ \When an RC-V100 Remote Controller is connected to the camera, you can adjust the aperture with the
remote controller’s IRIS dial. At default settings, turn the dial right to open up the aperture and left to close the
aperture.
¢ Using an RF/EF Cinema lens
- The aperture value displayed on the screen will be a T value*. The aperture value (T value) displayed on the
screen may differ from the indication on the lens’s aperture scale.
* Updating the firmware is necessary for RF Cinema lenses ([1] 31).
- When the iris is almost fully closed, the aperture value (T value) will appear in gray on the screen.
- When you change the aperture value from a position of fully open or fully closed iris, multiple adjustment
operations may be required until the aperture changes.
e |f you use the EF-EOS R 0.71x Mount Adapter to attach an EF lens, the aperture will be approximately one
level brighter than the value indicated by the lens.

Momentary Automatic Aperture - Push Auto Iris

During manual aperture, you can press the PUSH AUTO IRIS button to have the camera temporarily take control
and adjust the aperture automatically for an optimal exposure.
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This function is not available when slow & fast motion recording is activated.
1 Select MENU > ["™ Camera Setup] > [Iris Mode] > [Manual].

2 When using a lens equipped with aperture settings, set the lens to
automatic aperture mode ([] 73).

3 Press and hold the PUSH AUTO IRIS button.

e The camera will automatically adjust the aperture to obtain optimal
exposure as long as you hold the button pressed down, and [ will
appear on the screen next to the aperture value.

¢ \When you release the button the aperture value will be set, automatic
aperture mode will end and the @ icon will disappear.

(i) NOTES

* You can use the MENU > ["™ Camera Setup] > [AE Response] setting to change how quickly the aperture
changes during automatic aperture mode. This setting has no effect when using an incompatible lens

(1 249).

PUSH
AUTO IRIS

Automatic Aperture

When a compatible lens is attached to the camera, you can have the camera automatically adjust the aperture.
This function is not available when slow & fast motion recording is activated.

1 Select MENU > ["™ Camera Setup] > [Iris Mode] > [Automatic].
e The camera will automatically adjust the aperture to obtain optimal exposure. The selected aperture value
will appear at the bottom of the screen with an [ icon next to it.

2 When using a lens equipped with aperture settings, set the lens to automatic aperture mode ([J1 73).

(i) notes

e If you set an assignable button to [Iris Mode] (11 125), you can press the button to toggle between the
[Automatic] and [Manual] settings.

* The aperture value may change in the following cases.

- While using the built-in extender or iris compensation function of an EF Cinema lens, when you switch from
automatic aperture to manual aperture.

- When the aperture controls on the lens are switched between automatic/manual mode.

¢ When using EF Cinema lenses that let you adjust the aperture gain, if the aperture gain is set too high, the
aperture adjustment may not be stable (“aperture hunting”), depending on the shooting conditions. In such
case, reset the lens’s aperture gain to its initial value.

Exposure Compensation - AE Shift

Use AE shift to compensate the exposure that was set using automatic aperture, in order to darken or lighten the
image.
You can also perform this function remotely using Browser Remote on a connected network device (1] 187).

1 Select MENU > ["™ Camera Setup] > [AE Shift].

2 Select the desired option.
e The camera will attempt to adjust the exposure accordingly.
® You can select one of 17 AE shift levels from —2.0 to +2.0.
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(i) Notes

e If you set an assignable button to [AE Shift +] or [AE Shift -] (11 125), you can press the button to adjust the
AE shift level.

The exposure bar Optimal exposure AE+0
The W on top of the exposure bar indicates optimal exposure without any shift P p| a

(AE+0); the scale markings indicate the deviation from optimal exposure in
1/2 EV increments. The indicator inside the exposure bar represents the current ﬁ
exposure. When the difference between current and optimal exposure is larger |

than £2 EV, the indicator will flash at the edge of the exposure bar. Optimal Current exposure
exposure will change depending on the light metering mode used.

Light Metering Mode

Select the light metering mode to match the recording conditions. Using the appropriate setting will help achieve
a more appropriate exposure level.
1 Select MENU > ["™ Camera Setup] > [Light Metering].

2 Select the desired option.
e The icon of the selected mode (7Y or /s\) appears on the screen.

Options

[Backlight]: Suitable when recording backlit scenes.

[Standard]: Averages the light metered from the entire screen, giving more weight to the subject in the center.
[Spotlight]*: Use this option when recording a scene in which only a certain part of the picture is lit, for

example, when the subject is lit by a spotlight.
* Cannot be selected when a VR lens is attached.

(i) notes

e |f [EOS Standard] or [EOS Neutral] is selected for [Select File], the light metering mode cannot be selected.
However, it can be selected if the custom picture file is edited (gamma adjustment, registering a different LUT
as a Look File).

e |f you set an assignable button to [Backlight] or [Spotlight] (1] 125), you can press the button to toggle
between the respective light metering mode and [Standard].

e Adjust the exposure again if you change the metering mode after adjusting the aperture manually.
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White Balance

The camera uses an electronic white balance process to calibrate the picture and produce accurate colors under
different lighting conditions. The camera offers the following ways to set the white balance.
You can also perform this function remotely using Browser Remote on a connected network device ([11 187).

Custom white balance: You can use a gray card or white object with no pattern to establish the white balance
and set it to one of two custom white balance positions, 21 A or 8®4B. When recording under fluorescent lights,
we recommend setting the custom white balance.

Preset white balance: Set the white balance to 8¢ (daylight) or 32 (tungsten lamp). You can further adjust the
color temperature (K) value and the color compensation (CC) value, which adjusts the color along the green/
magenta gradation.

Color temperature: Allows you to set the color temperature between 2,000 K and 15,000 K, and further adjust
the color compensation (CC) value.

Auto white balance (AWB): The camera automatically adjusts the white balance to the optimal level.

(i) NoTES

¢ The [White Balance] setting in the custom picture file (1] 137) takes precedence over the white balance set
with these procedures.

¢ You can use the MENU > ["™ Camera Setup] > [Shockless WB] setting to make the transition look smoother
when you change the white balance settings.

¢ \When an RC-V100 Remote Controller is connected to the camera, you can adjust the white balance with the
remote controller's AWB button, A button, B button, PRESET button and = button.

¢ The color temperatures displayed on the screen are approximate. Use them only as a reference.

White Balance Mode

Select a white balance mode using the direct setting mode

(T 57).

¢ You can also use direct touch control (] 56).

e Ifyou set MENU > [ System Setup] > [Front Control Diall,
[Rear Control Dial] or [Control Ring] to [White Balance Mode],
you can change the white balance mode using the control dials
or control ring of an RF lens.

(i) NnoTes

e |f you set an assignable button to [[[} AWB]. [~ Set A],
(2% Set B, [38: Daylight], [:# Tungsten] or [E4 Kelvin] (11 125), you can press the button to change the white
balance mode temporarily. Press the button again to return to the previous white balance mode.
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White Balance

Custom White Balance

1 Select the A or 2B icon ([I1 77).
¢ To apply the stored custom white balance setting as is, the rest
of the procedure is not necessary. To set a new custom white
balance, continue the procedure.

2 Point the camera at a gray card or white object so that it fills
the center of screen.

e Use the same lighting conditions you plan to use when
recording.

3 Press the ~% button.
e The o A or 4 B icon will flash quickly.
e Make sure the gray card or white object fills the center of the screen until the procedure is completed.

e Once the icon stops flashing, the procedure is completed. The setting is retained even if you turn off the
camera.

e The color temperature and CC value registered by the camera will appear at the bottom of the screen next
to the A or B icon.

(i) NoTEs

¢ Readjust the custom white balance if the light source or ND filter setting changes.

e \ery rarely and depending on the light source, x4 may keep flashing (it will change to a slow flashing). In that
case, change the subject brightness and adjust the custom white balance again.

e After the camera registers a custom white balance, the color temperature or CC value may appear in gray. This
indicates that the value registered exceeds the range of values that can be displayed but the white balance is
correctly calibrated and you can continue shooting.

Color Temperature/Preset White Balance
1 Select the s8: or #¢ icon (preset white balance), or the
4 icon (color temperature setting) (11 77).

¢ To apply the stored preset setting or color temperature as is, the
rest of the procedure is not necessary. To adjust the color
temperature or CC value, continue the procedure.

2 Press the »® button.

¢ The camera will enter the direct setting mode with the color
temperature highlighted in orange. To adjust the CC value, push
the joystick right.

¢ You can also adjust the color temperature or CC value using direct touch control (11 56).

3 Select the desired value.
¢ The selected color temperature and CC value will be set and will appear on the screen next to the white
balance icon.

. . Adjustment range
White balance mode/setting

Color temperature (K) Color compensation (CC) value
se: (daylight) 4,300 K to 8,000 K 51045
-5t0 +
8% (tungsten lamp) 2,700 K t0 3,700 K

8 (color temperature) 2,000 K to 15,000 K -20 to +20
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(i) noTes

¢ You can use the MENU > ["™ Camera Setup] > [C. Temp. Increment] setting to change the units for the color
temperature increment to [Mired] (5-mired increments) or [Kelvin] (100-kelvin increments). Even when [Mired] is
selected, the color temperature is converted to and displayed in kelvins. Changing this setting may change the
white balance setting.

e |fyou set MENU > [ System Setup] > [Front Control Dial], [Rear Control Dial] or [Control Ring] to [White
Balance (K)] or [White Balance (CC)], you can adjust the color temperature (K) value and the color
compensation (CC) value using the control dials or control ring of an RF lens.

Auto White Balance (AWB)

The camera constantly adjusts the white balance automatically to achieve an appropriate level. The camera will
adjust the white balance if the light source changes.

Select the [ icon ([1] 77).

e The color temperature and CC value set automatically by the camera will appear at the bottom of the screen
next to the icon.

(i) NoTES

e Custom white balance may provide better results in the following cases:
- Changing lighting conditions
- Close-ups
- Subjects in a single color (sky, sea or forest)
- Under mercury lamps and certain types of fluorescent and LED lights

® You can use the MENU > ["™ Camera Setup] > [AWB Response] setting to change how quickly the white
balance changes in auto white balance (AWB) mode.

e |f you set an assignable button to [AWB Lock] ([1] 125), you can press the button to lock the current white
balance settings set automatically by the camera. To cancel the lock, press the button again (resume auto
white balance mode) or select a different white balance setting.
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Focus

Focus

The camera offers the following ways to focus, depending on the lens used. The camera incorporates Dual Pixel
CMOS AF technology for advanced autofocus performance with compatible lenses. Refer to the list of
compatible lenses and functions that can be used ([11] 249).

You can also adjust the focus remotely using Browser Remote on a connected network device ([ 187).

Note that some methods allow you to operate aspects of the focus by touching the LCD screen.

Manual focus (MF): Turn the focus ring on the lens to adjust the focus. The camera offers several focus
assistance functions ([J] 81) to help you focus more accurately when using the manual focus.

Automatic focus (AF): The focus is adjusted automatically.

- One-shot AF*: You will be able to focus manually but still have the option to press an assignable button set
to [One-Shot AF] to let the camera focus automatically once on the subject inside the AF frame.

- Continuous AF*: The camera automatically keeps the subject inside the AF frame in focus at all times. You
can use the AF lock function ([11 85) to change the composition of the picture while keeping the focus on
the selected spot.

Functions related to focus adjustment:

- Subject detection: Set a subject to be detected in advance to automatically detect the face/head, eyes or
body of a person or an animal.

- Subject tracking: After you select a subject, the camera keeps focusing it and tracks the subject if it moves.

* Not available when a manual focus lens is attached to the camera.

Focus Mode on the Lens

Use the switch on the lens to select the lens’s focus mode (automatic, manual). The name of the controls may
differ depending on the lens. Refer to the instruction manual of the lens used.

Set the lens’s focus mode to either automatic or manual.
e Either (automatic) or (MF) (manual) will appear on the screen.

¢ When using a lens without a focus mode switch, select MENU > ["™ Camera Setup] > [Focus Mode] > [AF]
(automatic) or [MF] (manual).

Manual Focus

Focus manually using the focus ring on the lens.

Turn the focus ring to adjust the focus.

(i) Notes

¢ With some lenses, you may be able to operate the focus ring even when the focus mode is set to automatic.

e If you operate the zoom after focusing, the focus on the subject may be lost.

¢ |f you focus manually and then leave the camera with the power turned on, the focus on the subject may be
lost after a while. This possible slight shift in focus is a result of the internal temperature rising in the camera
and lens. Check the focus before resuming shooting.

¢ When adjusting the focus, be careful not to touch the front of the lens or moving parts on the lens except for
the focus ring.

¢ When an RC-V100 Remote Controller is connected to the camera, you can adjust the focus with the remote
controller's FOCUS dial. At default settings, turn the dial right to focus farther and left to focus nearer.
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Using the RF lens's focus ring
- You can change the direction of the adjustment when operating the focus ring with the MENU > [ System
Setup] > [Focus Ring Dir.] setting.
- You can link the amount of focus adjustment when using the focus ring to either the rotation angle or the
rotation speed with the MENU > [ System Setup] > [Focus Ring Response] setting.
- When the lens is set to autofocus, you can enable/disable manual adjustments with the MENU >
[¢ System Setup] > [Focus Ring Operation] setting.

Using the Focus Assistance Functions

In order to focus more accurately, you can use the following focus assistance functions: Dual Pixel Focus Guide,
an onscreen guide that shows you if the selected subject is in focus; peaking, which creates a clearer contrast
by emphasizing the outlines of the subject; and magnification, which enlarges the image on the screen. You can
use peaking and the focus guide or peaking and magnification simultaneously for greater effect.

Focus guide

The focus guide gives you an intuitive visual indication of the current focus distance and the direction and
amount of adjustment necessary to bring the selected subject into full focus. When used in combination with
subject detection (11 86), the guide will focus as follows: if set to [People] / [Animals], on the face (or body, if a
face cannot be detected) of the subject. If [Eye Detection] is set to [On], the guide will focus on the vicinity of the
eyes of the detected person or animal.

1 Set the focus mode on the lens to manual ([1] 80).
2 Using direct touch control (11 56), you can touch the [Focus Guide] switch to turn on/off the focus guide.
e Alternatively, you can use the MENU > [ Assistance Functions] > [Focus Guide] setting or an assignable
button set to [Focus Guide], to display/hide the focus guide.
3 Touch the point where you want to focus on the LCD screen to move the focus guide.
e You can also use the joystick to move the focus guide’s frame. Press SET or the CANCEL button to return
the focus guide’s frame to the center of the screen.
4 Adjust the focus manually as necessary.
¢ \When the focus guide turns green, the subject is correctly focused.

4 B B N B

Focus farther Focus farther In focus Focus closer Focus closer Cannot determine
(large adjustment) (small adjustment) (in green) (small adjustment) (large adjustment) adjustment

(i) NoTES

¢ With subjects or in situations where autofocus may not work well ([T] 84), the focus guide may not work
correctly.

e The focus guide cannot be used in the following cases:
- While the focus is being adjusted automatically using one-shot AF or continuous AF.
- When a manual focus lens is attached to the camera, except for compatible RF/EF Cinema lenses ([11 249).
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Peaking
The camera offers two peaking levels.
1 Press the PEAKING button.

e The peaking icon (EE or @I®) appears on the left of the
screen and outlines (contour lines) in the image that are in
focus will be shown highlighted.

¢ Press the button again to turn off peaking.

* You can use direct touch control ([J] 56) to turn the
[Peaking 1]/[Peaking 2] setting on/off.

¢ Alternatively, you can use one of the MENU > [ Assistance
Functions] > [Peaking:] settings to turn the peaking function
on/off separately on the respective terminal/output destination.

2 To change the peaking level, select MENU > [ Assistance Functions] > [Peaking] > [Peaking 1] or
[Peaking 2].

Magnification
1 Press the MAGN. button.
o [ appears on the left of the screen and the center of the
screen* is magnified 2 times.

¢ The orange frame displayed on the top right of the screen
(magnification frame) shows the approximate part of the image
shown magnified.

e Press SET to change the magnification setting in the following
order: 2x = 5x = 10x.

2 If necessary, use the joystick to move around the magnification frame
and check other parts of the image.
¢ You can also drag your finger across the LCD screen to move the frame.
¢ Press the CANCEL button to return the magnification frame to the center position.

¢ Press the MAGN. button again to cancel the magnification.

* If one of the AF frames or a subject detection frame is displayed on the screen, the area around the active frame will be magnified
instead.

(i) Notes

¢ About Peaking/Magnification:

- You can use the MENU > [ Assistance Functions] > [Peaking 1] and [Peaking 2] settings to set the color,
gain and frequency of the two peaking levels independently of each other.

- You can use the MENU > [ Assistance Functions] > [Magn. Output] setting to select where to show the
magnified image.

- The assistance functions will not affect your recordings.

- Magnification will be turned off if you change the video configuration ([1] 59), turn MENU > "™ Camera
Setup] > [Digital IS] on/off, or if you turn slow & fast motion recording on/off while the magnified image is
displayed.

¢ This function is not applied to the output destination of the HDMI OUT terminal when [HDMI RAW] is set to
[On].

e Peaking/magnification are not available while the color bars are displayed.

¢ When MENU > [& Assistance Functions] > [B&W during Magn.] is set to [On], the screen is set to black and
white during magnification. The assistance functions will not affect your recordings.

e Magnification cannot be displayed under the following conditions.

- When [Sensor Mode] is set to [Full Frame] or [Super 35mm (Cropped)] and the slow & fast motion recording
frame rate exceeds 60P.
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e Peaking cannot be displayed under the following conditions.
- When [OSD Output: SDI] or [OSD Output: HDMI] is set to [Off (Clean)] or [Off].

One-Shot AF

In this focus mode, you will focus manually in most situations but still have the option to have the camera focus
automatically only once on the subject inside the AF frame. You can change the type and position of the AF
frame.

1 Set the focus mode on the lens to automatic ([I] 80).
2 Assign an assignable button to [One-Shot AF].
3 If necessary, change the type and position of the AF frame ([] 85).

4 Press and hold the assigned button.
® As long as the assigned button is held down the camera will focus automatically.
* \When correct focus has been achieved, a green frame is displayed.

e |f [Continuous AF] is disabled and [Subject to detect] is set to [None], the AF frame will disappear when you
release the assigned button (after a certain time has passed).

Continuous AF

The camera will focus automatically on a subject inside the area of the selected AF frame position/type ([ 85).
For details on compatible lenses, refer to Compatible Lenses and Functions ([11] 249).

1 Set the focus mode on the lens to automatic ([J] 80).

2 Select MENU > ["™ Camera Setup] > [Continuous AF] > [Enable].
e A white AF frame will appear on the screen (if the AF frame type is set to an option other than [Whole Area)).
¢ \When focusing nearer is not possible, the AF frame will turn red.
e |f [Lens action if cannot AF] was set to [Stop], when distance measurement is not possible, the AF operation
is stopped, the focus position is fixed and the AF frame becomes yellow.

3 If necessary, change the type and position of the AF frame ([I] 85).

Subject Tracking Adjustment After Focus

After focusing manually on the desired subject, you can automatically track the subject using the [Track after
Focusing] function. When there is no subject in focus, subject tracking is not performed and the AF operation is
performed on the automatically detected subject. Available when Continuous AF is enabled.

1 Select MENU > "™ Camera Setup] > [Track after Focusing] > Desired option.
2 Turn the focus ring to adjust as needed.

Options for [Track after Focusing]:

[On (tracking frame)]:
An orange frame for trackable subjects is displayed on the screen during focus operation. After
the focus operation, the frame changes to a white double frame ¢ J (tracking frame) to perform
subject tracking.

[On (no tracking frame)):
No frame for trackable subjects is displayed during focus operation. After the focus operation, a
white double frame ¢ 1 (tracking frame) is displayed to perform subject tracking.

[Disable]: The subject is not tracked.
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(i) Notes

About the autofocus (AF) functions:

¢ The point where the camera focuses may change slightly depending on shooting conditions, such as subject,
brightness and zoom position. Check the focus before resuming shooting.

e Autofocus may take longer in the following cases.

With some lenses, the camera may take longer to focus automatically or may not be able to focus correctly.
Visit your local Canon website for the latest information.

¢ You can change the adjustment speed and responsiveness of the autofocus function with the following
settings. Visit your local Canon website for the latest information.

MENU > "™ Camera Setup] > [AF Speed] to set the AF speed (the speed at which the focus is adjusted)
to one of 10 levels.

MENU > "™ Camera Setup] > [AF Responseg] to set the responsiveness of the autofocus function to one
of 7 levels.

While using continuous AF, you can hold the button assigned to [One-Shot AF] pressed down to temporarily
adjust the focus using the maximum AF speed and AF response. This is helpful when you want to focus
quickly after focus was lost or to keep a subject in focus while you follow it.

e Continuous AF and one-shot AF will not work in the following cases.

When the shooting frame rate in slow & fast motion recording is not set to 24, 25, 30, 48, 50, 60, 100 or 120
(fos).

e Subject tracking after focus operation will not work in the following cases:

During slow & fast motion recording when the frame rate is not set to 24, 25, 30, 48, 50, 60, 100 or 120
(fps).

When the shutter speed used is slower than 1/30 (59.94 Hz recordings), 1/25 (50.00 Hz recordings) or 1/24
(24.00 Hz recordings or 59.94 Hz recordings with a 23.98P frame rate).

When MENU > [¥ System Setup] > [Focus Ring Operation] is set to [Disable During AF].

When [Tele-converter] is enabled.

AF lock is enabled or the focus mode is set to MF.

When there is no subject in focus on the screen.

When operating the focus ring with a VR lens or a lens other than an RF lens attached to the camera.
When operating the focus from a controller connected to the REMOTE terminal with an attached lens that
does not support tracking (11 249).

When operating the focus using Browser Remote or an XC protocol-compatible device.

¢ In the following cases, you may not be able to select a subject or track the selected subject after focusing.

When switching between multiple subjects at the same depth.
In case of landscapes/distant subjects with a near identical depth.
When the subject on the screen appears small.

e Autofocus may not work well on the following subjects or in the following cases. In such case, focus manually.

Reflective surfaces - Through dirty or wet windows
Subjects with low contrast or without vertical lines - Night scenes
Fast moving subjects - Subjects with a repetitive pattern

When using small apertures.

When subjects at different distances appear in the picture.

When an ISO speed or gain value in the extended range is selected ([1] 68).

When the gamma curve component of the [Gamma/Color Space] setting in the custom picture file (11 134)
is set to an option other than [BT.709 Standard].

When the main recording format is set to RAW.
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AF Lock

While using continuous AF, you can lock the focus on a certain
subject and then move the camera to change the composition.
1 While the autofocus is active, press the AF LOCK button.

* The focus will be locked and and the AF frame will turn
gray. When you are using subject detection, the frame ‘
around the main subject will turn gray. \ °) o= AF LOCK

® The frame displayed on the screen will be the focus guide ‘
frame if [Focus Guide] is set to [On].

¢ \When you use a button assigned to [AF Lock (While
Pressed)], the focus will only be locked while the button is
held pressed down.

2 Press the AF LOCK button again to cancel the AF lock.

(i) Nnotes

AF lock will be canceled automatically in the following cases:
- If the camera is turned off or the camera’s system frequency is changed.
- If the lens is removed or replaced.
- If MENU > ["™ Camera Setup] > [Continuous AF] is changed to [Disable].
- When slow & fast motion recording is activated and the shooting frame rate used is other than 24P, 25R,
30P, 48P, 50P, 60F, 100P or 120P.

Changing the AF Frame Type and Position

You can change the type and position of the AF frame that appears on the screen while using one of the
autofocus functions. You can change the position of the AF frame when the frame type is set to an option other
than [Whole Areal.

Select MENU > ["™ Camera Setup] > [AF Frame] > Desired option.

[Small Zone] [Zone] [Large Zone: Horizontal] [Large Zone: Vertical] [Whole Area]
r al
r i r A
i
L 4 L 4
L m]

e To move the AF frame (when set to an option other than [Whole Area]), you can touch the desired subject on
the LCD monitor or press the joystick (in 8 directions). Press SET or CANCEL to move the AF frame back to
the center of the screen.

(i) Nnotes

¢ When [Tele-converter] is enabled, the [Small Zone] frame will be displayed and the position will be [Center
Frame]. The size of the AF frame will change depending on the set magnification.
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Subject Detection Function

The subject detection function automatically detects the face/head, eyes or body* of a person or animal,
according to the menu settings.

You can use subject detection with one of the autofocus functions to let the camera focus on the main subject
automatically. You can use the focus guide ([1] 81) in combination to help you focus on the main subject
manually. You can use the focus guide to adjust the focus on the main subject manually. You can also change
the main subject.

* Detected when a person’s face/head (after being tracked once) is hidden from view.

1 Select MENU > ["™ Camera Setup] > [Subject to detect] > [People] or [Animals].
. E (People) or ﬂ (Animals) appears on the left side of the screen.

2 Select MENU > ["™ Camera Setup] > [Subj. detect. AF] > [Detect. priority] or [Detect. only].
e @ (detection priority) or & (detection only) will appear on the left of the screen.

3 Select MENU > ["™ Camera Setup] > [Eye Detection] > [On].
4 Select MENU > "™ Camera Setup] > [Face Detection AE] > [On].

5 Point the camera at the subject.
¢ \When [Subject to detect] is set to [People], a frame is displayed on all detected people. When set to [Animals],
a frame is displayed only the main subject (animals or people). The main subject is determined automatically

and is displayed in white when using autofocus, and in gray or yellow* when using manual focus.
* When [Continuous AF] is enabled and [Lens action if cannot AF] was set to [Stop].

¢ \When multiple subjects are detected, < and P> are shown on the main subject frame. If [Subject to detect]
is set to [People], a gray frame is displayed on subjects other than the main subject. When < and B> are
shown, pressing the joystick to the left/right switches the main subject to another subject and tracking
starts.

Options for [Subj. detect. AF]

[Detect. priority]: When a subject is not being detected, the camera determines the main subject and focuses on
it.

[Detect. only]:  When a subject is not being detected, the camera locks the focus.
AF operation according to the [Subject to detect] settings is as follows:
- Continuous AF: The camera continuously focuses on the subject it determines to be the main subject.

- One-shot AF: When you press a button assigned to [One-Shot AF], the camera focuses on the subject it
determines to be the main subject.

Operation by AF mode
Subj. Detect. AF

AF mode Focus aperation [Detect. Priority] [Detect. Only]
. No subject . No subject
Subject detected detected Subject detected detected
Manual focus Manual focus
Continuous AF: disabled _ _ Focus on the
One-shot AF in operation subject inside the
Focus on the AF frame
; Focus on the o Focusonthe [—(1
Automatic ) subject inside the ) Manual focus
detected subject AF frame detected subject | " "
Continuous AF: enabled . . Fgcug Or? the
One-shot AF in operation subject inside the

AF frame
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(i) noTes

¢ Typical examples of subjects not correctly detected

- Faces extremely small, large, dark or bright in relation to the overall picture.

- Faces that are turned to the side, at a diagonal, partially hidden or upside-down.

- When the subject is blurred due to weather, the background, etc.

e The subject detection function cannot be used in the following cases.

- When the shutter speed used is slower than 1/30 (59.94 Hz recordings), 1/25 (50.00 Hz recordings) or 1/24
(24.00 Hz recordings or 59.94 Hz recordings with a 23.98P frame rate), except when slow & fast motion
recording mode is activated.

- When the shooting frame rate for slow & fast motion recording is lower than 24P or higher than 120P.

- When a manual focus lens is attached to the camera.

- When [Tele-converter] is enabled.

¢ Face detection AE cannot be used in the following cases.

- When shutter speed, ISO speed/gain and aperture are set to manual.

e The camera may mistakenly detect a subject other than the desired subject. In such case, set [Subject to
detect] to [None].
e |f you set an assignable button to [Subject to detect], [Subj. detect. AF], [Eye Detection] or [Face Detection AE]

(11 125), you can press the button to adjust those settings.

Tracking a Specific Subject

You can have the camera track other moving subjects that are not faces and also combine the tracking function
with one of the autofocus functions to let the camera focus on the desired subject automatically.
To use the tracking function, you will need to set an assignable button to [Tracking] in advance.

1 Set an assignable button to [Tracking] (1] 125).

2 Press the assignable button.
® The subject selection mark »Z« will appear on the screen.
e Press the assignable button again or the CANCEL button to end the subject selection mode.

3 Select the subject you want to track.
e Touch the desired subject on the LCD screen.
® You can press the joystick up, down, left, or right to move to the subject you want to track, and then press
SET (or press the joystick itself) to start tracking.
4 The »Z« mark changes to a double frame | J (tracking frame) and the camera will start tracking the
selected subject.
e To stop tracking the selected subject, press CANCEL.

(i) NoTES

¢ \When the AF frame type is set to [Whole Area] or during subject tracking, you can track a subject by touching
the subject to be tracked on the LCD monitor. If [Subject to detect] is set to [People] or [Animals], you can
switch the main subject by pressing the joystick left or right and start tracking. In this case, no frame will be
displayed for subjects other than the main subject (even if set to [People]).

e The camera may start tracking the incorrect subject if there is another subject in the picture with similar color/
pattern characteristics. In that case, select the desired subject again.

¢ Tracking cannot be used in the same cases in which the subject detection function cannot be used.
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Image Stabilization

You can use the image stabilizer to compensate for camera shake and achieve steadier shots. The image
stabilizer is more effective at wider angles and the effect is reduced the more you approach the telephoto end.

1 Select MENU > ["® Camera Setup] > [Digital IS] > [On].

¢ \When using lenses not compatible with camera-lens communication, perform step 4 to enter the lens’s focal
length manually.

¢ Image stabilization is activated and (=1 appears on the left of the screen.
e You can also turn image stabilization on/off using an assignable button set to [Digital IS].

2 Select MENU > ["™ Camera Setup] > [Digital IS Mode] > Desired option.

L

o (¥#.n (standard) or (an (nigh) will appear on the screen.

3 Select MENU > ["™ Camera Setup] > [Motion Vector For Digital IS] > Desired option.

4 For lenses for which the focal length cannot be obtained, select MENU > ["™ Camera Setup] >
[Lens Focal Length] and enter the lens’s focal length using the data entry screen ([11 28).
¢ The image stabilization is adjusted according to the focal length entered.

5 When using an anamorphic lens, select MENU > ["™ Camera Setup] > [Anamorphic Corr.] >
Squeeze factor to use to correct the image stabilization.
e |f you selected [Lens Squeeze Factor], the anamorphic correction will be applied according to the squeeze

factor specified with the MENU > [ £¥ Recording/Media Setup] > [Metadata] > [Lens Squeeze] setting.

Options for [Digital IS Mode]

[Standard]: Compensates for camera shake. The viewing angle is slightly reduced.

[High]: Achieves stronger compensation for camera shake. The viewing angle is further reduced.

Options for [Motion Vector For Digital IS]

[Enable]: Image stabilization using camera shake information and motion vectors. This setting allows for
very effective image stabilization.

[Disable]: Image stabilization using only camera shake information.

¢ \When recording a subject (such as a person or an animal) with a large amount movement, enabling this setting
may cause the image to shake along with the subject.

(i) Notes

¢ [Digital IS Mode] will be [Standard] when all of the following conditions are met:

- [Sensor Mode] is set to [Full Frame] and [Main Resolution] is set to [4096x2160] or [3840x2160].

- [Recording Mode] is set to [Slow & Fast Motion] and the recording frame rate is 60P or higher, [Recording
Mode] is set to [S&F Clip / Audio (WAV)] and the recording frame rate is 60F, or [Recording Mode] is set to
another option and the recording frame rate is 59.94P.

- [SDI Output Signal] is set to [4096x2160P/3840x2160P].

e [f the IS function is turned off on a lens, the camera’s image stabilization function is deactivated too and the
&t icon will flash on the left of the screen. When an RF-S lens is attached, select MENU > ["™ Camera
Setup] > [Lens Optical IS] > [On] to turn on the image stabilization function of the lens.

¢ \When an assignable button set to [Pause Digital IS] is pressed during camera image stabilization, image
stabilization will be temporarily paused (%0 or (E%a1 are displayed in gray). Even while the digital IS function is
paused, the narrower angle of view is maintained. Pressing the assignable button again will resume image
stabilization. Lens image stabilization is not affected. Even during recording, the digital IS function pause/
resume can be toggled.

¢ Depending on the subject and shooting conditions, subject blur may be more prominent (the subject may be
momentarily blurred) due to the use of image stabilization.
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¢ Turning off the camera’s image stabilization is recommended in the following cases:
- When using TS-E lenses and fisheye lenses
- When the camera is expected to be stable, for example when it is mounted on a tripod
¢ |f the degree of camera shake is too high, the image stabilizer may not be able to compensate fully.
* The camera's image stabilizer will not work when using lenses with a focal length exceeding 1000 mm.
¢ The camera's image stabilizer will not function in the following cases:
- When recording in RAW format
- When [HDMI RAW] is set to [On].
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Zoom

When a lens that supports zoom adjustment is attached, the zoom can be controlled from this camera ([1] 249).
You can also zoom remotely using Browser Remote on a connected network device ([1] 191).

Additionally, you can select the digital tele-converter from the menu and move the focal length to the telephoto
range (except when recording in RAW format).

Zoom Modes of the Lens
Use the switch on the lens to select the lens’s zoom mode (automatic, manual). The name of the controls may
differ depending on the lens. Refer to the instruction manual of the lens/accessory used.

Set the lens’s zoom mode to automatic.
e Operating the zoom from the camera is enabled.

Adjusting the Zoom

1 Enable automatic zoom mode on the lens.

2 Select MENU > ["™ Camera Setup] > [Camera Grip Zoom] > [On].

3 Select MENU > ["™ Camera Setup] > [Camera Grip Zoom Speed] > Desired zoom speed.
e Zoom speeds are constant; [1] being the slowest and [16] the fastest.

4 Use the joystick on the camera grip to zoom.
e Push the joystick up to zoom in (telephoto) and push it down to zoom out (wide-angle).

(i) NoTES

¢ \When an RC-V100 Remote Controller is connected to the camera and the lens is correctly set, you can zoom
with the remote controller’s ZOOM dial.

¢ \When using slow zoom speeds, it may take longer for the lens to start moving.

Using the digital tele-converter:

The focal length is multiplied by the selected factor when you select MENU > ["™ Camera Setup] >
[Tele-converter] > desired option.
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Onscreen Markers, Zebra Patterns and False Color

Using onscreen markers allows you to make sure your subject is correctly framed and is within the appropriate
safe area. Zebra patterns help you identify areas that are overexposed. The false color overlay allows you to
check if the exposure is correct. You can display the assistance overlays independently on the LCD monitor and
SDI OUT terminal / HDMI OUT terminal. The assistance overlays will not affect your recordings.

Displaying Onscreen Markers

The camera offers several onscreen markers. You can display multiple onscreen markers simultaneously and
select their color individually.

[Center Marker]: Displays a small marker that indicates the center of the screen. You can select the shape of the
center marker.

[Horizontal Marker], [Vertical Marker]: Displays a horizontal or vertical line to help you compose level shots.
[Grid Marker]: Displays a grid that allows you to frame your shots correctly (horizontally and vertically).

[Aspect Marker]: Indicates various aspect ratios by displaying border lines or by masking the image outside the
selected aspect ratio. The aspect ratio can be set freely by the user.

[Safe Area Marker]: Displays a margin from the edges of the image (using border lines or by masking the image)
to indicate the action safe area, text safe area, etc. You can select the core area used as the basis for calculating
the safe area and a percentage, relative to the side length.

[User Marker 1], [User Marker 2], [User Marker 3]: Displays up to three rectangular frames whose size and
position you can set freely and independently of each other.
Safe area 88%

l--l by side Iength

B Horizontal
marker
ﬁ o

Aspect guide 4:3

User marker ~ Center marker Grid marker
(100, 250) ([Cross 1] type)

1 Select MENU > [ Assistance Functions] > Desired [Markers:] setting > [On].
e Onscreen markers will be displayed on the corresponding video output.
® You can also use direct touch control ([ 56) to turn the [Markers: LCD] setting on/off.
e [f the respective setting is set to [Off], onscreen markers will not be displayed on the corresponding video
outputs even if individual markers are configured.
2 Select the marker(s) you wish to display and configure them with the following procedures.
* You can display multiple markers simultaneously.

Center Marker / Horizontal Marker / Vertical Marker / Grid Marker

1 Select MENU > [T Assistance Functions] > [Center Marker], [Horizontal Marker], [Vertical Marker] or [Grid
Marker] > Desired marker color.

e Select [Off] to turn off the marker.
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2 For [Center Marker] only: Select MENU > [ Assistance Functions] > [Center Marker Type] > Desired marker
shape.

Aspect Marker

1 Select MENU > [ Assistance Functions] > [Aspect Marker] > Desired marker color or transparency of the
masked area.
e Select [Off] to turn off the marker.

2 Select MENU > [ Assistance Functions] > [Marker Aspect Ratio] > Desired option.

3 For [Custom] only: Select MENU > [{& Assistance Functions] > [Marker Custom Asp. Ratio] and enter the
aspect ratio using the data entry screen ([1] 28).

(i) NOTES

Aspect markers will not be displayed in the following cases.
- When the resolution is set to 3840x2160 or 1920x1080 and the marker aspect ratio is set to [16:9].
- When the resolution is set to 4096x2160 or 2048x1080 and the marker aspect ratio is set to [1.90:1].
- The same applies when the same aspect ratio is set manually using [Custom].

Safe Area Marker

The safe area is displayed using a border line or by masking the image outside the safe area. It can be calculated

as a percentage of the width/height.

1 Select MENU > [T Assistance Functions] > [Safe Area Marker] > Desired marker color/mask opacity level.
e Select [Off] to turn off the marker.

2 Only when an aspect marker is already activated: Select MENU > [ Assistance Functions] > [Basis for
Marker Safe Area] > [Whole Picture] or [Selected Aspect Marker].

3 Select MENU > [T Assistance Functions] > [Marker Safe Area %] > Desired percentage.
¢ You can select the margin as a percentage of the width/height [(Side Length)].

User Markers

You can set 3 individual user markers ((User Marker 1] to [User Marker 3]) and adjust their color, size and position
separately.

1 Select MENU > [T Assistance Functions] > [User Marker 1], [User Marker 2] or [User Marker 3] > Desired
marker color.

e Select [Off] to turn off the marker.
2 Select MENU > [ Assistance Functions] > [User Marker 1 Settings], [User Marker 2 Settings] or [User
Marker 3 Settings] > [Size] > [Specification Method] > Desired option.
Options:
[Pixel]: Specify the number of pixels (width and height).
[Ref. Area & Aspect Ratiol:
Specify an aspect ratio for the reference area.
[Ref. Area & Magn. Ratio]:
Specify a magnification ratio for the selected reference area.
e Select the input value or setting value according to the selected specification method.

3 Select MENU > [ Assistance Functions] > [User Marker 1 Settings], [User Marker 2 Settings] or [User
Marker 3 Settings] > [Position] > [Specification Method] > Desired option.
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Options:
[Center Coordinates], [Upper-left Coordinates]:
Sets the user marker reference coordinates to the center or the upper-left.
[Centering (User Marker 1)], [Centering (User Marker 2)]:
Aligns the center with that of a user marker. Available options differ depending on the set user 93
marker. -
¢ Select the input value or setting value according to the selected specification method.

When setting a method other than [Reference Area] > [Whole Picture] or a method relative to other markers,
such as [Centering (User Marker 1)] to [Centering (User Marker 2)], you can select the following markers for the
reference:

- When [User Marker 1] is set: No reference marker can be selected

- When [User Marker 2] is set: [User Marker 1]

- When [User Marker 3] is set: Either [User Marker 1] or [User Marker 2] can be selected

(i) Nnotes

® You can choose the onscreen display level to turn off all other onscreen displays, leaving only the markers
(L1 53).

e If you set an assignable button to one of the [Markers:] settings ([11 125), you can press the button to turn the
markers on and off on the corresponding video output.

¢ In MEDIA mode, you can display the same markers as in CAMERA mode by selecting MENU >
[ Assistance Functions] > [Playback Marker Display] > [Enable].

Displaying Zebra Patterns

The camera has a zebra pattern function that shows black and white diagonal stripes over

areas that are overexposed. There are two types of zebra patterns and you can display both \ /
simultaneously. Zebra 1 lets you identify areas within a certain range (5% of a specified level \ /
from 5% to 95%) while zebra 2 lets you identify areas that exceed a specified level (from 0%  Zebra1  Zebra2
1o 100%).

1 Press the ZEBRA button to activate the selected zebra
pattern on all monitoring devices at once.

* You can also use direct touch control (] 56) to turn the
[Zebra: LCD] setting on/off.

e You can turn the zebra pattern overlay on/off from MENU >
[y Assistance Functions] > [Zebra:] > Desired option.

e Alternatively, you can press an assignable button set to one of
the [Zebra:] settings ([11 125), to turn the zebra pattern overlay
on and off on the corresponding video output.

2 Select MENU > [ Assistance Functions] > [Zebra] > Desired option.
3 Select MENU > [ Assistance Functions] > [Zebra 1 Level] or [Zebra 2 Level] > Desired option.

e [Zebra: SDI] cannot be displayed under the following conditions.

- When [Sensor Mode] is set to [Full Frame] or [Super 35mm (Cropped)], the frame rate exceeds 60P, [SDI
Output Signal] is [3840x2160] or higher, and [Peaking: SDI] is set to [On].

- When [OSD Output: SDI] is set to [Off (Clean)].

e [Zebra: HDMI] cannot be displayed under the following conditions.

- When [OSD Output: HDMI] is set to [Off].
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Displaying False Color

In CAMERA mode, you can display the false color overlay to check the brightness levels as different colors.

Select MENU > [& Assistance Functions] > Desired [False Color:] setting > [On].
¢ You can also use direct touch control ([I] 56) to turn the [False Color: LCD] setting on/off.

¢ Alternatively, you can press an assignable button ([I] 125) set to one of the [False Color:] settings to turn the
false color overlay on and off on the corresponding output destination.

(i) NOTES

* You can use the MENU > [ Assistance Functions] > [False Color Index] setting to check an index (in
English only) of the colors used in the false color overlay.

Color Meaning
Red White clipping

Yellow | Just below white clipping
Pink One stop over 18% gray
Green | 18% gray (medium gray)

Blue | Just above black clipping

Purple | Black clipping

* Depending on the custom picture file settings, the color displayed might not be that of the correct brightness
level.
e [False Color: SDI] cannot be displayed under the following conditions.
- When [Sensor Mode] is set to [Full Frame] or [Super 35mm (Cropped)], the slow & fast motion recording
frame rate exceeds 60P and [SDI Output Signal] is [3840x2160] or higher.
- When [OSD Output: SDI] is set to [Off (Clean)].
e [False Color: HDMI] cannot be displayed under the following conditions.
- When [OSD Output: HDMI] is set to [Off].
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Setting the Time Code

The camera generates a time code signal and records it with the recorded clips. The time code signal can be
output from the TIME CODE terminal, SDI OUT terminal or HDMI OUT terminal. During playback in MEDIA mode,
a time code retrieved from the recording media can be output to the SDI OUT terminal.

Depending on the frame rate used, you may be able to select between a drop frame an non-drop frame time
code signal (11 96). The default mode varies depending on the country/region of purchase and, though the time
code display style is different for DF and NDF, in this section the NDF display style is used for simplicity’s sake.

Selecting the Time Code Mode

You can select the camera’s time code mode.

Select MENU > [ System Setup] > [Time Code Mode] > Desired option.
Options

[Preset]: The time code starts from an initial value you can select in advance. The default initial time code
is 00:00:00.00 (00:00:00:00 for NDF).
See the following procedures to select the time code running mode and set the initial time code.

[Regen.]: The camera will read the selected card and the time code will continue from the last time code
recorded on the card. The time code runs only while recording so clips recorded consecutively
on the same card will have continuous time codes.

Setting the Time Code Running Mode
If you set the time code mode to [Preset], you can select the time code running mode.
Select MENU > [¥ System Setup] > [Time Code Run] > Desired option.

Options

[Rec Run]: The time code runs only while recording so clips recorded consecutively on the same card will
have continuous time codes.

[Free Run]: The time code starts running the moment you confirm the selection and keeps running

regardless of the camera’s operation.

Setting the Time Code’s Initial Value

If you set the time code mode to [Preset], you can set the initial value of the time code.

1 Select MENU > [§ System Setup] > [Set Time Code] > [Change].

¢ The time code setting screen appears with an orange selection frame indicating the hours.

e To reset the time code to [00:00:00:00], select [Reset] instead. If the running mode is set to [Free Run], the
time code will be reset the moment you confirm the selection and keep running continuously from
00:00:00:00.

2 Enter the initial time code using the data entry screen (11 28).

e |f the running mode is set to [Free Run], the time code will start running from the selected time code the
moment you confirm the selection.
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Selecting Drop or Non-Drop Frame

When the frame rate is set to 59.94P, 59.94i or 29.97P, you can select between a drop frame (DF) or non-drop
frame (NDF) time code, depending on how you plan to use your recordings.

With all other frame rates, the time code is set to non-drop frame (NDF) and cannot be changed.

Select MENU > [¥ System Setup] > [Time Code DF/NDF] > Desired option.

¢ The time code display will change depending on the setting. When you select [DF], the time code will appear
as [00:00:00.00]; when you select [NDF], it will appear as [00:00:00:00].

About the time code display
A letter may appear next to the time code depending on the setting/status. Refer to the following table.
Letter Description
R The time code mode is set to [Regen.].
P The time code mode is set to [Preset] and the running mode is set to [Rec Run].
F The time code mode is set to [Preset] and the running mode is set to [Free Run].
E The time code signal is coming from an external source.
No letter | Time code during clip playback.

Setting the User Bit

You can set a user bit composed of the date or the time of recording or an identification code consisting of

8 characters in the hexadecimal system. There are sixteen possible characters: the numbers 0 to 9 and the
letters Ato F.

The user bit is recorded with clips and can be output from the TIME CODE terminal/SDI OUT terminal/HDMI
OUT terminal. It can be used freely to categorize and manage recordings or to keep additional information about
them.

1 Select MENU > [§ System Setup] > [User Bit Type] > [Setting], [Date] or [Time].
e |f you select [Time] or [Date] the rest of the procedure is not necessary.

2 Select [Change].
e To reset the user bit to [00 00 00 00], select [Reset] instead.

3 Enter the user bit using the data entry screen ([11 28).

(i) NoTES

e The frames value of the time code runs from O to 23 (frame rate set to 23.98P or 24.00P), from 0 to 24 (frame
rate set to 25.00P, 50.00i or 50.00P), or from 0 to 29 (all other frame rates). However, if the frame rate is
23.98P/24.00P and MENU > [€ System Setup] > [SDI Output Signal] is set to [1920x1080i(PsF)] or
[1280x720P], or if [HDMI Output Signal] is set to [1920x1080i] or [1280x720], the frame count of the time code
output to the SDI OUT/HDMI OUT terminal runs from 0 to 29.

¢ When slow & fast motion recording / frame recording / interval recording is activated, you cannot select the
[Free Run] running mode. Conversely, when pre-recording is activated, [Free Run] is set automatically and
cannot be changed.

¢ When slow & fast motion recording / frame recording / interval recording is activated, the time code signal and
user bit will not be output from any of the terminals.

¢ \When you mix drop frame and non-drop frame time codes, there might be a discontinuity in the time code at
the point where the recording starts.

¢ \When you are using the [Free Run] running mode, the time code will continue running as long as the built-in
backup battery has some charge left, even if you disconnect all other power sources.
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¢ If you set an assignable button to [Time Code] (11 125), you can press the button to open the
[& System Setup] menu page with the time code settings.

97



98

Synchronizing with an External Device

Synchronizing with an External Device

You can use the camera’s TIME CODE terminal to synchronize this camera’s time code to an external signal.
Using the same external time code signal with multiple cameras allows you to set up a multi-camera recording.
You can output the time code signal from this camera to other cameras. You can also output the time code
signal from the SDI OUT terminal to an editing device (while recording or during playback), so the editor can
create video with the same time code.

Connecting an External Device

When synchronizing a time code signal, connect the external device to the TIME CODE terminal on the camera.
Be sure to set the TIME CODE terminal to input or output in advance.

Connection diagram

TIME CODE terminal

Standard TC signal

—>

Time Code Signal Input

An external SMPTE-standard LTC timing signal received from the TIME CODE terminal can be recorded as the
time code. The user bit of the external timing signal can also be recorded with clips. Before connecting the
device, set the TIME CODE terminal to input with the procedure below and make sure the time code running
mode is set to [Free Run] ([ 95).

1 Select MENU > [¥ System Setup] > [TC In/Out] > [In].

2 To record the external signal’s user bit, select also MENU > [¥ System Setup] > [User Bit Recording
Mode] > [External].

(i) Notes

e Synchronize the camera’s time code with an external time code signal that matches the camera’s system
frequency. Use a 24-frame time code signal when the frame rate is set to 23.98P or 24.00P, a 25-frame time
code signal when it is set to 25.00P, 50.00i or 50.00P and a 30-frame time code signal for other frame rates.

¢ \When a suitable external time code signal is received, the camera’s own time code will be synchronized to it
and the synchronization will be maintained even if you disconnect the cable from the TIME CODE terminal.

¢ |f the external time code signal is incorrect or there is no input signal, the internal time code set in the camera
will be recorded instead.
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¢ When an external time code signal is received, the DF/NDF selection will follow the external time code signal’s
settings.

e |f an external time code signal is input while pre-recording is activated, there might be a discontinuity in the
time code of the pre-recorded clip.

e Performing any of the following actions while the cable is not connected will cause the synchronization to be
disrupted; the correct time code will be restored once you reconnect the cable.
- Turning the camera on/off
- Switching to MEDIA mode
- Changing the video configuration

Time Code Signal Output

The time code signal output from the TIME CODE terminal will be a SMPTE-standard LTC timing signal. The user
bit will also be output.

Select MENU > [ System Setup] > [TC In/Out] > [Out].

(i) NoTES

¢ About the user bit output: The user bit set by the user (1] 96) will be output. In MEDIA mode, the user bit is not
output from the TIME CODE terminal.

e The time code and user bit will not be output when slow & fast motion recording / frame recording / interval
recording is activated.

¢ With the MENU > [£% Recording/Media Setup] > [HDMI Time Code] set to [On] you can output the time
code signal from the HDMI OUT terminal (1] 155).
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Recording Audio

The camera features the following options for audio recording and playback. You can record audio using an
external microphone/line-in device (INPUT terminals or MIC terminal), the monaural microphone*, or an

accessory compatible with the multi-function shoe.
The audio signal will be output with the video signal from the SDI OUT terminal / HDMI OUT terminal. You can
record the audio signal on an external recorder.
* Only for recording voice memos while shooting. Recording voice memos is useful when synchronizing video and audio during

editing.

Available audio recording formats

. ) ) Audio format
Video format / audio recording m— T
function Codec ampling Bit depth umber o Bit rate
frequency audio channels
RAW Linear PCM 24 bit 4 channels 4.5 Mbps
Video XF-AVC Linear PCM 18 K 24 bit 4 channels 4.5 Mbps
; z
recording XE-HEVC 311 Linear PCM 24 bit 4 channels 4.5 Mbps
XF-AVC S AAC 16 bit 2 channels? 256 Kbps
Audl For slow & fast motion recording | Linear PCM 48 kHz 24 bit 4 channels 4.5 Mbps
udio
recordin For second card recording : .
Y functions Linear PCM 8 kHz 16 bit 1 channel 128 Kbps
1 Audio for proxy clips is recorded in AAC format.
2 CH1 and CH2 audio is recorded.
Audio Settings and Recorded Audio Channels
Menu settings Recorded audio channels/audio sources
[Audio Input Selection]*
[CH2 Input]* CH1 CH2 CH3 CH4
[CH1/CH2] [CH3/CH4]
[INPUT Terminals] | [INPUT Terminals] [INPUT 2] INPUT 1 terminal INPUT 2 terminal INPUT 1 terminal INPUT 2 terminal
[INPUT Terminals] | [INPUT Terminals] [INPUT 1] INPUT 1 terminal INPUT 1 terminal INPUT 1 terminal INPUT 2 terminal
[INPUT Terminals] | [MIC Terminal] [INPUT 2] INPUT 1 terminal INPUT 2 terminal MIC terminal (L) MIC terminal (R)
[INPUT Terminals] | [MIC Terminal] [INPUT 1] INPUT 1 terminal INPUT 1 terminal MIC terminal (L) MIC terminal (R)
[INPUT Terminals] | [MIC Terminal] [MIC Terminal] || INPUT 1 terminal | MIC terminal (L+R) | MIC terminal (L) MIC terminal (R)
[INPUT Terminals] | [Monaural Mic] [INPUT 2] INPUT 1 terminal INPUT 2 terminal
[INPUT Terminals] | [Monaural Mic] [INPUT 1] INPUT 1 terminal INPUT 1 terminal [Monaural Mic]
[INPUT Terminals] | [Monaural Mic] | [Monaural Mic] | INPUT 1 terminal [Monaural Mic]
(INPUT Terminals] | [MUt-FUnclion o or | INPUT 1 terminal | INPUT 2 terminal
Shoe] ) )
Multi-Functi [Multi-Function Shoe]
(INPUT Terminals] ™M é’hseqc O INPUT1] | INPUT1 terminal | INPUT 1 terminal
[MIC Terminal] | [INPUT Terminals] - MIC terminal (L) MIC terminal (R) INPUT 1 terminal INPUT 2 terminal
[MIC Terminal] [MIC Terminal] - MIC terminal (L) MIC terminal (R) MIC terminal (L) MIC terminal (R)
[MIC Terminal] [Monaural Mic] - MIC terminal (L) MIC terminal (R) [Monaural Mic]
[MIC Terminal] [M”'té'hF;Je'}Ct'O" - MIC terminal () | MIC terminal (R) [Multi-Function Shoe]
[Monaural Mic] | [INPUT Terminals] - INPUT 1 terminal INPUT 2 terminal
[Monaural Mic] [MIC Terminal] - MIC terminal (L) MIC terminal (R)

[Monaural Mic]

[Monaural Mic]

[Monaural Mic]

[Multi-Function
Shoe]

[Monaural Mic]

[Monaural Mic]

[Multi-Function Shoe]




Menu settings Recorded audio channels/audio sources
[Audio Input Selection]* (CH2 Input] o e
nput]*
[CH1/CH2] [CH3/CH4] P
[M”'g'hF;er}Ct“’" [INPUT Terminals] -
[M”'g'hF;er}Ct“’" [MIC Terminal] -
Mulfi-Funct [Multi-Function Shoe]
Mu é-h(;]er}c 00 [Monaural Mi] -
[Multi-Function [Multi-Function _
Shoe] Shoe]

CH3

INPUT 1 terminal

Recording Audio

CH4

INPUT 2 terminal

MIC terminal (L)

MIC terminal (R)

[Monaural Mic]

[Multi-Function Shoe]

* Menu items under the [M) Audio Setup] menu.

(i) NoTES

¢ You can press the AUDIO STATUS button to display only the [d) Audio
Setup] status screens. On these status screens you can check the input
source selected for each audio channel and other audio-related settings.

Audio Format for XF-HEVC S / XF-AVC S Clips

Select the audio recording format for XF-HEVC S / XF-AVC S clips (primary
clips or sub recording clips).

Select MENU > [ £% Recording/Media Setup] > [ (ZE® / Main
Audio] or [(EA / Audio] > Desired option.
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Connecting an External Microphone or External Audio Input Source to the Camera

To each of the INPUT terminals you can attach commercially available microphones or analog line in sources with
a Mini XLR connector. To the MIC terminal you can attach commercially available condenser microphones/line-in
devices (analog) with a & 3.5 mm stereo mini plug.

Using the supplied microphone holder, you can fix external microphones with a diameter of 19 mm to 20 mm.

1 To use a microphone, loosen the microphone lock
screw (1), open the microphone holder and insert
the microphone ().

Microphone
2 Tighten the lock screw (®) and put the microphone lock screw

cable through the cable clamp.

3 When using any INPUT terminal, set the
corresponding INPUT 1/INPUT 2 (audio source
selection) switch to a position other than MIC+48V

(@).

4 Plug the microphone/external line-in device cable
into the desired INPUT terminal or the MIC terminal

®).

INPUT 1/ INPUT 2 switches
(audio source selection)
MIC_MIC

UNE= gy

ineut 1 (QID

Cable clamp

MIC_MIC
UNE— [GMIC M

eur2 (QID>

INPUT 2 terminal MIC terminal

INPUT 1 terminal

@ vroRTANT

¢ Do not connect or disconnect microphones and other audio devices from any INPUT terminal when the
corresponding INPUT (audio source selection) switch is set to the MIC+48V position. This may damage the
camera and/or device.

Selecting the Input Type for the INPUT 1/INPUT 2 Terminals

Change the position of the corresponding INPUT (audio source selection) switch according to the audio device
connected to the INPUT 1/INPUT 2 terminals.
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Set the INPUT 1 or INPUT 2 switch to LINE, MIC, or MIC+48V.
¢ When using the INPUT terminals to record to only one channel, use the INPUT 1 terminal.

@ vPorRTANT 103

¢ \When using a microphone that requires phantom power, turn off the camera and set the respective INPUT
switch to MIC. After connecting a +48V compatible microphone, switch the INPUT switch to MIC+48V.

e To connect a microphone or other audio device that is not compatible with phantom power to an INPUT
terminal, make sure the respective INPUT (audio source selection) switch is set to LINE or MIC. Setting the
switch to MIC+48V may damage the audio device.

Selecting the Input Type for the MIC Terminal
Change the setting according to the audio device connected to the MIC terminal.

1 Select MENU > [P Audio Setup] > [MIC Input]
2 Select [MIC (with Power Supply)] or [LINE]
e Select [MIC (with Power Supply)] to supply plug-in power to the external microphone.

Selecting the Audio Input Source for Audio Channels

You can select the audio input source that will be recorded on CH1/CH2 or CH3/CH4, independently for each
pair of audio channels. For details refer to the Audio Settings and Recorded Audio Channels table (1] 100).

1 Select MENU > [P Audio Setup] > [Audio Input Selection] > [CH1/CH2].

2 Select [INPUT Terminals], [MIC Terminal], [Monaural Mic] or [Multi-Function Shoe].
3 Select the audio input for [CH3/CH4], in the same way.

4 Press CANCEL to return to the previous screen.

Recording the Same Analog Audio Input to Two Channels

By default, each audio input is recorded to a separate audio channel (INPUT 1 to CH1 and INPUT 2 to CH2).
If necessary audio from the INPUT 1 terminal can be recorded on both CH1 and CH2 (CH2 as backup). In that
case, you can adjust the audio recording levels of each channel independently of each other.

Select MENU > [) Audio Setup] > [CH2 Input] > Desired option.

Options

[INPUT 2 Records audio to each channel separately. Audio input into INPUT 1 is recorded to CH1, while
audio input into INPUT 2 is recorded to CH2.

[INPUT 1] Audio input into INPUT 1 is recorded to both channels. Audio input into INPUT 2 will not be
recorded.

[Monaural Mic] / [MIC Terminall:
Audio input into INPUT 1 is recorded to CH1, while audio input to the built-in microphone and
the MIC terminal is recorded to CH2.

Adjusting the Audio Recording Level

You can adjust the audio recording level of the INPUT terminals/ MIC terminal. You can select automatic or
manual audio level adjustment, and adjust each audio channel separately or adjust CH1/CH2 or CH3/CH4
together (when the audio level adjustment of the audio channels is linked, [11 104).
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Automatic Audio Level Adjustment for CH1, CH2 or CH1/CH2

Set the audio level switch of the desired channel to A (automatic) to let CH1/CH2 audio level switches
the camera automatically adjust that channel’s audio level. " W

UNE— [FMIC M,

weut1 CQID)

=) | EE

)
% MIC_M

o — UNE = [IE MG
9

eur2 CQID)

G| ¥
e )6

Manual Audio Level Adjustment for CH1, CH2 or CH1/CH2
You can set the audio level manually from —oco to +18 dB.

. ) \ CH1/CH2 audio level switches
1 Set the audio level switch of the desired channel to M (manual).

2 Turn the corresponding audio level dial to adjust the audio level.
e For reference, the O corresponds to —oo, 5 corresponds to
0 dB, and 10 corresponds to +18 dB.
¢ As a guideline, adjust the audio recording level so that the audio
level meter on the screen will go to the right of the —18 dB mark
(one mark right of the —20 dB mark) only occasionally.

UNE— [FC "ﬁ%\/

INPUT 1

LNE— I—M\[ V\+/H(

ineu2 (QID)

CH1/CH2 audio level dials

Using the Menu to Adjust the Audio Level for Each Channel

1 Select MENU > [) Audio Setup] > [Audio Rec Level] > Desired option.
e Use /P to choose the desired option.
- Select [A] (automatic) to adjust the audio level automatically.
- Select [M] (manual) to manually adjust the audio level using /P .

Automatic Level Control (ALC): Linking the audio level adjustment of CH1/CH2 or CH3/CH4

* \When both CH1 and CH2, or CH3 and CH4, are set to the MIC terminal or INPUT terminals and to the
same type of analog audio source (external line input or external microphone), you can use the MENU >
[d) Audio Setup] > [CH1/CH2 ALC Link] or [CH3/CH4 ALC Link] setting to link the audio level adjustment
of both channels.

e \When CH1 and CH2 are linked, you can use the CH1 audio level switch and dial to affect both CH1 and
CH2. When CH3 and CH4 are linked, you can use the [Audio Rec Level] settings to affect both CH3 and
CHa4.

Audio peak limiter
¢ You can set MENU > [ M) Audio Setup] > [INPUT Limiter] to [On] to activate the audio limiter to limit the
amplitude of audio input signals when they start to distort.

(i) NOTES

¢ \We recommend using headphones when adjusting the audio level. If the input level is too high, audio may
become distorted even if the audio level indicator shows an appropriate level.
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¢ If you set an assignable button to [Audio Level Indicator] (11 125), you can press the button to turn the
onscreen audio level indicator on and off.

¢ \When the optional the Canon DM-E1D Multi-Function Shoe Directional Stereo Microphone is attached,
adjustment with the audio level switch is also possible. In this case, CH1 settings are also applied to CH2.

Advanced Audio Input Settings

You can adjust the audio input settings for the INPUT terminals/MIC terminal. The corresponding menu settings
become available only when the respective audio input is active and the following conditions are met:

INPUT terminals: INPUT 1 or INPUT 2 switch is set to MIC or MIC+48V

MIC terminal: [MIC Input] is set to [MIC (with Power Supply)]

Microphone Sensitivity (INPUT Terminals)
You can select the external microphone’s sensitivity.

Select MENU > [ ) Audio Setup] > [INPUT 1 Mic Trimming] or [INPUT 2 Mic Trimming] > Desired
sensitivity level.

e You can select one of 5 sensitivity levels from —12 dB to +12 dB.

Microphone Attenuator (INPUT Terminals/MIC Terminal)

You can activate the external microphone’s attenuator (20 dB).

INPUT Terminals: Select MENU > [) Audio Setup] > [INPUT 1 Mic Att.] or [INPUT 2 Mic Att.] > [On].
MIC Terminal: Select MENU > [) Audio Setup] > [MIC Att.] > [On].

Low-Cut Filter (INPUT Terminals/MIC Terminal)

You can select the characteristics of the microphone according to the sound to be recorded.

INPUT Terminals: Select MENU > [M) Audio Setup] > [INPUT 1 Mic Low Cut] or [INPUT 2 Mic Low
Cut] > Desired option.

MIC Terminal: Select MENU > [) Audio Setup] > [MIC Low Cut] > Desired option.

Options

[Off]: For recording audio under usual conditions.

[LCA]: For recording mainly people’s voices.

[LC2]: For reducing the background sound of wind when recording outdoors in windy surroundings (for

example, on a beach or close to buildings). Note that when you use this setting some
low-frequency sounds may be suppressed along with the sound of wind.

Changing the Reference Level of the External Microphone (INPUT Terminals)
You can select the reference level of each INPUT terminal (-18 dB or —20 dB).
Select MENU > [ ) Audio Setup] > [INPUT Reference Level] > Desired option.
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Multi-Function Shoe Audio Input Settings

You can adjust the audio settings for the DM-E1D Directional Stereo Microphone attached to the multi-function
shoe. The corresponding adjustment function become available only when the audio input is active. Refer to the
DM-E1D instruction manual for more information and details on connections.

Microphone Attenuator (DM-E1D Directional Stereo Microphone)

You can activate the microphone attenuator for a shoe microphone attached to the multi-function shoe (20 dB).

Select MENU > [ M) Audio Setup] > [Multi-Function Shoe Input] > [Shoe Mic] > [Shoe Mic Attenuator]
> [On].

Low Cut (DM-E1D Directional Stereo Microphone)
You can choose the characteristics of the shoe microphone according to the recorded audio.

Select MENU > [M) Audio Setup] > [Multi-Function Shoe Input] > [Shoe Mic] > [Shoe Mic Low Cut] >
Desired option.

Options
[Off]: For recording audio under usual conditions.
[On]: For reducing the background sound of wind when recording outdoors in windy surroundings (for

example, on a beach or close to buildings). Note that when you use this setting some low-
frequency sounds may be suppressed along with the sound of wind.

Microphone Directionality (DM-E1D Directional Stereo Microphone)

Select MENU > [ ) Audio Setup] > [Multi-Function Shoe Input] > [Shoe Mic] > [Shoe Mic
Directionality] > Desired option.

Options
[Shotgun (Monoaural)):
Captures clear audio from the front of the microphone.
[90°(Stereo)]:  Captures suitable audio from both the front and the sides of the microphone.
[120°(Stereo)]: Captures audio from a wider angle.

Monitoring the Audio with Headphones

Connect headphones with a @ 3.5 mm stereo mini-plug to the ) (headphone)
terminal to monitor the recorded audio.

(i) NoTES

¢ You can adjust the headphone volume with the MENU > [) Audio Setup] >
[Headphone Volume] setting. If you set an assignable button to [Headphones
+] or [Headphones -] ([1] 125), you can press the button to adjust the
headphone volume without using the menu.

ﬂ (headphone)
terminal
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Colors Bars/Audio Reference Signal

You can have the camera generate color bars and a 1 kHz audio reference signal and output them from the
following terminals.

LCD monitor SDI OUT terminal HDMI OUT terminal () (headphone) terminal
Color bars @ @ o -
Audio reference signal - @ o o

Color Bars
The camera offers SMPTE, EBU and ARIB color bars.

1 Select MENU > ["™ Camera Setup] > [Color Bars] > [On].
® The selected color bars appear on the screen.

2 Select MENU > ["™ Camera Setup] > [Color Bar Type] > Desired option.
e The selected color bars will be recorded when you press the REC button.
e Turning off the camera or changing the operating mode to MEDIA mode will deactivate the color bars.

(i) NoTES

¢ If you set an assignable button to [Color Bars] (1] 125), you can press the button to turn the color bars on/off.
Color bars cannot be displayed in the following cases:
- When the gamma curve component of the [Gamma/Color Space] setting in the custom picture is set to an
option other than [BT.709 Wide DR], [BT.709 Standard] or [Canon 709].
- When recording in RAW format.
- When [HDMI RAW] is set to [On].

Audio Reference Signal

The camera can record a 1 kHz audio reference signal with the color bars.

Select MENU > [) Audio Setup] > [1 kHz Tone] > Desired option.
® You can select one of three audio levels (-12 dB, -18 dB, —20 dB), or [Off] to turn off the signal.

¢ The reference signal will be output at the selected level when you display the color bars, and will be recorded
when you press the REC button.
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Video Scopes

The camera can display a simplified waveform monitor or a vectorscope to check your recordings. The selected
video scope is displayed on the LCD monitor and can be output to other monitoring devices as well.

Displaying a Video Scope
Choose between a waveform monitor or a vectorscope. You can
also change opacity, position and waveform monitor size settings.

1 Select MENU > [& Assistance Functions] >
[WFM Function] > [Waveform Monitor] or [Vectorscope].

2 Press the WFM button.

e Alternatively, you can use one of the MENU > [ Assistance
Functions] > [WFM:] settings to turn the video scope on/off
separately on the desired video output.

¢ By default, the video scope will appear on the right of the
screen. Using the MENU > [f& Assistance Functions] > [Waveform Settings] or [Vectorscope Settings] >
[Position] settings, you can select where to display it (left or right side).

* You can also use direct touch control ([T1 56) to turn on/off the display of video scopes, or to change their
position.

3 If needed, select MENU > [ Assistance Functions] > [WFM Opacity Level] > Desired option.
¢ The smaller the percentage the more transparent the onscreen displays.

(i) NoTES

¢ The waveform monitor will not be affected even if a view assistance function is applied to the image, the range
is changed or anamorphic desqueeze is used on the selected video output or screen.

¢ The video scopes will also be displayed while adjusting a custom picture file's image settings (11 130).

Changing the Waveform Monitor Settings

1 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Type] > Desired option.
e |f you selected an option other than [Select Line], skip to step 4.

2 Select MENU > [& Assistance Functions] > [Waveform Settings] > [Select Line].

3 Enter the Y coordinate of the red horizontal line to display using the data entry screen ([ 28).
¢ The available range of lines that can be selected depends on the vertical component of the resolution used.

For 2160 and over: 0 to maximum value, minus 2 lines (in 2-line increments)
Example: O to 2158 (for 2160)

Below 2160: 0 to maximum value, minus 1 line (in 1-line increments)
Example: 0 to 1079 (for 1080)
4 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Vertical Scale for HDR] >
Desired option.
e Select the Y axis (luminance) scale used when displaying the waveform monitor of an HDR image.
5 If needed, touch the waveform monitor on the screen to change its display size (only for LCD).

* You can also select MENU > [ Assistance Functions] > [Waveform Settings] > [Size: LCD] > Desired
option.
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Options for [Type]

[Line]: Sets the waveform monitor to line display mode.

[Line+Spot]:  The waveform of the area in the red frame is displayed in red on top of the [Line] mode
waveform.

[Select Line]:  The selected horizontal line (in red) will be displayed along with its waveform.

[RGB]: Shows 3 side-by-side waveforms in an RGB parade.

[YPobPY]: Shows 3 side-by-side waveforms in a YPbPr parade.

Options for [Vertical Scale for HDR]

[IRE]: Displays the video scope in IRE units.

[PQ/HLGI: For HDR-PQ images, displays the video scope in nits (cd/m?) and the narrow range’s (video
range) waveform monitor (including when the gamma curve after applying the Look File is set to
[PQY)).

For HDR-HLG images, the Y axis shows a relative-index value between 0 and 1000 nits
(including when the gamma curve after applying the Look File is set to [HLG]).

(i) NnoTes

¢ If the waveform monitor is activated and the MENU > [[@d Custom Picture] > [Edit File] > [Knee] > [Point]
setting is changed, when you display the waveform monitor, a horizontal line will appear indicating the
luminance (Y) level* corresponding to the knee point.
*When a Look File registered to the custom picture file is active, the displayed luminance may not be at the correct level.

¢ \When the waveform monitor’s Y axis is set to display in IRE units, a level of 10 bit 64 maps to 0 IRE and 10 bit
940 maps to 100 IRE, regardless of the custom picture settings.

Changing the Vectorscope Settings
1 Select MENU > [ Assistance Functions] > [Vectorscope Settings] > [Type] > Desired option.

2 Touch the onscreen vectorscope to switch its magnification rate between [1x] and [2x].
¢ You can also select MENU > [ Assistance Functions] > [Vectorscope Settings] > [Gain] > Desired option.

Options for [Type]
[Normal]: Displays the usual vectorscope.
[Spot]: The color signal of the area in the red frame is displayed in red on top of the [Normal] mode

waveform.
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Adding Marks to Clips in CAMERA Mode

Adding Marks to Clips in CAMERA Mode

When the recording format is set to XF-AVC, while recording, you can add shot marks (H) to flag an important
shot or frame. After recording a clip, you can add an OK mark (i) or check mark ([) to help you identify
particular clips.

You can add and delete marks also in MEDIA mode ([11 149, 149).

Marks cannot be added to proxy clips.

Adding a Shot Mark while Recording

To add a shot mark to a clip while recording, you must set an assignable button to [Add Shot Mark] in advance.

1 Set an assignable button to [Add Shot Mark] ([1] 125).

2 While you are recording, press the assignable button at the beginning of the shot you wish to mark.
e [Shot Mark] will appear briefly and the shot mark will be added to the current frame of the clip.

(i) NoTES

¢ Up to 100 shot marks can be added to a single clip.

e There may be up to a 0.5 second delay from when you press the button to when the camera adds the shot
mark.

* When a clip contains a shot mark, B will appear next to the clip’s thumbnail in the playback index screen.

e You cannot add a shot mark before pressing the REC button (start/stop recording) when pre-recording is
activated, or during interval recording/frame recording.

Adding an [l Mark or [ Mark to the Last Clip Recorded

[ marks can be used to protect important clips, as clips with an [l mark cannot be deleted with the camera.
To add a mark in CAMERA mode, you must set an assignable button to [Add [l Mark] or [Add M Mark] in
advance.

1 Set an assignable button to [Add [ Mark] or [Add [ Mark] (11 125).

2 After recording a clip, press the assignable button.
o [MMark] or [MMark] will appear briefly and the selected clip mark will be added to the clip.

(i) NOTES

¢ A clip cannot have both an [l mark and a M mark at the same time.

¢ When a clip has an [l mark or [ mark, the respective icon will appear next to the clip's thumbnail in the
playback index screen.
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Using Metadata

In CAMERA mode, when the recording format is set to XF-AVC / XF-AVC S / XF-HEVC S, the camera
automatically adds metadata to the recorded clips. You can use Canon XF Utility to check and search for specific
metadata. You can also create and transfer a user memo remotely using Browser Remote on a connected
network device (11 187).

Metadata components

Entering content Checking content
Metadata CanonF content Canonx  Content
Camera utility Transfer Camera utilty Transfer
Professional Professional

User Memao: clip title, creator, location and description. - o' - o o -
GPS information: altitude, latitude and longitude. o’ e’ - o o -
Information about the recording: scene and take. @ - - o’ o -
Information about camera settings: shutter speed, ISO 5
speed/gain value, etc. - - - e * -
Unique Material Identifiers (UMID): country, organization @ _ _ Py _ _
and user codes based on the SMPTE standard. (202
News Metadata ([7] 112) - - o o - o

T User memo files need to be created using the software and saved on an SD card in advance.
Only when a GP-E2 GPS Receiver is connected to the camera. While recording, GPS information is recorded automatically by
the camera.

3 GPS information can only be added to clips already recorded.

4 Only in CAMERA mode.

5 Recording data is logged automatically by the camera.

Setting a User Memo Created with Canon XF Utility

Before you can add a user memo, you must first install Canon XF Utility ((J] 161). Next, create the user memo
and then save it to an SD card. Once you insert the SD card in the camera and select the user memo, it will be
added to clips you record.

1 Use Canon XF Utility to save a user memo to an SD card.
e User memo files are saved to the “/XMLCMF” folder in the SD card. For details, refer to Managing User
Memo Profiles in the Canon XF Utility Instruction Manual.
2 Insert the SD card into the camera’s SD card slot B.
3 Select MENU > [£% Recording/Media Setup] > [Metadata] > [Add XML File] > [On].
4 Select MENU > [£% Recording/Media Setup] > [Metadata] > [XML File Format] > [User Memo].

5 Select MENU > [£% Recording/Media Setup] > [Metadata] > [User Memo] > Desired user memo file.

¢ The @D icon appears on the left of the screen. (only when [(Z) Monitoring Setup] > [Custom Display 2] >
[User Memo] is set to [On].)

e Select [Off] to record clips without a user memo.

(i) Nnotes

e After you set a user memo, do not remove SD card B while you are recording. If the SD card is removed, the
user memo will not be added to the clip.

¢ You must set the user memo before you start recording for it to be added to the clips. You cannot change the user
memo already added to a clip using the camera but you can do so with Canon XF Utility.
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Using News Metadata

When recording, you can add News Metadata* to the recorded clips. Using Content Transfer Professional, you
can check and edit News Metadata files. The most recently set News Metadata will be prioritized and added.
News Metadata cannot be added to clips when the main recording format is RAW. See the following table for
details on News Metadata settings.

* Refers to a metadata file compliant with the DPP0O02 Metadata Exchange for News recommendation ver. 1.1.1.

Entering content Checking content
News Metadata Content Content
Camera Transfer Camera Transfer
Professional Professional
Story Title, Description, Keyword (Tags), Category, Contributor, Source/
L . . - o [ J o
Originator, Copyright Holder, Restrictions.
Genre - o - o
Language - — - o

(i) NoTEs

¢ News Metadata files with file names that exceed 64 characters (extension included) cannot be used.

Setting News Metadata saved on an SD card

Before setting News Metadata, create a News Metadata file and save it to an SD card. Once you insert the SD
card into the camera, select the News Metadata file and start recording. The News Metadata will be added to
the recorded clips.

1 Save the News Metadata file to an SD card.
¢ News Metadata files should be saved in the “/XMLTAG” folder of the SD card.

2 Insert the SD card into the camera’s card slot B.
3 Select MENU > [£% Recording/Media Setup] > [Metadata] > [Add XML File] > [On].
4 Select MENU > [£% Recording/Media Setup] > [Metadata] > [XML File Format] > [News Metadata).

5 Select MENU > [ £% Recording/Media Setup] > [Metadata] > [News Metadata)] > Desired News
Metadata file saved to the SD card.

¢ The selected News Metadata file will be saved to the camera.

(i) NOTES

¢ You cannot change the News Metadata already added to a clip using the camera but you can do so using
Content Transfer Professional.

Setting News Metadata edited with Content Transfer Professional

Before setting News Metadata, edit the News Metadata file using Content Transfer Professional. Connect the
camera to a smartphone using the smartphone application ([J] 162, 195) to transfer and save News Metadata
files from a smartphone to the camera. News Metadata will be added to the recorded clips.

1 Smartphone: edit and save the News Metadata file with Content Transfer Professional.
2 Connect the camera to a smartphone.
3 Operate Content Transfer Professional to load the News Metadata file and transfer it to the camera.
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4 Save the News Metadata to the camera.
¢ News Metadata files transferred from a smartphone will be saved automatically to the camera.

o Automatically, MENU > [ £% Recording/Media Setup] > [Metadata] > [Add XML File] will be set to [On], and
[XML File Format] will be set to [News Metadata].

e Only the most recently transferred file can be saved.

Resetting News Metadata
You can reset the News Metadata added to clips.

1 Select MENU > [£% Recording/Media Setup] > [Metadata] > [News Metadata Reset All].
2 Select [OK].

@ vPoRTANT

¢ \When the camera is turned off normally, the News Metadata file is saved or a previously saved News Metadata
is reset. In the case of a power outage or if the power is not terminated normally the file will not be saved or
reset.

¢ News Metadata saved to the camera will be reset if you select MENU > [ System Setup] > [Reset] > [All
Settings], or if the camera’s firmware is updated.

Entering Slate Information About the Recording
You can enter scene and take information to help identify the recording later on.
1 Select MENU > [£% Recording/Media Setup] > [Metadata] > [Scene] or [Take] > [Change].

2 Enter the desired text using the keyboard screen ([ ] 28).
¢ To clear the scene/take information, select [Reset] instead.
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Special Recording Modes

The camera features the following special recording modes.

114 - Slow & fast motion recording (11 114).
- Pre-recording (11 117).

Continuous recording (11 118).

Frame recording (11 119).

- Interval recording ([11 119).

Slow & Fast Motion Recording

The camera can record using a frame rate* (shooting frame rate) that is different from the playback frame rate.
Recording a clip with a shooting frame rate higher than the [Frame Rate] setting will result in a slow motion effect
during playback. Conversely, a lower shooting frame rate will result in a fast motion effect.

Sound is not recorded with the clip, but it can be recorded separately as a WAV file.

You can also use direct touch control to perform this function (1] 56).

* Progressive format.

Available shooting frame rates

Frame rate Available shooting frame rate (fps) during slow & fast motion recording
59.94P 1,2, 3,6, 15, 30, 44, 48, 52, 56, 60, 90, 120, 150, 180
29.97P 1,2,3,6, 15,22, 24, 26, 28, 30, 32, 36, 40, 44, 48, 52, 56, 60, 90, 120, 150, 180
;gggﬁ 1,2,3,6,12,16, 18, 20, 22, 24, 26, 28, 30, 32, 36, 40, 44, 48, 52, 56, 60, 72, 96, 120, 144, 168, 180
50.00P 1,5, 15, 25, 34, 38, 42, 46, 50, 54, 58, 60, 75, 100, 120, 125, 150, 175, 180
25.00P 1,5,15,17,19, 21, 23, 25, 26, 28, 30, 34, 38, 42, 46, 50, 54, 58, 60, 75, 100, 120, 125, 150, 175, 180

Available shooting frame rates (RAW)

Main recording . . Frame rate
Main resolution
format 59.94P 29.97P 23.98P 50.00P 25.00P 24.00P
RAW LT 6000x3164 - 11030 11024 - 11025 11024
RAW ST - 11030 11030 - 11030 11030
——— 4368x2304
RAW LT 1t0 60 11030 11030 11050 11030 11030




Available shooting frame rates (XF-AVC)
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Shooting frame rate during slow & fast

Main recording format Main resolution Frame rate Bit rate motion recording
59.94P 600 Mbps 11060
50.00P 500 Mbps 11060
29.97P 600 Mbps, 450 Mbps 11030
4096x2160 Intra-frame 29.97p 300 Mbps 11060
3840x2160 Intra-frame 25.00P 500 Mbps, 375 Mbps 11030
25.00P 250 Mbps 11060
24.00P, 23.98P 480 Mbps, 360 Mbps 11030
24.00P, 23.98P 240 Mbps 11060
59.94P, 50.00P 250 Mbps 110120
29.97P 150 Mbps 110120
EACYCCHEION o0 Longop | e 1S0MwS
25.00P 135 Mbps 120
24.00P, 23.98P 130 Mbps 120
59.94P 300 Mbps 110120
50.00P 250 Mbps 110120
25.00P 125 Mbps 110120
24.00P, 23.98P 120 Mbps 110120
BIONUNONR | s soue o 10
24.00P, 23.98P
" Up to 120 when the sensor mode is [Super 35mm (Cropped)].
Available shooting frame rates (XF-HEVC S)
Main recording ) ) Frame rate
format Main resolution 59.94P 29.97P 23.98P / 24.00P 50.00P 25.00P
XF-HEVC S ggzgﬁlgg tg:g gg§ 110120 110120 1t0120" 110120 110120
YCC422 10 bit
Yé&ﬂﬁf’oin fg:gﬂggg tg:g ggi 1101802 110 1802 110 1802 1101802 110 1802

1 For XF-HEVC S YCC422 10 bit recording at 135 Mbps, the bit rate is 130 Mbps only for 120P.

2 Up to 120 when the sensor mode is [Super 35mm (Cropped)).
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Available shooting frame rates (XF-AVC S)

Main recording

Shooting frame rate during slow & fast

format Main resolution Frame rate Bit rate motion recording
59.94P 600 Mbps 110 60
50.00P 500 Mbps 110 60
29.97P 600 Mbps, 450 Mbps 11030
4096x2160 Intra-frame 29.97P 300 Mbps 11060
3840x2160 Intra-frame 25.00P 500 Mbps, 375 Mbps 110 30
25.00P 250 Mbps 110 60
24.00P, 23.98P 480 Mbps, 360 Mbps 11030
24.00P, 23.98P 240 Mbps 110 60
59.94P, 50.00P 250 Mbps 110120
XF-AVC S YCC422 29.97P 150 Mbps 110120
10bit ggigig}gg tggg ggE 25.00F, 24.00P, 23.98P 150 Mbps 110100
25.00P 135 Mbps 120
24.00P, 23.98P 130 Mbps 120
59.94P 300 Mbps 110120
50.00P 250 Mbps 110120
25.00P 125 Mbps 110120
24.00P, 23.98P 120 Mbps 110120
T TARIIAT sown
4096x2160 Long GOP _ 110120
XF-AVC SYCC420 8 | 3840x2160 Long GOP | 59 94p, 50.00P, 29.97P,
bit 20481080 Long GOP | 25.00P, 24.00P, 23.98P ~ 110 180"
1920x1080 Long GOP

! Up to 120 when the sensor mode is [Super 35mm (Cropped)].

Available shooting frame rates (Proxy clip recording: XF-AVC / XF-HEVC S / XF-AVC S)

Proxy clip resolution

2048x1080

59.94P
] 110 60

29.97P
‘ 11030

Frame rate
23.98P / 24.00P
11030

50.00P
11050 \

25.00P
11030

1 To record audio, insert an SD card into the card slot where video is not being recorded.
2 Select MENU > [£% Recording/Media Setup] > [Recording Mode] > [Slow & Fast Motion] or [S&F
Clip/Audio (WAV)].
e Slow & fast motion recording is activated. [S&F STBY] appears on the screen and the shooting frame rate
appears next to the frame rate setting (the playback frame rate).

3 Select MENU > [£8 Recording/Media Setup] > [Slow & Fast Frame Rate] > Desired frame rate.

4 Press the REC button to begin recording.
e The tally lamp changes from green (power indicator) to red.

¢ [S&F STBY] changes to [S&F @ REC] while recording.
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5 Press the REC button again to stop recording.
e The clip is recorded on the selected SD card.
¢ When [S&F Clip/Audio (WAV)] is selected, audio in WAV format will be recorded on the SD card where video
is not being recorded.
e The tally lamp changes from red to green (power indicator) and the onscreen display changes back to [S&F
STBY].
6 Select MENU > [£% Recording/Media Setup] > [Recording Mode] > [Normal Recording] to turn off
slow & fast motion recording.

(i) Nnotes

e When [Sensor Mode] is set to [Super 35mm (Cropped)] and the frame rate is 120P, the viewing angle is slightly

narrow regardless of the [Main Rec Format] and [Main Resolution] settings.

When the slow & fast motion recording frame rate exceeds 60P, the following functions cannot be used.

- Second card recording functions (proxy clips and sub recording clips).

- GV protocol.

When [S&F Clip / Audio (WAV)] is selected, slow & fast motion recording frame rates exceeding 60P cannot be

set.

¢ The maximum recording time of a single clip is the equivalent of approximately 6 hours of playback time.

¢ The shooting frame rate cannot be changed while recording.

e |f you change the system frequency, slow & fast motion recording will be canceled and the shooting frame rate

will be reset to its default value.

About the time code when slow & fast motion recording is activated:

- The time code mode can be set to [Regen.], or to [Preset] with [Rec Run] running mode.

- If the time code running mode was set to [Free Run], the time code running mode will be changed
automatically to [Rec Run] when slow & fast motion recording is activated.

- When the special recording mode is turned off, the time code running mode will return to its previous setting.

- The time code signal will not be output from any terminal.

Recording Audio (WAV)

- Audio is recorded with the following settings: 48 kHz, 24 bit, 4 channels.

- If video cannot be recorded due to a card problem, audio will also not be recorded.

- However, video will be recorded even if audio cannot be recorded due to a card problem.

- Audio will not be recorded if there is an existing WAV file with the same file name.

- Audio recording will stop automatically after reaching 60 minutes (video recording will continue).

- A maximum of 999 WAV files can be recorded.

Pre-recording

When pre-recording is activated, the camera starts recording continuously onto a temporary memory (approx.
3 seconds) so when you press the REC button, the clip will contain also a few seconds of video and audio
recorded before you pressed the button. Pre-recording is not available when the main recording format is set to
RAW.

You can also use direct touch control to perform this function (1] 56).

1 Select MENU > [£% Recording/Media Setup] > [Recording Mode] > [Pre-Recording].
e [PRE STBY] appears on the screen.

2 Press the REC button to begin recording.
e The tally lamp changes from green (power indicator) to red.
¢ [PRE STBY] changes to [PRE @ REC] while recording.
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3 Press the REC button again to stop recording.

e The clip is recorded. The recorded clip will include a few seconds of video and audio recorded before the
REC button was pressed.

e The tally lamp changes from red to green (power indicator) and the onscreen display changes back to [PRE
STBY].

4 Select MENU > [£% Recording/Media Setup] > [Recording Mode] > [Normal Recording] to stop pre-
recording.

(i) Notes

e Pre-recording will be canceled if the recording mode is changed.
e About the time code when pre-recording is activated:
- The time code of the clip will start a few seconds before the REC button was pressed.
- The time code will be recorded with the running mode set to [Free Run].
- If the time code mode was set to [Regen.], or to [Preset] with [Rec Run] running mode, the time code
running mode will be changed automatically to [Free Run] when pre-recording is activated.
- When the special recording mode is turned off, the time code running mode will return to its previous
setting.

Continuous Recording

Audio and video are recorded on both cards in this mode, normal recording on SD card A, and continuous
recording on SD card B. This function can be used when the main recording format is set to XF-HEVC S /
XF-AVC S. Audio will be recorded in linear PCM format.

With the exception of step 5, you can also use direct touch control to perform this function (11 56).

1 Insert an SD card into each card slot (slot A for normal recording, slot B for continuous recording).

2 Select MENU > [£% Recording/Media Setup] > [Recording Mode] > [ Main / @ Continuous Rec].
¢ The continuous recording mode is activated and [CONT] appears on the screen next to the SD card B
indicator.
3 Select MENU > [£% Recording/Media Setup] > [Continuous Recording] > [REC].
e The tally lamp changes from green (power indicator) to red and continuous recording starts on SD card B.
The onscreen display changes to [@ CONT].
4 Press the REC button to start recording.
e Normal recording on SD card A starts.
e |f you press the button before step 3, recording will start on both cards.

5 Select MENU > [£% Recording/Media Setup] > [Continuous Recording] > [STBY].
¢ The tally lamp changes from red to green (power indicator) and recording stops on both cards. The
onscreen display changes to [CONT].

6 Select MENU > [£% Recording/Media Setup] > [Recording Mode] > [Normal Recording] to turn off
continuous recording.

(i) NoTES

¢ \When continuous recording is activated, if recording on SD card B (continuous recording) is not available,
normal recording on SD card A will not be possible either.

e Continuous recording will continue even if SD card A becomes full.

e |f [Continuous Recording] is set to [STBY] and the main recording format is changed to an option other than
XF-HEVC S / XF-AVC S, continuous recording will be canceled.
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Frame Recording Mode

Set the number of frames in advance. We recommend operating the camera remotely or stabilizing the camera,
for example, on a tripod. Sound is not recorded in this mode.
You can also use direct touch control to perform this function (1] 56).

1 Select > [£% Recording/Media Setup] > [Recording Mode] > [Frame Recording].
e [FRM STBY] appears on the screen (with [FRM] flashing).

2 Select > [ £¥ Recording/Media Setup] > [Frame Rec: Frame Rate] (1] 202) > Desired option.

3 Press the REC button to begin recording.
e The tally lamp changes from green (power indicator) to red.
¢ [FRM STBY] changes to [FRM @ REC] while recording.
e The camera automatically records the specified number of frames.

4 Repeat until you finish recording.

5 Select > [ £¥ Recording/Media Setup] > [Recording Mode] > [Normal Recording] to stop frame
recording.
e Frame recording mode ends and all of the recorded frames are joined together into one clip.
e The tally lamp changes from red to green (power indicator) and [STBY] appears on the screen.

(i) NoTES

¢ Frame recording cannot be used when the frame rate is set to 59.94i or 50.00i. When in use, frame recording
will end if the frame rate is set to 59.94i or 50.00i.

® The number of frames recorded cannot be changed while recording.

¢ The same image as the last frame when frame recording was stopped may be recorded and added to the end

of the clip.

About the time code when frame recording is activated:

- The time code mode can be set to [Regen.], or to [Preset] with [Rec Run] running mode. The time code
advances by the number of frames recorded every time.

- If the time code running mode was set to [Free Run] or the camera was synchronized to an external time
code signal, the time code running mode will be changed automatically to [Rec Run] when frame recording
is activated.

- When the special recording mode is deactivated, the time code will return to its previous setting.

- The time code will not be output from any terminal.

Interval Recording Mode

Set the interval and number of frames in advance. Sound is not recorded in this mode.
You can also use direct touch control to perform this function ([1] 56).

1 Select > [£% Recording/Media Setup] > [Recording Mode] > [Interval Recording].
e [INT STBY] appears at the top of the screen (with [INT] flashing).

2 Select > [ £¥ Recording/Media Setup] > [Interval Rec: Time Interval] (1] 202) > Desired option.
3 Select > [£¥ Recording/Media Setup] > [Interval Rec: Frame Rate] ([J] 202) > Desired option.
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4 Press the REC button to begin recording.
e The tally lamp changes from green (power indicator) to red.
¢ [INT STBY] changes to [INT @ REC] while recording.
¢ The camera automatically records the set number of frames at the specified interval.

5 Press the REC button again to stop recording.
e The tally lamp changes from red to green (power indicator) and [INT STBY] appears at the top of the screen
(with [INT] flashing).
6 Select > [ £% Recording/Media Setup] > [Recording Mode] > [Normal Recording] to stop interval
recording.

(i) notes

* Interval recording cannot be used when the frame rate is set to 59.94i or 50.00i. When in use, interval
recording will end if the frame rate is set to 59.94i or 50.00i.

* The interval and the number of frames recorded cannot be changed while recording.

* The same image as the last frame when interval recording was stopped may be recorded and added to the
end of the clip.

e About the time code when interval recording is activated:

- The time code mode can be set to [Regen.], or to [Preset] with [Rec Run] running mode. The time code
advances by the number of frames recorded every time.

- If the time code running mode was set to [Free Run] or the camera was synchronized to an external time
code signal, the time code running mode will be changed automatically to [Rec Run] when interval recording
is activated.

- When the special recording mode is deactivated, the time code will return to its previous setting.

- The time code will not be output from any terminal.
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Using Anamorphic Lenses

You can attach an anamorphic lens to the camera and set the anamorphic desqueeze ratio used to display the
image from the camera on monitoring devices while shooting or during playback.
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1 Select MENU > [[Z) Monitoring Setup] > Desired [Anamorphic:] setting > [On].
2 Select MENU > [[Z) Monitoring Setup] > [Anamorphic Desqueeze] > Desired option.

3 If necessary, select MENU > [[Z) Monitoring Setup] > [Desqueeze for S&F] > [Reduced Display].

¢ \When slow & fast motion recording is activated, the desqueezed image can only be displayed windowboxed
((Reduced Display]).

Options

[Lens Squeeze Factorl:
The desqueeze factor is linked to the MENU > [£% Recording/Media Setup] > [Metadata] >
[Lens Squeeze] setting.

[x2.0]: Stretches the video horizontally by a factor of 2.
[x1.8]: Stretches the video horizontally by a factor of 1.8.
[x1.3]: Stretches the video horizontally by a factor of 1.3.

(i) Nnotes

* You can record the lens’s squeeze factor in the clip’s metadata with the MENU > [ €% Recording/Media
Setup] > [Metadata] > [Lens Squeeze] setting.

e |f [Anamorphic: HDMI] is set to [On] when the HDMI OUT terminal’s resolution is set to [4096x2160 /
3840x2160] and the frame rate is set to 59.94P or 50.00P, the video output from the HDMI OUT terminal will
be a 1920x1080 image.

e |f [Anamorphic: SDI] is set to [On], 4K output (4096x2160 / 3840x2160) at 59.94P / 50.00P to the SDI OUT
terminal is converted to 2K output (2048x1080 / 1920x1080).

¢ The image displayed during photo playback and the camera’s live view image in the Browser Remote
application will not be desqueezed.
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Web Camera Function

You can connect the camera to a computer using an interface cable, and use the camera as a web camera (with
compatible software). Only video can be recorded while using this function. For more details about supported
122  operative systems or software tested for use with the camera, visit your local Canon website. For more details,
— refer to the computer’s instruction manual.
When connecting the camera to a computer, use a Canon cable.

USB terminal
Computer
Interface cable
Video output configuration
Main resolution Video format Resolution Frame rate
3840x2160, 1920x1080 ) 1024x576 )
Motion JPEG 30 fps (maximum)
6000x3164, 4368x2304, 4096x2160, 2048x1080 1088x576

1 Select MENU > [¥ System Setup] > [USB Mode] > [Video Output (UVC)].

2 Connect the camera to a computer.

3 Open the desired compatible software on the computer.

4 When the connection ends, disconnect the interface cable from the camera.

(i) NoTES

¢ This function cannot be used simultaneously with IP streaming, the Browser Remote function (1] 187), XC
protocol (11 193) or while shooting photos.
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Using the RC-V100 Remote Controller

You can connect the RC-V100 Remote Controller to the camera in order to control the camera (including

advanced recording functions) from a distance. The remote controller lets you turn the camera on, navigate the

menus and remotely control the aperture and shutter speed, change picture-related settings like the knee and 123
sharpness, and more. —
For details on how to connect and use the remote controller, refer to its instruction manual.

REMOTEA

~REMOTE

Remote cable
(supplied with the RC-V100)

1 Turn off the camera and connect the RC-V100 Remote Controller to the camera.
2 Turn on the camera in CAMERA mode.
3 Select MENU > [¥ System Setup] > [REMOTE Term.] > [RC-V100 (REMOTE A)].

Options

[RC-V100 (REMOTE A)l:
Select this option to use the RC-V100 connected to the camera with the RC-V100’s remote
cable.

[Standard]: Select this option to use commercially available remote controls.

(i) Notes

¢ The AUTO KNEE button and AF button will have no effect on the camera.
e The AUTO IRIS button on the remote controller can operate the camera only when a lens compatible with auto
iris ([11 249) is attached to the camera.

e The ZOOM dial on the remote controller can operate the lens only when a compatible lens ([I] 249) is
attached to the camera.
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Assignable Buttons

The camera offers a number of assignable buttons to which you can assign various function. Assign often-used
functions to the buttons you find most convenient to personalize the camera to your needs and preferences.
You can find 13 assignable buttons on the camera’s body, and 4 assignable buttons on the RC-V100 Remote
Controller, RC-IP100/RC-IP1000 Remote Camera Controller, Remote Camera Control Application, and Multi-
Camera Control. In most cases, the names of the buttons printed on the camera and accessories also indicate
their default settings.

PUSH INDEX
AUTO RIS

AF LOCK

Changing the Assigned Function
Functions can be set separately in CAMERA mode and MEDIA mode.

1 Press the MENU button and, while holding it pressed down, press the assignable button whose
function you wish to change.

e A list of available functions appears.
e You can also select the appropriate menu setting from the various pages of the MENU > [&@ Assignable
Buttons] menu.
2 Select the desired function.
® The selected function will be assigned to the selected button.

3 If you selected [User Setting], select the menu setting you want to register.

e The selected menu setting will be assigned to the selected button. User-selected settings will be indicated
with a icon in the [& Assignable Buttons] menu.

4 Press the assignable button to use the assigned function as described in the following table.
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(i) notes

¢ You can check the [@ Assignable Buttons] status screens (11 213) to see what functions are currently
assigned to each button.

126 e You can reset only the functions assigned to the assignable buttons, without affecting other camera settings,
— with the MENU > [ System Setup] > [Reset] > [Assignable Buttons] function. All the assignable buttons will
return to their default function.

¢ When you select MENU > [& Assignable Buttons] > [Link to Camera] > [Enable], the functions assigned to
assignable buttons 1-4 on the camera can also be assigned to assignable buttons 1-4 of the
RC-V100, RC-IP100/RC-IP1000, Remote Camera Control Application, and Multi-Camera Control.

Assignable functions
Functions whose names include a video output destination (LCD, terminal name) affect only the specified video
output, while [All] indicates the function affects all video outputs.

. L CAMERA  MEDIA
Function name Description mode mode M
[One-Shot AFJ1 The camera focuses automatically one time only (one-shot AF function). o - 83
[AF Lock] Turns the AF lock function on/off. ° 85
[AF Lock (While Pressed)]‘* z Activates the AF lock function while the button is held pressed down.
[AF Frame] Toggles the type of the AF frame. o - 85
[Focus Mode] Toggles the focus mode between AF (autofocus) and MF (manual focus). o - 80
[Face Detection AE] Turns face detection AE on/off o - 86
[Subj. detect, AF] Iﬁigles the [Subj. detect. AF] setting between [Detect. priority] and [Detect. ° _ 86
[Subject to detect] Switches the subject to be detected. o - 86
[Eye Detection] Turns eye detection on/off. o - -
[Tracking] Enters/cancels tracking standby mode. o - 87
[Focus Guide] Turns the focus guide on/off. o - 81
[Peaking: All],
{EZZE::S IS-}IC)E] Turns peaking on/off. o - 82
[Peaking: HDMI]
[Magnification],
mgg: ;gﬁ] Turns magpnification on/off. (] - 82
[Magn.: HDMI]
Cycles through the digital tele-converter options in the following order:
[Tele-converter] X1.5 - x2.0 = x2.5 = x3.0 ~0ff. o %
[Push Auto |ris]1 The camera automatically adjusts the aperture only while the button is held ° _ 74
pressed down.
[Iris Mode] Switches the aperture adjustment mode between automatic and manual. o - 7
[Iris +], [lris -] Opens up/closes the aperture, respectively. o -
IND +], [ND -] Cycles throggh ND filter settlr?gs in increasing (higher density) or decreasing ° _ 72
(lower density) order, respectively.
[Auto Clear Scan Setting] Displays the [Auto Clear Scan Setting] screen o - 67
[Base 1SO] Switches between base IS0 speed settings. o - 68
[ISO/Gain Mode] Changes the ISO speed/Gain adjustment mode. o - 68
[AE Shift +], [AE Shift -] Compensates the exposure making the image brighter/darker, respectively. o - 75
[Backlight], [Spotiight] Iggs;i;‘tlr:layhght metering mode between [Standard] and [Backlight]/[Spotlight], ° _ 76
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. _ CAMERA  MEDIA
Function name Description mode mode A

[Zebra: All], [Zebra: LCD],

(Zebra: SDI], [Zebra: HDMI] Turns zebra patterns on/off. o 93

[WEM: All}, [WFM: LCD], )

[WEM: SDI], [WFM: HDMI] Turns the selected video scope on/off. o o 108

[View Assist: All],

[View Assist: LCD], . . B

View Assist: SDI, Turns view assistance on/off. o 159

[View Assist: HDMI]

[False Color: All],

[False Color: LCD],

[False Color: SDI, Turns the false color overlay on/off. ° _ o1

[False Color: HDMI]

[False Color Index] Displays/hides the false color index screen.

(White Balance] Enters the dlrept setting mode with the white balance mode highlighted and S _ 77
ready to be adjusted.

[Set White Balance] Starts the white balance calibration for a custom white balance setting. o - 78

[AWB Lock]1 While using auto white balance (AWB), locks the current white balance settings. o - 79

(AR AWB,

[n®% Set A], [ Set B],

[¢¢ Daylight], Changes the white balance mode/setting to the respective option. o - 77

[>8¢ Tungsten],

[ (4 Kelvin]

[Lens Optical IS] Turn lens optical IS on/off. o - -

[Digital IS] Turns the digital image stabilizer (digital IS) on/off. o - 88
Pauses/resumes the digital IS function. Switching is possible while recording.

[Pause Digital IS]' The angle of view is maintained even when the digital IS function is temporarily ] - 88
paused.

(LCD Setup] Opens the [ Monitoring Setup] menu page with the settings for adjusting P P 204
the LCD screen.

[0SD Output: SDI], , )

(0SD Output: HDMI] Turns the camera’s onscreen displays on/off. o @ 157

[OSD Opacity: Alll,

[0SD Opacity: LCD], )

[0SD Opacity: SDI], Changes the transparency level of onscreen displays. o o 157

[0SD Opacity: HDMI]

[DISP] Changes the onscreen display level. o o 53

(0SD Orientation: LCD] Changes the ons.creen display dwechoq in the following order: standard, P B 55
90 degrees rotation, 270 degrees rotation.

[Markers: All],

[Markers: LCD],

Markers: SDI], Turns onscreen markers on/off. o ([ J 91

[Markers: HDMI]

[Color Bars] Turns color bars on/off. o - 107

[IP Streaming] Turns the IP streaming function on/off. o - 185

[Photo]’ Records a photo. o - 48

[Review Recording]1 Plays back the last clip recorded in CAMERA mode. o - 55

[Time Code] Opens the [§ System Setup] menu page with the time code settings. o - 95

127
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. - CAMERA  MEDIA
Function name Description mode mode (A
[Add Shot Mark]1 Adds a shot mark to the clip. o [ 110,
[Add [ Mark], ) 149,
[Add 1% Merk] Adds an [ or [ mark to the clip. o o 149
[Headphones +], .
[Headphones -] Increases/reduces the headphone volume, respectively. o [ ) 146
- : A .
[Monitor Channels] SV\{ITC.heS the audio channels output from the () (headphone) terminal and the ° PY 160
built-in speaker.
[Audio Level Indicator] Turns the audio level meter on/off. o @ 103
[FUNC] Enters the direct setting mode. o - 57
[Slow & Fast Motion] Turns slow & fast motion recording on/off.
(Slow & Fast Frame Rete] When slow & fast motion recording is activated, highlights the shooting frame [ ] - 114
rate in order to adjust it.
[Output: 60 < 60 (24) fps] 3 % When the frame rate is 59.94P or 59.94i, toggles the frame rate of video output
) terminals and the LCD screen between said frame rates and 24 fps or 30 fps, o - -
60 © 1,3,4
[Output: 60 <> 60 (30) fps] respectively.
. Enters the direct setting mode with the aperture value highlighted and ready to
[Iris] . [ ] - 73
be adjusted.
[Shutter] Enterg the direct setting mode with the shutter speed highlighted and ready to ° _ 66
be adjusted.
(1S0/Gain] Enters the dlrept setting mode with the I1SO speed or gain value highlighted and ° _ 69
ready to be adjusted.
[Status]' Displays the status screens. o [ J 213
i ) i .
[Audio Status] Displays the [d) Audio Setup] status screens. You can press SET to open the ° °® 213
[ Audio Setup] menu.
[MENU] Displays the menu. o [ J -
[Custom Picture] Opens the [[@& Custom Picture] menu. o - 129
[My Menu] Opens the [ Y& My Menu] customized menu. o - 27
[Initialize Media] Opens the [Initialize Media] submenu. o [ J 37
[Play/Pause] Pauses and resumes the playback. - @ 142
[INDEX/Cancel Resume] Returns to the index screen. The next time the clip is selected, playback will
start from the beginning. ° 11
[INDEX] Returns to the index screen. The next time the clip is selected, playback will
start from the frame where it stopped.
[Slot Selection] Switches between card slots. o [ J 38
[Select File] File selection. - [ J -
[Refine] Switches [Refine] (refining clip selection) on/off. - [ J -
[REC] Functions as the REC button. Can only be assigned to assignable button ° _ 47
Camera 4 and 11.
[CAMERA < MEDIA]Z' 5 Switches between CAMERA mode and MEDIA mode. o @ -
((E User Setting]1 :Jeugs;ts(;zlzable slot. Assign to the button any menu setting you would like to ° Py _

! Function can be used only by assigning it to a button.
2 Cannot be used with XC Protocol.
3 Not available when slow & fast motion recording is activated.
4 Cannot be used when [HDMI RAW] is set to [On].
5 Cannot be set with Browser Remote/XC Protocol. Even when [Link to Camera] is set to [Enable], operation from Browser
Remote or XC protocol is not possible.
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Custom Picture Settings

The camera lets you change many settings (11 134) that control various aspects of the image produced. As a
set, all these settings are treated as a single custom picture file. After adjusting the desired settings to your
preference, you can save up to 20 custom picture files (in the camera or on an SD card), and load them later to
apply exactly the same settings ([J1 132). You can also save the custom picture file as part of the metadata
recorded with clips (1] 134). Custom picture settings do not affect the recording or output of RAW clips.

Selecting Custom Picture Files

In CAMERA mode, select a custom picture file to apply its settings to your recordings or to edit, rename, protect,

or transfer it.

1 Select MENU > [[@d Custom Picture] > [Select File].
e The custom picture file selection screen is displayed.

e Select one of the custom picture files saved in the camera (C1 to C20). To use the settings of a custom
picture file saved on an SD card, copy the file to the camera in advance ([J] 133).

¢ You can also use direct touch control's £% recording settings (1 56).
2 Select the desired file.
¢ \When you close the menu, the selected custom picture file’s settings will be applied.

Preset Picture Settings

The following settings are saved to custom picture files C1 to C20 as preset custom picture settings. Custom
picture files C1 to C9 are protected by default and need to be unprotected before they can be edited.

Preset custom picture

file [Gamma/Color Space]* [Color Matrix]  [Look File] Characteristics
These settings produce a look appropriate also for use without
. _ post processing, featuring high contrast while ensuring a wide
C1: [Canon 709] [Canon 709/ BT.709] dynamic range optimized for playback on BT.709 compliant
monitors.
These settings use Canon Log 2 gamma and require post-
[Canon Log 2/ ) ) ) . N
C2: [Canon Log 2] C.Gamut] - production processing. They achieve superior gradation in the
' (Neutral] shadows (dark areas of the image).
These settings use Canon Log 3 gamma and require post-
[Canon Log 3/ ) .
C3: [Canon Log 3] - production processing. They keep the [Canon Log] gamma
C.Gamut] L . L .
characteristics while expanding its dynamic range.
) ) [BT.709 Wide DR / _ These settings produce a wide dynamic range and are
C4: [BT709 Wide DR] BT.709] appropriate for playback on BT.709 compliant monitors.
These settings are appropriate for playback on BT.709 compliant
C5: [BT.709 Standard] [BT.70BQTS7t§1£;1]dard / [Video] - monitors, and use a gamma curve that meets ITU-R BT.709

standards.
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Preset custom picture

file [Gamma/Color Space]* [Color Matrix] [Look File] Characteristics
. _ These settings use a high dynamic range gamma curve
130 ce: [PQl [PQ/BT.2020] compliant with the PQ standard defined by ITU-R BT.2100**.
C7: [HLG] [HLG / BT.2020] _ These settings use a high dynamic range gamma curve

compliant with the HLG standard defined by ITU-R BT.2100**.

[BT.709 Wide DR / Reproduces the image quality and look of an EOS

(8: [EOS Standard] On interchangeable lens DSLR camera with its picture style set to
BT.709] [Standard]
[Neutral] : . o
. Reproduces the image quality and look of an E
C9: [EOS Neutral] [BT-709 Wide DR/ On interchangeable lens DSLR camera with its picture style set to
BT.709]
[Neutral].
These settings produce a look appropriate also for use without
C10: [User10] to post processing, featuring high contrast while ensuring a wide
C20: [User20] [Canon 709 /BT.709] dynamic range optimized for playback on BT.709 compliant

monitors.

* This setting is found under MENU > [[@ Custom Picture] > [Edit File].
** ITU-R BT.2100 is a standard for a bit depth of 10 or 12 bits. When the video configuration is set to one of the 8 bit options, the
gamma curve is approximately equivalent to this standard.

(i) NoTES

About the logarithmic gamma curves (Canon Log settings)
- These gamma curves require post-production processing. They were designed to make the most of the
imaging sensor characteristics in order to obtain impressive levels of dynamic range.
- In CAMERA mode, you can apply a view assistance function to the LCD screen's image to use gamma
curve settings more suitable for viewing on a monitor screen.

- There are also other LUTs available that can be applied for processing in post-production. For the latest
information on available LUTs, please visit your local Canon website.

About changing custom picture related settings using the RC-V100 Remote Controller

- When an RC-V100 Remote Controller is connected to the camera, you can press the remote controller’s
CUSTOM PICT. button to open the [[@d Custom Picture] menu.

- If a protected custom picture file is selected on the camera, custom picture related settings cannot be
changed using the remote controller.

- Adjusting custom picture related settings using the remote controller will change the settings registered
under the currently selected custom picture file. If you want to keep an important custom picture file, copy it
in advance to an SD card or select in advance a custom picture file you do not mind changing.

Editing a Custom Picture File’s Settings
In CAMERA mode, adjust the image quality to your preference and save the settings as part of a custom picture
file.
1 Select a custom picture file ([J] 129).
2 Select MENU > [[@@ Custom Picture] > [Edit File].
e Select an unprotected custom picture file.
3 Select a setting you wish to change and select the desired option.
¢ Refer to Available Custom Picture Settings (11 134) for details on the various settings.
e Repeat step 3 for other settings as necessary.
¢ \When you close the menu, the new custom picture settings will be applied.
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Renaming Custom Picture Files
1 Select a custom picture file (1] 129).

2 Select MENU > [[@ Custom Picture] > [Edit File] > [Rename] > [Input].
¢ Enter the desired file name (16 characters long) (11 28).

Protecting Custom Picture Files
Protecting a custom picture file prevents its settings from being accidentally changed.
1 Select a custom picture file (1] 129).
2 Select MENU > [[@ Custom Picture] > [Edit File] > [Protect] > [Protect].
o [ox] will appear next to the file name.
* To remove the protection, select [Unprotect] instead.

Resetting Custom Picture Files
1 Select a custom picture file (1] 129).
2 Select MENU > [[@ Custom Picture] > [Edit File] > [Reset].

3 Select a preset custom picture setting and then select [OK].
e The custom picture file will be reset to the selected values.

Look Files

You can register LUT files created with Blackmagic Design’s DaVinci Resolve as Look Files in the custom picture
file. Using a Look File allows you to adjust the video quality of the recorded video. These adjustments apply also
to proxy clips, photos, and screen/output terminals.

1 Insert the SD card with the desired Look File (.cube format, located in the root directory of the SD
card) into the camera’s SD card slot B.

2 Select a custom picture file. (] 129)
3 Select MENU > [[@ Custom Picture] > [Edit File] > [Gamma/Color Space] > Desired option.
4 Select MENU > [[@d Custom Picture] > [Edit File] > [Look File Setup] > [Register].
e The Look Files in the SD card will be displayed.
5 Select the desired Look File.
6 Select the [Gamma/Color Space] setting to use after the Look File is applied.
7 Select [OK] twice.
* The selected Look File will be loaded and registered to the custom picture file.

¢ The image quality adjustments set in the Look File will be applied, and (LOOK] will appear on the screen.

¢ When disabling the image quality adjustments set in the Look File, select MENU > [[€d Custom Picture] >
[Edit File] > [Look File] > [Off].
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(i) notes

About Look files

- The camera supports LUT files (3D LUT/.cube format) in 17 grid or 33 grid format created with Blackmagic
Design’s DaVinci Resolve.

- LUT files with input ranges outside the O to 1 range in the header (“LUT_3D_INPUT_RANGE”) are not
supported.

- LUT files which include values outside of the 0 to 1 range in the data area are not supported.

- LUT files 2 MB and larger, as well as files with a name containing over 65 characters are not supported.

- Only the following characters can be used in the file name:
Numbers 0 to 9, upper/lower case letters a to z, underscore (_), hyphen (-), period (.) and a single byte
space.

Save a Look File to the root directory of the SD card.

If the correct input/output gamma curve and color space conversion are not selected, video will not be output

correctly.

e A Look File cannot be used if the [Gamma/Color Space], [HLG Color], [White Level 100%)], or [Over 100%)]

settings are changed after registering it.

When the gamma curve component of the [Gamma/Color Space] setting in the custom picture is set to either

[BT.709 Standard] or [BT.709 Wide DR], super-white (video signal above 100%) and super-black (video signal

below 0%) levels of brightness will be clipped. When the video signal contains super-white brightness levels,

select MENU > [[@d Custom Picture] > [Edit File] > [Other Functions] > [Over 100%] > [Press] and then

activate the Look File to apply it to a signal compressed to 100%.

When playing RAW clips, the Look File registered when the clip was recorded will only be applied to the

thumbnail and not the clip itself.

Deleting a Look File
You can delete Look Files registered in custom picture files.

1 Select a custom picture file (11 129).
2 Select MENU > [[@ Custom Picture] > [Edit File] > [Look File Setup] > [Delete] > [OK].

® The Look File will be deleted and the image quality adjustments will be reversed to the original settings of the
selected custom picture file.

Saving a Custom Picture File

Copying Custom Picture Files

You can copy custom picture files between the camera and SD card. Insert in advance into the camera the card
where you want to save your custom picture files or the card that contains the custom picture file you want to
load.

Copying a File from the Camera to an SD Card

1 Select a custom picture file (11 129).

2 Select MENU > [[@d Custom Picture] > [Save File] > [Copy to SD Card B].
3 Select the destination file on the card and then select [OK].

e Select an existing custom picture file to overwrite it or [New File] to save the settings as a new custom
picture file on the card.

4 When the confirmation message appears, press SET.
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(i) Nnotes

e Custom picture files are exclusively compatible for use only with the same camera model.

Replacing a File in the Camera with a File on an SD Card 133
1 Select the custom picture file that you wish to replace (11 129). —
2 Select MENU > [[@ Custom Picture] > [Save File] > [Load from SD Card B].
3 Select the file with the settings that you want to replicate and then select [OK].
e The file in the camera will be overwritten by the one on the card.
4 When the confirmation message appears, press SET.
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Embedding the Custom Picture File in Clips (CAMERA Mode)

When you record after having set custom picture settings, you can have the custom picture file embedded in the
metadata and saved along with the clips. When displaying the information screen in MEDIA mode, you can
check the custom picture settings used at the time of recording.

Select MENU > [ 2% Recording/Media Setup] > [Metadata] > [Add File] > [On].

Available Custom Picture Settings

Menu items Options / Additional information
[Gamma/Color Space] [Canon Log 2 / C.Gamut], [Canon Log 3 / C.Gamut], [Canon Log 3 / BT.2020],
[Canon Log 3/ BT.709], [Canon 709 / BT.709], [BT.709 Wide DR / BT.709],
[BT.709 Standard / BT.709], [PQ / BT.2020], [HLG / BT.2020]

Combination of gamma curve and color space settings that affects the overall look and color space of
the image.

Gamma curve
[Canon Log 2]: Logarithmic gamma curve that obtains a richer color gradation in the dark areas of

é j  BT709 Standard the image. Requires image processing in post-production.
© sr7oowide bR [Canon Log 3]: Logarithmic gamma curve that keeps the characteristics of the [Canon Log] setting
o ggﬁm 700 while expanding its dynamic range. Requires image processing in post-production.
[PQ]: HDR (high dynamic range) gamma curve compliant with the PQ standard defined by ITU-R
|nput BT.2100.*
[HLG]: HDR (high dynamic range) gamma curve compliant with the HLG standard defined by ITU-R
BT.2100.*

[BT.709 Wide DR]: Gamma curve with a very wide dynamic range. Optimized for playback on BT.709
compliant monitors. Equivalent to the [Wide DR] setting in previous camera models.

*(51 [BT.709 Standard]: Gamma curve that meets ITU-R BT.709 standards, for playback on BT.709
g compliant monitors. Equivalent to the [Normal 3] setting in previous camera models.
"""" g:gg; tggg [Canon 709]: Gamma curve appropriate also for use without post processing, featuring high contrast
—PQ while ensuring a wide dynamic range. Use this when outputting to a BT.709 compliant monitor.
* ITU-R BT.2100 is a standard for a bit depth of 10 or 12 bits. When the video
Input configuration is set to one of the 8 bit options, the gamma curve is approximately

equivalent to this standard.

Color space

[C.Gamut]: Color space developed by Canon based on the specific characteristics of the camera’s
imaging sensor. It covers a wider color gamut than that of BT.2020. Use this setting with
workflows that require ACES2065-1 color space.

[BT.2020]: Color space that meets ITU-R BT.2020 standards, which defines parameters for ultra-
high-definition television (4K/8K).

[BT.709]: Standard color space that is compatible with SRGB specifications.

[Color Matrix] [Neutral], [Production Camera], [Video]

The color matrix affects the overall color tonality of the image.

[Neutral]: Reproduces neutral colors.

[Production Camera]: Reproduces colors more suitable for motion picture production.
[Video]: Reproduces colors with a contrast suitable for TV broadcasting.

[Look File] [On], [Off]
Image quality adjustments set in the Look File will be applied.

[Look File Setup]
[Register] Registers a Look File to a custom picture file.

[Delete] Deletes a Look File registered to a custom picture file.
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Menu items Options / Additional information
[HLG Color] [BT.2100], [Vivid]
Changes the quality of color reproduction when using the hybrid log gamma (HLG). This setting is
only available when [Gamma/Color Space] is set to [HLG / BT.2020].
[BT.2100]: Color reproduction according to ITU-R BT.2100 specifications.
[Vivid]: More saturated color reproduction according to the 'Traditional Colour' approach in ITU-R
BT.2390.
[Black]
[Master Pedestal] -50 to +50 (+0)
Increases or decreases the black level. Higher settings will make dark areas brighter but decrease
contrast. This setting is not available when the gamma curve component of the [Gamma/Color
Space] setting is set to one of the [Canon Log 2] or [Canon Log 3] options.
[Master Black Red], —-50 to +50 (+0)
[Master Black Green], These settings correct the color cast in blacks. These settings are not available when the gamma
[Master Black Blue] curve component of the [Gamma/Color Space] setting is set to one of the [Canon Log 2] or [Canon

Log 3] options.

[Black Gamma]

[Level]

-50 10 +50 (+0)

[Range], [Point]

[Point] s

: / 7% Levell

iARange]J

Output

Input

~20 10 +50 (+0)

These settings control the lower part of the gamma curve (dark areas of the image). These settings
are only available when the gamma curve component of the [Gamma/Color Space] setting is set to
one of the [BT.709 Standard] options.

[Level]: Raises or lowers the lower part of the gamma curve.

[Range]: Selects the adjustment range from the selected [Point].

[Point]: Determines the shape of the lower part of the gamma curve.

[Low Key Saturation]

[Activate] [On], [Off]
Set this setting to [On] to enable the adjustment of color saturation in dark areas with the [Level]
setting.
[Level] -50 to +50 (x0)
Specifies how saturated colors are in dark areas.
[Knee]
[Activate] [On], [Off]

Set this setting to [On] to enable the adjustment of the knee point with the following settings. These
settings are only available when the gamma curve component of the [Gamma/Color Space] setting is
set to one of the [BT.709 Standard] options.

[White Level 100%)] [On], [Off]
[Slope] —-3510 +50 (---)
[Point] 50% to 100% (85%)
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Custom Picture Settings

Menu items

[Saturation]
[Slope]

Output

Input

Options / Additional information
—10to +10 (x0)

These settings control the upper part of the gamma curve (highlights of the image). By compressing
the highlights, you can prevent parts of the image from being overexposed.

[White Level 100%)]: Adjusts automatically to keep output at 100% even if [Point] is changed.
[Slope]: Determines the slope of the gamma curve above the knee point (can only be adjusted if

Po
Por [White Level 100%] is set to [Off).
< [Point]: Sets the knee point of the gamma curve. When [White Level 100%] is set to [Off], it is
= adjusted within a range of 50% to 109%.
© [Saturation]: Adjusts the color saturation in the highlights.
Input
[Sharpness]
[Level] —10 to +50 (+0)
Sets the sharpness level of the video output signal and the recorded signal.
[Detail Frequency] -8 to +8 (x0)

Sets the center frequency of horizontal sharpness. Setting higher values increases the frequency,
which, in turn, increases the sharpness.

[Coring Level]

-30 to +50 (x0)

Sets the level of correction of artifacts caused by high sharpness levels (coring). Higher values
prevent sharpness from being applied to minute details, resulting in less noise.

[Limit]

-50 to +50 (+0)
Restricts how much sharpness is applied.

[Noise Reduction]

[Automatic] [On], [Off]
Adaptively changes the noise reduction effect.
[Spatial Filter] [Off], 1 to 12

Reduces noise by applying a soft focus-like effect on the entire picture. When set to a value other
than [Off], afterimages are not produced but the whole image will have a softer look.

[Frame Correlation]

[0ff], 1t0 3

Reduces noise elements by comparing the current image to the previous one (field). When set to a
value other than [Off], the perceived resolution will not be affected but an afterimage may appear for
moving subjects.

[Skin Detail]
[Effect Level] [0ff], [Low], [Middle], [High]
[Hue] —16 10 +16 (£0)
[Chroma], [Area], [Y Level] 0to 31 (16)

The camera applies a softening filter to areas in the picture with skin tones to give a more pleasant
appearance. By changing these settings, you can determine what areas will be detected as skin
tones. A zebra pattern will appear on the screen or video output terminal over areas of the image that
are detected as having skin tones.

[Effect Level]: Adjusts the level of the filter.

[Hue]: Adjusts the hue for detection of skin tones.

[Chroma]: Adjusts the color saturation for detection of skin tones.

[Area]: Adjusts the color range for detection of skin tones.

[Y Level]: Adjusts the brightness for detection of skin tones.




Custom Picture Settings

Menu items Options / Additional information
[Color Matrix Tuning]
[Gain] -50 to +50 (x0)
[Phase] —-18 to +18 (x0)

These settings adjust the color intensity ([Gain]) and color phase ([Phase]) of the color matrix,
affecting the color tones of the whole image.

[R-G], [R-B], [G-R], [G-B],
[B-RI, [B-G]

-50 to +50 (+0)

Each matrix changes the tint of the picture along the color gradations detailed below, affecting the
color tones of the whole image.

[R-G]: cyan/green and red/magenta; [R-B]: cyan/blue and red/yellow;

[G-R]: magenta/red and green/cyan; [G-B]: magenta/blue and green/yellow;

[B-R]: yellow/red and blue/cyan; [B-G]: yellow/green and blue/magenta.

[White Balance]

[R Gain], [G Gain], [B Gain]

-50 to +50 (x0)

These settings adjust the amount of white balance throughout the whole image by changing the
intensity of red tones ([R Gain]), green tones ([G Gain]), and blue tones ([B Gain]).

[Color Correction]

[Select Area] [Off], [Area A], [Area B], [Area A&B]
The camera detects areas with certain color characteristics (color phase, chroma, area and Y level)
and corrects them when recording. You can set the color correction for up to two different areas
(A and B) and apply the color correction to either one ([Area A] or [Area B]) or both of them ([Area
A&B]).
While color correction is activated, parts of the image that are not detected as having the
characteristics specified for area A or B will appear colorless on the screen or the image output from
the output terminals (except when adjusting the [Revision Level]/[Revision Phase] settings).

[Area A Setting Phase], 0to 31(0)

[Area B Setting Phase] These settings determine the color phase of the area to be corrected (A or B, respectively).

[Area A Setting Chroma], 010 31 (16)

[AreaB Sett?ng Chromal, These settings determine the following color characteristics of the area to be corrected (A or B,

[Area A Setting Area], respectively).

[Area B Setting Area], [Area A Setting Chroma], [Area B Setting Chroma]: Color saturation.

[Area A Sett!ng Y Level], [Area A Setting Area], [Area B Setting Area]: Color range.

[Area B Setting Y Level] [Area A Setting Y Level], [Area B Setting Y Level]: Brightness.

[Area A Revision Level],
[Area B Revision Level]

-50 to +50 (x0)

These settings adjust the amount of correction applied to the color saturation in the corrected area
(A or B, respectively).

[Area A Revision Phase],
[Area B Revision Phase]

-1810 +18 (+0)

These settings adjust the amount of correction applied to the color phase in the corrected area
(A or B, respectively).

[Other Functions]

[Over 100%]

[Through], [Press], [Clip]

Determines how the camera handles video signals exceeding 100%. This setting is not available
when the gamma curve component of the [Gamma/Color Space] setting is set to one of the
[Canon Log 2], [Canon Log 3], [PQ], [HLG] or [Canon 709] options.

[Through]: Leave the signal unchanged.

[Press]: Compress a signal of up to 108% down to 100% levels.

[Clip]: Clip the signal at 100%.

(i) NoTES

¢ Depending on other menu settings, you may not be able to obtain the desired image effect even after
changing the custom picture settings.
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¢ When an RC-V100 Remote Controller is connected to the camera, the following custom picture settings can
be changed using the buttons and dials on the remote controller.
- [Black] > [Master Pedestal], [Master Black Red], [Master Black Blue]

[Black Gamma] > [Level]

[Knee] > [Slope], [Point] (only when [Knee] > [Activate] is set to [On])

- [Sharpness] > [Levell

[White Balance] > [R Gain], [B Gain]
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Saving and Loading Menu Settings

After you adjust settings in the various menus, you can save those settings in the camera or on SD card B. You
can load those settings at a later date or on another camera of the same model so that you can use that camera
in the same way.

Saving Menu Settings
1 Select MENU > [¥ System Setup] > [Transfer Menu/[€d] > [Save].

2 Select [To Camera] or [To SD Card B] and then select [OK].

e The camera’s menu settings will be saved to the selected destination. If menu settings were previously
saved, the old file will be overwritten by the current menu settings.

Loading Menu Settings
1 Select MENU > [¥ System Setup] > [Transfer Menu/[€] > [Load].

2 Select [From Camera] or [From SD Card B] and then select [OK].

® The camera’s menu settings will be replaced by the settings in the previously saved file. Then, the screen will
turn black momentarily and the camera will restart.

(i) NoTES

¢ The following menu settings are not saved with this operation.
- MENU > "™ Camera Setup] > [ABB], [Color Bars]
- MENU > [£% Recording/Media Setup] > [Metadata] > [News Metadata], [User Memo]
- MENU > [ Assistance Functions] > [Magnification], [Magn. Output], [False Color Index]
- MENU > [ Assistance Functions] > [Waveform Settings] > [Size: LCD]
- MENU > [ Network Settings] > [Advanced Settings] > [FTP Transfer Settings]
- MENU > [¥ System Setup] > [Level Reference Setting]
¢ \When menu settings are loaded with this operation, even protected custom picture files in the camera will be
replaced.
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Playback

Playback

141

This section explains how to play back clips, photos and WAV audio with the camera. For details on playing back
recordings using an external monitor, refer to Connecting to an External Monitor or Recorder ([1] 154).

Displaying the Index Screen
Press the MEDIA button (1 15)

e The camera is set to MEDIA mode and the clip thumbnails will appear in the index screen.
e Use the joystick or the SELECT dial to move the orange selection frame.
¢ Flick up/down on the screen or turn the front control dial to move to the next/previous page.

Key lock ([1] 15)
Shot mark (11 149)
[ mark/M mark (1] 149)
Orange selection frame
Proxy clip (11 64)
Clip identification (camera index, reel number, clip
number and clip/audio file name) (11 42)
Recording date and time
Network status / functions (1] 183)
Recording media N / 22
¢ The toggle button is displayed on the side of the
currently selected card.

10 File selection ([1] 143)
11 Index screen currently displayed (11 142)
12 Clip thumbnail

OOk~ wWND =

© 00 N

13 Power supply level (1] 51)
14 Clip number / Total number of clips
15 Recording date (month and day only) and time
16 Clip’s start time code
17 Clip duration
18 Custom picture file embedded ([J] 134)
19 Special recording mode ([ 114)
20 Color sampling and resolution, audio recording
format
e For RAW clips, RAW mode (ST/LT) and
resolution are displayed.
21 Frame rate ([11] 62)
e For slow & fast motion recording clips, the
recording/playback frame rate is displayed.
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(i) notes

e |f the card contains XF-AVC clips recorded at a system frequency other than the one currently used by the
camera, you will not be able to play back the clips and the clip thumbnails will not appear in the index screen.
To play back such clips, change the camera’s system frequency ([ 61) to match the recordings on the card.

Switching Card Slots

If both card slots contain a card, press the SLOT SELECT button to play
back recordings from the other card. You can also switch card slots by
touching the orange dot next to the card currently selected.

Switching Index Screens

The clip index screen that appears when you switch to MEDIA mode
depends on the current recording settings.

1 Press the INDEX button.
¢ The index screen selection menu appears.
2 Select the desired index screen.
e The selected index screen appears.
e Select [Cancel] to return to the previous index screen.

Options
[RAW Index]:  Clips in RAW format.
[XF-AVC Index]: Clips in XF-AVC format.

[XF-HEVC S / XF-AVC S Index]:
Clips in XF-HEVC S / XF-AVC S format.

[Photo index]:  Photos recorded on the card.
[WAV Index]:  Audio files (WAV format).

Playing Back Recordings

After selecting the desired index screen, play back the desired clips,
photos or audio files. You can use the touch screen or assignable
buttons to play back the recordings.

Touch the thumbnail of the recording you want to play back.

e Playback will start.

® You can also move the orange selection frame using the joystick or the
SELECT dial, and then press and hold the SET button (for
approximately 1 second) to start playback.

e Touch the screen or press the joystick to pause/resume playback.

¢ Press the INDEX button or flick the screen down to stop the playback
and return to the index screen.




Playback

¢ While browsing photos, press the joystick left/right to move to the previous/next photo.

Custom picture settings of RAW clips during playback
RAW clips are played back using the following custom picture settings.

e [Gamma/Color Space]: Same setting used for recording 143
e [Color Matrix]: [Neutral]

¢ Contour lines are de-emphasized in a way similar to setting [Sharpness] > [Level] to —10.

e Other settings are set to [Off].

Lens Correction of RAW clips during playback

¢ Depending on the shooting settings, peripheral illumination/chromatic aberration/distortion aberration of the
shooting lens is corrected and applied during playback.

(i) notes

¢ The following image files may not be displayed correctly.
- Images not recorded with this camera.
- Images edited on a computer.
- Images whose file names have been changed.

Refining Clip Selection for Playback

Play back only the selected clips in succession.

1 Touch & on the index screen. e
¢ The file selection screen is displayed. " "“” = e
e Touch X to return to the index screen. . 7' =

Nov. 3 9:09 AM

2 Touch a thumbnail to select a clip, then touch Y.
e The Refine screen is displayed.

* Touch 3 to return to the file selection screen, or X to return to
the index screen.

3 Touch the desired thumbnail on the Refine screen.

e Subsequent operations are the same as for Playing Back
Recordings.

e Once playback ends, the screen returns to the Refine screen.

Refine screen example
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Onscreen Displays During Clip Playback

144

@ 00:00:02.07

ol 0 00:00:03.29
180.00° 00 00 00 00

17 1819 20 21 22

1 Fan operation ([11 44) and temperature warning 8 Frame rate? ([1J 62)

(1 226) 9 Custom picture file embedded® ([0 134)
2 QOutput onscreen displays ([11 157) 10 [ mark®/ M mark3 / Proxy clip (1] 149, 64)
3 Playback button ® 11 Time code ([ 95)

Advance 10 seconds © 12 Video format ([I] 62)

Go back 10 seconds 13 Color sampling and bit depth (11 62)
4 Recording date and time 14 Resolution ([1] 62)
5 Frame reverse button [4I] 15 Headphone volume ([1] 146)

Frame advance button [} ] 16 Audio level meter*
6 Base SO 17 Aperture value® ((11 73)
7 Playback operation 18 ISO speed/Gain5 (M 68)

P PLAY Playback 19 Progress bar

11 PAUSE Playback pause 20 Shutter speed” ([ 66)

10sec PP Advance 10 seconds 21 User bit (LT1 96)

<<€ 10 sec Go back 10 seconds 22 Audio output channels ([] 160)

i/l Frame reverse/Frame advance

F FWD x5 Fast forward (speed: x5)

F FWD x15 Fast forward (speed: x15)

F FWD x60 Fast forward (speed: x60)

F REV x5 Rewind (speed: x5)

F REV x15 Rewind (speed: x15)

F REV x60 Rewind (speed: x60)

T Only when [[E) Monitoring Setup] > [Custom Display] > [Date/Time] is set to [On].
For clips recorded using slow & fast motion recording, the shooting frame rate and playback frame rate will both be displayed.
3 XF-AVC clips only.
4 Only when [[E=) Monitoring Setup] > [Custom Display] > [Audio Level Indicator] is set to [On].
5 Only when [[[E) Monitoring Setup] > [Custom Display] > [Camera Data] is set to [On].

(i) NoTES

¢ You can press the DISP button repeatedly to change the level of onscreen displays (11 53).



Playback

Audio (WAV) playback screen
See Onscreen Displays During Clip Playback (11 144) for the description of onscreen displays that are common

on all playback screens.

—

Audio file name

1l PAUSE

00:00:03/00:00:03
DCIN24.7v
6/6

48KHz 24bita]

Jan. 1,2024
12:00 AM

00:00:11

@& STOP

3 Audio level meter

2 Sampling frequency and bit depth

Clip Playback Controls

The following playback types are available using the joystick and the touchs screen.
You can also change the position in the video using the progress bar.

Playback type

Fast playback’

Operation

During playback, push the joystick up or down.
Repeat to increase the playback speed to approximately 5x = 15x = 60x the normal speedz.

Advance 10 seconds

During playback, touch the right side of the screen twice. During playback pause, touch © on the right side
of the screen.

Go back 10 seconds

During playback, touch the left side of the screen twice. During playback pause, touch @ on the left side of
the screen.

Frame advance/reverse

During playback pause, push the joystick up or down, or touch <@l / II»>

Skip to the beginning of the next
clip

During playback, push the joystick right, or flick the screen to the left.

Skip to the beginning of the
current clip

During playback, push the joystick left.

Skip to the previous clip

During playback, push the joystick left twice, or flick the screen to the right.

Change the playback/playback
pause position in the video

During playback/playback pause, touch or slide the progress bar.

" You may notice some anomalies (blocky video artifacts, banding, etc.) in the playback picture.
2 The speed indicated on the screen is approximate.

(i) NoTES

e There is no audio during any of the playback types listed in the previous table.
* You can press the /1l button during fast playback to return to playback at normal speed.
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Adjusting the Volume

You can use headphones or the built-in speaker to listen to the audio during
normal playback. When you connect headphones to the () (headphone)
146 terminal, the speaker will be muted. The audio signal will also be output from the

ﬂ (headphone)
terminal

SDI OUT terminal / HDMI OUT terminal.

1 Select MENU > [M) Audio Setup] > [Headphone Volume] or [Speaker “
Volume]. °

2 Select the desired level.

(i) NoTES

¢ For details on changing the audio channel, refer to Audio Output (1] 160).

e [f you set an assignable button to [Headphones +] or [Headphones -] (11 125), you can press the button to
adjust the headphone volume without using the menu.



File Operations

File Operations

You can perform various operations on the file selected in the index screen using the file menu. Available options
will depend on the type of recording selected.

File Menu Operations

1 Select the desired recording.

2 Press SET.

* The file menu will be displayed. Available functions will differ depending on the recording.

* You can also touch the screen for approximately 1 second to display the file menu.

3 Select a menu item.

File menu options

Index screen
Menu item Description [XF-HEVC S/
RAW]  XFAVC] F T S] [Photos] ~ [WAV]
[Cancel] Closes the menu. o [ J o ( J ([
[Play] Starts playback. o [ J o ( J (]
[Display Clip Info] Displays the information screen ([ 148). o @ @ - -
{é:?egnm';:a&'grgm Adds or deletes an B} mark (LI 149, 149). - ° - - -
{g:?etal\;'gr‘;]ﬂlz Adds or deletes a [% mark (L1 149, 149). - ° - - -
[Del. All Shot Marks]1 Deletes all the shot marks ([ 150). - @ - - -
[Recover] Recovers a recording. o @ @ - o
[Delete] Deletes a recording ((11 150). o [ J o ( J o
Deletes the user memo and GPS information of a clip
[Delete User Memo] (0 150, - @ o - -
[FTP Transfer] Transfers a clip using the FTP protocol ((1 184). - @ o - -
[Frame.io Upload] Adds clip to the Frame.io upload queue. (s (s - o’
[Stop] Ends photo playback. - - - o -
Displays the file selection screen on the index screen.
[Select] Alternatively, selects a file on the file selection o [ J o - -
screen.
[Deselect] Clears selection for a file. o [ J o - -
Clears selection for all files and returns to the index
[Deselect All] soreen. o [ J [ J - -
[Refine] Displays the Refine screen. ] [ ] ] - -
Returns from the Refine screen to the selection
[Reselect] soreen. o [ J [ J - -
[End Refining] Returns from the Refine screen to the index screen. o [ J o - -

1 Excluding proxy clips.

2 the clip already contains an [l or Mmark, the option to delete the mark will appear in the menu.

3 Only card slot B proxy clips and audio recordings (second card recording functions).
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Displaying Clip Information
1 Select the desired clip in the clip index screen.

2 On the file menu, select [Display Clip Info].
148 ¢ The [Clip Info] screen will appear.

e Push the joystick left/right or touch §/] on the screen to move to the previous/next clip. Press the CANCEL
button to return to the index screen.

A 301 min

Nov. 3,2024 9:20 AM
h_0003C026H240320_06073800_

CANON
3 End
Duration
4 &s) DX News Metadata

1 Thumbnail of the selected clip 11 Custom picture file embedded ([T] 134)
2 Clip geotagged with GPS information 12 Proxy clip (11 64)
3 Thumbnail of the previous clip 13 Color sampling and bit depth (11 62)
4 Thumbnail of the next clip e For RAW clips, RAW mode (ST/LT) and bit depth
5 Special recording mode ([J1 114) are displayed.
6 Recording date and time 14 Lens model name
7 Clip file name (11 42) 15 Clip’s start time code
8 Compression, bit rate and resolution ([1] 59) 16 Clip’s end time code
9 Framerate' (0 62) 17 Clip duration
10 Shot mark (11 149) and [ mark / @ mark
(1 149

" For clips recorded using slow & fast motion recording, the shooting frame rate and playback frame rate will both be displayed.

Displaying Additional Information (User Memo/News Metadata)

From the [Clip Info] screen, you can push the joystick up or down, or touch [@]/[®] on the screen to display user
memo or News Metadata details. To return to the [Clip Info] screen, push the joystick in the direction displayed to
the left of [Clip Info] at the bottom of the screen ([@]/[®]) or touch [Clip Info] at the top of the screen.

Displaying Custom Picture Settings

If a custom picture file was embedded with the clip, you can push the joystick up or down, or touch [@]/[®] on
the screen to display the custom picture settings used. To return to the [Clip Info] screen, push the joystick in the
direction displayed to the left of [Clip Info] at the bottom of the screen ([@]/[@]) or touch [Clip Info] at the top of
the screen.
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Adding [ Marks or [ Marks

You can add an OK mark () or check mark (M) to XF-AVC clips to help you identify particular clips. Since clips
with an [l mark cannot be deleted with the camera, you can use this mark also to protect important clips.

Adding an [l Mark or M Mark During Playback
You can add an [ mark or [ mark to a clip during playback or playback pause.

1 Set an assignable button to [Add [l Mark] or [Add M Mark] (1] 125).

2 During playback/playback pause of an XF-AVC clip, press the assignable button to add the clip mark.
o [[[AMark] or [Mark] will appear briefly and the selected clip mark will be added to the clip.
¢ Playback will be paused.

Adding an [l Mark or M Mark from the Index Screen
1 Select the desired clip from the XF-AVC index screen.

2 Press SET (file menu) and select [Add [ Mark] or [Add [ Mark] > [OK].
e The selected clip mark is added to the clip.

(i) NoTES

¢ A clip cannot have both an [l mark and [ mark at the same time. When you add a [ mark to a clip with an
[ mark, the [ mark will be deleted. Similarly, when you add an [l mark to a clip with a [ mark, the
mark will be deleted.

Deleting [l Marks or [4 Marks
You can delete an [l mark or M mark added to an XF-AVC clip.

1 Select the desired clip from the XF-AVC index screen.

2 Press SET (file menu) and select [Delete M Mark] or [Delete Mark] > [OK].
e The selected mark is deleted.

Adding/Deleting Shot Marks

During the playback of a clip recorded in XF-AVC format, you can add shot marks (H) to particular frames in the
clip that you want to single out. You can also delete all shot marks at once.

Adding Shot Marks during Playback
1 Set an assignable button to [Add Shot Mark] (1] 125).

2 During playback/playback pause of an XF-AVC clip, press the assignable button at the point in the clip where
you want to add the shot mark.

e [Shot Mark] will appear briefly and the shot mark will be added to the current frame of the clip.
e Playback will be paused.
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File Operations

Deleting All the Shot Marks from a Clip
1 Select the desired XF-AVC clip in the index screen.

2 Press SET (file menu) and select [Del. All Shot Marks] > [OK].
¢ All shot marks in the selected clip are deleted.

Deleting Recordings
You can delete clips, photos and audio files (WAV). To delete clips with an [l mark, you need to delete the [
mark beforehand ([ 149).

1 Select the desired file in the index screen.
e Photos are selectable on the playback screen.

2 Press SET (file menu) and select [Delete] > [OK].
e The file is deleted.
e The operation cannot be canceled.

@ wPoRTANT
¢ Be careful when deleting recordings. Once deleted, they cannot be recovered.

Deleting the User Memo and GPS Information from a Clip
1 Select the desired clip in the index screen.

2 Press SET (file menu) and select [Delete User Memo] > [OK].
¢ The user memo and GPS information that were recorded in the selected clip’s metadata are deleted.



External Connections

Video Output Configuration

The video signal output from the SDI OUT terminal / HDMI OUT terminal, depends on the clip’s video
configuration and on various menu settings.

Video Output Configuration (Recording/Playback)

Video configuration MENU > [¥ System Setup] SDI OUT terminal HDMI OUT terminal
Recording Resolution Frame [SDI Output [HDMI Output Output Output frame Output Output
format rate Signal] Signal] format’ rate? format’ frame rate?
4096x2160P / | 4096x2160P /
3840x2160P | 3840x2160p | 1006X2160 4096x2160 Same as
Same as shooting .
2048x1080P / 2048x1080 frame rate shooting
1920x1080P 1920x1080P 1920x1080 | frame rate
4368x2304 2?)(9)32 1920x1080P 1920x1080
' 1920x1080i(PsF) | 1920x1080i || 1920x1080 | 59.94i,50.00i | 1920x1080 | 59.94i, 50.00i
Same as shootin Same as
1280x720P 1280x720P || 1280x720 9 1280x720 shooting
frame rate
frame rate
RAW 4096x2160P / | 4096x2160P /
3840x2160P | 3840x2160p | 1006X2160 ‘ 4096x2160 Same ac
2048x1080P / Same as shooting shooting
2048x1080 frame rate
soooaies 2997P 1920x1080P 1920x1080P 1920x1080 | frame rate
X 25.00P, |  1920x1080P 1920x1080
24.00F, 29.97P i
43682304 -97PsF(59.94i), 59.94i,50.00i
23.98P | 1920x1080i(PsF) | 1920x1080i || 1920x1080 | 25.00PsF(50.00i), = 1920x1080 | oo 22
. . 60.00i, 59.94i
60.00i, 59.94i
59.94P, 50.00P, 59.94P, 50.00P,
1280X720P 1280x720P || 1280720 | 00F, 59.94p 1280x720 | 00P. 50,949
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Video Output Configuration

Video configuration

MENU > [ System Setup]

SDI OUT terminal

HDMI OUT terminal

Recording Resolution Frame [SDI Output [HDMI Output Output Output frame Output Output
format rate Signal] Signal] format’ rate? format! frame rate2
1 52 4096x2160P / 4096x2160P / || 4096x2160/ 4096x2160 /
v 3840x2160P | 3840x2160P || 3840x2160 | 3840x2160 | gumeas
2048x1080P / 20481080/ Sa";fa‘;‘ns::';?'"g shooting
4096x2160 1920x1080P 1920x1080P || 1920x1080 1920x1080 frame rate
1920x1080P 1920x1080
3840x2160 1920x1080i(PsF) | 1920x1080i || 1920x1080 | 59.94i,50.00i | 1920x1080 | 59.94i, 50.00i
Same as shootin Same as
1280x720P 1280x720P 1280x720 g 1280x720 shooting
frame rate
frame rate
59.94P,
s000p | 2048x1080P/ 2048x1080/ , Same as
1920K1080P° | 1gp01080p* | 1920x1080 | S2ME S SNOONG | 405051080 | snooting
rame rate
2048x1080 1920x1080P 1920x1080 frame rate
1920x1080i(PsF) 1920x1080i 1920x1080 59.94i, 50.00i 1920x1080 | 59.94i, 50.00i
1920x1080
Same as shooting Same as
1280x720P 1280x720P 1280x720 1280x720 shooting
frame rate
frame rate
Same as shootin Same as
1280x720 1280x720P3 1280x720P* 1280x720 g 1280x720 shooting
frame rate
frame rate
4096x2160P / 4096x2160P / || 4096x2160/ 4096x2160 /
3840x2160P 3840x2160P 3840x2160 3840x2160 Same as
XF-AVC 2 Same as shooting .
XF-HEVC S 048x1080P / 2048x1080/ shooting
frame rate
XF-AVC S 40962160 1920x1080P 1920x1080P || 1920x1080 1920x1080 frame rate
X 1920x1080P 19201080
3840x2160 29.97PsF(59.94i, 59.94i, 50.001
1920x1080i(PsF) 1920x1080i 1920x1080 | 25.00PsF(50.00i), | 1920x1080 60. OOi’ 59' 94;
60.00i, 59.94i R
29.97P, 59.94P, 50.00P, 59.94P, 50.00P,
25.00P 1280x720P 1280x720P 1280x720 60.00P. 59.94P 1280x720 60,00 5.94P
24.00P, | 2048x1080P / 204841080/ | i Same as
23.96P | 1920x1080P° | q920x1080p* | 1920x1080 ST BSRINY | 1920x1080 | shooting
rame rate
1920x1080P 1920x1080 frame rate
2048x1080
29.97PsF(59.94i), 59.94i. 50.00i
1920x1080 1920x1080i(PsF)  1920x1080i | 1920x1080 | 25.00PSF(50.00i) | 1920x1080 | >
X : . 60.00i, 59.94i
60.00i, 59.94i
59.94P, 50.00P, 59.94P, 50.00P,
1280x720P 1280x720P 1280x720 60.00P. 59.94P 1280x720 60.00P. 59.94P
59.94P, 50.00P, 59.94P, 50.00P,
3 4 ) ) ) f
1280x720 1280x720P 1280x720P 1280x720 60.00P, 59.94P 1280x720 60.00P, 59.94P
Same as shootin Same as
1 1920x1080i(PsF)3 | 1920x1080i || 1920x1080 9 1920x1080 | shooting
1920x1080 224 frame rate frame rate
50.001 59.94P,
1280x720P 1280x720P 1280x720 59.94P, 50.00P 1280x720 50' OOF;

1 Color sampling will be YCC422 10 bit. The video signal’s effective bit depth will be output.



Video Output Configuration

2 During slow & fast motion recording, the output frame rate will change depending on the output format of the terminal.
- When the resolution is [1920x1080i(PsF)]/[1920x1080i], it will be changed as follows: 59.94P / 29.97P / 23.98P - 59.94i,
50.00P / 25.00P - 50.00i, 24.00P = 60.00i.
- When the resolution is a option other than the above, it will be changed as follows: 59.94P / 29.97P / 23.98P - 59.94P,
50.00P / 25.00P - 50.00P, 24.00P - 60.00P.
3 During playback (MEDIA mode), [4096x2160P/3840x2160P)], [2048 x1080P/1920x1080P], [1920x1080P] and
[1920x1080i(PsF)] can also be selected. Available options depend on the setting values.
4 During playback (MEDIA mode), [4096x2160P/3840x2160P], [1920x1080P] and [1920x1080i] can also be selected. Available
options depend on the setting values.
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Connecting to an External Monitor or Recorder

Connecting to an External Monitor or Recorder

When you connect the camera to an external device, be it a monitor (to monitor the recording or for playback) or
an external video recorder (for recording), adjust the required settings in the menu. For details about output
signals, refer to Video Output Configuration (11 151).

Connection diagram

SDI OUT terminal

SDI inputs

HDMI inputs

0000

HDMI OUT terminal

BNC cable (commercially available)

HDMI cable (commercially available)

(i) NoTES

¢ Powering the camera from a power outlet using an AC adapter is recommended.

e Ifyou set MENU > [£% Recording/Media Setup] > [Rec Command(EXT REC)] to [On] and connect the
camera to another device using the SDI OUT or HDMI OUT terminal, you can control the recording operation
on the other device in conjunction with the camera’s recording operation (REC button). However, this function
cannot be used during slow & fast motion recording, frame recording, interval recording or continuous
recording.

When connecting to the HDMI OUT terminal, select [HDMI Time Code] > [On].

Using the SDI OUT Terminal

The digital signal that is output from the SDI OUT terminal includes the video signal, audio signal, time code
signal, recording command signal, metadata and clip file name information. You can connect an external video
recorder to the SDI OUT terminal to record 4K or 2K video. For details about configuring and using external
recorders, refer to the instruction manual of the external device used.

1 Select MENU > [¥ System Setup] > [SDI Output] > [On].
2 Select MENU > [¥ System Setup] > [SDI Output Signal] > Desired option.

(i) NoTES

¢ You can select a video output signal compliant with Level A of the SMPTE ST 425-1 standard.

¢ Depending on the external recorder, you may not be able to record at the desired video configuration.

e After you connect the camera to the external recorder, make a test recording first to check that audio and
video are recorded correctly on the external recorder.



Connecting to an External Monitor or Recorder

Using the HDMI OUT Terminal

The digital signal that is output from the HDMI OUT terminal includes the video signal and audio signal. You can
output also the time code signal, recording command and various assistance displays (onscreen displays,
markers, etc.) in order to check them also on an external monitor.

1 Connect the HDMI cable to the HDMI OUT terminal.

2 Select MENU > [¥ System Setup] > [HDMI Output Signal] > Desired option.

3 To output the time code signal, select MENU > [ £% Recording/Media Setup] > [HDMI Time Code] >
[On].

(i) NnoTes

¢ You can set MENU > [ System Setup] > [Linked to HDMI Monitor] to [On] to automatically change the HDMI
OUT terminal’s output resolution according to the capabilities of the connected monitor. When this setting is
set to [Off], the output resolution is set according to the menu settings and if the connected monitor is not
compatible with the signal output from the camera, HDMI output will stop.

e The HDMI OUT terminal is for output only. Do not connect the camera to another device’s output terminal
using the HDMI OUT terminal as this will cause a malfunction.

e Correct operation cannot be guaranteed when connecting the camera to DVI monitors.

¢ Video may not be output correctly depending on the connected external monitor/recorder or the HDMI cable
used. In such case, use another terminal.

RAW Video Output from the HDMI OUT terminal

You can output video in RAW format from the HDMI OUT terminal and perform 6K recording with a compatible
recorder. During video output, you can also record video to card B simultaneously.

1 Select MENU > [£% Recording/Media Setup] > [Sensor Mode] > [Full Frame].

2 Select MENU > [£% Recording/Media Setup] > [System Frequency] > [59.94Hz] or [50.00Hz].

3 Select MENU > [£% Recording/Media Setup] > [Frame Rate] > [59.94P] or [50.00P].
e Change the main recording format to a format that allows you to select [Frame Rate] > [59.94P] or [50.00P].
4 Select MENU > [£% Recording/Media Setup] > [HDMI RAW] > [On].
5 When recording to card B, select MENU > [ £% Recording/Media Setup] > [2nd Card Rec Functions]
> an option other than [Off].

Video Output Configuration

Main recording video configuration HDMI OUT terminal
Main recording format Main resolution* Frame rate Resolution Frame rate
59.94P 59.94pP
HDMI RAW 6000x3164 4096x2160
50.00P 50.00P

* Bit depth will be 10 bit.

(i) NoTES

e MENU > [£® Recording/Media Setup] > [Recording Modg] is set to [Normal Recording].

¢ Image will not be displayed correctly when connected to a device that is not compatible with the camera's
HDMI RAW output function.
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Connecting to an External Monitor or Recorder

When set to HDMI RAW, The following settings are not applied to video output from the HDMI OUT terminal:
- Any of the MENU > [[E) Monitoring Setup] > [B&W Image:], [Anamorphic:], [OSD Output:], [OSD
Orientation:], [View Assist:] options.
- Any of the MENU > [ Assistance Functions] > [Peaking:], [False Color:], [Zebra:], [WFM:] or [Markers:]
156 options.

When set to HDMI RAW, the following settings cannot be used:
- MENU > [ Assistance Functions] > [Magn. Output] > [HDMI].
- MENU > [¥ System Setup] > [HDMI Output Signal] and [Linked to HDMI Monitor].
- [Output: 6060(24)fps] and [Output: 60 60(30)fps] (assignable functions).

Selecting the Output Range

You can select the output range of video signals (when using log gamma or PQ/HLG HDR) output from the SDI
OUT terminal / HDMI OUT terminal to determine how the image levels are mapped to code values. Moreover,
you can select the setting independently for Canon Log output and for HDR output.

Applied output range settings

Custom picture file Applied range settings
) [Gamma/Color Space] .
[Gamma] [Look File] after the Look File is applied MENU > [[Z) Monitoring Setup] > [Range]
0 —
[Canon Log 2] [off [During Canon Log Output]
[Canon Log 3] [on] [Conform to Custom Picture]
0 —_
[Pl (o [During HDR Output]
[HLG] [on] [Conform to Custom Picture]
[BT.709 Wide DR] [Off] -
[BT.709 Standard]
[Canon 709] [On] [Conform to Custom Picture] ) N
(Fixed narrow range)
[SDR BT.709]
[SDR BT.2020]
- [On]
[HDR PQ(BT.2100)]
[During HDR Output]
[HDR HLG(BT.2100)]

1 Select MENU > [[Z) Monitoring Setup] > Desired [Range] option.
2 Select [During Canon Log Output] or [During HDR Output] > Desired option.

Options (SDI OUT terminal)
[Full Range]:  The signal output will use full range coding.

[Narrow Rangel:
The signal output will use narrow range (video range) coding.

Options (HDMI OUT terminal)

[Full Range Priority]:
The signal output will use full range coding whenever possible but will change the range
automatically according to the capabilities of the connected monitor.

[Narrow Range]:
The signal output will use narrow range (video range) coding.
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(i) Nnotes

¢ During playback, the applied range is determined according to the gamma used at the time of recording.
e When [View Assist:] (7] 159) are set to [On], output range settings are disabled.

Superimposing Onscreen Displays on Video Outputs

You can output the camera's onscreen displays along with the video output from the SDI OUT terminal / HDMI
OUT terminal to check the onscreen displays on an external monitor. You can also adjust the opacity level of
superimposed onscreen displays. This setting will not affect your recordings.

Select MENU > [[=) Monitoring Setup] > [OSD Output: SDI] or [OSD Output: HDMI] > [On].

. appears on the right of the screen (In CAMERA mode, only if MENU > [[E) Monitoring Setup] >
[Custom Display 2] > [OSD Output] is set to [On]).

(i) NoTES

e Assistance functions will not be superimposed when the [OSD Output:] options are set to [Off (Clean)] or [Off],
with the following exceptions.
- Magnification
- Range display when [Custom Picture] > [Skin Detail] or [Color Correction] is set

* \When only peaking/zebra pattern/false color is superimposed, set the desired [OSD Output:] option to [On]
and set the onscreen display level to [DISP Level 3].

e |f you set an assignable button to one of the [OSD Output:] options, you can press the button to turn the
camera’s onscreen displays on and off.

Changing the Opacity Level of Onscreen Displays

You can make onscreen displays more visible or less conspicuous by changing their opacity level. You can select
to which screens to apply the opacity levels. This function allows you to reduce screen glare when recording in
dark places.

1 To change the visibility of onscreen displays on individual video outputs, select MENU >
[[=D Monitoring Setup] > Desired [OSD Opacity:] setting > [On].

2 Select MENU > [(Z) Monitoring Setup] > [OSD Opacity Level] > Desired option.
* The smaller the percentage the more transparent the onscreen displays.

3 Select MENU > [[Z) Monitoring Setup] > [OSD Opacity: Appl. Screens] > [All] or [Only Rec/Playback
Screens].

e You can apply the selected opacity level to all onscreen displays (including menus, etc.) or only to onscreen
displays on the shooting and playback screens.

(i) Nnotes

e |f you set an assignable button to one of the [OSD Opacity:] settings, you can press the button to change the
opacity level of onscreen displays on the corresponding video outputs.
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Applying the View Assistance Function to the LCD Screen

When a special gamma curve/color space is selected in the custom picture file, you can easily convert the image
output by enabling the View Assistance function, resulting in a gamma curve/color space optimal for viewing on
158 BT.709 compliant monitors.

List of view assistance
View assistance Gamma curve Color space Description

Converts the gamma curve/color space of the image output, resulting in a
[CMT 709] CMT 709 BT.709 standard gamma curve/color space. It produces a look suitable for a cinema
production, keeping a wide dynamic range without clipping when log recording.

These settings produce a look appropriate also for use without post processing,
[Canon 709] Canon 709 BT.709 featuring high contrast while ensuring a wide dynamic range optimized for
playback on BT.709 compliant monitors.

LUT for viewing HDR (high dynamic range) images. The view assistance follows
: ] curve BT.709 the ITU-R BT.2100 transfer function to convert a brightness range of 1600% or
[HDR Assist. (1600%)] 400% respectively into a linear brightness scale.

i 1
[HDR Assist. (400%)" | oyiginal gamma

! Only MENU > [[Z Monitoring Setup] > [View Assist: LCD] can be selected.

Available view assistance options

Availability and whether or not the View Assistance function can be applied depend on the [Gamma/Color
Space] and [Look File] settings in the custom picture file (11 129). If these settings are changed, View
Assistance will be turned off.

Custom picture file Available View Assistance options
[Look File] aﬂiffh";":xi";ﬁ; ?spz;:]"e ; [CMT 709] [Canon 709] [HDR Assist. (400%)]  [HDR Assist. (1600%)]
[0ff] - .
See the following table (A).
[Conform to Custom Picture]

[SDR BT.709] - - - -
[on] [SDR BT.2020] - - - -
[HDR PQ(BT.2100)] @ o [ o
[HDR HLG(BT.2100)] @ o [ J -

Available view assistance options (A)

Custom picture file Available View Assistance options
[Gamma/Color Space] [CMT 709] [Canon 709] [HDR Assist. (400%)] [HDR Assist. (1600%)]

[Canon Log 2 / C.Gamut] [ J o o (]
[Canon Log 3 / C.Gamut] [ ) o o o
[Canon Log 3/ BT.2020] @ o ] o
[Canon Log 3/ BT.709] @ o - -
[PQ / BT.2020] [ J ( J ([ ([
[HLG / BT.2020] o ( J ([ -
[Canon 709 / BT.709]

[BT.709 Wide DR / BT.709] - - - -
[BT.709 Standard / BT.709]
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Applying the View Assistance Function

1 Select MENU > [[Z) Monitoring Setup] > desired [View Assist:] setting > [On].

¢ The view assistance function is applied and the gamma curve and color space of the displayed image will
change.

e The signal output will use narrow range (video range) coding.
2 Select MENU > [[E) Monitoring Setup] > desired [Select View Assist:] option > desired setting.

(i) Nnotes

¢ The colors modified by using this function are an approximation.

* If you enable MENU > [ Assistance Functions] > one of the [False Color:] settings, the effect of the view
assistance is temporarily removed.

Adjusting the Gain Difference When Converting HDR to SDR
You can adjust the SDR gain difference relative to HDR within a range of = 7.5 dB (in 0.5 dB increments) in the
following cases:

¢ \When the main clip is set to HDR* and a view assistance function that changes the color space to CMT 709 /
Canon 709 is applied to the output.

¢ \When the main clip is set to HDR* and [Proxy Rec Color Conversion] is set to [BT.709 (Canon 709)] / [BT.709
(CMT 709)].

* When the [Gamma/Color Space] setting in the custom picture file is set to [PQ / BT.2020] or [HLG / BT.2020], or when the
[Gamma/Color space] setting after applying a Look File is set to [HDR PQ (BT.2100)] or [HDR HLG (BT.2100)].

Select MENU > [[Z) Monitoring Setup] > [Gain for HDR—>SDR Conv.] > Desired option.
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Audio Output Channels

Audio Output Channels

The camera can output audio from the SDI OUT terminal, HDMI OUT terminal, () (headphone) terminal or
speaker. When recording or playing back clips recorded with 4-channel audio, you can select which audio
channels are output from the HDMI OUT terminal and headphones.

Audio output configuration

Recorded audio configuration Audio output during recording/playback
Audio format Audio bit depth SDI OUT terminal HDMI OUT terminal () (headphone) terminal
4-channel . 4-channel 2-channel
) 24 bit ; )
linear PCM linear PCM linear PCM 2 channels
2-channel AAC 16 bit 24 bit 16 bit

To select the audio channels for headphone output

Select MENU > [)) Audio Setup] > [Monitor Channels] > Desired audio output option (L/R).

e Options like [CH1+2] indicate that two audio channels (CH1 and CH2 in this example) are mixed and output
from the same side.

To select the audio channels for HDMI output
Select MENU > [ ) Audio Setup] > [HDMI OUT Channels] > [CH1/CH2] or [CH3/CH4].



Importing Files to a Computer/Smartphone

Importing Files to a Computer/Smartphone

Canon offers software applications as free downloads that allow you to save on a computer/smartphone clips
recorded with the camera, develop RAW clips, and more.

Saving Files

Use Canon XF Utility to save and organize XF-AVC clips and other recorded files on a computer. You can use the
Canon XF plugins to easily use XF-AVC clips directly from Avid non-linear editing (NLE) software. The software
and plugins are available as free downloads from your local Canon website. Check the download page for the
system requirements and latest information.

You will find detailed instructions about installing and uninstalling the software in the "Read This First" file
(Install-XF Utility.pdf) included in the compressed file you will download from the website. For details about using
the software, refer to the instruction manual (PDF file) that is installed with the software.

Canon XF Utility (for Windows/macOS): Software application that allows you to save clips on a computer,
check, play back and organize clips and grab still frames from clips.

Canon XF Plugin for Avid Media Access (for Windows/macOS): Plugin that allows you to easily import clips
from a card or a local folder in the computer to the compatible version of Avid Media Composer (an NLE
application compatible with Avid Media Access), directly from within the application.

Saving XF-HEVC S/XF-AVC S Clips

Make sure to save XF-HEVC S/XF-AVC S clips recorded with this camera to a computer. To do so, you will need
a card reader connected to a computer or a computer with a card slot. For details on transferring files from the
card, refer to the computer’s instruction manual or OS’s help modules.

Under certain circumstances, clips may be split and recorded as separate files. Using MP4 Join Tool you can join
the split XF-HEVC S/XF-AVC S clips and save them as a single seamless clip.

Transferring Files to a Computer

1 Insert the card with the desired clips into the card slot of the computer or card reader connected to the
computer.

2 Follow the OS’s onscreen instructions.

3 Copy the clips on the card to the computer.

e XF-HEVC S/XF-AVC S clips are located in folders named “XFVC/REEL_XXXX” and photos are located in
folders named “DCIM/XXX_mmdd”, where XXX is the folder number and mmdd stands for the recording
date.

Joining Clips Split by the Camera

Use MP4 Join Tool to join XF-HEVC S/XF-AVC S clips split by the camera in the following cases.
¢ \When the camera switches to the other card while recording video due to the relay recording function (1 39).
¢ The video (stream) file in the clip will be split approximately every 4 GB.

MP4 Join Tool is available as a free download (for Windows or macOS) from your local Canon website. Check
the download page for the system requirements and latest information.

You will find detailed instructions about installing and uninstalling the software in the "Read This First" file (Install-
MP4 Join Tool.pdf) included in the compressed file you download. For details about using the software, refer to
the instruction manual (PDF file) that is installed with the software.
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Saving Audio Files (WAV)

Audio files in WAV format can be saved to a computer in the same way as XF-HEVC S / XF-AVC S files. Copy the
desired audio files (located in the “/PRIVATE/AUDIO” folder of the SD card) to the computer.

Developing RAW Clips

Use Cinema RAW Development to develop RAW clips shot/recorded with the camera. After you develop the
clips and export them to a full-quality standard file type such as DPX, they will be ready for color grading.
Alternatively, you can use the Canon RAW Plugin to easily use RAW clips unaltered (in RAW format) directly from
major non-linear editing (NLE) applications. The software and plugin are available as free downloads from your
local Canon website. Check the download page for the system requirements and the latest information.

You will find detailed instructions about installing and uninstalling the software in the “Read This First” file
(Install-Cinema RAW Development.pdf) included in the compressed file you will download from the website. For
details about using the software, refer to the instruction manual (PDF file) that is installed with the software.

Cinema RAW Development (for Windows/macOS): Software application that allows you to develop, play back
and export RAW clips.

Canon RAW Plugin for Avid Media Access (for Windows/macOS): Plugin that allows you to easily import RAW
clips to the compatible version of Avid Media Composer (an NLE application compatible with Avid Media
Access), directly from within the application.

Canon RAW Plugin for Final Cut Pro (macOS): Plugin that allows you to easily import RAW clips to Apple’s
Final Cut Pro, directly from the application.

Saving Recordings to a Smartphone

You can save XF-HEVC S / XF-AVC S clips recorded with the camera, as well as WAV audio, photos and News
Metadata files to a smartphone. Content Transfer Professional is needed for this operation. You can connect a
smartphone to the camera using a compatible USB cable* or the network functions ([J] 195).

* For details on compatible USB cables, visit your local Canon website.

Smartphone

Connection port

Compatible USB cable

1 Select MENU > [¥ System Setup] > [USB Mode] > Desired option.
For iOS devices: select [Canon App(s) for iPhone].
For Android devices: select [Canon App(s)/GP-E2].

2 Connect the smartphone to the camera using a compatible USB cable.
3 Open the application on the smartphone.

4 Use the application to save the files.

5 When the connection ends, disconnect the USB cable from the camera.
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Automatically Transferring Recording Data to an FTP Server

You can use Content Transfer Professional to automatically transfer XF-HEVC S clips, XF-AVC S clips, WAV
audio, photos and News Metadata to an FTP server. Install Content Transfer Professional on your smartphone in
advance ([1] 195).

1 Connect the smartphone to the camera.
When using a USB cable, perform steps 1 to 3 of Saving Recordings to a Smartphone ([11 162).
When using network functions, perform steps 2 to 6 of Transferring Recordings to a Smartphone ([11 195).

2 Smartphone: specify the destination FTP server on Content Transfer Professional, and start the
[Transfer by camera operation] function.

3 Press REC to start recording.
e Recorded clips are automatically transferred.

4 End the connection.
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165
Network functions and connection types

To be able to use the following network functions you will need to connect to a Wi-Fi network, or use the ==5
(Ethernet) terminal on the camera to connect to a wired (Ethernet) network.

Network functions and connection types

Wi-Fi
Wired network
Network function Description
P (Ethernet) Infrastructure? e Agcess =
Point!
Transfer clips recorded with the camera to
FTP File Transfer another device connected to the network @ o o 184

using the FTP protocol.

Stream the camera’s live video and audio over
IP Streaming IP to a compatible IP video decoder connected [ J o - 185
to the network.

Control the camera remotely from the Web
browser of a connected device.

Canon App Transfer clips/audio recorded with the camera
to a smartphone, or apply News Metadata
Transf ) . - - 1
Lcrg?;:;tong?s e created/edited with Content Transfer ® 9

Professional to the camera.

Browser Remote [ ) o o 187

Control the camera remotely using a
XC Protocol controller or application compatible with the [ J o o 193
XC Protocol via an IP connection.

Output metadata information (from the

CV Protocol Ethernet terminal) necessary for virtual e’ - - 173
production in real time on a PC application.
Frame.io® Upload recording data from the camera using ° ° _ 196

Abobe's Frame.io Camera to Cloud function.

1 Connection to a Wi-Fi network via an external access point (wireless router, etc.)

2 Direct connection to one Wi-Fi-enabled device where the camera serves as the Wi-Fi access point.
S 1Pv4 only.

4 Cannot be used outside the service area of Frame.io.

Security

When connecting the camera to a network, make sure to use a secure network environment.

It is recommended to use the camera with the default settings.

When connecting the camera to a network, there is a risk of unauthorized access from unintended third parties
or cyber-attacks. If access from an external network is not required, physically and/or virtually block access so
that only specified devices can access the network. Additionally, Wi-Fi (wireless LAN) may be intercepted by
malicious third parties, posing a risk of eavesdropping on communication content.

If access to an external network is required, it is important to implement a secure method of communication,
such as using a VPN (Virtual Private Network) that can block access from the outside. Use Wi-Fi in a secure
environment. AES encryption is recommended.

In particular, the following functions do not support protocol encryption for communication with the camera;
therefore, use these functions in a secure network environment.

e Canon App (Content Transfer Professional)

e CV Protocol
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@ wPorTANT
e Canon shall not be liable for any direct or indirect damages caused by network security issues.

e The camera cannot be directly connected to the communication lines (including public wireless LAN) of
telecommunications carriers (mobile communications companies, fixed-line communications companies,
Internet providers, etc.). When connecting the camera to the Internet, be sure to connect via a router or similar
device.

Before using the network functions

¢ The instructions in this chapter assume you already have a correctly configured and working network and
correctly configured network device(s). If necessary, refer to the documentation provided with the network
devices you plan to use.

e Configuring the network settings requires adequate knowledge about configuring and using wired (Ethernet)
and/or wireless (Wi-Fi) networks. Canon cannot provide support regarding network configurations.

@ vrorTANT

e In case it is necessary to set a password for network connections or function settings, make sure to set a
secure password that is long enough to be hard to guess, including a combination of characters and symbols.
Use caution not to lose the password.

(i) NoTES

e Do not open the card compartment cover while using network
functions.

e Do not place cables connected to the camera’s SDI OUT terminal or
HDMI OUT terminal, INPUT terminals, MIC terminal or USB terminal
near the built-in wireless antenna. Doing so may negatively affect the
wireless communication or the audio recorded.

Built-in wireless antenna

Using a Wi-Fi Network

Wi-Fi Connection Types

You can connect the camera in Infrastructure mode, using an access point (wireless router etc.), or in Camera
Access Point mode, directly to a network device. The type of connection you can use, depends on the network
function you wish to use ([1] 165).

For an Infrastructure connection, the camera offers 4 ways to configure an access point and the method you use
will depend on the type and specifications of the access point and network you plan to use.

Camera Access Point: When shooting in a location where there are no access points available, the camera can
serve as a wireless access point*. Wi-Fi enabled devices will be able to connect to the camera directly.

* Limited only to the connection between the camera and supported Wi-Fi enabled devices. The functionality is not the same as
that of commercially available access points.



Network functions and connection types

Infrastructure connection:

WPS (button): If your wireless router supports Wi-Fi Protected Setup (WPS), setup will be pp—

easy and require minimal configuring and no passwords. To check if your wireless router @ SETUP

has a WPS button and for details about how to activate the Wi-Fi protected setup, refer to

the instruction manual of your wireless router. 167

WPS (PIN code): Even if your wireless router does not have a dedicated WPS button, it may support WPS using
a PIN code instead. For setup using a PIN code, you will need to know in advance how to activate the wireless
router’s WPS function. For details refer to the instruction manual of your wireless router.

Searching for Access Points: If your access point does not support the WPS function or you cannot activate it,
you can have the camera search for access points in the area.

Entering the SSID and authentication method: Manually enter the SSID and other information about the access
point.

@ vrPoRTANT

e Depending on the country/region of use, some restrictions on outdoor use or Camera Access Point
connections may apply when using the IEEE 802.11b/g/a/n/ac wireless standard. Check in advance the
applicable areas of use and restrictions.

Using a Wired (Ethernet) Network

Connect a commercially available Ethernet cable to the camera’s =% (Ethernet) terminal to use a wired network.
Use Category 5e, shielded twisted pair (STP) Ethernet cables compatible with Gigabit Ethernet (1000BASE-T)
and with good shielding capability. For more details about Ethernet cables, refer to the manufacturer’s instruction
manual.

Connecting

Ethernet terminal

Ethernet port on a
network device

Ethernet cable
(commercially available)

0O00OO0OO0ODO0OODO
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Configuring Connection Settings

To connect to a network you will need to define in advance a connection setting (SET), which is a combination of

one or two communication settings (networks, NW) and one or two network function settings (MODE). You can
168  savein the camera up to 25 individual communication settings and function settings, and up to 20 combinations

— of connection settings (SET1 to SET20).

To configure a connection setting for the first time, you will follow the setup wizard ([J] 169). Using the wizard,

you can set up only one network and one function per connection setting. After having configured multiple

connection settings, you can change them (for example to add a secondary network or second function) and

you can create new ones combining existing communication and function settings (11 178).

If you configure a connection setting with both the [IP Streaming] and [Browser Remote] network functions, you

will be able to use both functions simultaneously.

Configure the necessary connection settings for the networks and network functions
you wish to use.

Connection setting (SET)

Communication Communication Function Function
Setting 1* (NW) Setting 2 Setting 1* (MODE) Setting 2**
* Configured using the wizard.
S ** Only in CAMERA mode.
Wi-Fi —— FTP transfer
—E Camera Access Point —— IP streaming
Infrastructure Browser Remote

WPS (push button)

WPS (PIN code) Canon App

Detected access points — XC Protocol

SSID/authentication mode input —— CV Protocol
Frame.io

\/ L Ethernet

Select a connection setting appropriate for the network function you wish to use and
start using the function.

Step 2 FTP transfer (1] 184)

IP streaming ([11 185)

Browser Remote ([1] 187)

Canon App (11 172)

XC Protocol ([J1 173)

CV Protocol (1] 173)

Frame.io (11 173)

Activating a Network Connection

Activate the desired network connection to use network functions or to configure the connection setting online.

1 Select MENU > [V Network Settings] > [Network] > [Enable].

2 When using connection settings that you saved previously, select MENU > [#N* Network Settings] >
[Connect] > Desired connection setting ([SET1] to [SET20]) > [OK].

¢ To end the network connection, set [Connect] to [Disconnect] instead.
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Adding a New Connection Setting Using the Wizard

You can use the wizard to set up a new connection setting. This section uses a connection to a Wi-Fi network
using the WPS push button method as an example. Refer to the instruction manual of the access point for
details about the location and operation of the WPS button. 169

1 Enable the network functions ([J] 168).

2 Select MENU > [#W Network Settings] > [New Conn. Setting (Wizard)] > Desired network function >
[OK].

3 Select [Create New Comm. Setting].

e Once you have added multiple communication settings, you can select [Select Existing Setting] to reuse the
settings for a network that you saved previously.

4 Select [Wi-Fi 1.
¢ To configure a wired (Ethernet) network (11 174).
5 Select [Connect with WPS] > [WPS (Push Button)].

¢ To use a different configuration method, complete the corresponding procedure.
Camera Access Point ([J] 174)
WPS using a PIN code ([1] 175)
Detected access points ([J1 175)
SSID/authentication mode input ([J1 175)
Manual setup without connecting to the network ([J1 176)

6 Press and hold the WPS button on the wireless router and then, on the camera, select [OK].
7 To configure the IPv4 settings automatically and not use IPv6 settings, select [Automatic Setting] >
[Disable].
¢ To configure IPv4 settings manually (1] 176).
e To use the default IPv6 settings, select [Enable] instead. After completing the wizard, change the IPv6
settings as necessary ([11 180).
8 Select [OK] to continue to configure the function settings.
e The communication settings are saved to an [NW] file.

e Continue with one the following procedures to configure the selected function’s settings.
FTP transfer (11 169), IP streaming (11 170), Browser Remote ([1] 172), Canon App (11 172),
XC Protocol ([J] 173), CV Protocol (1] 173), Frame.io ([J] 173)

(i) NoTES

e The [WPS (Push Button)] method may not work correctly depending on the devices used or the surrounding
conditions. In such case try using [WPS (PIN Code)] ([0 175) or selecting one of the detected networks
(1 175).

Function Settings
FTP Transfer

This section continues the connection settings wizard ([J] 169). In the function settings you will configure the
FTP server settings and other settings related to the handling of folders and files. If necessary, consult the
network administrator in charge of the FTP server.

1 Select [Create New Func. Setting].

¢ Once you have added multiple function settings, you can select [Select Existing Setting] to reuse the
settings for an FTP server that you saved previously.

2 Select the desired transfer mode.
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3 Configure the destination FTP server. Select [Server] and [Port No.] > [OK].

e Enter the FTP server’s IP address or host name using the keyboard screen. Enter the port number using the
data entry screen ([ 28).

e Usually, the port number used is 21 (FTP or FTPS transfers) or 22 (SFTP transfers).

¢ Depending on the FTP mode selected in step 2, perform either step 4 or steps 4-5 and then continue to
step 6.

SFETP transfers

4 Enter the user name and password for the SSH protocol’s authentication. Select [User Name] and [Password]
> [OK].

¢ Enter the desired user name and password using the keyboard screen (1] 28).

FTP/FTPS transfers
4 Select [Enable] to use passive mode or [Disable] to use active mode.
¢ In most cases, select [Disable].

5 Enter the user name and password for the FTP server. Select [User Name] and [Password] > [OK].
¢ Enter the desired user name and password using the keyboard screen ([1] 28).

All transfer modes
6 Select the destination folder on the server.
7 Select [OK]
e The function settings are saved to a [MODE] file.
8 Select the connection setting (SET1 to SET20) where to save the settings and then select [OK].
¢ The camera will connect to the network and will be ready to use the FTP transfer function (1] 184).

Options for [FTP Mode]

[FTP]: Transfer method where the data is not encrypted.
[FTPS]: Secure transfer method using a root certificate (11 177).
[SFTPI: Secure transfer method using an SSH secure channel.

Options for [Destination Folder]
[Root Directory]:
Files are saved on the root directory of the destination FTP server.

[Select Folder]: Enter the desired path using the keyboard screen ([11 28). If the folder does not exist on the
destination FTP server, it will be created automatically.

IP Streaming

This section continues the connection settings wizard ([J] 169). In the function settings you will configure the
streaming video bit rate and resolution, the protocol used and the receiver’s settings. For details refer to the
instruction manual of the decoder device or software you will use.

1 Select [Create New Func. Setting].

e Once you have added multiple function settings, you can select [Select Existing Setting] to reuse IP
streaming settings that you saved previously.

2 Select the desired protocol.
¢ Depending on the selected protocol, perform steps 3 to 6 if necessary and then continue to step 7.
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[RTP+FEC] streaming

3 Configure the receiver’s settings. Select [Destination Server] and [Dest. Port No.] > [OK].

® Enter the receiver’s IP address using the keyboard screen. Enter the port number using the data entry
screen ([ 28).

e Using the default port number is recommended.
4 Configure the settings used to send FEC packets. Select [FEC Port No.] and [FEC Interval] > [OK].
¢ Enter the port number using the data entry screen ([1] 28).
e Using the default settings is recommended.
e Proceed to step 7.

[RTSP+RTP] streaming
3 Configure the receiver’s settings. Select [Destination Server] and [Dest. Port No.] > [OK].

® Enter the receiver’s IP address using the keyboard screen. Enter the port number using the data entry
screen ([ 28).

e Using the default port number is recommended.

4 Enter the user name and password of the RTSP client. Select [RTSP: User Name] and [RTSP: Password] >
[OK].
¢ Enter the desired user name and password using the keyboard screen ([ 28).
e Proceed to step 7.

SRT
3 Select the connection mode.
Caller: Connect to a decoder or a computer from the camera.

Listener: Listens for connections from the decoder or computer.

4 When [Caller] is selected, enter [Destination Server], [Dest. Port No.] and [Stream D], then select [OK].
e Using the default port number is recommended.

5 When [Listener] is selected, enter [Listening Port No.] then select [OK].
e Enter the port number of the decoder or computer.

6 Select [Encryption Settings], enter [Passphrase] and [Latency], and then select [OK].

All streaming protocols

7 Select the video streaming configuration.
8 Select the audio channels.

9 Depending on the resolution and frame rate, a screen may prompt you to change other settings. Change the
settings as necessary.

10 Select [OK].

¢ The function settings are saved to a [MODE] file.
11 Select the connection setting (SET1 to SET20) where to save the settings.
12 Select [OK].

* The camera will connect to the network and will be ready to start streaming.

13 Connect the decoder to the network and complete any necessary configurations on the receiving side so the
decoder is ready to receive video over IP.

¢ To start streaming, refer to IP Streaming ([11 185).

Options for [Protocol]
[UDPY: This protocol prioritizes transfer speeds but does not guarantee the reliability/integrity of the
data. Lost or delayed IP packets are ignored.
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[RTPY: Standard protocol for video/audio broadcasts over the Internet. Lost or delayed IP packets are
ignored.

[RTP+FEC]: This setting uses the RTP protocol and adds a layer of FEC error correction so the receiving
side* can recover lost or delayed IP packets.

[RTSP+RTP]:  This setting uses the RTSP (real time streaming) protocol to control the streaming server
(camera) in real time and the RTP protocol for the broadcast over IP. With the RTSP protocol,
the receiver can control when to start and stop the broadcast.

[SRT]: A protocol for high-speed transmission that suppresses the occurrence of lost/delayed packets.

Transmitted data can be encrypted.
* A decoder compatible with FEC error correction is required.

Browser Remote

This section continues the connection settings wizard ([J1] 169). A user name and password are required to log
in to the Browser Remote application. In the function settings you will configure up to three different users for
single-user or two-user operation.
1 Select [Create New Func. Setting].
e Once you have added multiple function settings, you can select [Select Existing Setting] to reuse Browser
Remote settings that you saved previously.
2 Enter the user names and passwords as necessary.
3 Select [OK] twice.
¢ The function settings are saved to a [MODE] file.
4 Select the connection setting (SET1 to SET20) where to save the settings and then select [OK].

e The camera will connect to the network and will be ready to accept commands from the Browser Remote
application (11 187).

Canon App (Connecting to a Smartphone)

This section details the necessary settings to connect the camera to a smartphone through a network. Be sure
to connect both the smartphone and the camera to the same network in advance.

A Content Transfer Professional is necessary to connect the camera to a smartphone. For details on
downloading the necessary Content Transfer Professional, refer to Transferring Recordings to a Smartphone
(I 195). For more details, refer to the smartphone’s instruction manual.

1 Select [Create New Func. Setting].
¢ Once you have added multiple function settings, you can select [Select Existing Setting] to reuse Canon App
settings that you saved previously.
2 Select [OK].
3 As indicated on the screen, open the application on the smartphone.
4 Select the camera using the Content Transfer Professional.
e |f the camera and the smartphone are connected to the same network, the camera will be detected
automatically.
5 Select [OK].
e The connection will be completed.
¢ The function settings are saved to a [MODE] file.
6 Select the connection setting (SET1 to SET20) where to save the settings.
7 Select [OK].
e The connection will be completed and the camera will be ready to operate with the connected smartphone

(00 195).
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XC Protocol
Set a user name and password to connect to an XC Protocol compatible device connected to a network.
1 Select [Create New Func. Setting].
2 Set the authentication method used by the XC Protocol (HTTP/HTTPS) server.
e After selecting [Basic Authentication] or [Digest Authentication], set the user name and password.
User name: 5 to 15 alphanumeric characters or symbols.
Password: 8 to 32 alphanumeric characters or symbols (use at least 2 types from each).
3 Select [OK].
e The function settings are saved to a [MODE] file.
4 Select the connection setting (SET1 to SET20) where to save the settings.
5 When the confirmation message appears, press SET.

e The camera will connect to the network and will be ready to accept commands from the remote controller/
application ([ 193).

CV Protocol

Configure the camera to output metadata information necessary for virtual production in real time on a PC
application. Ethernet IPv4 only.

1 Select [Create New Func. Setting].

2 Enter [Destination Server] and [Dest. Port No.] as the destination settings and select [OK].

e Enter the address for the communication method (Unicast/Multicast*/Broadcast) used by the destination
server.
* Transmission is possible only within the same network segment.

e Using the default port number is recommended.
3 Select the connection setting (SET1 to SET20) where to save the settings.
4 When the confirmation message appears, press SET.

e Use the Canon Live Link Plugin for Unreal Engine to send metadata information to applications used for
virtual production. For details about using and downloading Live Link Plugin for Unreal Engine refer to the
Canon website.

(i) NoTES

¢ \When the set slow & fast motion recording frame rate exceeds 60P, [CV Protocol] cannot be used at the same
time.

Frame.io

Set up a connection between the camera and Frame.io.

1 Select [Create New Func. Setting].
e [f there is a previously registered function setting related to Frame.io, you can select it from [Select Existing
Setting].
2 Select the pairing destination.
[Keep Current Pairing]: Maintains the pairing status with the camera.
[Create New Pairing]:  Creates a new pairing with Frame.io. If you want to re-pair when the camera is already
paired, select [OK].
3 Select [OK].
e The pairing code is displayed.
e |f [Keep Current Pairing] is selected, proceed to step 6.
4 From Frame.io: Access Frame.io and enter the pairing code.
e The camera is paired with Frame.io.
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5 Select [OK].
6 Select [Auto Upload File Formats].

[XF-AVC Proxy]: Proxy clips in XF-AVC format.

[XF-HEVC S/XF-AVC S Proxy]: Proxy clips in XF-HEVC S/XF-AVC S format.

[Audio Proxy]: Audio recording files (second card recording functions).
7 Select [OK].

¢ The function settings are saved to a [MODE] file.
8 Select the connection setting (SET1 to SET20) where to save the settings, then select [OK].
¢ The connection is completed. Refer to Uploading Recording Data to Frame.io ([1] 196) for operation details.

Other Connection Methods
This section explains how to configure communication settings using methods other than the WPS push button.

Ethernet Settings
1 In the [Network Type] screen, select [Ethernet =5s].

2 Make sure the Ethernet cable is correctly connected ([1] 167) and select [Setup with Network Connection].

e Select [Setup without Network Connection] to only configure the settings, without connecting to the
network.

3 Set the IP address ([1] 176).
4 Select [OK] to continue to configure the function settings.
e The communication settings are saved to an [NW] file.
¢ Continue with one the following procedures to configure the selected function’s settings ([J1 169).

Camera Access Point

Connect a network device with the camera’s access point. Two configuration methods are available: easy
connection and manual connection.

1 In the [Select a network] screen, select [Camera Access Point Mode].

2 Select the configuration method.
¢ Depending on the selected method, perform either step 3 or steps 3-7 and then continue to step 8.

Easy Connection

3 The camera will assign the network name (SSID) and password automatically. Review the settings for the
camera’s Wi-Fi access point and select [OK].

¢ These settings are necessary to connect a network device to the camera.

[Manual Connection]

3 Enter the SSID (network name) for the Camera Access Point and then select [OK].
¢ Enter the desired network name using the keyboard screen ([11] 28).
4 Select the Wi-Fi channel.

e Select [Automatic Setting] to have the camera select the channel automatically, or select [Manual Setting] >
Desired channel.

5 Select the encryption settings.
e Select [AES] to use AES encryption, or [Disable] to use no encryption.
e |f you selected [Disable], skip to step 7.
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6 Enter the password for the Camera Access Point and then select [OK].
e Enter the desired password using the keyboard screen ([] 28).
7 Set the IP address ([11 176).

Both configuration methods

8 Select [OK] to continue to configure the function settings.

* The communication settings are saved to an [NW] file.

¢ Continue with one the following procedures to configure the selected function’s settings ([ 169).
9 Before you can save the connection setting, connect the network device to the camera.

e Activate the device’s Wi-Fi function, select the camera’s SSID (network name) from the list and enter the
password to connect to the camera.

WPS using a PIN Code

Connect to an access point using a PIN code. For most wireless routers, you must use a Web browser to
access the setup screen. For details on how to set up the access point, refer to the access point’s user manual.

1 In the [Select a network] screen, select [Connect with WPS] > [WPS (PIN Code)].
® The camera will generate and display an 8-digit PIN code.
2 Enter the PIN code into the wireless router’s WPS (PIN code) setup screen and then, on the camera, select
[OK].
3 Set the IP address ([J1 176).
4 Select [OK] to continue to configure the function settings.
e The communication settings are saved to an [NW] file.
¢ Continue with one the following procedures to configure the selected function’s settings (11 169).

Detected Access Points

The camera will automatically detect access points in the vicinity. After you select the desired access point, you
only need to enter the selected network’s password to connect the camera. Be sure to activate tethering in
advance when using a smartphone as an access point. For details about the access point’s network name
(SSID) and password refer to the wireless router’s instruction manual or consult the network administrator in
charge of the access point.

1 In the [Select a network] screen, scroll through the list of detected networks and select the desired network.

e [f the access point is encrypted, enter the password of the access point using the keyboard screen (1] 28).
2 Set the IP address ([1] 176).
3 Select [OK] to continue to configure the function settings.

e The communication settings are saved to an [NW] file.

¢ Continue with one the following procedures to configure the selected function’s settings (11 169).

SSID/Authentication Mode Input

You can connect to a specific access point by manually entering its details. For details about the access point’s
network name (SSID) and password refer to the wireless router’s instruction manual or consult the network
administrator in charge of the access point.

1 In the [Select a network] screen, select [Enter SSID/Authentication Method].
2 Enter the SSID (network name) of the desired network and then select [OK].
e Enter the desired network name using the keyboard screen ([1] 28).
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3 Select the network’s authentication method.

e |f you select [Open System], select [Disable] (no encryption) and skip to step 6, or select [WEP] and continue
the procedure.

e |f you select [Shared Key] or [Open System] > [WEP], select the key index.
e |f you select [WPA/WPA2/WPA3-Personal], proceed to step 4.
e |f you select [WPA/WPA2/WPA3-Enterprise], proceed to step 5.
4 Enter the password of the desired network and then select [OK].
¢ Enter the desired password using the keyboard screen ([] 28).
5 Set the IP address ([1] 176).
6 Select [OK] to continue to configure the function settings.
e The communication settings are saved to an [NW] file.
¢ Continue with one the following procedures to configure the selected function’s settings (11 169).

Offline Configuration without Connecting to a Network
1 In the [Select a network] screen, select [Configure Offline].

2 Select the network type.

e |f you select [Infrastructure], continue with the procedure to enter the SSID and authentication mode, from
step 2 (] 175).
If you select [Camera Access Point Mode], continue from that procedure, from step 2 (11 174).

Configuring the Camera’s IP Address

This section explains how to configure the IP address. Available settings will change depending on the network
function selected.

1 Select the method used to configure IPv4 settings, [Automatic Setting] or [Manual Setting].

¢ \When using the wizard to add a new connection setting, make the selection in the [IP Address Settings
(IPv4)] screen.

e If you select [Automatic Setting], skip to step 4.

Manual Setting

2 Select [IP Address] and [Subnet Mask] and enter the desired addresses using the data entry screen ([11 28).
¢ To use a default gateway, select [Use Gateway| > [Enable] and then select [Gateway] and enter the address.
e To use a DNS address, select [Use DNS Address] > [Manual Setting] and enter the address.

3 Select [OK].

Both methods

4 Select whether to use TCP/IPv6 settings or not.
e To use IPv4 settings, select [Disable].
e To configure IPv6 settings (1] 180).
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Other Network Settings

Reading/Deleting a Root Certificate for FTP Transfer

When you use the [FTPS] transfer mode, you will need to read onto the camera the same root certificate saved
on the FTP server. You can also check the content of a previously loaded root certificate or delete it.

1 Set the camera to MEDIA mode.

2 Save the desired root certificate file onto the root directory of a card and insert it into card slot B.

3 Select MENU > [#W Network Settings] > [Advanced Settings] > [FTP Transfer Settings] > [Read Root
Certificate] > [OK].
* The root certificate file is read from the card.

e After reading a root certificate file, you can select [Root Certificate Details] to check the certificate’s issuer
and expiration date, or select [Delete Root Certificate] to delete the root certificate in the camera.

(i) NoTES

¢ Only one root certificate, with one of the following file names, can be read by the camera: “ROOT.CER”,
“ROOT.CRT” and “ROOT.PEM”.

e |f you transfer files using FTPS transfer with a self-signed certificate, you may not be able to trust the
destination server.

802.1X Authentication

The camera is compatible with the following protocols.
EAP-TLS: X.509 supported
EAP-TTLS, PEAP: MS-CHAP v.2 supported

Select MENU > [#V* Network Settings] > [Advanced Settings] > [802.1X Authentication] > [Setup
Wizard).
¢ Follow the wizard to complete the authentication settings.
When you select the [EAP-TLS] protocol, the root certificate (8021X_R.CER), client certificate (8021X_C.CER)
and private key (8021X_C.KEY) will be read from the card.
When you select the [EAP-TTLS] or [PEAP] protocol, select [User Name] and [Password] and enter the
information using the keyboard screen ([I] 28). Then, read the root certificate from the card. Each must be
saved directly in the card’s root directory.

e After reading the authentication files, select [Check Settings] to check their content. Select [Delete Settings] to
delete the authentication files in the camera.

Reading/Deleting a Root Certificate for Frame.io Upload
This section describes how to read a root certificate onto the camera when using Frame.io.

1 Save the desired root certificate file onto the root directory of a card and insert it into card slot B.
2 Select MENU > [#W Network Settings] > [Frame.io] > [Root Certificate].
3 Select [Read Root certificate], then select [OK].

* The root certificate file is read from the card.

e After reading a root certificate file, you can select [Root Certificate Details] to check the certificate’s issuer
and expiration date, or select [Delete Root Certificate] to delete the root certificate in the camera.

(i) NoTES

e Only one root certificate, with one of the following file names, can be read by the camera: "FRAMEIO.CER",
"FRAMEIO.CRT" and "FRAMEIO.PEM",
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Giving a Nickname to the Camera

You can give the camera a nickname that is used on network connections and network devices to make it easier
to identify.

Select MENU > [V Network Settings] > [Nickname].
¢ Enter the desired nickname using the keyboard screen (11 28).

Checking and Changing Connection Settings (SET)

You can check and, if necessary, change the settings of connection settings (SET) registered in the camera. In
addition to deleting and renaming connection settings, you can also add to a connection setting a secondary
network or second function.

Checking the Content of a Connection Setting

Select MENU > [#W Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20))
> [Check Settings].

¢ The detailed content of the connection setting is displayed.

e Push the joystick left/right or turn the SELECT dial to review all the settings and press the CANCEL button to
return to the menu.

Changing Settings using the Wizard
1 Select MENU > [#8* Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to
[SET20]) > [Change with Wizard)].

2 Select the desired network function and then follow the wizard as described in the previous procedure (from
step 3, [1] 169) and make any changes as necessary.

Changing Connection Settings using Existing Settings

You can use previously registered communication settings ([NW] files) or function settings ((MODE] files) to easily
replace the content of a connection setting or to add a second network or network function in addition to those
registered using the wizard.

1 Select MENU > [ Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to
[SET20]) > [Select Existing Setting].

To add/replace a communication or function setting
2 Select the setting you want to change > [Select Existing Setting] > Desired NW or MODE file.
¢ In the list of communication settings and function settings registered in the camera, only those that can be
selected will be displayed in white and others will be grayed out.
3 Select [Set].

e |f necessary, select [Check Comm. Settings] or [Check Function Settings] to check the content of the
selected file before making the change.
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To delete a communication or function setting
2 Select the setting you want to remove > [Clear Selected] > [OK].

(i) NoTES

¢ A connection setting can have two communication settings (primary/secondary network) and up to two
function settings (only for [IP Streaming] and [Browser Remote]).

e |f both communication settings are deleted, the connection setting itself will be reset and will appear as
[Unspecified].

Renaming Connection Settings
You can rename connection setting (SET) files to make them easier to identify from the list.

Select MENU > [V Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20])
> [Settings Name].
¢ Enter the desired name (up to 12 characters) using the keyboard screen ([1] 28).

Deleting Connection Settings

Select MENU > [#W Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20])
> [Delete Settings] > [OK].
¢ The connection setting will be deleted.

(i) NoTES

e Even if you delete a connection setting, the individual communication/function settings stored in it are not
deleted. You can reuse these settings to configure other connection settings.

Checking and Changing Communication Settings (NW)/Function Settings (MODE)

You can check the content of communication settings ([NW] files) and function settings ((MODE] files) saved in
the camera and change or delete them as necessary.

Checking the Content of a Communication Setting/Function Setting
1 Select MENU > [V Network Settings] > [Advanced Settings] > [Communication Settings] or [Function
Settings].
2 Select the desired communication setting ((NW1] to [NW25]) or function setting (MODE1] to [MODE25)).
3 Select [Check Settings].
e The detailed content of the selected setting is displayed.

e Push the joystick left/right or turn the SELECT dial to review all the settings and press the CANCEL button to
return to the menu.

Changing/Deleting Communication Settings/Function Settings

1 Select MENU > [#8 Network Settings] > [Advanced Settings] > [Communication Settings] or [Function
Settings].

2 Select the desired communication setting ((NW1] to [NW25]) or function setting (MODE1] to [MODE25)).

3 Select [Change Settings] and change the various settings as necessary.
e |fin step 2 you selected an [Unspecified] settings file, the only option available is [Create New with Wizard]

(11 169).

e Select [Delete Settings] > [OK] to delete the communication setting/function setting.
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Configuring TCP/IPv6 Settings
If in the wizard you selected [Enable] to use IPv6 settings, change the settings as necessary after completing the
wizard.

1 After step 3 in the previous procedure, select [TCP/IPv6] > [TCP/IPv6 Settings] > [Enable].
e This step is not necessary if you selected [Enable] when you used the wizard to add a new connection
setting.
e Continue the procedure to change the default IPv6 settings.
2 To configure the IPv6 settings manually, select [Manual Setting] > [Enable].
¢ [DNS Server] changes to [Manual Setting].
3 Select [DNS Server] > Desired option.
e |f you selected [Disable] in step 2, you can set [DNS Server] to [Auto Assign].
¢ \When not using a DNS server, select [Disable].
4 If you set [DNS Server] to [Manual Setting] in step 3, configure the [DNS Address].
¢ Enter the IP address using the data entry screen ([ 28).

When [Manual Setting] is set to [Enable]

5 Select [Manual Address] (manually entered IPv6 address), [Prefix Length] (bits available for the network
address) and [Gateway] (gateway’s IP address) and enter the necessary information.

¢ Enter the IP addresses and prefix length using the data entry screen ([ 28).

Individual settings available for manual change (communication settings)

Menu item Setting options and additional information
[Wi-Fi]
[SSID] -
[Advanced Settings] [Authentication Method], [Password]
[TCP/IPv4]
[IP Address Settings]* [Automatic Setting], [Manual Setting]
[DNS Server] [Disable], [Auto Assign], [Manual Setting]

[DNS Address]*, [IP Address]*,
[Subnet Mask]*, [Gateway]*

[TCP/IPv6]
[TCP/IPv6 Settings]* [Disable], [Enable]
[Manual Setting] [Disable], [Enable]
[DNS Server] [Disable], [Auto Assign], [Manual Setting]
[DNS Address],
[Manual Address], Enter the desired address using the data entry screen ([1] 28).

[Prefix Length], [Gateway]
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Individual settings available for manual change (function settings)

Menu item Setting options and additional information
[FTP Transfer]
[Destination Server] 181
[Server]*, [Port No.]* —
[User Name/Password]

[User Name]*,
[Password]*
[Destination Folder]*

[Dest. Folder Structure] [Default], [Camera]

[Overwrite Files] [Skip], [Save As (New Name)], [Overwrite]

Determines how to deal with files to be transferred when files with the same name already exists in the
destination folder.

[Skip]: The file will not be transferred.

[Save As (New Name)]: The file will be transferred and “_1” will be added to the end of the file name.
[Overwrite]: The file will be transferred, overwriting any file with the same name on the FTP server.

[Passive Mode]* [Disable], [Enable]
[New Folder by Date] [Enable], [Disable]
[IP Streaming]

Protocol]* [UDP], [RTP], [RTP+FEC], [RTSP+RTP], [SRT]

[

[Destination Server]*,
[Dest. Port No.]*,
[FEC Port No.]*

[FEC Interval] 10 to 100 (intervals of 5)
[RTSP: User Name]*,
[RTSP: Password]*
[
[
[
[
[
[

SRT: Connection Mode] [Caller], [Listener]
SRT: Stream ID]

SRT: Listening Port No.]
SRT: Encryption Settings] | [Disable], [AES-128], [AES-192], [AES-256]
SRT: Passphrase]
SRT: Latency]

[Video Output Conf.]* [9Mbps/1920x1080 59.94P], [4Mbps/1920x1080 59.94P], [9Mbps/1920x1080 50.00P],
[4Mbps/1920x1080 50.00P], [9Mbps/1920x1080 59.94i], [4Mbps/1920x1080 59.94i],
[9Mbps/1920x1080 50.00i], [4Mbps/1920x1080 50.00i]

[Audio Out Channels]* [CH1/CH2], [CH3/CH4]
[CV Protocol]

[Destination Server]

[Dest. Port No.]

* Change these settings as explained in the wizard ([] 169).
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Changing Browser Remote Settings

1 Select MENU > [ Network Settings] > [Advanced Settings] > [Browser Remote Settings].

2 Change the various settings as necessary.

182 e You can select [Port No. (HTTP)] or [Port No. (HTTPS)] to change the port numbers used for each
—— connection. Using the default port numbers (HTTP: 80, HTTPS: 443) is recommended.
¢ To use an HTTPS connection, select [HTTPS] > [Enable].

To use a secure HTTPS connection, use a Camera Access Point connection setting and connect the
network device to the camera using a normal HTTP connection ([J1 187) and download the necessary

certificate from the Browser Remote’s settings tab (] 192). After you import the certificate you
downloaded to your Web browser, you will be able to use a secure HTTPS connection.

To change XC Protocol settings
1 Select MENU > [ Network Settings] > [Advanced Settings] > [XC Protocol Settings].
2 Change the various settings as necessary.
e You can select [Port No. (HTTP)] or [Port No. (HTTPS)] to change the port numbers used for each
connection. Using the default port numbers (HTTP: 80, HTTPS: 443) is recommended.

e When [HTTPS] > [Enable] is selected, you will be able to access XC Protocol-compatible devices connected
to the network via HTTPS communication. To use HTTPS communication, first select [Save HTTPS Self-
signed Cert] to save the self-signed certificate to the SD card in slot B. Next, import the saved self-signed
certificate into the XC Protocol-compatible device to enable HTTPS communication.
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Checking the Network’s Status

Unless you selected to configure a connection setting offline (without connecting to the network), immediately

after configuring a new connection setting, the camera will connect to the network automatically and the

selected function settings will be activated. The icons displayed on the screen will indicate the type of network 183
selected and the connection status. When you disable the network functions or disconnect from the network, —
the icons will disappear.

PN 32min 10

2min U

Network connection icons

2 Wi-Fi (Infrastructure):
In yellow — the camera is connecting to or disconnecting from the network. In white — the
network function can be used.

Wi-Fi (Camera Access Point):
In yellow — starting the camera’s access point. In white — the camera’s access point is ready.
Connect the Wi-Fi enabled device to the camera.

Ethernet:  In yellow — the camera is connecting to or disconnecting from the network. In white — the
network function can be used.

Network function icons

FTPE FTP file transfer ([11 184)
P IP streaming ([11 185)

[CV Protocol | CV protocol (1 173)

- frameio : Frame.io (11 196)

Frame.io upload status icons
[ 00, =11 00, Full: Uploading, upload paused, upload requests are full.



FTP File Transfer

FTP File Transfer

In MEDIA mode, you can transfer clips from the camera to another device connected to the network, using the
FTP protocol.
184  The following explanations assume that the FTP server is on, ready and correctly configured.

Transferring a Single Clip

1 Connect the camera to the desired network and activate the network functions (11 168).
e Select a connection setting with the [FTP Transfer] function setting.

2 Select the desired clip in the [XF-AVC] or [XF-HEVC S / XF-AVC S] index screen ([11 141).

3 Press SET to open the file menu and select [FTP Transfer] > [OK].
e The camera will connect to the FTP server and the file will be transferred.
e Select [Cancel] to interrupt the file transfer in progress.

Transferring All Clips

1 Connect the camera to the desired network and activate the network functions (11 168).
e Select a connection setting with the [FTP Transfer] function setting.

2 Open the [XF-AVC] or [XF-HEVC S/ XF-AVC S] index screen ([1] 141).

3 Select MENU > [V Network Settings] > [FTP Transfer All Clips] > [OK].
e The camera will connect to the FTP server and all the files will be transferred.
e Select [Cancel] to interrupt the file transfer in progress.

@ wPoRTANT

¢ Observe the following precautions when transferring files. Failing to do so may interrupt the transfer and
incomplete files may remain at the transfer destination.
- Do not open the card compartment cover.
- Do not remove the power source or turn off the camera.

e |f incomplete files remain at the transfer destination, check the content and make sure they are safe to delete
before deleting them.

(i) NoTES

* Depending on the access point’s settings and capabilities, it may take some time to transfer files.
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IP Streaming

In CAMERA mode, you can stream the camera’s live video and audio over IP to a compatible IP video decoder*
connected to the network. You can use IP streaming for live broadcasts or to send video reports from a location

with poor network connectivity. 185
* This can be a dedicated video transfer device or decoder software on a computer. For details about compatible decoders, —
please visit your local Canon website.

Configuration of video streamed over IP

Main recording video configuration Streamed video configuration
_ . . Video Audio
Video format  Main resolution Frame rate - - - -
Bit rate Resolution Frame rate Audio format Bit rate
59.94P 59.94P, 59.94i
- 59.94i 59.94i _

XF-AVC, 3840x2160, 4 Mbps, 19201080 . MPEG-2 AAE 256 Kbps

XF-AVC S 1920x1080 50.00P 9 Mbps 50.00P, 50.00i 2 channels
50.00i 50.00i

* When the audio of the primary clip uses 4 channels, you can select which channels to stream over IP.

1 On the receiver’s side: Connect the decoder to the network and complete any necessary
configurations so it is ready to receive video over IP.
e For details refer to the instruction manual of the decoder device or software you will use.

2 On the camera: Connect the camera to the desired network and activate the network functions
(T 168).

e Select a connection setting with the [IP Streaming] function setting.

3 Select MENU > [#\V Network Settings] > [Activate IP Streaming] > [Enable].
e The camera will start streaming video over the selected network.
e You can press the REC button to simultaneously record the same image in the camera.

4 On the receiver’s side: Connect to the camera.

When the streaming protocol is [RTSP+RTP], access the following URL and log in using the RTSP user name
and password ([] 170).

rtsp://XXX.XXX.XXX.XXx/stream

Camera’s IP address

When the streaming protocol is [SRT] and the connection mode is [Listener], access the following URL.

sr‘t://Ixxx.xxx.xxx.xx>§/|xxx...I

Camera’s IP adldress Listener port number
e |f the data to be transmitted is encrypted, enter the SRT passphrase.

5 On the camera: To end the streaming, select MENU > [\ Network Settings] > [Activate IP
Streaming] > [Disable].

@ vrPoRTANT
e Streamed data is not encrypted.

(i) NoTES

e Except when the streaming protocol is RTSP or SRT, once IP streaming is activated, the camera will continue
to broadcast video and audio data over the network, regardless of the status of the receiver. Be careful to set
up the correct IP address and test in advance that the receiving decoder can indeed receive the signals.
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IP Streaming

e Depending on the network used and the connection conditions, you may experience lost or delayed IP
packets.

e After streaming continuously for 24 hours, the camera will stop the IP streaming momentarily and then restart
it automatically.

¢ When using IP streaming together with the Browser Remote function, you may experience stuttering issues in
the streamed video or audio. When the two functions are used simultaneously, it is recommended not to log
out from/reconnect to Browser Remote.

¢ Opening the card compartment cover and removing a card while IP streaming is activated may cause brief
stops in the streamed video and audio.

¢ |P streaming cannot be used in the following cases:
- When the main recording format is set to one of the [XF-HEVC S] or [RAW] options.
- When using a recording mode other than [Normal Recording].

When [2nd Card Rec Functions] is set to an option other than [Off].

When using the camera as a web camera.
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Browser Remote: Controlling the Camera from a Network Device

In CAMERA mode, you can operate the camera remotely using Browser Remote, an application that can be

accesses on a connected network device. Using Browser Remote you can check the camera’s live image and

control various recording settings*. You can also check other important indications, such as remaining recording 187
time on the card, remaining battery charge/power source details, time code, etc. —
* White balance, ISO speed/gain, shutter speed, ND filter, aperture, focus and zoom.

Starting Browser Remote

After connecting the camera to the network In CAMERA mode, you can start the Browser Remote application
on the Web browser* of any network device* connected to the same network.

* A Web browser that supports JavaScript and is enabled to accept cookies is required.
** For details about compatible devices, operating systems, Web browsers, etc., please visit your local Canon website.

Preparations on the Camera

1 Connect the camera to the desired network and activate the network functions ([1] 168).
e Select a connection setting with the [Browser Remote] function setting.

2 Check the Browser Remote’s URL in the [#N® Network Settings] status screen ([11] 213).
¢ \When using IPv6 settings, check the camera’s IP address instead ([1] 213).
e Write down the URL or IP address if necessary.

On the Network Device
1 Connect the network device to the camera or to the same access point as the camera.
2 Start the Web browser on the network device.

3 Enter Browser Remote’s URL.
e Enter the URL / IP address you checked previously into the Web browser’s address bar as follows.

http://XXX.XXX.XXX.XXX:nNN
Sy M
Camera’s IP address Port No. (can be omitted when using the default port no.)

e To use an HTTPS connection, enter "https:" instead of "http:".
¢ \When using IPv6 settings, enter the camera's IPv6 IP address instead.
4 Enter the user name and password.

e Be sure to log in with the user name and password of one of the
users that were set on the camera ([I] 172). If necessary, consult
the administrator who configured the camera’s settings.

* The Browser Remote screen will appear. The screen displayed may Ei;firr”gfpg;gﬂgéog*”tﬁg\‘j\fgbE;g soreen may

be different depending on the user information used to log in. version used.

Log in10192.168.0.5

5 To change the application’s language, select [ § ] > [Language &3] >
Desired language.
e Most buttons and controls emulate physical controls on the camera
and are labeled in English only, regardless of the language selected.
e Note that not all the languages supported by the camera are
supported by the Browser Remote application.

6 Use the Browser Remote controls to operate the camera.
e Descriptions of the controls are given in the following pages.
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7 When you have finished using Browser Remote, select [ ¢ ] > [Log Out] on the Browser Remote screen to end
the application.

(i) notes

* Depending on the network used and the connection performance, you may notice delays in the refreshing of
the live view image and other settings. If the delay is too long, changing the resolution of the live view image is
recommended ([] 192).

¢ |f Browser Remote is set to a language other than the language set on the network device, the application may
not be displayed correctly.

188



Browser Remote: Controlling the Camera from a Network Device

Using Browser Remote

(i) notes

* Browser Remote does not support multi-touch gestures.

The Main Remote Operation Screen

- C80
4. EF-518-55mm f/3.5-5.6 IS Il

LIVE VIEW OFF
Disable

People

Cancel Tracking

B 19min 00:14:51.25 @ 57min

Push Auto Iris
Slot Select

121314 15 16 17 18
1 Network connection indicator 8 Add an [ mark
While Browser Remote is correctly connected to 9 Camera’s nickname ([1] 178) and lens model
the camera, the dots will keep turning on and off name

in a loop.
10 [LIVE VIEW] button

2 Live view screen Touch the button to display the camera’s live view

Shows the camera’s live view image. image on the Browser Remote screen.

3 Double slot recording 11 [Touch Focus] button

4 Recording operation ([J1 51) and recording Touch the button to unlock (enable) the touch
command (] 202) (same as on the camera) focus mode.

5 Time code (same as on the camera) 12 IP streaming
Add a shot mark Available only when using a connection setting

with both the [Browser Remote] and [IP

7 Adda mark Streaming] function settings.

189



Browser Remote: Controlling the Camera from a Network Device

13 [REC] button

Touch the button to start recording. The recording
operation indicator changes to [@REC] and the
190 center of the button turns red.

— The time code will advance while recording.
Touch the button again to stop recording. The
recording operation indicator changes back to
[STBY].

14 Card selection and approximate remaining
recording time

15 [SLOT SELECT] button
Touch to select the other card when both card
slots contain a card.

16 Assignable buttons
17 Assignable functions check
18 Remaining battery charge
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The menu is displayed in detail as follows when Full Controls is selected.

If needed, use the [Full Ctrl] switch.

414243

30mm

continuous Pisable

ar Large Zone
e Landscape

5600K +2CC

19 Manual zoom slider
Touch to adjust the zoom.

20 Manual focus controls

When [Focus] is active, touch [Ed], [IEl] or [IEHl] to
focus closer or [IEH], [IEA] or [BA] to focus farther.
There are three levels of adjustment - [IEll]/[IEll] is the
smallest and [IB4]/[BA] the largest. Keep touching the
button (long press) for a continuous operation.

21 Continuous AF

22 AF frame

23 AF response

24 One-shot AF

25 Subject to detect
26 Tracking

27 Eye detection

28 ND filter

29 Aperture value

30 lIris increment

31 Push auto iris

32 Base ISO

33 ISO speed/gain value
34 ISO/Gain increment
35 Shutter mode

36 Shutter increment
37 AE response

38 Face detection AE

39 White balance method selection

When the white balance mode is set to [}, touch [AWB
Lock] to lock the current white balance settings. Touch
again to resume the automatic white balance (AWB).
When the white balance mode is set to %A or B,
touch 4 to register a custom white balance.

40 Custom picture file
41 Full Ctrl (full controls) switch

42 Key lock button

Touch the icon to lock the Browser Remote screens in
order to prevent settings from being changed
inadvertently. Controls on the camera are not locked.

43 Browser Remote settings ([11 192)

44 Function shortcut button

Displays the various adjustable functions. Touch the
function you wish to adjust.
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45 [Focus Guide] switch 50 Cancel tracking
Touch to display the focus guide (1] 81). 51 Extended ND range
46 Lens action if AF is not possible 52 Fine increment
47 AF speed 53 ISO speed/gain extended range
48 AF lock 54 AE shift
49 Subject detection AF 55 Color temperature, Color compensation

! Browser Remote Settings Tab

1

Language selection
Touch to select the display language for some screens and messages.

Settings

Display style

Touch to select the background color of the Browser Remote screens. Sacies Transis
Secured connection Live view resolution
Touch to download the certificate required to use a secure HTTPS Log Out
connection.

Live view resolution

Select [Large] (higher resolution) or [Small] (lower resolution) depending on the quality of the connection.

Log out
Touch to log out from the Browser Remote application.
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Recording Remotely Using an XC Protocol Compatible Controller/
Application

Set the IP address of the camera on the optional XC Protocol compatible RC-IP100/RC-IP1000 Remote Camera
Controller or Remote Camera Control Applioation1 to control the camera remotely. You can also control the
camera remotely using Multi-Camera Control? on a smartphone connected to the same network as the camera.

1 Available from your local Canon website.
2 Available from the App Store.

1 In CAMERA mode, activate the network functions ([J] 168)
e Select a connection setting with the [XC Protocol] function setting.

Recording remotely using the RC-IP100/RC-IP1000 Remote Camera Controller

You can remotely control camera settings like the aperture and shutter speed, or change picture related settings
like the knee and sharpness. For more details on the connection, settings and the RC-IP100/RC-IP1000 refer to
the RC-IP100/RC-IP1000 instruction manual.

(i) NoTES

¢ The zoom can only be operated when a compatible lens ([J1] 249) is attached to the camera.

e [PRESET] focus and zoom settings can only be used when a compatible RF lens / EF Cinema lens is attached
to the camera (CN-E70-200mm T4.4 L IS KAS S, CN-E18-80mm T4.4 L IS KAS S or RF24-105mm F2.8 L IS
USM 2).

e Even if the camera’s controls are locked (key lock), you can use the RC-IP100/RC-IP1000 to operate the
camera ([] 15).

(i) NoTES

e About changing custom picture related settings

- If a protected custom picture file is selected on the camera, custom picture related settings cannot be
changed using the remote camera controller or Remote Camera Control Application.

- Adjusting custom picture related settings using the remote camera controller or Remote Camera Control
Application will change the settings registered under the currently selected custom picture file. If you want to
keep an important custom picture file, backup it or select in advance a custom picture file you do not mind
changing.

Recording remotely using the Remote Camera Control Application

During recording, you can check the angle of view using Live View and adjust various picture related settings.
For details about connection/setup and the Remote Camera Control Application, refer to the Remote Camera
Control Application manual.

(i) notes

e Even when camera operation is disabled by key lock, operation is possible using the Remote Camera Control
Application (1] 15).
¢ \When adjusting custom picture related settings, refer to About changing custom picture related settings

(00 199).
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Recording remotely using Multi-Camera Control

You can use a smartphone connected to the same network as the camera to remotely operate the camera and
record video. During recording, you can check the angle of view using Live View and adjust various picture
related settings.

1 Install Multi-Camera Control on your smartphone.
e Download and install Multi-Camera Control from the App Store.
e There is no need to repeat this step after the first time.

2 Connect the smartphone to the same network (access point) as the camera.
e For details, refer to the smartphone's instruction manual.

3 Activate the desired network connection ([] 168).
e Select a connection setting with the [XC Protocol] function setting.

4 Open Multi-Camera Control on the smartphone.
5 Operate the smartphone to connect to the camera.
6 Operate Multi-Camera Control on the smartphone to record remotely.

7 When you finish the procedure, set MENU > [#M Network Settings] > [Network] to [Disable].
¢ You can also set MENU > [sa# Network Settings] > [Connect] to [Disconnect].

(i) NoTES

e Even when camera operation is disabled by key lock, operation is possible using the Multi-Camera Control

(T 15).
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Transferring Recordings to a Smartphone

You can transfer and save clips (XF-HEVC S, XF-AVC S), audio (WAV), photos (JPEG) and News Metadata files
to a smartphone (connected to the same network as the camera) ([1] 162).

1 Install Content Transfer Professional on your smartphone.
¢ Download and install the Content Transfer Professional from the App Store or Google Play.
e There is no need to repeat this step after the first time.
2 Connect the smartphone to the same network (access point) as the camera.
e Be sure to activate tethering in advance when using a smartphone as an access point.
e [or details, refer to the smartphone’s instruction manual.
3 Activate the desired network connection ([I] 168).
e Select a connection setting with the [Canon App] function setting. However, since the Canon application
settings are saved for each smartphone, reconfiguration is required when using a different smartphone.
4 As indicated on the screen, open the application on the smartphone.
5 Operate the smartphone to connect to the camera.
6 Select [OK].
7 Using the Content Transfer Professional, transfer recordings from the camera.
8 When you finish the procedure, set MENU > [#M Network Settings] > [Network] to [Disable].
e You can also set MENU > [V Network Settings] > [Connect] to [Disconnect].

¢ \When you end the connection from the smartphone, MENU > [#W® Network Settings] > [Network] will be
set to [Disable].

(i) notes

e Use a supported USB cable* or the network functions to connect the camera to a smartphone. When
connecting using a USB cable, refer to Saving Recordings to a Smartphone ([ 162).
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Uploading Recording Data to Frame.io

Uploading Recording Data to Frame.io

Once paired with the camera, you can use Adobe's Frame.io Camera to Cloud function to upload proxy clips
XF-AVC, XF-HEVC S, XF-AVC S) and WAV audio (second card recording functions) recorded on the card in
slot B.

Automatic upload

1 Activate the network functions ([ 168).
e Select a connection setting with the [Frame.io] function setting.

2 Select MENU > [#W Network Settings] > [Frame.io] > [Auto Upload On Recording] > [On], then start
recording.
¢ The data is added to the upload queue and uploaded to Frame.io sequentially.

Manual upload

1 Switch to MEDIA mode.

2 Activate the network functions (] 168).
¢ Select a connection setting with the [Frame.io] function setting.

3 Select the recording data to be uploaded from the slot B [XF-AVC], [XF-HEVC S/XF-AVC S] or [WAV] index
screen.

4 Select the clip menu > [Frame.io Upload] > [OK].
e The data is added to the upload queue and uploaded to Frame.io sequentially.

(i) NoTES

e You can check the upload status from MENU > [#W Network Settings] > [Frame.io] > [Upload Status/Del.
Request]. If you want to delete a request, select the clip and select SET > [OK].

e Select MENU > [#W Network Settings] > [Frame.io] > [Delete All Requests] > [OK] to clear all upload
requests.

e Select MENU > [#W Network Settings] > [Frame.io] > [Pause Uploading] > [Enable] to pause the upload.
e During recording, uploads to Frame.io are paused.
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Updating the Firmware Automatically

If the server has the latest firmware when the camera is connected to a network using a function setting other
than the CV protocol, an asterisk will be shown on § on the menu. In this case, you can update the camera's
firmware using the following procedure.

1 Insert an SD card into the camera's SD card slot B ([I] 36).

2 Select MENU > [§ System Settings] > [Firmware] > [Download Latest Firmware] > [OK].
3 Read the End User License Agreement (EULA) carefully and agree to it.
e The latest firmware is downloaded to the SD card.
4 After downloading is complete, select [OK] twice.
e The firmware update starts and cannot be aborted.
5 When the update is complete, select [OK].
* The camera's settings are reset and the PIN code setting screen appears.

@ PorTANT

e Make sure that you observe the following during firmware update:
- Do not turn off power. Do not remove the battery or power supply.
- Do not perform any other button operation.
- Do not open the memory card cover and remove the SD card.

(i) NoTES

e Connect the AC adapter or attach a fully charged battery to the camera.
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Menu Options

Additional Information

For details about how to select an item, refer to Using the Menus ([11 26). For details about each function, see
the reference page or the explanation accompanying the menu entry. Setting options in boldface indicate default

values.

Depending on the camera’s operating mode and the settings, some menu items may not be available. Such
menu items do not appear or appear grayed out in menu screens.

To skip directly to the page of a specific menu:

["™ Camera Setup] menu 11199 (%4 Assistance Functions] menu 11206
[[@d Custom Picture] menu 11 201 [snr Network Settings] menu 11208
[£% Recording/Media Setup] menu 11 201 [€ Assignable Buttons] menu 11209
[d) Audio Setup] menu 11203 [ System Setup] menu 210
[ED Monitoring Setup] menu [ 204 [ My Menu] customized menu 212
["™ Camera Setup] menu (CAMERA mode only)

Menu item Setting options and additional information
[Iris Mode] [Automatic], [Manual] (M73)

This setting is available only when a compatible lens ([ 249) is attached to the camera.

[Iris Increment] [1/2 stop], [1/3 stop] (73
[Fine Increment] [On], [Off]
[Zoom-Iris Correction] [On], [Off]

If you are using a compatible lens, when this setting is set to [On], the camera will adjust as needed to
keep the selected aperture value while zooming. Because of this adjustment, the brightness of the image
might flicker slightly or you may hear the operation sound. When the setting is set to [0ff], there will be no
flickering or operation sounds but the aperture value will gradually increase (the picture will get darker) as
you zoom.

[ND Display Units] [Stop], [Transmittance], [Optical Density] (@M72
[Extended ND Range] [on], [Off] (@M72
[Shutter Mode] [Speed], [Angle], [Clear Scan], [Slow], [Off] (17 66)

[Shutter Increment]

[1/3 stop], [1/4 stop]

[Auto Clear Scan Setting] - (@me7)
[Flicker Reduction] [Automatic], [Off] (@e7)
[Base ISO] Available settings differ depending on the [Gamma/Color Space] component in the custom (1 68)
picture file and the recording format settings.
[1S0/Gain] [1S0], [Gain] (de8)
[ISO/Gain Mode] [Automatic], [Manual] (3 70)
[ISO/Gain Extended Range] [On], [Off] (@esg)
[ISO/Gain Increment] [ISO]: [1 stop], [1/3 stop] (11 68)

[Gain]: [Nermal], [Fine]

[Limit for Auto Mode] Available values differ depending on the main recording format, gamma curve in the custom (70
picture file, ISO/gain extended range and base ISO settings.

[Light Metering] [Backlight], [Standard], [Spotlight] (A 76)

[AE Shift] —2.0 to +2.0 in 0.25 point intervals (+0) (@75
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Menu item Setting options and additional information

[AE Response] [High], [Normal], [Low] (@74
Determines how quickly the exposure (aperture, shutter speed and gain) changes when using the
automatic adjustment mode.

[Shockless WB] [On], [Off] (@77)

[AWB Response] [High], [Normal], [Low] (M9

[C. Temp. Increment] [Mired], [Kelvin] (77

[Continuous AF] [Disable], [Enable] (17 80)

[Lens action if cannot AF] [Continue focus search], [Stop] (M 83)

[Track after Focusing] [On (tracking frame)], [On (no tracking frame)], [Disable] (@2 83)

[AF Frame] [Small Zone], [Zone], [Large Zone: Vertical], [Large Zone: Horizontal], [Whole Area] (17 85)

[AF Speed] +110 +10(7) ([T 84)

[AF Response] -3t0+3(0)

[Focus Mode] [AF], [MF] ([T 80)

[Subject to detect] [People], [Animals], [None] (T 86)

[Subj. detect. AF] [Detect. priority], [Detect. only] (1 86)

[Eye Detection] [On], [Off] (11 86)

[Face Detection AE] [On], [Off] (2 126)

[Camera Grip Zoom] [On], [Off] (32 90)

[Camera Grip Zoom Speed] 11016 (8)

[Tele-converter] [x3.0], [x2.5], [x2.0], [x1.5], [Off]

[ABB] - (17 45)

[Color Bars] [On], [Off] (M107)

[Color Bar Type] [SMPTE], [EBU]*, [ARIB]

[Periph. lllum. Corr)], [On], [Off] (M 31)

[Chromatic Aberr. Corr.],

[Diffraction Correction],

[Distortion Aberr. Corr.]

[RF-S/EF-S Lens] [On], [Off] (0129

If peripheral brightness fall-off or vignetting occurs when using an EF-S lens, you can set [RF-S/EF-S
Lens] to [On] to slightly crop the imaging area. The image is enlarged digitally by a factor of about 1.09x
(when the resolution is 4096x2160 or 2048x1080), or 1.04x (when the resolution is 3840x2160 or
1920x1080), affecting image quality. Available only when the main recording format is set to an option
other than RAW, the sensor mode is set to an option other than [Full Frame], and the digitial tele-converter
is disabled. In most cases, leaving the [Off] option is recommended.

[Lens Optical IS]

[On], [Off] (a8y)
When an RF-S lens is attached, set this setting to [On] to compensate for camera shake using optical
image stabilization.

[Digital IS] [on], [Off] (@8y)
[Digital IS Mode] [High], [Standard] ([T 88)
[Motion Vector For Digital IS] [Enable], [Disable] (17 88)
[Lens Focal Length] 1 to 1000 (50) (17 88)

[Anamorphic Corr.]

[Lens Squeeze Factor], [x2.0], [x1.8], [x1.3], [Off]

* The default value depends on the country/region of purchase.



[[@d Custom Picture] menu (CAMERA mode only)

Menu Options

Menu item Setting options and additional information
[Select File] [C1:Canon 709], [C2:Canon Log 2], [C3:Canon Log 3], [C4:BT.709 Wide DR], (@ 129)
[C5:BT.709 Standard], [C6:PQ], [C7: HLG], [C8:EQS Standard], [C9:EQS Neutral],
[C10: User10] to [C20: User20]
[Edit [@ File]
[Rename] - (3 131)
[Protect] [Unprotect], [Protect]
[Reset] [Canon 709], [Canon Log 2], [Canon Log 3], [BT.709 Wide DR], [BT.709 Standard], [PQ],
[HLG], [EOS Standard], [EOS Neutral], [User (Canon 709)]
Detailed custom picture Refer to the tables in the Available Custom Picture Settings section. (2 134)
settings
[Save [@[ File] (01 132)
[Copy to SD Card B], -
[Load from SD Card B]
[£% Recording/Media Setup] menu
Menu item Setting options and additional information
[Initialize Media] [SD Card A], [SD Card B] (37
[Sensor Mode] [Full Frame], [Super 35mm (Cropped)] (62
[System Frequency] [59.94 Hz], [50.00 Hz]', [24.00 Hz] (e
[Main Rec Format] [RAW ST], [RAW LT], [XF-AVC YCC422 10 bit], [XF-HEVC S YCC422 10 bit], (T 62)
[XF-HEVC S YCC420 10 bit], [XF-AVC S YCC422 10 bit], [XF-AVC S YCC420 8 bit]
Available options vary depending on the sensor mode.
[Main Resolution] [RAW]: (62
[6000x3164], [4368x2304]
[XF-AVC]:
[4096x2160 Intra-frame], [4096x2160 Long GOP], [3840x2160 Intra-frame],
[3840x2160 Long GOP], [2048x1080 Intra-frame], [2048x1080 Long GOP],
[1920x1080 Intra-frame], [1920x1080 Long GOP]
[XF-HEVC S]:
[4096x2160], [3840x2160], [2048x1080], [1920x1080]
[XF-AVC S]:
[XF-AVC S YCC422 10 bit]:
[4096x2160 Intra-frame], [4096x2160 Long GOP], [3840x2160 Intra-frame],
[3840x2160 Long GOP], [2048x1080 Intra-frame], [2048x1080 Long GOP],
[1920x1080 Intra-frame], [1920x1080 Long GOP]
[XF-AVC S YCC420 8 bit]:
[4096x2160], [3840x2160], [2048x1080], [1920x1080]
Available options vary depending on the sensor mode and frame rate.
[Frame Rate] When [System Frequency] is set to [59.94 Hz]: (62

[59.94i]*, [59.94P]", [29.97P], [23.98P]
When [System Frequency] is set to [50.00 Hz]:
[50.00i]*, [50.00P]", [25.00P]
When [System Frequency] is set to [24.00 Hz]:
[24.00P]

* XF-AVC clips only. Not available when slow & fast motion recording, frame recording or

interval recording is activated.

Available options vary depending on the sensor mode and main recording format/main resolution.
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Menu item Setting options and additional information

[Bit Rate] (62
Available options vary depending on the main recording format, main resolution and frame rate.

[1XF-HEVC S Main Audio] [AAC 16 bit 2CH], [LPCM 24 bit 4CH] ([ 101)

[Recording Mode] [Normal Recording], [Slow & Fast Motion], [S&F Clip / Audio (WAV)], (739, 114)
[Pre-Recording], [ Main / [ Continuous Rec], [Frame Recording],
[Interval Recording]

[Slow & Fast Frame Rate] (114)

Available options and default value vary depending on other settings. See the tables on the reference
page.

[Continuous Recording]

[REC], [STBY] (M118)

[Frame Rec: Frame Rate]

[11. (31, (6], 9] (M119)

[Interval Rec: Time Interval]

[1 sec], [2 sec], [3 sec], [5 sec], [10 sec], [15 sec], [30 sec], [1 min], [2 min], [3 min], [5 min], (] 119)
[10 min]

[Interval Rec: Frame Rate]

[11. (3] (6], 9]

[2nd Card Rec Functions]

[off], (M Main / [Proxy Rec], [ Main / EHSub Rec], [ Main / B Audio Rec], (239)
[Relay Recording], [Double Slot Recording], [ Y ---(EEII Main) / [EQProxy Rec]*,

(N ---(CBID Main) / [EPSub Rec]*

* Only available when [HDMI RAW] is set to [On].

(W Rec Format] [XF-AVC YCG422 10 hit], [XF-AVC YCC420 8 bit], [XF-HEVC S YCC422 10 bit], (1 63)
[XF-HEVC S YCC420 10 bit], [XF-AVC S YCC422 10 bit], [XF-AVC S YCC420 8 bit] (07 64)
Available options vary depending on the main recording format.
(W Resolution] Available options vary depending on the main recording’s settings. (1 63)
(] Frame Rate] [Same as Main Recording], [59.94i], [59.94P], [50.00i], [50.00P] (1 63)
(X Bit Rate] Available options vary depending on the [ 5] Resolution] and [{J] Frame Rate] settings. (2 63)
(B ] / Audio] [AAC 16 bit 2CH], [LPCM 24 bit 4CH] (1o1)
[Proxy Rec Color Conversion] [Conform to Custom Picture], [BT.709 (Canon 709)], [BT.709 (CMT 709)] (T 64)
[Metadata]
[Camera Index] [A_]to [ZZ] (42
[Reel Number] [0001] to [9999]
[Clip Number] [001] to [999]
[User Defined] User defined string up to 5 characters ([CANON]) (M 43)
[Scene], [Take] Scene description up to 16 characters / Take description up to 8 characters (M113)
[Lens Squeeze] [x2.0], [x1.8], [x1.3], [Off] (@121)
[Add XML File] [On], [Off] (M111)
[XML File Format] [News Metadata], [User Memo] (112
[News Metadata] [Off], list of available News Metadata files (112
[News Metadata Reset All] - (113)
[User Memo] [Off], list of available user memo files (M)
[Country Code], [Organization], Identifiers up to 4 characters ([00__] default for [Organization] only)
[User Code] [Country Code]: This identifier is the country code defined by ISO-3166-1 and is to be entered starting

from the left.
[Organization]: This identifier represents the organization that owns or operates the camera and can be
obtained by registering with the SMPTE Registration Authority. If the organization is not registered,

enter [0000].
[User Code]: This identifier designates the user. Leave this blank if [Organization] is set to [0000].
[Add [€3 File] [On], [Off] (T134)
[Clip Numbering] [Reset], [Continuous] (42
[HDMI RAW] [On], [Off] (@ 155)
[Rec Command(EXT REC)] [On], [Off] (M 154)




Menu Options

Menu item Setting options and additional information
[HDMI Time Code] [On], [Off] (154)
[Photo Numbering] [Reset], [Continuous] (T 43)
[Volume Label] [Canon], [Canon + Metadata] (M 37)
" The default value depends on the country/region of purchase.
[d) Audio Setup] menu
Menu item Setting options and additional information
[Audio Input Selection]

[CH1/CH2], [CH3/CH4] [INPUT Terminals], [MIC Terminal], [Monaural Mic], [Multi-Function Shoe] (2 103)
[CH2 Input] [INPUT 2], [INPUT 1], [Monaural Mic], [MIC Terminal] (T103)
[CH1/CH2 ALC Link], [Linked], [Separated] (1 104)
[CH3/CH4 ALC Link]

[Audio Rec Level] [A] (Automatic), [M] (Manual) (@104)
0to 100 (50)
[INPUT 1 Mic Trimming], [+12 dB], [+6 dB], [0 dB], [-6 dB], [-12 dB] (07 105)
[INPUT 2 Mic Trimming]
[INPUT 1 Mic Att.], [INPUT 2 Mic Att.] [On], [Off] (07 105)
[INPUT 1 Mic Low Cut], [0ff], [LC1], [LC2] (07 105)
[INPUT 2 Mic Low Cut]
[INPUT Reference Level] [-18 dB], [-20 dB] (@105)
[INPUT Limiter] [On], [Off] (1 104)
[MIC Att.] [On], [Off] (X1 105)
[MIC Low Cuf] [off], [LC1], [LC2] (T2 105)
[MIC Input] [MIC (with Power Supply)], [LINE] (T 103)
[Multi-Function Shoe Input] (@ 100)
[Shoe Mic]

[Shoe Mic Attenuator] [On], [Off]

[Shoe Mic Low Cut] [On], [Off]

[Shoe Mic Directionality] ~ [Shotgun (Monoaural)], [90°(Stereo)], [120°(Stereo)]

[Wireless Mic]
[Audio Rec Level] [A] (Automatic), [M] (Manual)
0to 100 (50)

[Yicc1 Wind Filter], [On], [Off]

[%icc2 Wind Filter]

[%icc1 Attenuator], [On], [Off]

[%icc2 Attenuator]

[Wireless Mic Mixing] [Enable], [Disable]

[MUTE button] [Enable], [Disable]

[Movie recording button] ~ [Enable], [Disable]

[Tally Lamp] [On], [Off]

[Display Wireless Mic -

Status]

[1 kHz Tone]

[-12 dB], [-18 dB], [-20 dB], [Off]

(1 107)
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Menu item Setting options and additional information
[Headphone Volume] [0ff], 1 to 15 (8) (11 146)
[Speaker Volume] [0ff], 1 to 15 (8)
[Monitor Channels] [CH1/CH2], [CH1/CH1], [CH2/CH2], [CH1+2/CH1+2], [CH3/CH4], [CH3/CH3], [CH4/CH4], ([T 160)
[CH3+4/CH3+4], [CH1/CH3], [CH2/CH4], [CH1+3/CH2+4]
[HDMI OUT Channels] [CH1/CH2], [CH3/CH4]
[Level Meter Display Color] [Color], [White]
[(=D Monitoring Setup] menu
Menu item Setting options and additional information
[LCD Brightness], —-50 10 50 (x0) (3 23)
[LCD Contrast]
[LCD Color] —20 to 20 (+0)
[LCD Sharpness] 1104 (2)
[LCD Luminance] [-2], [-1], [Normal], [+1] to [+6]
[LCD Mirror Image] [On], [Off]
[Anamorphic: LCD], [on], [Off] (@121
[Anamorphic: SDI],
[Anamorphic: HDMI]
[Anamorphic Desqueeze] [Lens Squeeze Factor], [x2.0], [x1.8], [x1.3]
[Desqueeze for S&F] [Reduced Display], [0ff]
[B&W Image: LCD], [On], [Off] (M 23)
[B&W Image: SDI],
[B&W Image: HDMI]
[OSD Output: SDI] [On], [Off (Clean)] (@ 157)
[0SD Output: HDMI] [On], [Off] (@ 157)
[Tally OSD: LCD], [Tally OSD: SDI},  [On], [Off] ([T 54)
[Tally OSD: HDMI]
[Tally OSD Settings] [REC/Tally In (PGM/PVW)], [REC], [Tally In (PGM/PVW)]
[Tally OSD Position] [Frame], [Top], [Bottom]
[DISP Level 1] [All Displays], [All Displays (Periph. Border)] (1 53)
[DISP Level 2] [Main Recording Displays], [Only FUNC/MENU]
[DISP Level 3] [Only REC/STBY], [No Displays]
[Apply Peripheral Border] [DISP Level 1/2/3], [DISP Level 1/2], [DISP Level 1], [DISP Level 2], [DISP Level 3], [Off] (T 54)
[Custom Display 1] (11 49)

[Light Metering],

Custom Picture],

Focal Length],

ND Filter], [Focus Mode],
Key Lock], [White Balance],
[AE Shift], [Iris], [ISO/Gain],

[
[
[
[

[Shutter], [Base IS0], [Peaking],

[Tele-converter], [Digital IS],

[Magnification], [View Assist],

Lens]

[On], [Off]

Object Distance (Numeric)],
Object Distance (Bar)]

[Always On], [Only in MF Mode], [Off]

[
[
[
[

Level (Numeric)]

(On], [Off]




Menu item
[Level (Bar)]

Menu Options

Setting options and additional information
[Tilt+Roll], [Roll], [Tilt], [Off]

[Exposure Bar]

[On], [Disable During AE], [Off]

[Custom Display 2]

([ 49)

[Remaining Battery],
[Remaining Rec Time]

[Only Warnings], [Normal], [Off]

[Recording Mode],

[Interval Counter], [Time Code],

[Reel/Clip Number]

[on], [Off]

[Photo]

[Only Warnings], [Normal], [Off]

[Temperature/Fan],

[Sensor Mode],
[Resolution/Color Sampling],
[Frame Rate],

[Output Terminals Status],
[OSD Output]*,

[Rec Command(EXT REC)],
[User Memo]*, [User Bit]*,

[Monitor Channels]*,
[Audio Level Indicator],
[Multi-Function Shoe]

[on], [Off]

[On], [Normal]: Show the icon/onscreen display always or whenever the necessary conditions are
triggered.

[Only Warnings]: Show the icon/onscreen display only when a critical level is reached.

e The default setting for items marked with an asterisk (*) is [Off].

[Wireless Mic]

[Only Warnings], [Normal], [Off]

[Network Functions], [GPS]

[on], [Off]

[Date/Time]

[Date/Time), [Time], [Date], [Off]

[Custom Display]

(1144

These settings are available only in MEDIA mode and determine whether the following onscreen displays
will appear on the playback image.

[Audio Level Indicator]

[On], [Off]

[Date/Time], [Camera Data]

[On], [Off]

[Audio Level Indicator]: The audio level meter (clips only).

[Date/Time]: The date and time when the clip/photo was recorded.

[Camera Data]: The aperture value, shutter speed and ISO speed/gain value used to record the clip (clips
only).

[Displayed Units]

[Meters], [Feet]'
Changes the distance units used in camera displays between meters and feet.

[0SD Opacity: LCD], [On], [Off] (M157)
[OSD Opacity: SDI],

[OSD Opacity: HDMI]

[0SD Opacity Level] [75%], [62.5%)], [50%)], [37.5%)], [25%]

[OSD Opacity: Appl. Screens] [All], [Only Rec/Playback Screens]

[OSD Orientation: LCD] [0 Degrees], [ ¢« 90 Degrees Left], [ x2), 90 Degrees Right] (13 55)
[OSD Orientation: SDI], [Linked to LCD], [ ¢« 90 Degrees Left], [ =) 90 Degrees Right]

[OSD Orientation: HDMI]

[View Assist: LCD] [On], [Off] (158)
[Select View Assist: LCD] [CMT 709], [Canon 709], [HDR Assist. (1600%)], [HDR Assist. (400%)]

[View Assist: SDI], [On], [Off] (T 159)
[View Assist: HDMI]

[Select View Assist: SDI], [CMT 709], [Canon 709] (11 158)
[Select View Assist: HDMI]

[Gain for HDR—SDR Conv.] —7.5dB to +7.5 dB in 0.5 dB intervals (3.0 dB) (T 159)
[Range: SDI] (11 156)
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[During Canon Log Output] [Full Range], [Narrow Range]

[During HDR Output] [Full Range], [Narrow Range]
[Range: HDMI] ([T 156)

[During Canon Log Output] [Full Range Priority], [Narrow Range]

[During HDR Output] [Full Range Priority], [Narrow Range]

" The default value depends on the country/region of purchase.
[By Assistance Functions] menu
Menu item Setting options and additional information

[Focus Guide] [On], [Off] (7 81)
[Peaking: LCD], [Peaking: SDI], [On], [Off] (M 82)
[Peaking: HDMI]
[Peaking] [Peaking 1], [Peaking 2]
[Peaking 1]

[Color] [White], [Red], [Yellow], [Blue]

[Gain] [0ff], 1t0 15 (8)

[Frequency] 1t04(2)
[Peaking 2]

[Color] [White], [Red], [Yellow], [Blue]

[Gain] [0ff], 1 to 15 (15)

[Frequency] 1to4 (1)
[Magnification] [On], [Off] (82
[Magn. Output] [LCDY], [SDI], [HDMI]
[B&W during Magn.] [On], [Off] (M 82)
[False Color: LCD], [On], [Off] (94
[False Color: SDI],
[False Color: HDMI]
[False Color Index] -
[Zebra: LCD], [Zebra: SDI], [On], [Off] (93)
[Zebra: HDMI]
[Zebra] [Zebra 1], [Zebra 2], [Zebra 1+2]
[Zebra 1 Level] [5 +5%)] to [95 +5%)] in 5 percentage point intervals ([70 +5%)])
[Zebra 2 Level] 0% to 100% in 5 percentage point intervals (100%)
[WFM: LCD], [WFM: SDI], [On], [Off] ([T 108)
[WFM: HDMI]
[WFM Opacity Level] [Linked to OSD Opacity], [100%)], [80%)], [60%)], [40%)], [20%)]

Select the WFM opacity level. If set to [Linked to OSD Opacity], it will be linked to the [0SD

Opacity Level] setting.

[WFM Function]

[Waveform Monitor], [Vectorscope]




Menu Options

Menu item Setting options and additional information
[Waveform Settings] (C108)
[Size: LCD] [Normal], [2x]
Changes the size of the waveform displayed on the screen.
[Position] [Right], [Left]
[Type] [Line], [Line+Spot], [Select Line], [RGB], [YPbPr]
[Vertical Scale for HDR] [IRE], [PQ/HLG]
[Select Line] 2160 or higher: 0 to maximum value -2 lines (2-line increments)
Example: 0 to 2158 (for 2160) (1080)
Below 2160: 0 to maximum value —1 line (1-line increments)
Example: 0 to 1079 (for 1080) (540)
Available options depend on the resolution and operating mode (CAMERA/MEDIA mode).
[Vectorscope Settings] (2 109)
[Position] [Right], [Left]
[Type] [Normal], [Spot]
[Gain] [1x], [2X]
[Markers: LCD], [Markers: SDI], [On], [Off] (momn
[Markers: HDMI]
[Playback Marker Display] [Enable], [Disable] (9
[Center Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off] (9
[Center Marker Type] [Cross 1], [Cross 2], [Dot 1], [Dot 2]
[Horizontal Marker], [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off]
[Vertical Marker], [Grid Marker]
[Aspect Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Mask 100%)], [Mask 75%], (92
[Mask 50%], [Mask 25%], [Off]
[Marker Aspect Ratio] [4:3], [13:9], [14:9], [16:9], [1.375:1], [1.66:1], [1.75:1], [1.85:1], [1.90:1], [2.35:1], [2.39:1],
[9:16], [4:5], [2:1], [1:1], [Custom]
[Marker Custom Asp. Ratio] 0.01:0.01 10 9.99:9.99 (1.00:1:00)
[Safe Area Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Mask 100%)], [Mask 75%], (92
[Mask 50%], [Mask 25%], [Off]
[Basis for Marker Safe Area] [Whole Picture], [Selected Aspect Marker]
[Marker Safe Area %) [80% (Side Length)], [88% (Side Length)], [90% (Side Length)], [93% (Side Length)],
[95% (Side Length)]
[User Marker 1], [User Marker 2], [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off] (92

[User Marker 3]
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[User Marker 1 Settings], (92
[User Marker 2 Settings],
[User Marker 3 Settings]
[Size]
[Specification Method] [Pixel], [Ref. Area & Aspect Ratio], [Ref. Area & Magn. Ratio]
[Pixel] [Width]: 2 to 2048 (only even numbers) (1000)
[Height]: 2 to 1080 (only even numbers) (1000)
[Reference Area] [Whole Picture], [User Marker 1], [User Marker 2]
Available options differ depending on the settings for [User Marker 1 Settings] to [User Marker
3 Settings].
[Marker Aspect Ratio] [4:3], [13:9], [14:9], [16:9], [1.375:1], [1.66:1], [1.75:1], [1.85:1], [1.90:1], [2.35:1], [2.39:1],
[9:16], [4:5], [2:1], [1:1], [Custom]
[Marker Custom Asp. [Available Range]: 0.01:0.01 t0 9.99:9.99 (1.00:1.00)
Ratio]
[Magnification Ratio] [Available Range]: 50 to 150% (95%)
[Position]
[Specification Method] [Center Coordinates], [Upper-left Coordinates], [Centering (User Marker 1)],
[Centering (User Marker 2)]
Available options differ depending on the settings for [User Marker 1 Settings] to [User Marker
3 Settings].
[Center Coordinates] [Horizontal]: —1024 to 1024 (0)
[Vertical]: =540 to 540 (0)
[Upper-left Coordinates] [Horizontal]: 0 to 2048 (0)
[Vertical]: 0 to 1080 (0)
[in# Network Settings] menu
Menu item Setting options and additional information
[Network] [Enable], [Disable] (11 168)
[Connect] [Disconnect], [SET1] to [SET20]
[Connection Setting] [SET1] to [SET20] (178)
[Create New with Wizard] -
[Create with Existing Setting] -
[Check Settings] -
[Change with Wizard] -
[Select Existing Setting] -
[Settings Name] File name up to 12 characters
[Delete Settings] -

[New Conn. Setting (Wizard)]

[FTP Transfer], [IP Streaming], [Browser Remote], [Canon App], [XC Protocol], [CV Protocol], (31 169)
[Frame.io]

[Activate IP Streaming]

[Enable], [Disable] (3 185)




Menu Options

Menu item Setting options and additional information
[Frame.io] (2 196)
[Pair] -
[Unpair] -
[Pairing Information] -
[Upload Status/Del. Request] -
[Delete All Requests] -
[Pause Uploading] [Disable], [Enable]
[Auto Upload On Recording] [On], [Off]
[Auto Upload File Formats] [XF-AVC Proxy], [XF-HEVC S / XF-AVC S Proxy], [Audio Proxy]
[Root Certificate] [Read Root Certificate], [Root Certificate Details], [Delete Root Certificate]
[FTP Transfer All Clips] In MEDIA mode only. (@ 184)
[IPv4 address name] Displays the current IPv4 address information.
[View Error Info] Displays the latest network related error message.
[Advanced Settings] (179)
[Communication Settings] [NWA1] to [NW25]
[Function Settings] [MODE1] to [MODE25]
[Browser Remote Settings] [User Name/Password], [Port No. (HTTP)], [Port No. (HTTPS)], [HTTPS] (1182
[FTP Transfer Settings] [Read Root Certificate], [Root Certificate Details], [Delete Root Certificate] (17
[XC Protocol Settings] {ﬁﬁl:;t’lc[ggsg Ililllﬁggdi]s,e E]El_s:ieénl\gn&/g?ssword], [Port No. (HTTP)], [Port No. (HTTPS)], (173
[802.1X Authentication] [Setup Wizard], [Check Settings], [Delete Settings] (M177)
[Nickname] User defined string up to 16 characters ([G80]) (M 178)

[@ Assignable Buttons] menu

Following are the default settings for each assignable button. For a complete list of the functions that can be
assigned, refer to the detailed table ([11 126).

Menu item
[Camera]

Setting options and additional information

1: [White Balance], 2: [Set White Balance], 3: [Peaking: All], 4: [WFM: All], 5: [DISP],

6: [Zebra: All], 7: [Push Auto Iris], 8: [Magnification], 9: [FUNC], 10: [(NONE)],
11: [(NONE)], 12: [AF Lock], 13: [Audio Status]

[Browser Remote/XC Prot.]

[Link to Camera]

[Enable], [Disable]

1: [Magnification], 2: [Peaking: All], 3: [Zebra: All], 4: [WFM: All]

[REMOTE A]

(125

[Link to Camera]

[Enable], [Disable]

1: [Magnification], 2: [Peaking: All], 3: [Zebra: All], 4: [WFM: All]
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Menu Options

[¥ System Setup] menu

Menu item Setting options and additional information
[Reset] [All Settings], [Assignable Buttons], [Level]
These settings reset the following camera settings to default values/settings.
[All Settings]: All the camera’s settings except for the hour meter.
[Assignable Buttons]: Only the assignable buttons.
[Level]: The level reference angle settings.
[Transfer Menu/ [€3] (2 139)
[Save] [To Camera], [To SD Card B]
[Load] [From Camera], [From SD Card B]
[Time Zone] List of world time zones. (1 25)
[UTC-05:00 New York] or [UTC+01:00 Central Europe]’
[Date/Time] -
[Date Format] [YMD], [YMD/24H], [MDY], [MDY/24H], [DMY], [DMY/24H]'
[Language ﬁ] [Deutsch], [English], [Espafiol], [Frangais], [Italiano], [Polski], [Portugués], (12 25)
[Pycckuit], [YkpaiHebka], [{E 4 3], [8F=01], [BAE]
[REMOTE Term.] [RC-V100 (REMOTE A)], [Standard] (M 123)
[SDI Output] [On], [Off] (@ 154)
[SDI Output Signal] [4096x2160P/3840x2160P], [2048x1080P/1920x1080P], [1920x1080P], (T 154)
[1920x1080i(PsF)], [1280x720P]
[HDMI Output Signal] [4096x2160P/3840x2160P], [1920x1080P], [1920x1080i], [1280x720P] ([T 155)
[Linked to HDMI Monitor] [On], [Off]
[Time Code Mode] [Preset], [Regen.] (12 95)
[Time Code Run] [Rec Run], [Free Run]
[Time Code DF/NDF] [DF], [NDF] ([T 96)
[Set Time Code] 59.94 Hz: [00:00:00.00] to [23:59:59.29] (M 95)
50.00 Hz: [23:59:59:24]
24.00 Hz: [23:59:59:23]
[TC In/Out] [In], [Out] ([T 98, 99)
[User Bit Recording Mode] [Internal], [External] (98)
[User Bit Type] [Setting], [Time], [Date] (12 96)
[Front Control Dial], [Iris], [Shutter], [Clear Scan (Steps)], [ISO/Gain], [White Balance Mode], (T 69, 74,
[Rear Control Dial], [White Balance (K)], [White Balance (CC)], [Select Subject], [Off] 78, 86)
[

Control Ring]

Determines the function assigned to the respective control dial/control ring. The [Select Subject] setting

allows you to switch the main subject/eye used for subject detection/eye detection.

¢ The default function for the rear control dial and control ring is [Off].

Front Ctrl Dial Dir.],
Rear Ctrl Dial Dir.],

SELECT Dial Dir.]

[Reverse], [Normal]

Changes the direction of the adjustment when operating the front/rear control dial, the control ring on the

lens/adapter or the SELECT dial, respectively.

[
[
[Control Ring Dir.],
[
[

Ctrl Dial in Menus]

[Disable], [Enable]

([ 26)

Enables or disables the use of the front and rear control dials to navigate the setup menus, direct touch

control, direct setting mode and status screens.

[Focus Ring Operation]

[Enable During AF], [Disable During AF]

[Focus Ring Direction]

[Reverse], [Normal]

Changes the direction of the adjustment when operating the focus ring on an RF lens.

[Focus Ring Response]

[Varies with Rotation Speed], [Linked to Rotation Degree]




Menu item
[Focus/Control Ring]

Menu Options

Setting options and additional information
[Focus Ring], [Control Ring]

Selects the function assigned to the RF-S lens focus/control ring. When set to [Control Ring], focus is set

to AF*,

*When the focus is in the Center Focus Macro range (using a lens equipped with the Center Focus Macro
function), focus is not set to AF even if set to [Control Ring] and focus operations from other devices will
not be possible. To leave the Center Focus Macro range, select [Focus Ring] and operate the ring to
focus at infinity focus.

[Key Lock] [All Buttons], [All Except REC Button] (T 15)

[REC Button] [Disable], [Enable] (M 47)
Enables or disables the use of the REC buttons.

[Assign. Button 4 as REC] [On], [Off] (2 125)
When this setting is set to [On], assignable button 4's function changes to [REC].

[Assign. Button 11 as REC] [on], [Off] (@125
When this setting is set to [On], assignable button 11’s function changes to [REC].

[Onscreen REC/STBY Button] [On], [Off] (@47

When this setting is set to [On], the recording operation indicator (REC/STBY) on the CAMERA mode
screen becomes an onscreen button you can touch to start/stop recording.

[Touch Screen Response] [Normal], [Low] (3 23)
[Review Recording] [Entire Clip], [Last 4 sec] (12 55)
[Tally Lamp] [On], [Off]

When this setting is set to [On], the tally lamp illuminates/flashes according to the camera and tally input
status.

[Tally Lamp Settings]

[Power/Media/Tally In (PGM)], [REC/Tally In (PGM)], [REC], [Tally In (PGM)] (00 48)

When this setting is set to [Power/Media/Tally In (PGM)], the tally lamp illuminates/flashes according to
battery and recording warnings and the SD card recording status.

[Card Access LED] [On], [Off] (12 36)
When this setting is set to [On], the card access indicator illuminates when the camera is accessing the
card.

[== (Ethernet) LED] [On], [Off]

When this setting is set to [On], the =5 (Ethernet) indicator illuminates/flashes when the camera is
accessing a wired network.

[USB Mode] [Video Output (UVC)], [Canon App(s) for iPhone], [Ganon App(s)/GP-E2] (M 162)
Select [Canon App(s)/GP-E2] when connecting the GP-E2 GPS Receiver to the camera using an optional
interface cable.

[GPS Auto Time]? [On], [Off]

When this setting is set to [On], the camera automatically adjust its date and time settings according to

the information received from the GPS signal.

» While the automatic date/time adjustment is activated, the MENU > [¥ System Setup] > [Date/
Time] setting will not be available.

e The time will not be updated while recording video.

[Fan Mode] [Automatic], [Always On] (3 44)

[Fan Speed (STBY)] [Maximum], [High], [Middle], [Low]

[Fan Speed (REC)], [High], [Middle], [Low]

[Fan Speed (Always)], [Fan Speed]

[Level Sensitivity] [x16], [x8], [x4], [x2], [Standard] (@ 33)

[Level Reference Setting] [Cancel], [0K] (3 33)

[DC IN Warning (V)] 11.5V10 15.0 Vin 0.1 Vintervals (13.0 V) (M 22
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Menu Options

Menu item
[Retract Lens]

Setting options and additional information

[On], [Off]

When a compatible lens ([ 250) is attached to the camera and the focus mode switch on the lens is set
to AF, if this setting is set to [On], the lens will retract fully when the camera is turned off.

When this setting is set to [On], turning off the camera will move the focus position. To prevent this, set
this setting to [Off]. Note that there is no guarantee that the focus position will not move, so checking the
focus position is recommended when turning on the camera.

[Reset Hour Meter]

The camera has two “hour meters” — the first keeps track of total operation time and the second keeps
track of operation time since the last time the second hour meter was reset with this function.

[Certification Information]

This displays select certification information that apply to this camera.

[Firmware]

[Camera], [Lens],
[Mount Adapter],
[Power Zoom Adapter],
[Accessory]

Check/update the firmware version of the camera, lens ([ 31), mount adapter, power zoom adapter or
accessory.

[Download Latest Firmware]

Download the latest firmware and update the camera. (M197)

[PIN Code Management]

(24

[PIN Code Request]

[Disable], [Enable]

[PIN Code Change]

[Access Log Display]

— (1237)

! The default value depends on the country/region of purchase.
2 Only when the GP-E2 GPS Receiver is connected to the camera.

[Y% My Menu] menu (CAMERA mode only)

Menu item

[CAMERA-1: Edit] to
[CAMERA-5: Edit]

Setting options and additional information
[Register], [Move], [Delete], [Reset All], [Rename] (M 27)




Displaying the Status Screens

Displaying the Status Screens

You can use the status screens to check the camera’s various settings. You can also output the status screens
to an external monitor. Portions of the status screens will be displayed in English regardless of the language
selected. 213

1 Set an assignable button to [Status] ([J1 125).

2 Press the assignable button to open the status screens.

e The status screen most recently displayed will appear unless you turned off the camera or changed the
operating mode.

* You can also press the AUDIO STATUS button to open directly only the [ Audio Setup] status screen.
3 Scroll through the status screens to check the desired settings.

¢ Bring the cursor to a page number and push the joystick left/right to move between the status screens.

® You can also use front/rear control dials and the SELECT dial to navigate the status screens in the same way
as the setup menus.

4 Press the assignable button again or select [X CLOSE] to close the status screens.
® You can also press the MENU button to close the status screens and open the menu instead.



Recording / Output Signal and Detailed Settings

Recording / Output Signal and Detailed Settings

Sub Recording Clips ([11 63)

21 Main clip: RAW
Sub recording clip: XF-AVC, XF-HEVC S

Primary clip Sub recording clip configuration‘
Main . Sub recording format and resolution/bit rate
recording Malq FEIG Bit rate
format resolution rate XF-AVC YCC422 10 bit XF-HEVC S YCC422 10 bit XF-HEVC S YCC420 10 bit
4096x2160 / 600 Mbps Intra-frame | 4096x2160 / 4096x2160 / 150 Mbps
4096x2160 / 250 Mbps Long GOP 225 Mbps Long GOP Long GOP
59.94P | 678 Mbps 2048x1080 / 300 Mbps Intra-frame | 2048x1080 / 2048x1080 / 35 Mbps
2048x1080 / 50 Mbps Long GOP 50 Mbps Long GOP Long GOP
RAW LT | 4368x2304
4096x2160 / 500 Mbps Intra-frame | 4096x2160 / 4096x2160 / 150 Mbps
50.00P | 611 Mbps 4096x2160 / 250 Mbps Long GOP 225 Mbps Long GOP Long GOP
2048x1080 / 250 Mbps Intra-frame | 2048x1080 / 2048x1080 / 35 Mbps
2048x1080 / 50 Mbps Long GOP 50 Mbps Long GOP Long GOP
4096x2160 / 600 Mbps Intra-frame | 4096x2160 / 4096x2160 /
50.04P _ 4096x2160 / 250 Mbps Long GOP 225 Mbps Long GOP 150 Mbps Long GOP
2048x1080 / 300 Mbps Intra-frame | 2048x1080 / 2048x1080 /
HDMI 6000x3164 2048x1080 / 50 Mbps Long GOP 50 Mbps Long GOP 35 Mbps Long GOP
RAW " 4096x2160 / 500 Mbps Intra-frame | 4096x2160 / 4096x2160 /
50.00P _ 4096x2160 / 250 Mbps Long GOP 225 Mbps Long GOP 150 Mbps Long GOP
2048x1080 / 250 Mbps Intra-frame | 2048x1080 / 2048x1080 /
2048x1080 / 50 Mbps Long GOP 50 Mbps Long GOP 35 Mbps Long GOP
4096x2160 / 600 Mbps Intra-frame
639 Mbps, 4096x2160 / 450 Mbps Intra-frame | 4096x2160 / 4096x2160 /
29.97P | 563 Mbps, 4096x2160 / 300 Mbps Intra-frame | 135 Mbps Long GOP 100 Mbps Long GOP
366 Mbps 4096x2160 / 150 Mbps Long GOP | 2048x1080 / 2048x1080 /
2048x1080 / 150 Mbps Intra-frame | 50 Mbps Long GOP 35 Mbps Long GOP
2048x1080 / 50 Mbps Long GOP
4096x2160 / 500 Mbps Intra-frame
576 Mbps, 4096x2160 / 375 Mbps Intra-frame | 4096x2160 / 4096x2160 /
25.00P | 470 Mbps, 4096x2160 / 250 Mbps Intra-frame | 135 Mbps Long GOP 100 Mbps Long GOP
306 Mbps 4096x2160 / 150 Mbps Long GOP | 2048x1080 / 2048x1080 /
2048x1080 / 125 Mbps Intra-frame | 50 Mbps Long GOP 35 Mbps Long GOP
RAW ST, | 6000x3164, 2048x1080 / 50 Mbps Long GOP
RAWLT | 4368x2304 4096x2160 / 480 Mbps Intra-frame
553 Mbps, 4096x2160 / 360 Mbps Intra-frame | 4096x2160 / 4096x2160 /
24.00P | 541 Mbps 4096x2160 / 240 Mbps Intra-frame | 135 Mbps Long GOP 100 Mbps Long GOP
203 Mbps: 4096x2160 / 150 Mbps Long GOP | 2048x1080 / 2048x1080 /
2048x1080 / 120 Mbps Intra-frame | 50 Mbps Long GOP 35 Mbps Long GOP
2048x1080 / 50 Mbps Long GOP
4096x2160 / 480 Mbps Intra-frame
552 Mbps 4096x2160 / 360 Mbps Intra-frame | 4096x2160 / 4096x2160 /
23.98P | 541 Mbps’ 4096x2160 / 240 Mbps Intra-frame | 135 Mbps Long GOP 100 Mbps Long GOP
203 Mbps: 4096x2160 / 150 Mbps Long GOP | 2048x1080 / 2048x1080 /
2048x1080 / 120 Mbps Intra-frame | 50 Mbps Long GOP 35 Mbps Long GOP
2048x1080 / 50 Mbps Long GOP

" In most cases, the frame rate is the same as in the primary clip.



Sub recording clip: XF-AVC S

Recording / Output Signal and Detailed Settings

Primary clip Sub recording clip configuration1
Main . Sub recording format and resolution/bit rate
recording Malq Frame rate Bit rate
format resolution XF-AVC S YCC422 10 bit XF-AVC S YCC420 8 bit
4096x2160 / 600 Mbps Intra-frame
4096x2160 / 250 Mbps Long GOP 4096x2160 / 150 Mbps Long GOP
5994 678MPS | 2048x1080 / 300 Mbps Intra-frame | 2048x1080 / 35 Mbps Long GOP
2048x1080 / 50 Mbps Long GOP
RAW LT | 4368x2304
4096x2160 / 500 Mbps Intra-frame
50.00P 611 Mbps 4096x2160 / 250 Mbps Long GOP 4096x2160 / 150 Mbps Long GOP
2048x1080 / 250 Mbps Intra-frame 2048x1080 / 35 Mbps Long GOP
2048x1080 / 50 Mbps Long GOP
4096x2160 / 600 Mbps Intra-frame
50.94p _ 4096x2160 / 250 Mbps Long GOP 4096x2160 / 150 Mbps Long GOP
2048x1080 / 300 Mbps Intra-frame 2048x1080 / 35 Mbps Long GOP
2048x1080 / 50 Mbps Long GOP
HDMI RAW | 6000x3164
4096x2160 / 500 Mbps Intra-frame
50.00P _ 4096x2160 / 250 Mbps Long GOP 4096x2160 / 150 Mbps Long GOP
2048x1080 / 250 Mbps Intra-frame 2048x1080 / 35 Mbps Long GOP
2048x1080 / 50 Mbps Long GOP
4096x2160 / 600 Mbps Intra-frame
639 Mbps, 4096x2160 / 450 Mbps Intra-frame
99 97P 563 Mbps, 4096x2160 / 300 Mbps Intra-frame 4096x2160 / 100 Mbps Long GOP
366 Mbps 4096x2160 / 150 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP
2048x1080 / 150 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP
4096x2160 / 500 Mbps Intra-frame
576 Mbps, 4096x2160 / 375 Mbps Intra-frame
25, 00P 470 Mbps 4096x2160 / 250 Mbps Intra-frame 4096x2160 / 100 Mbps Long GOP
306 Mbps‘ 4096x2160 / 150 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP
2048x1080 / 125 Mbps Intra-frame
RAW ST, | 6000x3164, 2048x1080 / 50 Mbps Long GOP
RAWLT | 4368x2304 4096x2160 / 480 Mbps Intra-frame
553 Mbps, 4096x2160 / 360 Mbps Intra-frame
24.00P 541 Mbps 4096x2160 / 240 Mbps Intra-frame 4096x2160 / 100 Mbps Long GOP
203 Mbps‘ 4096x2160 / 150 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP
2048x1080 / 120 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP
4096x2160 / 480 Mbps Intra-frame
552 Mbps, 4096x2160 / 360 Mbps Intra-frame
93.98P 541 Mbps 4096x2160 / 240 Mbps Intra-frame 4096x2160 / 100 Mbps Long GOP
203 Mbps‘ 4096x2160 / 150 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP

2048x1080 / 120 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

" In most cases, the frame rate is the same as in the primary clip.
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Recording / Output Signal and Detailed Settings

Main clip: XF-AVC
Sub recording clip: XF-AVC

Main
recording
format

XF-AVC
YCC422
10 bit

Primary clip

Main resolution

Intra-frame

Long GOP

Frame
rate

59.94P,
50.00P

Bit rate

600 Mbps,
500 Mbps

Sub recording clip configuration’

Sub recording format and resolution/bit rate
XF-AVC YCC422 10 bit

2048x1080 / 300 Mbps, 250 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

250 Mbps

2048x1080 / 50 Mbps Long GOP

Intra-frame

4096x2160
Intra-frame

Intra-frame

Long GOP

29.97P,
25.00P,
24.00P,
23.98P

600 Mbps,
500 Mbps,
480 Mbps,
480 Mbps

4096x2160 / 150 Mbps Long GOP
2048x1080 / 150 Mbps, 125 Mbps, 120 Mbps, 120 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

450 Mbps,
375 Mbps,
360 Mbps,
360 Mbps

4096x2160 / 150 Mbps Long GOP
2048x1080 / 150 Mbps, 125 Mbps, 120 Mbps, 120 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

300 Mbps,
250 Mbps,
240 Mbps,
240 Mbps

4096x2160 / 150 Mbps Long GOP
2048x1080 / 150 Mbps, 125 Mbps, 120 Mbps, 120 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

150 Mbps

2048x1080 / 50 Mbps Long GOP

Intra-frame

Long GOP

59.94P,
50.00P

600 Mbps,
500 Mbps

1920x1080 / 300 Mbps, 250 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP
The following are 59.94i / 50.00i:
1920x1080 / 150 Mbps, 125 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP
1920x1080 / 25 Mbps Long GOP

250 Mbps

1920x1080 / 50 Mbps Long GOP
The following are 59.94i / 50.00i:
1920x1080 / 50 Mbps Long GOP
1920x1080 / 25 Mbps Long GOP

3840x2160 | ntra_frame

Intra-frame

Intra-frame

Long GOP

29.97P,
25.00P,
24.00P,
23.98P

600 Mbps,
500 Mbps,
480 Mbps,
480 Mbps

3840x2160 / 150 Mbps Long GOP
1920x1080 / 150 Mbps, 125 Mbps, 120 Mbps, 120 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP

450 Mbps,
375 Mbps,
360 Mbps,
360 Mbps

3840x2160 / 150 Mbps Long GOP
1920x1080 / 150 Mbps, 125 Mbps, 120 Mbps, 120 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP

300 Mbps,
250 Mbps,
240 Mbps,
240 Mbps

3840x2160 / 150 Mbps Long GOP
1920x1080 / 150 Mbps, 125 Mbps, 120 Mbps, 120 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP

150 Mbps

1920x1080 / 50 Mbps Long GOP




Main
recording
format

XF-AVC
YCC422
10 bit

Recording / Output Signal and Detailed Settings

Primary clip Sub recording clip configuration1
Frame Sub recording format and resolution/bit rate
Main resolution Bit rate
rate XF-AVC YCC422 10 bit
Intra-frame | 59 04p 3;;% m’; 2048x1080 / 50 Mbps Long GOP
50.00P
Long GOP 50 Mbps -
2048x1080 sgg7p | o0 Mbps,
-~ 1125 Mbps,
Intra-frame | 25 ooP, 120 Mbps 2048x1080 / 50 Mbps Long GOP
24.00R, | 190 Mbps
23.98P
Long GOP 50 Mbps -
Intra-frame | 50.04p 32%(()) ““"nt;‘;z 1920x1080 / 50 Mbps Long GOP
50.00P
Long GOP 50 Mbps -
29.97P 150 Mbps,
i 125 Mbps,
Intra-frame | 25 ooP, 120 Mbps, 1920x1080 / 50 Mbps Long GOP
1920x1080 24.00P | 120 Mbps
23.98P
Long GOP 50 Mbps -
Intra-frame 150 Mbps, || 1920x1080 / 50 Mbps Long GOP
59.94i 125 Mbps || 1920x1080 / 25 Mbps Long GOP
Long GOP 50.00i 50 Mbps -
Long GOP 25 Mbps -

" In most cases, the frame rate is the same as in the primary clip.
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Recording / Output Signal and Detailed Settings

Sub recording clip: XF-AVC S

Main
recording
format

218

XF-AVC
YCC422
10 bit

Main resolution

4096x2160

Primary clip Sub recording clip configuration1
Sub recording format and resolution/bit rate
Frame i rate XF-AVC S YCC42
rate XF-AVC S YCC422 10 bit : 8 bit 0
Intra-frame 600 Mbps, |12048x1080 / 300 Mbps, 250 Mbps Intra-frame 2048x1080 /
59.94P, | 500 Mbps |2048x1080 / 50 Mbps Long GOP 35 Mbps Long GOP
50.00P 2048x1080 /
Long GOP 250 Mbps |2048x1080 / 50 Mbps Long GOP 35 Mbps Long GOP
4096x2160 /
600 Mbps, 500 Mbps, 480 Mbps, 480 Mbps Intra-frame
600 Mbps, ||450 Mbps, 375 Mbps, 360 Mbps, 360 Mbps Intra-frame | 4096x2160 /
Intra-frame 500 Mbps, || 300 Mbps, 250 Mbps, 240 Mbps, 240 Mbps Intra-frame | 100 Mbps Long GOP
480 Mbps, ||4096x2160 / 150 Mbps Long GOP 2048x1080 /
480 Mbps |12048x1080 / 35 Mbps Long GOP
150 Mbps, 125 Mbps, 120 Mbps, 120 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP
4096x2160 /
450 Mbps, 450 Mbps, 375 Mbps, 360 Mbps, 360 Mbps Intra-frame 4096x2160 /
300 Mbps, 250 Mbps, 240 Mbps, 240 Mbps Intra-frame
29.97P | 375Mbps, 100 Mbps Long GOP
Intra-frame ’ 4096x2160 / 150 Mbps Long GOP
25.00P | 360 Mbps, 2048x1080 /
| 360 Mbps || 2048X1080/ 35 Mbps Long GOP
24.00P, PS 11150 Mbps, 125 Mbps, 120 Mbps, 120 Mbps Intra-frame ps Long
23.98p 2048x1080 / 50 Mbps Long GOP
4096x2160 /
300 Mbps, ||300 Mbps, 250 Mbps, 240 Mbps, 240 Mbps Intra-frame | 4096x2160 /
Intra-frame 250 Mbps, ||4096x2160 / 150 Mbps Long GOP 100 Mbps Long GOP
240 Mbps, |12048x1080 / 2048x1080 /
240 Mbps || 150 Mbps, 125 Mbps, 120 Mbps, 120 Mbps Intra-frame | 35 Mbps Long GOP
2048x1080 / 50 Mbps Long GOP
4096x2160 /
4096x2160 / 150 Mbps Long GOP 100 Mbps Long GOP
Long GOP 150MOPS || 481080 / 50 Mbps Long GOP 2048x1080 /

35 Mbps Long GOP




Main

recording

format

XF-AVC
YCC422
10 bit

Recording / Output Signal and Detailed Settings

Primary clip Sub recording clip configuration1
Sub recording format and resolution/bit rate
Main resolution Frame Bit rate XE-AVC S YCC420
rate XF-AVC S YCC422 10 bit i 8 bit

Intra-frame 600 Mbps, || 1920x1080 / 300 Mbps, 250 Mbps Intra-frame 1920x1080 /
59.94P, 500 Mbps || 1920x1080 / 50 Mbps Long GOP 35 Mbps Long GOP
50.00P 1920x1080 /

Long GOP 250 Mbps |/ 1920x1080 / 50 Mbps Long GOP 35 Mbps Long GOP
3840x2160 /
600 Mbps, 500 Mbps, 480 Mbps, 480 Mbps Intra-frame
600 Mbps, || 450 Mbps, 375 Mbps, 360 Mbps, 360 Mbps Intra-frame | 3840x2160 /
Intra-frame 500 Mbps, || 300 Mbps, 250 Mbps, 240 Mbps, 240 Mbps Intra-frame | 100 Mbps Long GOP
480 Mbps, ||3840x2160 / 150 Mbps Long GOP 1920x1080 /
480 Mbps ||1920x1080 / 35 Mbps Long GOP
150 Mbps, 125 Mbps, 120 Mbps, 120 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP
3840x2160 /
450 Mbps, 375 Mbps, 360 Mbps, 360 Mbps Intra-frame
3840x2160 4S0MBDS, || 20 Mbps, 250 Mbps, 240 Mbps, 240 Mbps Intra-frame | ¢~ 02160/
29.97p | 375Mbps, 100 Mbps Long GOP

Intra-frame ’ 3840x2160 / 150 Mbps Long GOP

25.00P | 360 Mbps, 1920x1080 /
| 360 Mbps ||| 220X1080/ 35 Mbps Long GOP
24.00P PS 11150 Mbps, 125 Mbps, 120 Mbps, 120 Mbps Intra-frame psLong
23.98P 1920x1080 / 50 Mbps Long GOP
3840x2160 /
300 Mbps, ||300 Mbps, 250 Mbps, 240 Mbps, 240 Mbps Intra-frame | 3840x2160 /
Intra-frame 250 Mbps, ||3840x2160 / 150 Mbps Long GOP 100 Mbps Long GOP
240 Mbps, ||1920x1080 / 1920x1080 /
240 Mbps || 150 Mbps, 125 Mbps, 120 Mbps, 120 Mbps Intra-frame | 35 Mbps Long GOP
1920x1080 / 50 Mbps Long GOP
3840x2160 /
3840x2160 / 150 Mbps Long GOP 100 Mbps Long GOP
Long GOP 150 MbPS || 1990x1080 / 50 Mbps Long GOP 19201080 /
35 Mbps Long GOP

Intra-frame 300 Mbps, ||2048x1080 / 300 Mbps, 250 Mbps Intra-frame 2048x1080 /
59.94P, | 250 Mbps | 2048x1080 /50 Mbps Long GOP 35 Mbps Long GOP
50.00P 2048x1080 /

Long GOP 50 Mbps ||2048x1080 / 50 Mbps Long GOP 35 Mbps Long GOP
150 Mbps
2048x1080 " 112048x1080 /

Intra-frame 29.97P, Eg mgp:’ 150 Mbps, 125 Mbps, 120 Mbps, 120 Mbps Intra-frame 224521 (s)?_%; GOP
25.00P, PS. 112048x1080 / 50 Mbps Long GOP psLong
24.00P, | 120 Mbps
23.98P

Long GOP 50 Mbps ||2048x1080 / 50 Mbps Long GOP 2048¢1080/

35 Mbps Long GOP

219



220

Recording / Output Signal and Detailed Settings

Main
recording
format

XF-AVC
YCC422
10 bit

Main resolution

1920x1080

Primary clip Sub recording clip configuration1
Sub recording format and resolution/bit rate
Frame gy rate XF-AVC S YCCA420
rate XF-AVC S YCC422 10 bit : 8 bit

Intra-frame 300 Mbps, ||1920x1080 / 300 Mbps, 250 Mbps Intra-frame 1920x1080 /
59.94P, | 250 Mbps | 1920x1080 / 50 Mbps Long GOP 35 Mbps Long GOP
50.00P 19201080 /

Long GOP 50 Mbps || 1920x1080 / 50 Mbps Long GOP 35 Mbps Long GOP
150 Mbps,
1920x1080 /

Intra-frame 29.97P, Eg mgpz 150 Mbps, 125 Mbps, 120 Mbps, 120 Mbps Intra-frame :1322“%1 (s)?_?)r/] GOP
25.00P, PS: 1119201080 / 50 Mbps Long GOP ps Long
24.00P, | 120 Mbps
23.98P 1920x1080 /

Long GOP 50 Mbps || 1920x1080 / 50 Mbps Long GOP 35 Mbps Long GOP

Intra-frame 150 Mops, - -
59.94i, 125 Mbps

Long GOP | 50.00i | 50 Mbps - -
Long GOP 25 Mbps - -

" In most cases, the frame rate is the same as in the primary clip.



Main clip: XF-HEVC S

Main recording

Primary clip

Recording / Output Signal and Detailed Settings

Sub recording clip configuration’

Sub recording format and resolution/bit rate

Main resolution Frame rate Bit rate
format XF-HEVC S YCC422 10 bit XF-HEVC S YCC420 10 bit
Iégg 59.94P, 50.00P | 225 Mbps ||2048x1080 / 50 Mbps Long GOP | 2048x1080 / 35 Mbps Long GOP
4096x2160
Long | 29.97P, 25.00P, 4096x2160/
GOP | 24.00P 23.98P 135 Mbps || 2048x1080 / 50 Mbps Long GOP | 100 Mbps Long GOP
R 2048x1080 / 35 Mbps Long GOP
Iégg 59.94P, 50.00P | 225 Mbps || 1920x1080 / 50 Mbps Long GOP | 1920x1080 / 35 Mbps Long GOP
3840x2160
Long | 29.97P, 25.00P, 3840x2160/
XF-HEVC S GOP | 24.00P 23.98P 135 Mbps | 1920x1080 / 50 Mbps Long GOP | 100 Mbps Long GOP
YCC422 10 bit R 1920x1080 / 35 Mbps Long GOP
Iégg 59.94P, 50.00P | 50 Mbps - 2048x1080 / 35 Mbps Long GOP
20481080 L 29.97P, 25.00P,
ong .97P, 25.00P, _
GOP | 24.00P 23.98P 50 Mbps 2048x1080 / 35 Mbps Long GOP
Long
G0P 59.94P, 50.00P | 50 Mbps - 1920x1080 / 35 Mbps Long GOP
1920x1080 L 29.97P, 25.00P,
ong .97P, 25.00P,
GOP | 24.00P 23.98P 50 Mbps 1920x1080 / 35 Mbps Long GOP
Long
G0P 59.94P, 50.00P | 150 Mbps - 2048x1080 / 35 Mbps Long GOP
A096x2160 L 29.97P, 25.00P,
ong .97P, 25.00P, _
GOP | 24.00P 23.98P 100 Mbps 2048x1080 / 35 Mbps Long GOP
Long
coP 59.94P, 50.00P | 150 Mbps - 1920x1080 / 35 Mbps Long GOP
38402160 L 29.97P, 25.00P,
ong .97P, 25.00P,
YF-HEVC S GOP | 24.00P 23.98P 100 Mbps 1920x1080 / 35 Mbps Long GOP
YCC420 10 bit
E‘g‘g 50.94P, 50.00P | 35 Mbps - -
2046x1080 L 29.97P, 25.00P,
ong .97P, 25.00P,
GOP | 24.00P, 23.98p | OO MOPS
Long
G0P 59.94P, 50.00P | 35 Mbps - -
19201080 L 29.97P, 25.00P,
ong .97P, 25.00P, _ _
GOP | 24.00P 23.98p | OO MOPS

" In most cases, the frame rate is the same as in the primary clip.
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Recording / Output Signal and Detailed Settings

Main clip: XF-AVC S

Primary clip Sub recording clip configuration1
Main Sub recording format and resolution/bit rate
recording Main resolution Frame rate Bit rate . .
format XF-AVC S YCC422 10 bit XF-AVC S YCC420 8 bit
600 Mbos 2048x1080 /
Intra-frame 500 Mbps7 300 Mbps, 250 Mbps Intra-frame 2048x1080 / 35 Mbps Long GOP
59.94P, 50.00P PS 11 2048x1080 / 50 Mbps Long GOP
Long GOP 250 Mbps ||2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP
600 Mbps 4096x2160 / 150 Mbps Long GOP
" 112048x1080 /
§ 500 Mbps, 4096x2160 / 100 Mbps Long GOP
Intra-frame 480 Mbps, 150 Mbps, 125 Mbps, 120 Mbps, 2048x1080 / 35 Mbps Long GOP
480 Mbos 120 Mbps Intra-frame
PS 11 2048x1080 / 50 Mbps Long GOP
4096x 450 Mbps 4096x2160 / 150 Mbps Long GOP
2160 375 Mbps, 2048x1080 / 4096x2160 / 100 Mbps Long GOP
Intra-frame 150 Mbps, 125 Mbps, 120 Mbps,
29.97P. 25.00P. | 360 Mbps, 2048x1080 / 35 Mbps Long GOP
21T, £9-55% 360 Mbos 120 Mbps Intra-frame
24.00P, 23.98P PS 1120481080 / 50 Mbps Long GOP
300 Mbps, ggigﬁ:} gg; 150 Mbps Long GOP
250 Mbps, 4096x2160 / 100 Mbps Long GOP
Intra-frame 240 Mbps, 150 Mbps, 125 Mbps, 120 Mbps, 2048x1080 / 35 Mbps Long GOP
240 Mbos 120 Mbps Intra-frame
p 2048x1080 / 50 Mbps Long GOP
4096x2160 / 100 Mbps Long GOP
XF-AVCS Long GOP 150 Mbps || 2048x1080 / 50 Mbps Long GOP 20481080 / 35 Mbps Long GOP
YCC422
Intra-frame 500 Mb s 300 Mbps, 250 Mbps Intra-frame 1920x1080 / 35 Mbps Long GOP
59.94P, 50.00P PS 1 1920x1080 / 50 Mbps Long GOP
Long GOP 250 Mbps || 1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP
600 Mbps, ?gggﬁ:} gg; 150 Mbps Long GOP
500 Mbps, 3840x2160 / 100 Mbps Long GOP
Intra-frame 480 Mbps, 150 Mbps, 125 Mbps, 120 Mbps, 19201080 / 35 Mbps Long GOP
480 Mbos 120 Mbps Intra-frame
p 1920x1080 / 50 Mbps Long GOP
3840x 450 Mbps 3840x2160 / 150 Mbps Long GOP
" 111920x1080 /
2160
Intra-frame S75MDDS, || 0 Mbps, 125 Mbps, 120 Mbps, | So#0x2160./100 Mbps Long GOP
29.97P 25.00P. | 360 Mbps, 1920x1080 / 35 Mbps Long GOP
oI e0 A 360 Mbos 120 Mbps Intra-frame
24.00F, 23.98P P 1 1920x1080 / 50 Mbps Long GOP
300 Mbps, ?gggﬁ:} gg; 150 Mbps Long GOP
250 Mbps, 3840x2160 / 100 Mbps Long GOP
Intra-frame 240 Mbps, 150 Mbps, 125 Mbps, 120 Mbps, 19201080 / 35 Mbps Long GOP
240 Mbos 120 Mbps Intra-frame
p 1920x1080 / 50 Mbps Long GOP
3840x2160 / 100 Mbps Long GOP
Long GOP 150 Mbps |/ 1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP




Recording / Output Signal and Detailed Settings

Primary clip Sub recording clip configuration1
Main Sub recording format and resolution/bit rate
recording Main resolution Frame rate Bit rate . .
oyl XF-AVC S YCC422 10 bit XF-AVC S YCC420 8 bit
300 Mbps,
Intra-frame 2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP
59.94P, 50.00P | 250 Mbps g g
Long GOP 50 Mbps - 2048x1080 / 35 Mbps Long GOP
2048x 150 Mbps,
1080 125 Mbps,
Intra-frame | 29 97p, 25.00P, 120 Mbps 2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP
24.00P, 23.98P | 190 Mops
XF-AVCS Long GOP 50 Mbps - 2048x1080 / 35 Mbps Long GOP
YCC422
I Intra-frame 1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP
59.94P, 50.00P | 250 Mbps
Long GOP 50 Mbps - 1920x1080 / 35 Mbps Long GOP
1920x 150 Mbps,
1080 125 Mbps,
Intra-frame | 29.97p, 25.00P, 120 Mbps 1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP
24.00P, 23.98P | 120 Mbps
Long GOP 50 Mbps - 1920x1080 / 35 Mbps Long GOP
1096 Long GOP | 59.94P 50.00P | 150 Mbps - 2048x1080 / 35 Mbps Long GOP
X
29.97P, 25.00P,
2160 ’ ’ _
Long GOP 24.00P, 23.98P 100 Mbps 2048x1080 / 35 Mbps Long GOP
3840 Long GOP | 59.94P, 50.00P | 150 Mbps - 1920x1080 / 35 Mbps Long GOP
X
XF-AVCS | 2160 29.97P, 25.00P, _
VeCa20 Long GOP 24.00P, 23.98P 100 Mbps 1920x1080 / 35 Mbps Long GOP
8 bit Long GOP | 59.94P, 50.00P | 35 Mbps - -
2048x 29.97P, 25.00P,
1080 -1, 29,005 _ _
Long GOP 24.00P, 23.98P 35 Mbps
Long GOP | 59.94P, 50.00P | 35 Mbps - -
1920x 29.97P 25.00
1080 | Longgop | 2297P25.00R 1 onying - -

24.00P, 23.98P

" In most cases, the frame rate is the same as in the primary clip.
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Troubleshooting

Troubleshooting

If you have a problem with your camera, refer to this section. Consult your dealer or a Canon Service Center if
the problem persists.

Power source

The camera will not turn on or it turns off by itself.
- The battery pack is depleted. Replace or charge the battery pack.
- Remove the battery pack and reattach it correctly.

Shortly after turning it on, the camera turns off on its own.
- You are using a battery pack that is not compatible for use with this camera. Use a recommended battery pack

(7 241).

Cannot charge the battery pack.
- The temperature of the battery pack is outside the charging range. If the battery pack’s temperature is below 0 °C
(82 °F), warm it before charging it; if it is above 40 °C (104 °F), let the battery pack cool down before charging it.
- Charge the battery pack in temperatures between 0 °C and 40 °C (32 °F and 104 °F).
- The battery pack is faulty. Replace the battery pack.

The battery pack is depleted extremely quickly even at normal temperatures.
- Check the [ System Setup] status screen ([11 213) to check if the battery pack has reached the end of its battery
life. If so, buy a new battery pack.

Recording

The camera’s controls are not responsive/disabled.
- When the switch is set to i@, all buttons (or all buttons with the exception of some REC buttons) are locked
and cannot be operated. Set the AMED switch to CAMERA. You can change which controls are locked with the
MENU > [¥ System Setup] > [Key Lock] setting.

Performing a recording operation (pressing a button/touching the onscreen button) will not start recording.

- The card is full or it already contains the maximum number of clips (999 clips). Delete some clips ([I1 150) or save your
recordings and initialize the card ([1 37) to free some space. Alternatively, replace the card.

- The REC button was pressed while all the camera's controls were locked (key lock, [1] 15). Unlock the controls or set
MENU > [ System Setup] > [Key Lock] to [All Except REC Button].

- The REC button that was used may be disabled. Change the MENU > [§ System Setup] > [REC Button], [Assign.
Button 4 as REC]. [Assign. Button 11 as REC] and [Onscreen REC/STBY Button] settings to enable the use of the
desired button or onscreen button.

- Power supply to the camera has reached the level set for the power level warning ([11 211). Check the power source.

- The camera cannot record while the [Color Correction] settings in the custom picture file (11 137) are being adjusted
(except for the [Revision Level]/[Revision Phase] settings).

The point when the recording operation was performed does not match the beginning/end of the recording.
- There may be a slight interval between pressing the REC button (or touching the onscreen button) and the actual start/
end of recording. This is not a malfunction.

The camera will not focus.
- The camera may not be able to focus on certain subjects using autofocus. Focus manually ((11 80).
- When [Continuous AF] is enabled and [Lens action if cannot AF] is set to [Stop], start focusing manually until the AF
frame changes from yellow to white.
- The lens is dirty. Clean the lens with a soft lens-cleaning cloth.
When a subject flits across in front of the lens, the image appears slightly bent.

- This is a phenomenon typical of CMOS image sensors. When a subject crosses very quickly in front of the camera, the
image may seem slightly warped. This is not a malfunction.



Troubleshooting

Bright red, green or blue dots appear on the screen.

- Try adjusting the black balance ([11 45). The camera’s CMOS sensor is a delicate piece of precision engineering. Direct
exposure of the sensor to ion rays or other types of cosmic radiation may affect it and this may rarely appear as bright colored
dots on the screen. This is the nature of CMOS image sensors and does not represent a malfunction.

- The effects of the damage may be more noticeable when the camera is used in places subject to high temperatures,
when a high ISO speed or gain level is used and when slow shutter speeds are used.

Abnormal images appear on the screen and the camera cannot record properly.
- While recording using an almost empty battery pack together with an AC adapter, the AC adapter was inadvertently
disconnected or the power supply was suddenly interrupted. Reconnect the AC adapter and turn the camera off and
then on again or replace the battery pack with a fully charged one.

Changing between recording (@ REC) and record standby (STBY) takes longer than usual.
- When the card contains a large number of clips, some operations may take longer than usual. Save your recordings
and initialize the card ([I1 37). Alternatively, replace the card.

Clips or photos cannot be recorded properly.
- This may occur as clips and photos are recorded/deleted over time. Save your recordings and initialize the card
(37).
After using the camera for a long time, it becomes hot.
- The camera may become hot after using it continuously for long periods of time; this is not a malfunction. If the
camera becomes unusually hot or it becomes hot after using it only for a short while, it may indicate a problem with
the camera. Consult a Canon Service Center.

Playback

Cannot delete clips/photos
- XF-AVC clips with an [l mark cannot be deleted with the camera. Remove the [l mark ({13 149).
- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.
- Photos that were protected using other devices cannot be deleted with this camera.

Deleting clips takes longer than usual.
- When the card contains a large number of clips, some operations may take longer than usual. Save your recordings
and initialize the card ([11 37).

Indicators and Onscreen Displays

appears in red on the screen.
- Battery pack is depleted. Replace or charge the battery pack.

appears on the screen.
- The camera cannot communicate with the battery pack attached so the remaining battery time cannot be displayed.

The power indicator/tally lamp does not illuminate.
- Set MENU > [¥ System Setup] > [Tally Lamp] to [On]
The power indicator/tally lamp flashes quickly. o o:620- | (4 flashes per second)
- The battery pack is depleted. Replace or charge the battery pack.
- There is not enough available space on the cards. Delete recordings ([11 150) to free some space or replace the card.

- A system error has occurred. Turn the camera off and then on again. If this does not solve the problem, consult a
Canon Service Center.

The power indicator/tally lamp flashes slowly. 3 2 (1 flash per second)
- The combined available space on the cards is low. Delete recordings ([11 150) to free some space or replace the card.

IR or BB appears in red on the screen.
- An SD card error occurred. Remove and reinsert the SD card. If the display does not change back to normal, save your
recordings and initialize the SD card (1 37).

/ B appears in red on the screen followed by [END].
- The indicated card is full. Delete recordings ([T] 150) to free some space or replace the card.
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Even after stopping recording, the access indicator stays illuminated in red.
- The clip is being recorded on the card. This is not a malfunction.

appears in yellow on the screen.
- The camera’s internal temperature has reached a predetermined level. You can continue using the camera.

appears in red on the screen.
- The camera’s internal temperature has risen further while E3 appeared in yellow on the screen. Turn off the camera
and wait until the temperature has decreased.

XA appears in red on the screen.
- The cooling fan may not be working properly. The camera will automatically turn off after a few minutes. Consult a
Canon Service Center.

14N appears on the screen.
- The camera and lens cannot communicate normally. Clean the lens’s contacts and reattach the lens.

The aperture value (T or F value) appears in gray on the screen.

- When using a compatible EF Cinema lens ([1] 249), the aperture value will appear in gray when the camera detects
that the aperture may be close to fully closed. As you continue to close down the aperture further, the display will
change to [closed].

The ND filter indicator appears in red or as [- -] on the screen, and the ND filter indicators on the RC-V100 Remote
Controller are flashing.
- The ND filter mechanism may not be working properly. Consult a Canon Service Center.

Picture and Sound

There is no picture from an external monitor.
- Make sure the cable connecting the camera to the monitor is correctly connected on both sides.
- Check that the correct video input is selected on the external monitor.

There is no picture or sound from an external monitor/recorder connected to the HDMI OUT terminal
- Disconnect the HDMI cable and then restore the connection or turn the camera off and then on again.
- Check that the settings of the external monitor/recorder match the configuration of the output signal selected on the
camera (] 151).
- Replace the HDMI cable.

An assistance display (peaking/zebra pattern/video scope/onscreen markers/false color/magnification/B&W image/
tally OSD/anamorphic desqueeze/view assistance) does not appear or is not applied on the screen.

- These assistance displays have separate settings that allow you to turn the display on/off on individual monitoring
devices/video outputs. Check the settings to see that the desired function is enabled on the desired monitor/video
output.

- Onscreen displays output has not been enabled. Activate the output of the camera’s onscreen displays ([1] 157).

Screen displays turn on and off repeatedly.
- The battery pack is depleted. Replace or charge the battery pack.
- Remove the battery pack and reattach it correctly.

Abnormal characters appear on the screen and the camera does not operate properly.
- Remove all the cards and disconnect the power source. After a moment, reconnect the power and reinsert the cards.
If the problem still persists, use the MENU > [§ System Setup] > [Reset] > [All Settings] function. This resets all the
camera’s settings to default values, except for the hour meter.

Video noise appears on screen.
- Keep a distance between the camera and devices that emit strong electromagnetic fields such as near powerful
magnets and motors, MRI machines or high-voltage power lines.

Horizontal bands appear on the screen.

- This is a phenomenon typical of CMOS image sensors when recording under some types of lighting. This is not a
malfunction. You may be able to reduce the symptoms by setting the shutter speed mode to [Speed] and the shutter
speed to a value matching the frequency of the local electrical system: 1/50* or 1/100 for 50 Hz systems, 1/60 or 1/120
for 60 Hz systems.

*May not be available depending on the frame rate.



Troubleshooting

Audio is not recorded.

- The audio input source is not correctly selected (] 102) or a microphone is not connected to the selected terminal.

- When using the INPUT 1/INPUT 2 terminals, make sure you are using a mini XLR connector. When using the MIC
terminal, make sure you are using a condenser microphone with a & 3.5 mm stereo mini plug.

- The external microphone is not turned on or its battery is depleted.

- The external microphone connected to the INPUT 1/INPUT 2 terminal requires phantom power. Set the corresponding
INPUT 1/INPUT 2 audio source selection switch to MIC+48V ([T] 102).

- The external microphone connected to the MIC terminal requires plug-in power but MENU > [)) Audio Setup] >
[MIC Input] is set to an option other than [MIC (with Power Supply)].

- To record audio for slow & fast motion clips, set the recording mode to [S&F Clip / Audio (WAV)] (11 39).

Sound is distorted or is recorded at lower levels.

- This may happen when the appropriate audio level is not set correctly. Adjust the audio recording level manually
([T 104). You can also activate the microphone attenuator ([J1 105) to reduce the audio level.

- The audio source selected for the INPUT terminal or MIC terminal is incorrect. When using an external microphone, set
the INPUT switch to MIC or set MENU > [)) Audio Setup] > [MIC Input] to [MIC (with Power Supply)]. When using an
analog audio device set the INPUT switch or the [MIC Input] setting to [LINE].

- The audio level is adjusted manually and the recording level is set too low. Check the audio level meter on the screen
and adjust the audio level correctly (1] 103).

Cards and Accessories

Cannot insert the card.
- The card you are trying to insert is not facing the correct direction. Turn it over and insert it.

Cannot record on the SD card.

- A compatible card must be used ([11] 35).

- Initialize the card ([1] 37) when you use it with the camera for the first time.

- The card is full or it already contains the maximum number of clips (999 clips). Delete recordings ([1] 150) to free some
space or replace the card.

- The clip number has reached its maximum value. Save your recordings and initialize the card ([T] 37) or delete all the
clips (11 150).

- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.

- The folder and file numbers for photos have reached their maximum value. Set MENU > [£3 Recording/Media Setup]
> [Photo Numbering] to [Reset] and insert a new card.

Recording to and playing back from a card is slow.
- This may occur as recordings are made and deleted repeatedly over time. Save your recordings and initialize the card
(37).
The RC-V100 Remote Controller or commercially available remote control does not work.
- Make sure that MENU > [¥ System Setup] > [REMOTE Term.] is set to [RC-V100 (REMOTE A)] when using the
RC-V100 Remote Controller or to [Standard] when using a commercially available remote control ([1] 123).
- Turn off the camera, reconnect the remote controller and then turn the camera back on again.
- When the currently selected custom picture file is protected, detailed custom picture settings cannot be adjusted
using the RC-V100. Unprotect the file (1] 131).

Connections with External Devices

Video noise appears on a nearby TV screen.
- When using the camera in a room where a TV is located, keep a distance between the AC adapter and the power or
antenna cables of the TV.
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Network Functions

Check This First

e Are the camera, computer or other network devices all turned on?

e |s the camera properly powered on and ready for use? Is the PIN code correctly configured and entered if
required?

e |s the network working and correctly configured?

¢ Are all network devices correctly connected to the same network as the camera?

¢ \When using a Wi-Fi network, are there any obstructions between the camera and the access point or
between the network device used and the access point?

Cannot connect with an access point.
- Check that the settings on the network device the camera is trying to connect with are correct.
- The wireless signal is not strong enough or there are other devices in the vicinity interfering with the wireless signal.
Refer to Precautions Regarding Wi-Fi Networks ([11 229).
Cannot establish a Camera Access Point connection with a network device.
- When you reset all the camera settings, all network settings are lost as well. Configure the network settings again
(T 174).
- The wireless signal is not strong enough or there are other devices in the vicinity interfering with the wireless signal.
Refer to Precautions Regarding Wi-Fi Networks ([1] 229).
- If you cannot connect to the camera from a mobile device, change the [Network] setting to [Disable] and then change
it back to [Enable].
Cannot transfer clips
- Canceling data transfer or opening the card compartment cover may cause an unexpected error due to inconsistency
with the connection destination. Reconnect the AC adapter or reattach the battery and turn the camera off and then
back on.
- Clips that have not been recovered cannot be transferred. Recover clips in advance ([1 38).

Cannot connect with a wired (Ethernet) network.
- Use a category 5e or better shielded twisted pair (STP) Ethernet cable.
- Try replacing the Ethernet cable.
- When you reset all the camera settings, all network settings are lost as well.
- Check that the network device to which the camera is connected is on and functioning properly. To use 1000BASE-T
connection speeds, make sure to use network devices compatible with Gigabit Ethernet (1000BASE-T).

The % (Ethernet) indicator is illuminated or flashing in red or is turned off.
- The Ethernet cable was disconnected or the camera cannot connect to the network device. Check the cable
connection and the network device.

The Browser Remote application will not start on the Web browser.
- Make sure to use a connection setting with the [Browser Remote] function setting.
- The URL entered into the Web browser’s address bar is incorrect. Select MENU > [#8A# Network Settings] >
[Connection Setting] > Connection setting in use > [Check Settings] and check the camera’s IP address. Use this IP
address as the URL ([1] 187).

The Browser Remote screen is not displayed correctly on the Web browser.
- The device, operating system or Web browser used may not be supported. For the latest information about supported
systems, visit your local Canon website.
- Enable JavaScript and cookies in your Web browser’s settings. For details, refer to the help modules or online
documentation of the Web browser used.

Cannot start IP streaming.

- Make sure IP streaming was activated on the camera ([1] 185).

- If the IP streaming protocol is set to an option other than [RTSP+RTP], make sure the [Destination Server] is set
correctly ([I] 170).

- IP streaming cannot be used in the following cases. Check the settings.
¢ When the main recording format is set to [RAW].
* When the system frequency is set to 24.00 Hz.
* When the recording mode is set to an option other than normal recording.
¢ When [2nd Card Rec Functions] is set to an option other than [Off].



Troubleshooting

Cannot connect the optional XC Protocol compatible RC-1P100/RC-IP1000 Remote Camera Controller, Remote
Camera Control Application or Multi-Camera Control.

- Make sure to use a connection setting with the [XC Protocol] function setting.

- Check that the settings on the optional RC-IP100/RC-IP1000, Remote Camera Control Application or Multi-Camera
Control that the camera is trying to connect with are correct.

Precautions Regarding Wi-Fi Networks

When using a Wi-Fi network, try the following corrective actions if the transmission rate drops, the connection is
lost, or other problems occur.

Positioning a network device (access point, mobile device, etc.)
- When using a Wi-Fi network indoors, place the network device in the same room as the camera.
- Place the network device in an open, unobstructed location, where people or objects do not come between it and the
camera.
- Place the network device as close as possible to the camera. Change the position, height or facing of the network
device, as necessary.

About camera installation and setup when using the 2.4 GHz band.
The following operations may improve the communication status.
- Do not install the handle unit so as not to block the signal.
- When using Browser Remote, set the Browser Remote [Live view resolution] to [Small] (11 192).

Nearby electronic devices
- If the transmission rate over a Wi-Fi network drops because of interference from the following electronic devices,
switching to the 5 GHz band or to a different channel may solve the problem.
- Wi-Fi networks using the IEEE 802.11b/g/n protocol operate in the 2.4 GHz band. For this reason, the transmission
rate may drop if there are nearby microwave ovens, cordless telephones, wireless microphones and Bluetooth or
similar devices operating on the same frequency band.

Using multiple cameras/Wi-Fi adapters/access points

- Check that there are no IP address conflicts among the devices connected to the same network.

- If multiple cameras are connected to a single access point, connection speeds may be reduced.

- To reduce radio wave interference when there are multiple access points using IEEE 802.11b/g or IEEE 802.11n (in the
2.4 GHz band), leave a gap of four channels between each wireless access point. For example, use channels 1, 6, and
11, channels 2, 7, and 12, or channels 3, 8, and 13.

If you can use IEEE 802.11a/n/ac (in the 5 GHz band), switch to IEEE 802.11a/n/ac and specify a different channel,
leaving an appropriate gap between channels according to the wireless standard and frequency band used. For
example, when using IEEE 802.11ac (VHT80), leave a gap of 8 channels between access points.
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List of Messages

Refer to this section if a message appears on the screen. The messages in this section appear in alphabetical
order. Note that for some messages, an indication of the card involved ([SD Card A], [SD Card B] or [SD Card])
may appear above the message itself.

Media full
- The card is full. Replace the card or delete recordings ([T 150) to free some space on the card.
- Recording will not start because the card is full. Switch to the card in the other card slot to record.

Media is almost full
- Available space on one or both cards is insufficient as described below. Replace the relevant card(s) or delete
recordings ([11 150) to free some space on the card.
¢ During normal recording, the space available on the card being used for recording is low.
e During relay recording, the combined space available on cards A and B is low.
e During sub recording or double slot recording, the space available on card A or B (the fullest one) is low.
e During proxy recording, the space available on card A (primary clips) is low. Otherwise, when recording only on card
B (proxy clips), the space available on card B is low.
¢ During continuous recording, the space available on card B (continuous) is low.

Accessing <...> Do not remove
- You opened the card compartment cover while the camera was recording on the card. Be sure to stop the recording
before removing the card.

Currently, the accessory cannot be used
- A communication error occurred between the camera and an accessory attached to the multi-function shoe. Turn the
camera off and then back on again.

Currently, the accessory cannot be used
Please check the accessory power status
- Battery level is low on the accessory attached to the multi-function shoe. Replace the battery.

The following settings were changed.
- The settings displayed on the screen were changed automatically due to a change in one of the [ £% Recording/Media
Setup] settings. Check the settings before you continue recording.

Memory card is write-protected
- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.

Check the memory card

- Cannot access the card. If the card is correctly inserted, remove it. Check it has no defects or other problems and then
reinsert it.

- A card error occurred and recording/playback is not possible. Try removing and reinserting the card or replace it.

- You inserted a MultiMedia Card (MMC) into the camera. Use a recommended SD card ([] 35).

- If after the message disappears, IS or ES appears in red, perform the following: Turn off the camera and remove and
reinsert the card. If or B turns back to green you can resume recording/playback. If the problem persists, save
your recordings and initialize the card ([J1 37).

(M) The management file's version is different.
Recommend full backup and initializing.
- Cannot record/playback because the management file's version is different. Back up the content in the card, then
initialize the card ([11 37).

No photos
- There are no photos on the SD card.

Cover is open
- The card compartment cover is open. Insert a card and close the card compartment cover.

Camera & Lens communication error. Clean the lens’s contacts and reattach the lens.
- The camera cannot correctly communicate with the lens due to dirty lens contacts. After the message disappears, the
[1AM icon appears on the screen. Clean the lens contacts with a soft cloth and reattach the lens.

Management file error
- Cannot record because the camera cannot write to the file control information. This may occur if the files on the card
were accessed using another device. Save your recordings and initialize the card ([] 37).
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Recording was stopped.
- The file control information is corrupted or there was an encoder error. Turn the camera off and then on again. Then,
remove the card being used and reinsert it. Alternatively, replace the card. If this does not solve the problem, consult a
Canon Service Center.
* Corrupted file control information cannot be recovered. Cards or XF-AVC clips with corrupted file control information 231
cannot be read by the software (Canon XF Utility or plugins for NLE applications).
No clips
- There are no clips of the selected video format on the selected card.

Number of clips already at maximum
- The card selected for recording already contains the maximum number of clips (999 clips). Replace the card or use the
card in the other card slot.
- Because both cards reached the maximum number of clips, double slot recording is not available.

The memory card is not compatible with the current recording settings.
- One of the following recording settings was used with a card with a video speed class lower than V90. Change to a
V90 card.
e Slow & fast motion recording mode is activated and the frame rate selected is for slow recording.
® The recording format was set to [XF-AVC YCC422 10 bit] / [XF-AVC S YCC422 10 bit] and the resolution to
[4096x2160 Intra-frame] / [3840x2160 Intra-framel].
- One of the following recording settings was used with a card with a video speed class lower than V60. Change to a
V60 or V90 card.
® The recording format was set to [XF-AVC YCC422 10 bit] / [XF-AVC S YCC422 10 bit] with an [Intra-frame]
resolution.
e The recording format was set to [XF-AVC YCC422 10 bit] / [XF-AVC S YCC422 10 bit] with a resolution of
[4096x2160 Long GOP] / [3840x2160 Long GOP].
e The recording format was set to [XF-HEVC S YCC422 10 bit] with a resolution of [4096x2160] / [3840x2160].
- The recording format was changed to RAW when an SD/SDHC memory card was inserted. Insert an SDXC memory
card instead.

With the current [Gamma/Color Space] settings, setting the main recording format to one of the 10 bit options is
recommended.

- The main recording format is set to one of the options using 8 bit depth but the color space component of the
[Gamma/Color Space] setting in the custom picture file is set to [C.Gamut] or [BT.2020]. Using a 10 bit depth is
recommended to fully realize the characteristics of the selected color space.

May not be possible to record clips on this media
- The card used does not meet the camera's requirements. Use a recommended card ([T 35).

If you change this setting, you will not be able to use the current Look File.
- The Look File’s adjustments to the image quality cannot be applied because the [Gamma/Color Space], [HLG Color],
[White Level 100%], [Over 100%] settings in the custom picture file are different from those registered with the Look
File. Change these settings or register a different Look File.

This photo cannot be displayed
- You may not be able to display photos taken with other devices or image files created or edited on a computer.

Cannot play back
- The XF-AVC clip’s file control information is corrupted or there was a decoder error. Turn the camera off and then on
again. If this does not solve the problem, consult a Canon Service Center.

* Corrupted file control information cannot be recovered. Cards or XF-AVC clips with corrupted file control information
cannot be read by the software (Canon XF Utility or plugins for NLE applications).

- Playback was stopped because the card's read speed was too slow. Use a recommended card for recording/playback

(M35

Some clips require data recovery
- The power may have been suddenly turned off or the card may have been removed while the camera was recording.
As a result, one or more clips contain corrupted data. You can try to recover the clips (11 38).

Some audio files require data recovery.
- The power may have been suddenly turned off or the card may have been removed while the camera was recording.
As a result, one or more audio files contain corrupted data. You can try to recover the files (11 38).

False color cannot be used when [Slow & Fast Frame Rate] exceeds 60 and [SDI Output Signal] is 3840x2160 or
higher.
- False color cannot be used. Check the settings.
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Peaking and zebra cannot be used at the same time when [Slow & Fast Frame Rate] exceeds 60 and [SDI Output
Signal] is 3840x2160 or higher.
- Peaking and zebra cannot be used at the same time. Check the settings.

Invalid operation
- The following are not valid operations and cannot be performed.
¢ In MEDIA mode, during playback, trying to add a shot mark to a frame that has one already.
e Trying to add an [ mark and a [ mark to the same clip.
e Pressing the REC button when no cards are inserted in the camera.
Recommended settings for attached lens:
Sensor Mode: Full Frame
Digital IS: Off
Main Resolution: 3840x2160 or higher
- Adjust the menu settings as indicated in the message.

Attached lens accessory not supported by the camera. It may not work properly.
- The attached lens accessory is not supported. Some functions may not work correctly.

Attached lens’s firmware must be updated for the lens to work properly with this camera.

- For details about available firmware updates for the lens used, visit your local Canon website.

With the current combination of lens and mount adapter, some functions' performance may not be precise. Visit your
local Canon web site for details.

- With the current combination of lens and mount adapter used, the focal length and aperture value displayed by the
camera may not be accurate and should be considered only as a reference. Additionally, some functions may not work
as precisely.

Attached lens not supported by the camera. It may not work properly.
- The attached lens is not supported. Some functions may not work correctly.
Recommend checking the data and initializing
- The card cannot be used for any of the following reasons. Save your recordings and initialize the card ([1] 37).
e A problem has occurred with the card.
* The camera cannot read the data on the card.
* The card was initialized using a computer.
® The card is partitioned.
Unable to recover data

- Could not recover the selected recording (clip or audio file). Back up your recordings and delete the recordings that
could not be recovered (1 150).

- The camera may not be able to recover files when there is not enough space on the card. Delete recordings (1] 150)
to free some space.

Low Power Warning Check the power supply.

- The input power supplied to the camera (DC IN terminal) has reached the level set for the power level warning
(@ 211). Check the power source.

- The message appears every time you press the REC button when the power supply is too low (as described above).

Battery communication error. Does this battery display the Canon logo?

- You attached a battery pack that is not recommended by Canon for use with this camera.

- If you are using a battery pack recommended by Canon for use with this camera, there may be a problem with the
battery pack or camera. Consult a Canon Service Center.

Battery internal temperature is rising. Power supply from the battery may stop. Do not disconnect the AC adapter.

- Power supply from the battery may stop automatically if the internal temperature rises. Do not unplug the AC adapter
Buffer overflow. Recording was stopped.

- Recording was stopped because the card's write speed was too slow. Use a recommended card ([1] 35).

- Save your recordings and initialize the card ([11 37).
Power Zoom Adapter Temperature too high. Cannot perform task.

- The power zoom adapter cannot be operated because its temperature is too high. Stop using the power zoom adapter
and let it cool down before using it again.

Power Zoom Adapter Check the power supply.
- The power zoom adapter’s remaining battery charge is low. Replace the power zoom adapter’s batteries.
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File name error
- Clip/photo numbers have reached their maximum value. Save your recordings and initialize the card ([1] 37) or delete
all the recordings (1 150).

Fan error
- The cooling fan may not be working properly. The camera will turn off automatically after a few minutes. Consult a
Canon Service Center.

Lens error Turn the camera off, then on again.
- There was a communication error between the camera and the lens. Turn the camera off and then on again.

Set the lens to the shooting position.
- The collapsible lens attached to the camera is not set to the shooting position (with the barrel extended and locked).
Set the lens to the shooting position.

Set with switch on lens side
- If you select MENU > ["™ Camera Setup] > [Focus Mode], attach a lens with a focus mode switch to switch AF/MF.
- If you select MENU > ["™ Camera Setup] > [Lens Optical IS], attach a lens with an optical IS on/off switch to switch it.
Recorded at 24.00 Hz/50.00 Hz/59.94 Hz Recommend checking the data and initializing
- The card contains clips that were recorded using a system frequency different from the one currently used by the
camera. To record on this card, save your recordings and initialize the card with the camera ([1] 37). To play back the
XF-AVC clips recorded on the card, change the camera's system frequency ([11 61) to match the recordings on the
card.

60 minutes have elapsed. Audio (WAV) recording will stop.
- Recording of the audio file will stop after 60 minutes but video recording will continue unaffected.

Lens firmware update Firmware update failed. Try updating again.
- The lens’s firmware could not be correctly updated. Try updating the firmware again.

Mount Adapter firmware update  Firmware update failed. Try updating again.
- The mount adapter’s firmware could not be correctly updated. Try updating the firmware again.

Power zoom adapter firmware update Firmware update failed. Try updating again.
- The power zoom adapter’s firmware could not be correctly updated. Try updating the firmware again.

[Gamma/Color Space] ([HLG Color], [Over 100%] or [White Level 100%)])
Look File not available because these settings are different from those registered with the Look File.
- A Look File is disabled if the [Gamma/Color Space], [HLG Color], [Over 100%] or [White Level 100%] settings are
changed after registering it. Restore the setting or register the Look file again.

The number of ND filters used has changed. Check the focus.
- When using ND filter settings in the extended range (from 8 to 10 stops when [ND Display Units] is set to [Stop]), the
number of ND filters used changes and this may result in a shift in focus. Check the focus before resuming shooting.

Noise levels will rise on the image of the sub recording and on video outputs not in RAW.
- The main recording format is set to RAW and the gamma curve component of the [Gamma/Color Space] setting in the
custom picture file is set to an option other than [Canon Log 2]/[Canon Log 3]. Under such conditions, there may be
more noise on the recorded proxy clips (SD card) and on video output from the various terminals.

SD Card A-SD Card B/ SD Card B-»SD Card A Switched
- This message appears when you use the SLOT SELECT button to switch the card slot in use or recording continued
from one card to the other.

SD Card A—SD Card B / SD Card B—»SD Card A Will switch in a moment
- The card is almost full so recording will continue on the other card in approximately 1 minute.

Cannot switch SD card slots
- The SLOT SELECT button was pressed while the camera is recording. Wait until recording is finished to change the
selected card slot.

Number of Shot Marks at maximum
- The shot mark could not be added because the clip already contains 100 shot marks.

When [Slow & Fast Frame Rate] is set higher than 60 (fps), the Magnification function cannot be used.
- You attempted to use the magnification function with slow & fast motion recording activated with a shooting frame rate
higher than 60. Change the sensor mode or set a shooting frame rate of 60 or lower.
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Network Functions

Along with this list, refer also to the instruction manuals of the access point or other external devices you are
using.

No response from access point.
- Check that the access point is working properly.
- Refer to Precautions Regarding Wi-Fi Networks ([1] 229) and check if there are applicable steps you can take.

Unable to connect to access point.
- The camera’s encryption method is different from that of the access point. Change the settings on the camera to
match the access point.

Unable to connect to access point. Retry from the beginning.
- To configure a new network connection using the WPS function (push button method), refer to the access point’s
instruction manual and check how to activate the WPS function on the wireless router.

No Wi-Fi network found with the selected SSID.
- Check the access point’s SSID (network name) and make sure the same name is used in the camera’s settings.
- Check that the access point is working properly and try again.
Error code returned from the FTP server for the data session.
- The FTP server terminated the connection. Restart the FTP server.
- Change the file access permission settings on the FTP server to allow reading, writing and accessing logs.
- Allow access permissions to the selected destination folder on the FTP server.
- Check that the FTP server is turned on and working properly.
- Check that there is enough available space on the storage device (hard disk drive, etc.)

Security of server connection cannot be verified. To always trust this server and connect, set [Trust Destination
Server] to [Enable].

- Check that the necessary certificate is correctly configured.

- To trust and use this server even without the proper certificate, set [Trust Destination Server] to [Enable].

Another device with the same IP address already connected to the network.
- Another device on the same network has the same IP address as the camera. Change the IP address of the conflicting
device or the camera.
- When using a network with a DHCP server, if the camera’s IP address assignment is set to [Manual Setting], change it
to [Automatic Setting] (11 176).

Multiple access points detected. Unable to connect. Retry from the beginning.
- Other Wi-Fi devices are using the WPS function (push button method) to connect. Try the operation again or use other
methods to configure the network (11 174).

Another device has set the same IP address.
- Another device on the same network has the same IP address as the camera. Change the IP address of the conflicting
device or the camera.

A streaming error occurred.
- CV protocol data could not be sent to the receiver. Check the receiver’s [Destination Server] and [Dest. Port No.]
settings on the camera.

Firmware download failed.
File is write-protected.
- A file with the same name on the SD card is write-protected. Delete the corresponding file.

Invalid root certificate.
- The root certificate has expired. Load a root certificate from MENU > [sA# Network Settings] > [Frame.io] > [Root
Certificate] > [Read Root Certificate].

A user with the same login name is already accessing the camera.
- This message appears on the screen of the connected device. Another device connected to the network is already
operating the camera. To use this device, first end the connection on the device accessing the camera.
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No address assigned by the DHCP server.

- The camera is set to automatic IP address assignment. If the selected network does not use a DHCP server, change
the camera’s IP address assignment to [Manual Setting] and configure the IP address ([11 176).

- Check the DNS server.
e Check that the DHCP server is turned on and working properly.
* Make sure the DHCP server has enough IP addresses to assign.

- Check the network.
* Check if a router with an active gateway function is not being used on the network you are trying to connect to.
e Set the correct gateway address on the camera and on all the devices connected to the same network.
® Contact the network’s administrator and obtain the correct gateway address. Enter the same address in the

camera’s network settings.

No response from DNS server.
- The camera is set to automatic IP address assignment. If the selected network does not use a DNS server, change the
camera’s DNS address to [Disable] and configure the IP address ([11 176).
- Enter the same IP address of the DNS server used in the camera’s network settings.
- Check the DNS server.
® Check that the DNS server is turned on and working properly.
* On the DNS server, set the correct IP address and the name corresponding to the same address.
- Check the network.
* Check if a router with an active gateway function is not being used on the network you are trying to connect to.
* Contact the network’s administrator and obtain the correct gateway address. Enter the same address in the
camera’s network settings.
¢ Set the correct gateway address on the camera and on all the devices connected to the same network.
Pairing with Frame.io is disabled. Re-pair.
- The pairing has expired or was canceled from the menu settings. Select MENU > [sA# Network Settings] > [Frame.io]
> [Pair] to re-pair.
Communication with Frame.io failed.
- Check if there are any issues with the network connection or Frame.io.
File access error occurred during Frame.io upload.
- Check the SD card:
* The memory card cover may be open.
¢ A compatible card must be used ([] 35).
¢ Initialize the card ([I1 37) when you use it with the camera for the first time.
* The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.
* The card is full. Replace the card or delete recordings ([J1 150) to free some space on the card.
Connection refused by FTP server.
- The FTP server is set to allow connections only with specific IP addresses. Check the camera’s IP address ([11] 178),
and add it to the FTP server’s permission list settings.
Unable to disconnect from FTP server. Error code returned.
- The camera could not disconnect from the FTP server for an unknown reason. Turn the camera and FTP server off and
then on again.
File transfer completion was not confirmed by FTP server.

- The camera did not receive a transfer completion notification from the FTP server for an unknown reason. Turn the
camera and FTP server off and then on again and try the file transfer again.
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Unable to connect to FTP server.
- Enter the correct address for the FTP server in the camera’s network settings.
- The authentication method is set to [Open System] but the encryption key is incorrect. Check uppercase/lowercase
letters and other characters and make sure to enter the correct encryption key.
236 - The defaylt port number is 21 (or 22 for SFTP transfers). Check the FTP server’s port number and enter the same port
number in the camera’s network settings.
- Check that the server name of the selected FTP server is correctly configured on the DNS server and that the same
name is used also in the camera’s network settings.
Check the FTP server.
¢ Check that the FTP server is turned on and working properly.
® Check that the correct IP address assigned to the FTP server is the same as the FTP server’s IP address in the
camera’s network settings.
® Access to the FTP server may be protected by a firewall due to security software or broadband routers. Change the
firewall’s settings to allow connection to the FTP server.
¢ You may be able to access the FTP server by setting the camera’s passive mode to [Enable] (11 169).
¢ Contact the network’s administrator and obtain the correct IP address and port number for the FTP server. Enter the
same information in the camera’s network settings.
- Check the network.
* Check if a router with an active gateway function is not being used on the network you are trying to connect to.
¢ Contact the network’s administrator and obtain the correct gateway address. Enter the same address in the
camera’s network settings.
¢ Set the correct gateway address on the camera and on all the devices connected to the same network.

Unable to connect to FTP server. Error code returned.
- The maximum number allowed of connections to the FTP server was reached. Reduce the number of network devices
connected to the FTP server or increase the number of connections allowed.

Unable to log in to FTP server. Error code returned.
- Check the FTP server’s [User Name] and [Password] in the camera’s network settings.
- Change the file access permission settings on the FTP server to allow reading, writing and accessing logs.
- Change the destination folder so the path includes only ASCII characters.

Wi-Fi error. Incorrect encryption method.
- Make sure the camera and access point are using the same authentication/encryption method.

Wi-Fi connection lost.

- The camera could not connect to the access point or network device.
- The wireless signal may be affected by nearby cordless telephones, microwave ovens, refrigerators or other devices.
Operate the camera in a place more distant from such interference.

Wi-Fi authentication unsuccessful
- The camera’s authentication mode and/or encryption key are different from those of the access point. Change the
settings on the camera to match the access point.

Incorrect Wi-Fi password.
- Set the correct encryption key on the camera and the access point.
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Access Log

When security-related settings are changed or when device authentication/user authentication fails
consecutively, the information is saved as an access log in the camera. From a security perspective, it is
recommended to regularly check the access logs. ([11212)

Access Log List

Access Log
Change PIN code

Description
The PIN code was changed.

Update PIN code request setting

The PIN code request setting was enabled/disabled.

Update Browser Remote settings

The browser remote user name/password was changed, or HTTP/HTTPS were switched.

Update Function settings

The RTSP user name/password was changed.

Update XC Protocol settings

The XC Protocol authentication method/port number/user name/password was changed, or
HTTP/HTTPS were switched.

Update Communication settings

The Camera Access Point password or Wi-Fi connection parameters were changed.

Update Connection settings

The network connection settings (SET) were changed.

Update FTP root certificate

The root certificate for FTP transfer was changed or deleted.

Update 802.1X authentication

The root certificate for 802.1X authentication was changed or deleted.

Update Frame.io root certificate

The root certificate for Frame.io upload was changed or deleted.

Save Camera settings on camera

Menu/Custom Picture settings were saved to the camera.

Save Camera settings on card

Menu/Custom Picture settings were saved to the SD card.

Load Camera settings from camera

Menu/Custom Picture settings were loaded from the camera.

Load Camera settings from card

Menu/Custom Picture settings were loaded from the SD card.

Reset all settings

The camera's settings were reset or the firmware was updated.

Maximum PIN code attempts exceeded

An incorrect PIN code was entered consecutively.

Browser Remote Login Falil

Failed to log in consecutively with Browser Remote.

IP Streaming Login Fail

Failed to log in consecutively with IP Streaming.

XC Protocol Login Fail

Failed to log in consecutively with XC Protocol.

(i) notes

* The access log is cleared when you reset the camera's settings.
¢ When the number of access logs exceeds 100, the oldest ones will be deleted.
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Handling Precautions

Camera

Be sure to observe the following precautions to ensure maximum performance.

e Do not use or store the camera in dusty or sandy places. The camera is not waterproof — avoid also water,
mud or salt. If any of the above should get into the camera it may damage the camera and/or the lens. Consult
a Canon Service Center as soon as possible.

Be careful to avoid dust and dirt particles accumulating on the lens or entering the camera. When you finish
using the camera, make sure to attach the body cap to the lens mount and the lens cap and dust cap to the
lens.

Do not use the camera near strong electromagnetic fields such as near powerful magnets and motors, MRl
machines or high-voltage power lines. Using the camera in such places may cause anomalies in the video, or
audio/video noise.

¢ Do not point the camera toward an intense light source, such as the sun on a sunny day or an intense artificial
light source. Doing so may damage the image sensor or the camera’s internal components. Be especially
careful when using a tripod or shoulder strap. When you are not using the camera, make sure to attach the
lens cap to the lens.

Do not touch the lens contacts on the lens mount. Dirty contacts may cause a poor
contact between the camera and the lens resulting in incorrect operation of the
camera. After removing the lens, make sure to attach the body cap to the lens mount
and the lens cap and dust cap to the lens.

Do not carry the camera by the LCD monitor or store the camera in a forced position,
without returning the LCD monitor to its correct position. This may damage to the
monitor’s joints.

Do not apply excessive force when touching the screen. This may cause irregularities in the display quality or
damage to the monitor’s joints.

Do not apply protective film to the touch screen. The camera features a capacitive touch screen that may stop
working correctly with a protective overlay.

About cables connected to the SDI OUT terminal (] 154)

Connect the power supply or the battery to the camera (and devices connected to the camera) before
connecting cables. Also, be sure to disconnect the cables before removing the power supply or the battery.

Long-term storage
If you do not intend to use the camera for a long time, store it in a place free of dust, in low humidity, and at
temperatures not higher than 30 °C (86 °F).

Battery Pack

DANGER!

Treat the battery pack with care.
e Keep it away from fire (or it might explode).

¢ Do not expose the battery pack to temperature higher than 60 °C (140 °F). Do not leave it near a heater or
inside a car in hot weather.

¢ Do not try to disassemble or modify it.
e Do not drop it or subject it to shocks.
* Do not get it wet.




Handling Precautions

Dirty terminals may cause a poor contact between the battery pack and the camera. Wipe the terminals with a
soft dry cloth.

Be sure to attach the terminal cover (Figure 1) to transport or store the battery
pack. Do not allow any metal objects to touch the terminals (Figure 2), as this
can cause a short circuit and damage the battery pack.

The correct remaining battery time may not be displayed if a fully charged \/
battery pack is used continuously in high temperatures or is left unused for ) ‘
long periods of time. Also, the correct remaining time may not be displayed, .y
depending on the battery life. Use the time shown on the screen as an

approximation. Figure 1 Figure 2
The battery terminal cover has a [[C_1]-shaped hole. This is useful when you

wish to differentiate between charged and uncharged battery packs.

You can use the battery charger and AC adapter to charge battery packs in any country/region with power

supply between 100 and 240 V AC, 50/60 Hz. Consult a Canon Service Center for information on plug
adapters for overseas use.

Long-term storage

e Store battery packs in a dry place at temperatures no higher than 30 °C (86 °F).

e Before storing battery packs, charge them until two lamps (on the indicator on top of the battery) illuminate
(@ 21).

e Charge all your battery packs fully at least once every six months.

Recording Media

¢ Periodically backing up recordings from the cards used to a computer is recommended. Data may be
corrupted or lost due to defects or exposure to static electricity. Canon shall not be liable for lost or corrupted
data.

e Do not touch or expose the terminals to dust or dirt.

¢ Do not use cards in places subject to strong magnetic fields.

e Do not leave cards in places subject to high humidity and high temperature.

e Do not attach any labels or stickers on the cards.

e Do not disassemble, bend, drop, or subject cards to shocks and do not expose them to water.

Disposal

When you delete data on a card, only the file allocation table is altered and stored data is not physically erased.
Take the necessary precautions when you dispose of the card, for example by physically damaging it to prevent
the leakage of private data.

If giving the card to another person, initialize it. Fill it up with unimportant recordings, and then initialize it again.
This makes recovering the original recordings very difficult.

Built-in Backup Battery

The camera has a built-in rechargeable lithium battery to keep the date/time and other settings. The built-in
backup battery is recharged while you use the camera; however, it will be depleted completely if you do not use
the camera for about 3 months.

To recharge the built-in backup battery: Turn off the camera and attach a power source (sufficiently charged battery
or DC IN terminal). The built-in backup battery will be fully charged in approx. 24 hours.
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Maintenance/Others

Condensation

Moving the camera rapidly between hot and cold temperatures may cause condensation (water droplets) to form
on its internal surfaces. Stop using the camera if condensation is detected. Continued use may damage the
camera. Condensation may form in the following cases:

¢ \When the camera is moved quickly from cold to warm places
e \When the camera is left in a humid room
e \When a cold room is heated rapidly

When condensation is detected

Disconnect the battery or AC adapter. The precise time required for water droplets to evaporate will vary
depending on the location and weather conditions. As a general rule, wait for 2 hours before resuming use of the
camera.

To avoid condensation
Remove the battery pack and any cards. Then, place the camera in an airtight plastic bag and let it adjust
gradually to temperature changes before removing it from the bag.

Cleaning

Camera body

e Use a soft dry cloth to clean the camera’s body. Never use chemically treated cloths or volatile solvents such
as paint thinner.

Lens
e Remove any dust or dirt particles using a non-aerosol type blower.
e Use a clean, soft lens-cleaning cloth to gently wipe the lens. Never use tissue paper.

LCD screen

e Clean the LCD screen using a clean, soft lens-cleaning cloth and commercially available cleaning fluid for
eyeglasses.

e Condensation may form on the surface of the screen when the temperature changes suddenly. Wipe it with a
soft dry cloth.
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Optional Accessories

The following optional accessories are compatible with this camera. The availability differs from area to area.
For details on using the optional accessories and on their specifications, refer also to the Cinema EOS System

Expansion User Guide (PDF file), available from your local Canon website. 241
BP-A30, BP-A60 BP-A30N, BP-ABON CA-CP200 L CA-CP300 B
Battery Pack’ Battery Pack’ Compact Power Adapter Compact Power Adapter

CG-A10 Battery Charger CG-A20 Battery Charger and PL-RF Mount Adapter RC-V100
CA-CP300 B Compact Remote Controller
Power Adapter

RC-IP100 RC-IP1000 DM-E1D Multi-Function Shoe 0C-E4A
Remote Camera Controller? Remote Camera Controller? Directional Stereo Microphone 0ff-Camera Shoe Cord

IFC-100U / IFC-400U
Interface Cable

" These battery packs are compatible with Intelligent System. The camera can communicate with the battery pack and display a
more accurate approximate remaining usage time (in minutes).
This is a class A product. In a domestic environment this product may cause radio interference in which case the user may be
required to take adequate measures.

For our customers in the USA: Call or visit your local retailer/dealer for genuine Canon video accessories. You
can also obtain genuine accessories for your Canon camera by calling: 1-800-828-4040, Canon U.S.A.
Information Center.
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@ nvPorRTANT

¢ Use of genuine Canon accessories is recommended.
The message [Battery communication error] is displayed if you use a non-genuine Canon battery pack, and

user response is required. Note that Canon shall not be liable for any damages resulting from accidents, such
as malfunction or fire, that occur due to use of non-genuine Canon battery packs.
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chNOy,
o This mark identifies genuine Canon video accessories. When you use Canon video equipment, we
§ recommend Canon-brand accessories or products bearing the same mark.
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Specifications

C80
System

e Recording System
Clips:
RAW
Video format:
Audio format:
File format:
XF-AVC

Video compression:

Audio format:
File format:

XF-HEVC S/ XF-AVC S
Video compression:

Audio format:
File format:

WAV
Audio format:

File format:

Specifications

Cinema RAW Light
Linear PCM, 24 bit, 48 kHz, 4 channels
CRM (Canon RAW Movie; Canon proprietary file format)

MPEG-4 AVC / H.264
Linear PCM, 24 bit, 48 kHz, 4 channels
MXF

XF- HEVC S HEVC / H.265, XF-AVC S MPEG-4 AVC / H.264
Linear PCM, 24 bit, 48 kHz, 2 channels

MPEG-2 AAC-LC, 16 bit, 48 kHz, 2 channels

MP4

Audio files for slow & fast motion recording:
Linear PCM, 24 bit, 48 kHz, 4 channels
Audio files for the second card recording function:

Linear PCM, 16 bit, 8 kHz, 1 channel
BWF

Photos: DCF (Design rule for Camera File system), compatible with Exif Ver. 2.31, JPEG compression

¢ Video Configuration (recording/playback)

Primary clips:
RAW

Bit rate:

Resolution:

Color bit depth:

Frame rate:
XF-AVC

Bit rate:

Resolution:
Color sampling:
Frame rate:

XF-HEVC S/ XF-AVC S

Bit rate:

Resolution:

678 Mbps, 639 Mbps, 611 Mbps, 576 Mbps, 563 Mbps, 553 Mbps, 552 Mbps,
470 Mbps, 451 Mbps, 366 Mbps, 306 Mbps, 293 Mbps

6000x3164, 4368x2304

12 bit

59.94P, 50.00PF, 29.97PF, 25.00P, 24.00F, 23.98P

600 Mbps, 500 Mbps, 480 Mbps, 450 Mbps, 375 Mbps, 360 Mbps, 300 Mbps,
250 Mbps, 240 Mbps, 150 Mbps, 125 Mbps, 120 Mbps / Intra-frame,

250 Mbps, 150 Mbps, 50 Mbps, 25 Mbps / Long GOP

4096x2160, 3840x2160, 2048x1080, 1920x1080

YCbCr 4:2:2, 10 bit

59.94P, 59.94i, 50.00P, 50.00i, 29.97P, 25.00P, 24.00P, 23.98P

XF-HEVC S:
225 Mbps, 150 Mbps, 135 Mbps, 100 Mbps, 50 Mbps, 35 Mbps /
Long GOP
XF-AVC S:
600 Mbps, 500 Mbps, 480 Mbps, 450 Mbps, 375 Mbps, 360 Mbps,
300 Mbps, 250 Mbps, 240 Mbps, 150 Mbps, 125 Mbps, 120 Mbps /
Intra-frame
250 Mbps, 150 Mbps, 100 Mbps, 50 Mbps, 35 Mbps / Long GOP
4096x2160, 3840x2160, 2048x1080, 1920x1080
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Specifications

Color sampling:

Frame rate:

Sub recording clips:
XF-AVC
Bit rate:

Resolution:
Color sampling:
Frame rate:

XF-HEVC S / XF-AVC S

Bit rate:

Resolution:
Color sampling:

Frame rate:

Proxy clips:
XF-AVC

Bit rate:
Resolution:
Color sampling:
Frame rate:

XF-HEVC S/ XF-AVC S

Bit rate:
Resolution:
Color sampling:

Frame rate:

XF-HEVC S:
4:2:2 10 bit, 4:2:0 10 bit
XF-AVC S:
4:2:2 10 bit, 4:2:0 8 bit
59.94P, 50.00P, 29.97P, 25.00P, 24.00P, 23.98P

600 Mbps, 500 Mbps, 480 Mbps, 450 Mbps, 375 Mbps, 360 Mbps, 300 Mbps,

250 Mbps, 240 Mbps, 150 Mbps, 125 Mbps, 120 Mbps / Intra-frame,
250 Mbps, 150 Mbps, 50 Mbps, 25 Mbps / Long GOP

4096x2160, 3840x2160, 2048x1080, 1920x1080

YCbCr 4:2:2, 10 bit

59.94P, 59.94i, 50.00P, 50.00i, 29.97P, 25.00P, 24.00P, 23.98P

XF-HEVC S:
225 Mbps, 150 Mbps, 135 Mbps, 100 Mbps, 50 Mbps, 35 Mbps /
Long GOP
XF-AVC S:
600 Mbps, 500 Mbps, 480 Mbps, 450 Mbps, 375 Mbps, 360 Mbps,
300 Mbps, 250 Mbps, 240 Mbps, 150 Mbps, 125 Mbps, 120 Mbps /
Intra-frame
250 Mbps, 150 Mbps, 100 Mbps, 50 Mbps, 35 Mbps / Long GOP
4096x2160, 3840x2160, 2048x1080, 1920x1080
XF-HEVC S:
4:2:2 10 bit, 4:2:0 10 bit
XF-AVC S:
4:2:2 10 bit, 4:2:0 8 bit
59.94P, 50.00P, 29.97P, 25.00P, 24.00P, 23.98P

35 Mbps / Long GOP

2048x1080, 1920x1080

YCbCr 4:2:0, 8 bit

59.94P, 59.94i, 50.00P, 50.00i, 29.97PF, 25.00P, 24.00P, 23.98P

16 Mbps, 9 Mbps, 6 Mbps / Long GOP
2048x1080, 1920x1080, 1280x720
XF-HEVC S:
4:2:0 10 bit, 4:2:0 8 bit
XF-AVC S:
4:2:0 8 bit
59.94P, 50.00P, 29.97P, 23.98P, 25.00P, 24.00P

¢ Recording Media (not included)
SD, SDHC (SD High Capacity) or SDXC (SD eXtended Capacity) cards

¢ Image Sensor

Full frame back-illuminated stacked CMOS sensor
Total number of |oixe|s1 (approximate): 26,700,000 pixels
Effective camera pixels1 (approximate): 19,000,000 pixels

" Rounded to the nearest 10,000.



Specifications

LCD Touch Screen

8.8 cm (3.5 in.) color LCD, approx. 2,760,000 dots, 100% coverage, capacitive touch screen operation

- View assistance functions can be applied (Gamma: CMT 709 equivalent, Canon 709 equivalent, original /
Color space: BT.709 equivalent) and assistance displays can be output (onscreen displays, peaking, zebra
pattern, magnification, B&W image, video scope, false color, anamorphic desqueeze).

Lens Mount
Canon RF lens mount compatible with Canon RF/EF/PL lenses

T RF lenses include RF-S lenses and RF Cinema lenses. One of the available Canon EF-EOS R Mount Adapters is required for
using EF lenses (including EF-S and EF Cinema lenses). PL lenses can be used when a PL-RF Mount Adapter is attached.

1

Approximate lens multiplication factor (for 35mm equivalent focal length)
[Full Frame] sensor mode:
Actual focal Ieng‘[h1 x 1.062 (when the horizontal resolution is 6000/4096/2048)
Actual focal length! x 1.122 (when the horizontal resolution is 3840/1920)
[Super 35mm (Cropped)] sensor mode:
Actual focal length! x 1.462 (when the horizontal resolution is 4368/4096/2048)
Actual focal Iength1 x 1.542 (when the horizontal resolution is 3840/1920)
1 Lens focal length
2 Conversion factor
Lens Correction
Peripheral illumination/chromatic aberration/diffraction correction is available for Canon RF, EF and RF/EF
Cinema lenses?
Distortion aberration correction is available only for Canon RF and RF Cinema lenses
2 Some lenses are not compatible with in-camera correction.

Shutter Speed
Speed (1/3-stop increments, 1/4-stop increments), angle, clear scan, slow, off

Iris
Manual (1/2-stop increments, 1/3-stop increments, fine adjustment available), push auto iris, automatic
aperture

ISO Speed/Gain

Manual, automatic adjustment

ISO speed ([1 stop] and [1/3 stop] settings): ISO 100 to ISO 102400
Gain ([Normal] and [Fine] settings): -6 dB to 54 dB

ND Filter

Built-in (Off, 2, 4, 6, 8% or 10* stops), motor operated

4 With extended ND range.

Exposure

AE shift, light metering modes (standard, spotlight, backlight)

White Balance

Custom white balance (two sets, A and B); two preset settings (daylight, 5,600 K® and tungsten lamp,
3,200 K5); color temperature setting (2,000 K to 15,000 K); automatic white balance (AWB)

Color temperature and color compensation (CC) adjustment available for all settings except custom white
balance and AWB.

5 Color temperatures are approximate and given only as a reference.

Focus
Manual focus, autofocus (one-shot AF, continuous AF, subject detection AF); subject tracking available
AF type: Dual Pixel CMOS AF

Sensor Sensitivity (ISO 800, 2000 lux, 89.9% reflection)
59.94 Hz: F10 (at 59.94P), F14 (at 29.97P)
50.00 Hz: F11 (at 50.00P), F16 (at 25.00P)
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Specifications

o Wi-Fi
Wireless standard: IEEE 802.11b/g/n (2.4 GHz band), IEEE 802.11a/n/ac (5 GHz band)
Connection methods: Infrastructure (Wi-Fi Protected Setup (WPS), search for access points, manual),
Camera Access Point
246 Authentication methods: Open, shared key, WPA/WPA2/WPA3-Personal, WPA/WPA2/WPA3-Enterprise

- Encryption methods: WEP-64, WEP-128, TKIP, AES

¢ Microphone
Electret condenser microphone (monaural)

¢ Size of Photos
4096x2160, 38402160

Terminals

e SDI OUT Terminal
BNC jack
Video: HD: SMPTE 292
3G: SMPTE 424, SMPTE 425
6G: SMPTE ST 2081
12G: SMPTE ST 2082
Audio: SMPTE ST 299-1, SMPTE ST 299-2
Output signal level: 0.8 Vp-p
Output impedance: 75 Q

e HDMI OUT Terminal
HDMI connector, output only
The time code signal can be output (proprietary standard)
Video/audio output: Conforming to HDMI specifications.

e INPUT Terminals (INPUT 1 and INPUT 2)
Mini XLR 3-pin jack (pin1: shield, pin2: hot, pin3: cold), 2 sets, balanced
Sensitivity:
MIC setting: —60 dBu (volume center, full scale —18 dB) / microphone attenuator: 20 dB
LINE setting: 4 dBu (volume center, full scale —18 dB)

e MIC Terminal
& 3.5 mm stereo mini-jack
Sensitivity:
[MIC (with Power Supply)] setting:
—72 dBV (volume center, full scale —18 dB) / microphone attenuator: 20 dB
Plug-in power supply: 2.4V DC
[LINE] setting: —12 dBV (volume center, full scale —18 dB)

e () (Headphone) Terminal
& 3.5 mm stereo mini-jack, 17 dBV (32 Q load, Max volume)

e TIME CODE Terminal
BNC jack, input/output
Input setting: 0.5 Vp-p to 18 Vp-p / 100 kQ; Output setting: 1.3 Vp-p / 50 Q or less

e USB Terminal
USB Type-C™ equivalent to SuperSpeed USB (USB 3.1 Gen 1)

e REMOTE Terminal
@ 2.5 mm stereo sub-mini jack

® Ethernet Terminal
RJ45 connector (1000BASE-T supported)



Specifications

e Multi-Function Shoe Terminal
Proprietary Canon connector

Power/Others

247

e Power Supply (rated) —_—

14.4V DC (battery pack), 24 V DC (DC IN)

e Power Consumption / Continuous Recording Time (with a BP-A30N) / Continuous Recording Time (with a
BP-AGON)
The values were measured using normal recording (second card recording function turned off) with an
RF50mm F1.8 STM lens attached, LCD luminance set to [Normal], and using the SDI OUT terminal (3G-SDI).
RAW
Approx. 14.5 W /170 min. / 355 min.
Approx. 13.7 W /180 min. / 380 min.
Approx. 18.2 W /135 min. / 280 min.
Approx. 16.8 W/ 145 min. / 305 min.
XF-AVC
Approx. 19.6 W / 125 min. / 255 min. ([Full Frame] sensor, 3840x2160 at 59.94P)
Approx. 17.9 W / 140 min. / 290 min. ([Full Frame] sensor, 3840x2160 at 50.00P)
Approx. 17.9 W / 140 min. / 290 min. ([Super 35mm (Cropped)] sensor, 2048x1080 at 59.94P)
Approx. 16.5 W / 150 min. / 320 min. ([Super 35mm (Cropped)] sensor, 2048x1080 at 50.00P)

Operating Temperature
0-40°C (32 -104 °F)

Dimensions (W x H x D)6
Camera body only: 160 x 138 x 116 mm (6.3 x 5.4 x 4.6 in.)
Camera with handle unit, microphone holder: 160 x 276 x 173 mm (6.3 x 10.9 x 6.8 in.)

Full Frame] sensor, RAW LT, 6000x3164 at 29.97P)
Full Frame] sensor, RAW LT, 6000x3164 at 25.00P)
Super 35mm (Cropped)] sensor, RAW LT, 4368x2304 at 59.94P)
Super 35mm (Cropped)] sensor, RAW LT, 4368x2304 at 50.00P)

P

Weight6 (including tape measure hook and grip belt)

Camera body: 1,310 g (2.9 Ib.)

Camera with BP-A30N battery, 2 cards: 1,545 g (3.4 Ib.)

Camera with handle unit, microphone holder, BP-A30N battery, 2 cards: 1,750 g (3.9 Ib.)

Accessories

CG-A20 Battery Charger

e Rated Input: 24 VDC, 1.8 A

¢ Rated Output: 16.7 VDC, 1.5 A

e Operating Temperature: O — 40 °C (32 — 104 °F)

e Dimensions® (WxHxD): 100 x24 x 100 mm (3.9 x 0.9 x3.9in.)
o Weight®: 145 g (5.1 0z.)

CA-CP300 B Compact Power Adapter

e Rated Input: 100 — 240 V AC, 50/60 Hz, 0.88 A (100 V) - 0.43 A (240 V)
e Rated Output: 24 V DC, 1.8 A

e Operating Temperature: O — 40 °C (32 — 104 °F)

e Dimensions® (WxHxD):52.0x31.5x128.0mm (2.0x 1.2x5.01in.)
Weight®: 219 g (7.7 oz.)
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BP-A30N Battery Pack

¢ Battery Type: Rechargeable lithium ion battery, compatible with Intelligent System
e Rated Voltage: 14.4V DC

¢ Rated Battery Capacity: 3,200 mAh /47 Wh

e Operating Temperature: O — 40 °C (32 — 104 °F)

* Dimensions® WxHxD):41.5x45.1 x69.7 mm (1.6 x 1.8 x 2.7 in.)

 Weight®: 243 g (8.6 0z.)

6 All dimensions and weights are approximate.

Errors and omissions excepted.



Compatible Lenses and Functions

Compatible Lenses and Functions

Following is a list of lenses compatible with this camera and the various functions that can be used depending
on the lens. Depending on the lens’s purchase date, you may need to update the lens’s firmware to use these
functions. For details, visit your local Canon website or consult a Canon Service Center. 249
PL mount lenses can only be used after attaching the optional PL-RF Mount Adapter. In addition, connectionto  ————
an external power source is required for lenses equipped with a drive unit.

Lens Iris control from the camera Zoom control
Manual Pushautoiris ~ Automatic  from the camera
RF lenses (& (X X ®°
EF lenses' ) ® - [ 3
EF lenses compatible with auto iris o @ @ -
RF / EF' Cinema lenses / PL' lenses
CN7x17 KAS S/E144
CNEDR6 S HET® . . . .
CN8x15 IAS S/E1*
CN-E18-80mm T4.4 LIS KAS S
CN-E70-200mm T4.4 LIS KAS S o [ J [ J o
CN7x17 KAS T/R1
CN7x17 KAS S/P1*

CN20x50 IAS H/P14
CN10x25 IAS S/P14 - - - _
CN8x15 IAS S/P1*

CN7x17 KAS T/P14

Manual focus lenses compatible with focus guide
CN-E15.5-47mm T2.8L S

CN-E15.5-47mm T2.8 L SP - - - -
CN-E30-105mm T2.8 L S
CN-E30-105mm T2.8 L SP

T A mount adapter is required.

2 Except for the RF600mm F11 IS STM, RF800mm F11 IS STM.

3 Only lenses with the PZ-E1 Power Zoom Adapter attached.

4 The AE response setting (] 200) is not supported (not applicable).
5 Only lenses with the PZ-E2 / PZ-E2B Power Zoom Adapter attached.

e EF lenses compatible with auto iris:
EF85mm F1.4L IS USM EF70-200mm F4L IS I USM
EF400mm F2.8L IS Il USM EF600mm F4L IS Il USM



Compatible Lenses and Functions

Focus control from the camera
Lens Continuous Subject Focus guide

Manual One-shot AF AF detection AF Tracking
D50  RF/EF lenses o2 o2 ®? B o2 °
———  RF/EF Cinema lenses, PL' lenses
CN7x17 KAS S/E1
CN7x17 KAS T/R1
CN8x15 IAS S/E1 ® ® ® ® ® o
CN10x25 IAS S/E1
CN20x50 IAS H/E1 o - - - - -
CN7x17 KAS S/P1
CN20x50 IAS H/P1
CN10x25 IAS S/P1 - - - - - -
CN8x15 IAS S/P1
CN7x17 KAS T/P1
CN-E18-80mm T4.4 L ISKAS S,
CN-E70-200mm T4.4 L IS KAS S ® ® * * ® o
Manual focus lenses compatible with _ _ _ _ _ °
focus guide
T A mount adapter is required.
2 Except for the RF5.2mm F2.8 L Dual Fisheye lens.
* Manual focus lenses compatible with focus guide:
CN-E14mm T3.1 L F CN-EBOmMm T1.3 L F
CN-E20mm T1.5LF CN-E85mm T1.3 L F
CN-E24mm T1.5LF CN-E135mm T2.2 L F
CN-EB5mm T1.5LF CN-E20-50mm T2.4 L F
CN-E14-35mm T1.7L S CN-E45-135mm T2.4 L F
CN-E31.5-95mm T1.7 L S CN-R24mm T1.5LF
CN-R35mm T1.5LF CN-R50mm T1.3 L F
CN-R85mm T1.3 L F CN-R14mm T3.1 LF
CN-R20mm T1.5LF CN-R135mm T2.2 L F

¢ Lenses compatible with automatic retraction when the camera is turned off (11 212).

RF35mm F1.8 MACRO IS STM EF50mm F1.8 STM
EF40mm F2.8 STM EF-S24mm F2.8 STM
RF85mm F2 MACRO IS STM RF50mm F1.8 STM

RF24mm F1.8 MACRO IS STM RF16mm F2.8 STM



Reference Tables

Reference Tables

Approximate Recording Time on a Card

Approximate times, for reference only, based on a single recording that continues until the card is full. D51
Recording Bit rate 128 GB 512 GB Recording Bit rate 128 GB 512 GB
format format

678 Mbps 23 min. 92 min. 225 Mbps 70 min. 282 min.
639 Mbps 24 min. 99 min. 150 Mbps 105 min. 422 min.
563 Mbps 28 min. 112 min. 135 Mbps 117 min. 471 min.

RAW 552 Mbps 28 min. 114 min. XF-HEVCS 100 Mbps 158 min. 635 min.
451 Mbps 34 min. 139 min. 50 Mbps 309 min. 1237 min.
366 Mbps 42 min. 171 min. 35 Mbps 435 min. 1740 min.
293 Mbps 53 min. 213 min. 600 Mbps 26 min. 106 min.
600 Mbps 26 min. 105 min. 480 Mbps 33 min. 133 min.
480 Mbps 32 min. 131 min. 450 Mbps 35 min. 142 min.
450 Mbps 35 min. 140 min. 360 Mbps 44 min. 177 min.
360 Mbps 43 min. 174 min. 300 Mbps 53 min. 212 min.
300 Mbps 51 min. 206 min. 250 Mbps 63 min. 254 min.

XF-AVC 250 Mbps 61 min. 245 min. XFACS 240 Mbps 66 min. 266 min.
240 Mbps 64 min. 259 min. 150 Mbps 105 min. 422 min.
150 Mbps 101 min. 406 min. 120 Mbps 132 min. 531 min.
120 Mbps 125 min. 502 min. 100 Mbps 158 min. 635 min.
50 Mbps 261 min. 1044 min. 50 Mbps 309 min. 1237 min.
25 Mbps 485 min. 1943 min. 35 Mbps 435 min. 1740 min.

Charging Times

Charging times are approximate and vary according to charging conditions, ambient temperature and initial
charge of the battery pack.
Battery pack BP-A30N BP-A6ON
Charging time using the supplied
CG-A20 Battery Charger

175 min. 310 min.
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Appendix: Camera Dimensions

Appendix: Camera Dimensions
Unless indicated with the " (inch) mark, all units are in mm. J represents the depth of a hole or socket.
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Appendix: Camera Dimensions

Camera with handle unit, microphone holder and BP-A30N battery pack
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Index

() (headphones) terminal ... .......... 106, 146
802.1X Authentication . .................. 177
A
ABB (automatic black balance) ............. 45
Abroad, usingthecamera ................ 239
Accesslog ... 237
Accesspoint ... 165, 166
ACCESSONBS . v oo e ettt 10, 241
AEshift ... . 75
Airvents . ........... ... ... . ..... 12,13, 44
Anamorphic lenses and desqueeze . ........ 121
Aperture . ... 73
Automatic aperture (auto iris) . ........ 75
Push autoiris ............ ... .. .... 74
Assignable buttons . ........ ... 125
Audio
Audiolevel ............. ... ... ... 103
Bitdepth ....... ... ... ... ... ... 100
Format .......... ... ... ... ... ... 101
Qutputchannels . ................. 160
Peak limiter . . .................... 104
Recording .. ..................... 100
Audio files (for slow & fast motion clips) ... ... 114
Audio reference signal . .................. 107
Authentication ..................... 175,177
AWB (auto white balance) ................. 79
AWBIOCK . .o 79
B
BaselSO ... 68
Bitrate . . ... 62
Browser Remote ............. .. ... . .... 187
Built-in backup battery . .................. 239
Button connection mode (WPS) ... ... .. 167, 169
C
Camera Access Point . .................. 174
Cameradimensions . .................... 252
CAMERAmMode ........... .. .. 15
Cameranickname ...................... 178
Canon App vt 172,195
Canon Log 2, Canon Log 3
(Qammacurves) . ... 134

Canon XF Utility (download) ............... 161

Cardvolume label ...................... 37
Checkmarks (M) .................. 110, 149
Cinema EOS System Expansion
UserGuide ............. ... 241
Cinema RAW Development .............. 162
Clips
Adding [ marks/M marks .... 110, 149
Adding shotmarks ........... 110, 149
Clipinformation.................. 148
Clipnameformat ................. 42
Clipnumbering ................ 42,43
Deleting .......... ... .. 150
Playback . ........... ... .. ..... 142
Proxyclips ...................... 64
Recording .......... ... ... ... 47
Recovering ...................... 38
Colorbars .......... 107
Colorbitdepth ......................... 62
Color compensation (CC) value ............ 77
Colorsampling ... ... 62
Colorspace .............coouiun.. 134, 158
Computer ... ... .. . . 161
Condensation .............. ... ... ... 240
Connection to external devices ........... 154
Content Transfer Professional . ... 162, 163, 195
Continuous recording . . ..« v oo 118
Controldials . . ...................... 68, 73
Controlring (RFlens) ................... 210
Customdisplays . .................. 49, 204
Custompicture .............. ... ... 129
Detailed custom picture settings . . . . . 134
LookFile ....... ... .. .. .. ... 131
Presetsettings .................. 129
CVProtocol ........... .. 173
D
Data entry / keyboard screen .. ............ 28
Dateandtime ........... . ... .. ... .... 25
DCINterminal ..................... 21, 247
Deletingrecordings . ................... 150
Desqueeze ... ..o 121
Detection of access points .. ............. 175
Digital IS ... ... 88
Digital tele-converter . ................... 90
Direct settingmode . .................... 57
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Direct touch control .. .................... 56
Double slotrecording . .. ... .o 39
Drop frame (time code) ................... 96
E
EF Cinemalenses ................... 29, 249
Encryption ........ .. ... ... L. 174,175
Exposurebar ....... ... . 76
Exposure compensation .................. 75
F
Falsecolor ........ .. ... .. ... .. ... ... ... 94
Fan ... . 44
FEC error correction . ................... 170
Flemenu.............. ... ... ....... 147
Flenames ........... ... ... .. ... .. . ... 42
Filenumbering ............ ... ... ... .. ... 43
File operations . .......... .. ... .. ... ... 147
Flickerreduction .......... ... ... ... ....... 67
Focus ... ... .. . . 80
AFlocK . ..o 85
AFspeed .......... ... ... ... . ... 83
Continuous AF . ................... 83
Focus assistance functions .......... 81
Manualfocus ............ .. ... ..., 80
One-shot AF ....... ... ... ... ... 83
Subject detection AF . .............. 86
Tracking ... .. co oo 87
Focusguide ......... ... . ... .. .. ... 81
Focusring(lens) .......... ... ... ... . .... 80
Framerate ........... ... ... ... .. .. .... 62
Framerecording ........... ... .. ... .... 119
Frame.io ......... ... ... ... ... . ... ... 196
Free-run (timecode) ..................... 95
FTPtransfer .......... ... ... ... .. ..... 184
Full range/Video range (level mapping) .. ... .. 156
FUNCbutton ........... ... ... ... ..... 57
G
Gain .. 68
Gammacurnve ... 134, 158
GPS information ................... 111, 150
GPS receiver (optional) . .............. 50, 211

H

Handleunit .......... ... . ... .. ... . ... 32
HDMI OUT terminal .. ............... 151,155
HDMIRAW ... . e 155
HDR (high dynamic range) ........ 134, 158, 159
Headphones ...................... 106, 146
HLG (hybrid loggamma) ............. 134, 158
Hourmeter ......... .. ... .. ... .. ..... 212
HTTPS . 182
|

Image stabilizer ........ ... ... ... . 88
Importing files to a computer/smartphone . .. .161
INDEXbutton . ........ oo 142
Indexscreens ............ciiiii... 141
Infrastructure . ....... ... ... . L 167
Initializingacard ....... ... .. ... ... .. ..., 37
INPUT terminals .. .................. 100, 102
Intervalrecording .. ......... .. ... ... 119
IP address (IPv4 settings) . . ............... 176
IPstreaming .......... ... .. .. .. 185
IPv6 settings . ........ .. .. L 180
IS o 73
ISOspeed .......... .. ... i 68
J

Joystick . ... 26, 90
K

Keylock. ... ... 15
L

Language ........... .. 25
LCDmonitor . ... 23
Lens ... 29, 249

Lens correction (chromatic aberration/
peripheral illumination/diffraction/

distortion aberration) .................. 31
Lensfirmware .......................... 31
Llensmount ............ ... .. ... . ... 29, 245
Level ... .. 33
Light meteringmode . .................... 76

LookFile .......... .. ... .. i 131



M
Magnification ........... ... ... .. ... . ... 82
Main recording (primary clips) . .. ......... 39, 62
Main recording format . ................... 62
Maintenance ............ ... ... . . . .. ... 240
Manual network configuration ............. 175
MEDIAbutton ......... ... ... ... . .. ... 15
MEDIAmode .......... ... ... i 15
Menusettings ..................... 139, 199
Messagelist ........... ... .. ... ... ..... 230
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Trademark Acknowledgements
e SD, SDHC and SDXC Logos are trademarks of SD-3C, LLC.

¢ Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the United
States and/or other countries.

e Apple, macOS, App Store are trademarks of Apple Inc., registered in the U.S. and other countries.

e Adobe, Camera to Cloud, Frame.io, and the Frame.io logo are either registered trademarks or trademarks of
Adobe in the United States and/or other countries.

¢ Avid and Media Composer are trademarks or registered trademarks of Avid Technology, Inc. or its
subsidiaries in the United States and/or other countries.

¢ Wi-Fiis a registered trademark of the Wi-Fi Alliance.
e Wi-Fi Certified, WPA, WPA2, WPA3 and the Wi-Fi Certified logo are trademarks of the Wi-Fi Alliance.

¢ WPS as used on the camera’s settings, onscreen displays and in this manual signifies Wi-Fi Protected Setup.

e JavaScript is a trademark or registered trademark of Oracle Corporation, its affiliates or subsidiaries in the
United States and other countries.

e The terms HDMI, HDMI High-Definition Multimedia Interface, HDMI Trade dress and Hnml

the HDMI Logos are trademarks or registered trademarks of HDMI Licensing
Administrator, Inc.

e USB Type-C™ and USB-C™ are trademarks of USB Implementers Forum.
e DaVinci Resolve™ is the trademark of Blackmagic Design Pty. Ltd.

e Other names and products not mentioned above may be trademarks or registered trademarks of their
respective companies.

Licensing Information
e This device incorporates exFAT technology licensed from Microsoft.

e This product is licensed under AT&T patents for the MPEG-4 standard and may be used for encoding
MPEG-4 compliant video and/or decoding MPEG-4 compliant video that was encoded only (1) for a personal
and noncommercial purpose or (2) by a video provider licensed under the AT&T patents to provide MPEG-4
compliant video. No license is granted or implied for any other use for MPEG-4 standard.

e THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE
OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO (i) ENCODE
VIDEO IN COMPLIANCE WITH THE AVC STANDARD (“AVC VIDEO”) AND/OR (i) DECODE AVC VIDEO THAT
WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM
A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C.
SEE HTTP://WWW.MPEGLA.COM

Third Party Software

For details regarding third party software, refer to Software Used in This Product (PDF) available on the
download page of the Instruction Manual.
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CANON CINEMA EOS LIMITED WARRANTY FOR PRODUCTS PURCHASED IN THE UNITED STATES

The limited warranty set forth below is given by Canon U.S.A., Inc. (‘Canon USA') with respect to (a) the Canon Cinema EOS Product, and (b) the accessories
for the Canon Cinema EOS Product (if any), packaged with this limited warranty (collectively the “Products”)* and purchased in the United States. This limited
warranty is only effective upon presentation of your Bill of Sale or other proof of purchase. The Products are warranted to the original end-user purchaser,
when delivered in new condition in its original container, under normal use against defective materials or workmanship as follows: Parts: At Canon USA's
option, defective parts will be exchanged for new parts or comparable rebuilt parts for a period of ONE YEAR from the date of original purchase. Labor: For a
period of ONE YEAR from the date of original purchase, labor will be provided free of charge by Canon USA's factory service centers or designated service
facilities located in the United States. When returning Products under this warranty, you must pre-pay the shipping charges, and you must enclose a copy of
the Bill of Sale or other proof of purchase with a complete explanation of the problem. During the ONE-YEAR warranty period, repairs will be made and the
Products will be return-shipped to you free of charge. For repairs after the warranty period is over, you will be given an estimate of the cost of repair and an
opportunity to approve or disapprove of the repair expense before it is incurred. If you approve, repairs will be made and the Products will be returned to you
at your risk and expense. If you disapprove, we will return-ship the Products to you at no charge to you to an address within the United States.

This limited warranty only applies if the Products are used in conjunction with compatible computer equipment and compatible software, as
to which items Canon USA will have no responsibility. Canon USA shall have no responsibility under this limited warranty for use of the
Products in conjunction with incompatible peripheral equipment and/or incompatible software. Non-Canon brand peripheral equipment and
software which may be distributed with, or factory loaded on, the Products, are sold ‘AS IS’ without warranty of any kind by Canon USA,
including any implied warranty regarding merchantability or fitness for a particular purpose. The sole warranty with respect to such non-
Canon brand items is given by the manufacturer or producer thereof.

* Except for the battery pack packaged with the Products, which carries a separate ninety (90) day limited warranty.

In order to obtain warranty service, please contact the authorized Canon retail dealer from whom you purchased the Products or contact the CANON
INFORMATION CENTER AT 855-CINE-EOS (855-246-3367) or on the internet at pro.usa.canon.com/support. You will be directed to the nearest service
facility for your Products.

This Limited Warranty covers all defects encountered in normal use of the Products and does not apply in the following cases:

A. Loss or damage to the Products due to abuse, mishandling, accident, improper maintenance, use of non-Canon accessories or failure to follow
operating, maintenance or environmental instructions prescribed in Canon USA’s user’s manual;

B. If the Products are defective as a result of leaking batteries, sand, dirt or water damage;

C. If defects or damages are caused by the use of parts or supplies (other than those sold by Canon USA) that cause damage to the Products or that
cause abnormally frequent service calls or service problems;

D. If defects or damages are caused by service other than Canon USA'’s factory service centers or authorized service facilities;

E. Any internal modification to product hardware or firmware;

F. Any applicable fee for Maintenance of the Products;

G. If the Product has had its serial number or dating altered or removed.

This Limited Warranty does not apply to Products purchased outside the United States. This Limited Warranty does not apply to accessories or
consumables not originally packaged with the Product. Please retain this warranty card and your Bill of Sale as a permanent record of your purchase. This
card ensures that you are contacted promptly should there be a safety inspection, modification or Product recall under applicable laws or regulations.

NO IMPLIED WARRANTY, INCLUDING MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE APPLIES TO THE PRODUCTS AFTER THE
APPLICABLE PERIOD OF EXPRESS WARRANTY OR GUARANTY (EXCEPT AS MENTIONED ABOVE) GIVEN BY ANY PERSON, FIRM OR CORPORATION
WITH RESPECT TO THE PRODUCTS SHALL BIND CANON USA (SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED
WARRANTY LASTS, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU). CANON USA SHALL NOT BE LIABLE FOR LOSS OF
REVENUES OR PROFITS, EXPENSE FOR SUBSTITUTE PRODUCTS OR SERVICE, STORAGE CHARGES, LOSS OR CORRUPTION OF DATA, INCLUDING
WITHOUT LIMITATION, LOSS OR CORRUPTION OF DATA STORED ON THE PRODUCTS’ HARD DRIVE, OR ANY OTHER SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES CAUSED BY THE USE, MISUSE OR INABILITY TO USE THE PRODUCTS, REGARDLESS OF THE LEGAL THEORY ON
WHICH THE CLAIM IS BASED, AND EVEN IF CANON USA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY
OF ANY KIND AGAINST CANON USA BE GREATER THAN THE PURCHASE PRICE OF THE PRODUCTS SOLD BY CANON USA AND CAUSING THE
ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK AND LIABILITY FOR LOSS, DAMAGE OR INJURY TO YOU AND
YOUR PROPERTY AND TO OTHERS AND THEIR PROPERTY ARISING OUT OF USE, MISUSE OR INABILITY TO USE THE PRODUCTS NOT CAUSED
DIRECTLY BY THE NEGLIGENCE OF CANON USA (SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU).THIS LIMITED WARRANTY SHALL NOT EXTEND TO ANYONE
OTHER THAN THE ORIGINAL PURCHASER OF THE PRODUCTS OR THE PERSON FOR WHOM IT WAS PURCHASED AS A GIFT.

This warranty gives you specific legal rights, and you may also have other rights which vary from state to state.

CANON U.S.A., INC


http://pro.usa.canon.com/support

CANON CINEMA EOS LIMITED WARRANTY FOR PRODUCTS PURCHASED IN CANADA

The limited warranty set forth below is given by Canon Canada Inc. (‘Canon Canada’) with respect to (a) the Canon Cinema EOS product, and (b) the
accessories for the Canon Cinema EOS Product (if any), packaged with this limited warranty (collectively the “Products”)* and purchased in Canada. This
limited warranty is only effective upon presentation of your Bill of Sale or other proof of purchase. The Products are warranted to the original end-user
purchaser, when delivered in new condition in its original container, under normal use against defective materials or workmanship as follows: Parts: At
Canon Canada’s option, defective parts will be exchanged for new parts or comparable rebuilt parts for a period of ONE YEAR from the date of original
purchase. Labor: For a period of ONE YEAR from the date of original purchase, labor will be provided free of charge by Canon Canada’s factory service
center or designated service facilities located in Canada. When returning Products under this warranty, you must pre-pay the shipping charges, and you
must enclose a copy of the Bill of Sale or other proof of purchase with a complete explanation of the problem. During the ONE-YEAR warranty period,
repairs will be made and the Products will be return-shipped to you free of charge. For repairs after the warranty period is over, you will be given an
estimate of the cost of repair and an opportunity to approve or disapprove of the repair expense before it is incurred. If you approve, repairs will be made
and the Products will be returned to you at your risk and expense. If you disapprove, we will return-ship the Products to you at no charge to you to an
address within Canada.

This limited warranty only applies if the Products are used in conjunction with compatible computer equipment and compatible software, as to
which items Canon Canada will have no responsibility. Canon Canada shall have no responsibility under this limited warranty for use of the
Products in conjunction with incompatible peripheral equipment and/or incompatible software. Non-Canon brand peripheral equipment and
software which may be distributed with, or factory loaded on, the Products, are sold ‘AS IS’ without warranty of any kind by Canon Canada,
including any implied warranty or condition regarding merchantability or fitness for a particular purpose. The sole warranty with respect to such
non-Canon brand items is given by the manufacturer or producer thereof.

* Except for the battery pack packaged with the Products, which carries a separate ninety (90) day limited warranty.

In order to obtain warranty service, please contact the authorized Canon retail dealer from whom you purchased the Products or contact the CANON
PROFESSIONAL SERVICE CENTRE 1-800-667-2666 or on the internet at www.canon.ca/pro. You will be directed to the nearest service facility for your
Products.

This Limited Warranty covers all defects encountered in normal use of the Products and does not apply in the following cases:

A. Loss or damage to the Products due to abuse, mishandling, accident, improper maintenance, use of non-Canon accessories or failure to follow
operating, maintenance or environmental instructions prescribed in Canon Canada’s user's manual;

B. If the Products are defective as a result of leaking batteries, sand, dirt or water damage;

C. If defects or damages are caused by the use of parts or supplies (other than those sold by Canon Canada) that cause damage to the Products or
that cause abnormally frequent service calls or service problems;

D. If defects or damages are caused by service other than Canon Canada’s factory service centers or authorized service facilities;

E. Any internal modification to product hardware or firmware;

F. Any applicable fee for Maintenance of the Products;

G. If the Product has had its serial number or dating altered or removed.

This Limited Warranty does not apply to Products purchased outside Canada. This Limited Warranty does not apply to accessories or consumables not

originally packaged with the Product. Please retain this warranty card and your Bill of Sale as a permanent record of your purchase. This card ensures

that you are contacted promptly should there be a safety inspection, modification or Product recall under applicable laws or regulations.

NO IMPLIED WARRANTY OR CONDITION, INCLUDING MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE APPLIES TO THE
PRODUCTS AFTER THE APPLICABLE PERIOD OF EXPRESS WARRANTY OR GUARANTY (EXCEPT AS MENTIONED ABOVE) GIVEN BY ANY PERSON,
FIRM OR CORPORATION WITH RESPECT TO THE PRODUCTS SHALL BIND CANON CANADA (SOME PROVINCES DO NOT ALLOW LIMITATIONS ON
HOW LONG AN IMPLIED WARRANTY OR CONDITION LASTS, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU). CANON
CANADA SHALL NOT BE LIABLE FOR LOSS OF REVENUES OR PROFITS, EXPENSE FOR SUBSTITUTE PRODUCTS OR SERVICE, STORAGE
CHARGES, LOSS OR CORRUPTION OF DATA, INCLUDING WITHOUT LIMITATION, LOSS OR CORRUPTION OF DATA STORED ON THE PRODUCTS’
HARD DRIVE, OR ANY OTHER SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES CAUSED BY THE USE, MISUSE OR INABILITY TO USE THE
PRODUCTS, REGARDLESS OF THE LEGAL THEORY ON WHICH THE CLAIM IS BASED, AND EVEN IF CANON CANADA HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY OF ANY KIND AGAINST CANON CANADA BE GREATER THAN THE PURCHASE PRICE OF
THE PRODUCTS SOLD BY CANON CANADA AND CAUSING THE ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK
AND LIABILITY FOR LOSS, DAMAGE OR INJURY TO YOU AND YOUR PROPERTY AND TO OTHERS AND THEIR PROPERTY ARISING OUT OF USE,
MISUSE OR INABILITY TO USE THE PRODUCTS NOT CAUSED DIRECTLY BY THE NEGLIGENCE OF CANON CANADA (SOME PROVINCES DO NOT
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU).
THIS LIMITED WARRANTY SHALL NOT EXTEND TO ANYONE OTHER THAN THE ORIGINAL PURCHASER OF THE PRODUCTS OR THE PERSON FOR
WHOM IT WAS PURCHASED AS A GIFT.

This warranty gives you specific legal rights, and you may also have other rights which vary from province to province.

CANON CANADA INC.
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